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 Introduction 

The OLI Studio 

The OLI Studio is freeform electrolyte simulation software. With this software, a client can define 
chemistry and process pathways without predefined recipes that produce specific results. The OLI Studio is 
a software suite containing several modules including, Stream Analyzer, Corrosion Analyzer, and Studio 
ScaleChem. A client’s license determines which modules are enabled within the OLI Studio.  

The Training Manual 

This training manual is designed by Aqueous Process Simulations, Inc. (AQSim) to highlight OLI Studio: 
Stream Analyzer and Corrosion Analyzer features and functions. AQSim has a separate training manual for 
OLI Studio: ScaleChem.  

The manual provides general concepts, theory, explanations of chemical principles, and various 
calculations. Certain chapters have follow-up examples, which are designed to reinforce concepts learned 
within the chapter. The subsequent chapters have real world applications of the software. The manual is 
self-guided but is also used to accompany trainings provided by AQSim.  
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OLI Studio Components 

Stream Analyzer  

Stream Analyzer is standalone software. It 
requires no additional components to run basic 
calculations. It is the main interface of the OLI 
Studio, highlights of which include: 

 Thermodynamic Frameworks 

 Phase Selection and Manipulation 

 Names Manager and Units Manager 

 Calculation Objects 

 Plotting, Reporting, Customization tools; 

Water Analysis charge and pH 

reconciliation 
 

 

Corrosion Analyzer 

 

 

Corrosion Analyzer is a module within the OLI 
Studio. A separate license enables this module. 
Highlights include:  

 EH-pH Stability (Pourbaix) Diagrams  

 Species Phase Diagrams 

 Polarization Diagrams 

 General Corrosion Rates  

 Local Corrosion Rates 

 Extreme Value Statistics (a module within 

Corrosion Analyzer 

 

Studio ScaleChem 

ScaleChem was OLI Systems’ standalone, 
upstream software. This software is now a 
component within the OLI Studio. Studio 
ScaleChem can perform the following operations 
within both OLI thermodynamic frameworks 
(Mixed Solvent Electrolytes and Aqueous) and 
special databases:  

 Brine, Hydrocarbon, Oil Analyses  

 Scaling Scenarios  

 Mixer and Saturator Calculations 

 Facilities 

 Contour Diagrams  
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OLI Studio Interface 

The OLI Studio modules share a common interface. Clients can hide or show many of the sections 
described below. For instance, clients can remove the Calculation Status bar or Template Manager or add 
or remove tools from the Quick Access Ribbon (Toolbar).  

 

The Navigator Pane displays streams and calculation objects in a branched hierarchy. Below this is the 
Action Pane, which lists all the objects of Studio modules enabled by a client’s OLI license. The Calculation 
Status and Output bars are on by default but can be hidden. Clients will mostly work in the Description / 
Definition area, which is contextual - changing depending on which object a client is working on.  

Menu Bar 

 

Notable features within the menu bar are explained below. View, Window, Help are options   

File 

 

This File menu contains standard 
options like New, Save, Print, etc.   

 

 

Properties opens a box that shows 
file type, location, size, the date, build 
and version number of the last save. 

 

The most recently worked on streams 
will also be shown.  
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Edit  

Certain streams can be 
copied and pasted within the 
Navigator using the Edit menu 
or right-mouse click options.  

 

The Edit menu also has the 
following actions of note: 

Clear Results – Removes all 

calculation output  

Clear Status – Stops or 

removes a calculation  

Streams 

 

The Streams menu contains 
actions that can also be 
performed using the Actions 
Pane. These actions are Add 
Stream, Add Analysis, and 
ScaleChem, which has its own 
sub-menu.  

 

Calculations 

The Calculations menu 
contains all the calculations 
found in the Actions pane, as 
well as more specific 
calculation types. 

 

For instance, the Single Point 
calculation option opens into 
a submenu for the 10 single 
point calculations available in 
the software.  

 

Chemistry  

Clients can adjust the chemistry of the software in this menu 

 

 

 

Pre-built Models lets clients 

create a single, specialized 

model and port it to or from 

other application files.  

 

Templates allows clients to 

make a series of standard 

input component sets e.g. a 

standard seawater 

 

Selecting Model Options opens a submenu with that allows clients to 
make advanced changes to the chemistry of the software.  

 

Thermodynamic Framework –To select either the Aqueous or MSE 

(Mixed Solvent Electrolyte) Framework  

Databases –  To select an installed database 

Redox – To toggle on/off oxidation-reduction reactions  

Phases– To toggle on/off phases or solids can be selected as well.  

T/P Span – To change Temperature and Pressure maximums 
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Tools 

This menu item contains several features. 

 

Component Search allows clients search for species in the OLI database. 

 

Names Manager 

Names Style: clients select how to 
view chemical names i.e. by 
Formula, Display Name  or the OLI 
convention (TAG names). 

 

Search Criteria: clients determine 
how the software searches for 
components. The default option is 
to search by all available names.  

 

Names Dictionary: clients can 
rename components with this tab 
or import dictionaries used by OLI 
software.  

 

Units Manager allows clients to modify units.  
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Toolbar (Quick Access Ribbon) 

 

The Quick Access Ribbon or toolbar sits below the menu bar Menu Bar. Tools within the ribbon can be 
added or removed or repositioned (the Calculation Status Bar can also be hidden or moved).  

To move a set of tools, clients can drag the left side of a set of tools.  

The ribbon can also be customized by selecting View from the Menu 
bar, then selecting Toolbars. Key tools are described below: 

Phases Turn on/off specific phases i.e. if So (solid) is turned 

off, then no solid phases form  

Redox Turn on/off Oxidation-Reduction and select redox 

subsystems 

Chemistry Model Options Select the Aqueous or Mixed 

Solvent Electrolyte thermodynamic framework. 

Component Search  Add inflows to the calculation  

Names Manager Changes the style of names i.e. Display, Formula, OLI Tag names 

Units Manager  Changes units 

Customize window Customize the window appearance 

Tools Options Shortcut Adjusts default software settings 

Navigation Pane 

The Navigator Pane or tree level contains the list of streams and calculations that are active within a file. 
This view contains the icons and names of each action in a hierarchical tree. The Description/Definition 
pane changes depending on the level that is highlighted. A plus sign next to an object in the stream level 
indicates that that stream or object has substreams or branches. There are three main levels here.  

 

 

 

Filename A star next to a filename indicates that it has not been saved 

Global Streams Level Provides the broadest view of Navigator objects 

Stream Level Chemistry is entered at this level.  

Calculation Level Most calculations (except mixing blocks) are 
subordinate to streams and appear as substreams. Certain streams (i.e. 
ScaleChem objects) have embedded calculations.  

 

Calculation sublevel Some calculations have their own substreams. 
These substreams can be added to the Global level using the Add as 
Stream function.  
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Action Pane 

This view contains selectable action icons. Each icon represents either a new stream input or new 
calculation. Additional actions will appear depending on what kind of stream we are working with.  

 

After adding an item from the action pane, the action appears as a “stream” in the Navigator menu. 
Depending on the item selected, additional actions may appear in the actions pane. Items can also be 
selected from the menu bar.  

Calculation Types 

Once a client selects or highlights an object, object-specific calculations become available in the Actions 
bar. Stream and Water Analysis objects each have s specific set of calculations. The calculation available 
within a Water Analysis object is called a Reconciliation. Available Stream calculations are:  

Single Point calculations compute the properties for a stream at one set of conditions. 

Clients choose from isothermal, dew point, bubble point, precipitation point, or custom. 

Multiple Point or Survey calculations  are a series of single-point calculations in which 

independent variables such as temperature adjusts with `each calculation (e.g., a temperature survey). 

Up to two variables can be adjusted simultaneously, and a third can be fixed (e.g., pH or bubble point 

pressure/temperature). There are several examples of multiple point calculations in the TOT manual. 

Chemical or Stability Diagrams,  also known as real-solution Pourbaix diagrams, plot 

the phase stability region across a two-independent-variable range. An example would be Calcite 

stability when a pH and CO2 vary. 

Corrosion Rate calculations  compute the general and localized corrosion rates of metals 

and alloys. They contain both single- and multiple-point calculations 

Calculation Status Screens 

The Calculation Output Window 
shows progress, errors, temporary 
file locations, and other data.  

 

The Calculation Status Dialog 
shows an estimate of the 
remaining calculation time. 

 

The Summary Window shows 
inputs, calculation outputs, 
warnings, and has hyperlinks to 
the Units and Framework 
managers. This window varies 
with object.  

 



 Single Point 
Calculations 

Introduction 

Training of OLI Studio: Stream Analyzer begins with the Single Point Calculation.  It is the software’s 
simplest set of calculations. There are thirteen single-point calculation types, and elements of each are 
presented in this chapter. 

The key elements of training include entering molecular inflows in the Stream object, adding a single 
point object and selecting one of the calculation options.  Through each example, subtle changes are 
presented so that additional features and functions are learned.  These feature/functions enhance the 
software flexibility, enabling certain system states to be modeled.  

The single point calculations are listed below.  

2.1 Isothermal ............................................................................................................................................... 2 

2.2 Bubble Point .......................................................................................................................................... 11 

2.3 Dew Point .............................................................................................................................................. 15 

2.4 Vapor Fraction and Amount .................................................................................................................. 19 

2.5 Isochoric (Constant Volume) calculations ............................................................................................. 23 

2.6 Set pH .................................................................................................................................................... 26 

2.7 Precipitation Point ................................................................................................................................ 33 

2.8 Composition Point ................................................................................................................................. 41 

2.9 Reconcile Alkalinity ............................................................................................................................... 51 

2.10 Custom Calculations ............................................................................................................................ 52 

2.11 REDOX (REDuction/OXidation) Basics ................................................................................................. 61 

2.12 Air – Using Air in Analyzer Calculations .............................................................................................. 66 
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2.1 Isothermal 

Overview 

The default and most basic single point calculation is Isothermal. The 
software computes solution properties based on a known composition, and 
condition. You will create a 1.0 molal solution of FeCl3 at 25oC and 1 atm and 
calculate the solution properties.  

✓ Launch the software  

 

The Software opens with a new file named Document1.  The Navigation panel contains a single Streams 

object - .  This global Streams object is used to fix the default settings of the file, 
like the names, units, and thermodynamic framework.  

✓ Click Add Stream icon in the Actions pane.  Or, select Streams > Add Stream from the Menu 

 

A new stream object appears in the Navigator panel below the global Streams object. The object has 
the generic name “Stream.” The stream name is changed using the <F2> key, or by selecting the 
Description tab, or by right-mouse-clicking on the object and selecting rename.  

 

The software switches to the Definition tab.  This tab contains the grid in which the solution 
composition is defined (added). The grid is divided into two Stream Parameters and Inflows.   

This Stream Parameters section contains three rows, Stream Amount, temperature, and pressure.  The 

default settings are 1 kg at 25C and 1 atm.  The inflows category contains the molecular components 
that make up the system.  When a stream is created only H2O is present in the grid. Its cell is yellow 
because it cannot be removed, it is a permanent inflow.   

Starting the work 

Before starting a working file for this chapter… 
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✓ Save the file (File > Save As…) and type an appropriate name (e.g. Chapter 2) 

✓ Select the stream in the Navigator then press <F2> and rename it ‘Isothermal’ 

 

 

The software has two chemical frameworks. The Aqueous Framework (AQFW) which is the default and 
the Mixed Solvent Electrolytes Framework (MSEFW).  . We will use the MSEFW for this example. 

✓ Select the MSE Framework (MSE FW) button in the toolbar  

 

The grid formats and the thermodynamic setting changes are complete.  The object is ready for study.  

✓ Type FeCl3 in the white cell below H2O Inflows of the grid  

✓ Press <Tab> or <Enter>  

Pressing the Enter or Tab keys advances the cursor to the next selectable cell.  

✓ Enter a value of 1.0 mole  

 

Adding a Single Point Calculation  

The next step is to perform the calculation.  Calculations are run in a Calculation object that sits under a 
Stream object.  There are several calculation objects, and this chapter focuses on the Single Point. 

✓ Click on the Add Calculation dropdown menu and select Single Point 

Changing how components and species appear. The Names Manager is used to change the text in 
the grid.  It can be formulas (e.g. H2O) or display names (e.g. water). 

✓ Select the Names Manager in the toolbar then select Formula 
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The Single Point object is a unit of the Stream and will contain the stream inflows, formats, and 
specifications. 

✓ Label the calculation object FeCl3 

 

The overall format of a calculation object is similar to the Stream object, with some differences.  First, 
there are more yellow cells on the grid.  This is the chemistry added at the Stream level and it cannot be 
removed at this level (though the amount can be changed).   

 

Second, the upper right section (the calculation section) contains a calculate button and multiple 
calculation types.   

 

The calculation button has three colors:  

• Red - insufficient specifications for a calculation 

• Yellow - Incomplete specifications but calculation can continue 

• Green – Completed specifications, the calculation is ready 

The default calculation type is Isothermal.  An isothermal calculation is defined having the temperature, 
pressure, and total composition known. The total system energy, phase behavior and speciation are 
computed. 

 

The calculate button is green, and object is ready to calculate. 

✓ Click the Calculate button (you can also press the <F9> key) 
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A Calculation Dialog box appears during the calculation. It displays the calculation’s progress.  Single-
point isothermal calculations compute very fast.  This calculation dialog is more important when 
multiple point calculations are run. 

 

When finished, the box reads “Calculation Complete” then the window closes. There is now a check 

mark on completed calculation object. . 

Viewing the Results  

The Summary box, below the calculate button displays a partial set of results including pH, density, and 
volume, as well as the total calculation time.   

✓ Find the pH and the amount of solid that formed 

  

The pH should be about 1.5, and there is about 0.01 moles of solid present.  The complete set of results 
are in the Report tab. 

✓ Click the Report tab  

 

✓ Scroll down to the Stream Parameters table 

This table contains the thermophysical properties for each phase that forms in a calculation.  The top 
table is for Liquid 1 (the water phase), and the properties include pH, salinity (ionic strength), dielectric 
constant, viscosity and other measurable properties.   
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The next table is the Solids Properties There is less data computed for the solid phases.  This is in part 
because there can be multiple phases, and this information is presented in other sections.   

 

The next table down should be the thermodynamic properties.  This include density and enthalpy for 
each phase and for the Total system.  The Total Density is the bulk density. 

 

✓ Scroll down to the Scaling Tendency table 

This table contains the thermodynamic saturation of potential minerals.  If the value is 1.0, then the 
solid phase is present and in equilibrium with the water.  If the value is below 1, then the solid phase is 
subsaturated.   

 

It is common for the user to prefer the Pre-Scale tendency (also called Saturation Ratio).  The pre-scale 
tendency is the value BEFORE solids precipitate, and represents the driving force for precipitation or 
dissolution.  The pre-Scale Tendency, is an optional property that can be selected in the Calculation 
Options window. 
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✓ Scroll down to the Species Output (True Species) table 

✓ Review the Solid column first 

The software computes that 0.011 moles Fe(OH)3 solid has formed and is in equilibrium with the ~1.5 
pH solution.  The remaining 0.89 moles of iron added is dissolved in water as various aqueous 
complexes, such as iron chlorides and hydroxides.   

Calculation Options – Not all properties are computed by default.  There are additional properties 

available, including heat capacity, entropy, Gibbs energy, etc.  These properties are off by default but 

can be turned on in the calculation options window.   

 

This can be accessed in a few ways, including the specs button in the toolbar , the Specs. 

Button above the calculation button - , or by right-mouse-clicking on the Single Point 

Calculation and selecting Calculation options 
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The low pH computed results from iron’s reaction with water.  Dissolved iron-hydroxide complexes and 
solid Fe(OH)3 sequesters OH-1, results from H2O hydrolysis (splitting) according to the following example:  

 𝐹𝑒+3 +  6𝐻2𝑂 = 𝐹𝑒(𝑂𝐻)3 + 3𝐻3𝑂+ 

The 0.011 moles of Fe(OH)3 precipitate generates 0.033 moles H3O+.  This is about 3/4th the total H3O+1 
in solution (0.45 mol).  The remaining H3O+1 is produced from the 0.012 moles FeOH+2.    

By definition, 𝑝𝐻 = − log 𝑎𝐻3𝑂+1, where 𝑎𝐻3𝑂+1  is the activity of the hydronium ion.  An approximation 

is using the hydronium concentration:  

𝑝𝐻 ≅– 𝑙𝑜𝑔10(𝐻3𝑂+1) = 1.35 

This value is close to the computed value of 1.45, the difference being the hydronium ion activity 
coefficients that is not part of the approximation. 

The software computes nine total iron-containing species, each coordinate a different number of 
water, hydroxide, and chloride.  A more detailed explanation of iron speciation is provided in the 
appendix of this manual or in various aquatic chemistry textbooks.  

Recalculating using different iron-containing inflows  

The mixture FeCl3-H2O produces a low pH.  The chloride ion is the conjugate of the strong acid HCl, and 
it does not interact with H3O+ until the pH is very low (negative values).   If instead of using the 
conjugate of a strong acid, a weak acid conjugate like phosphate, acetate, borate, are used, then a 
different pH would be computed.  This is because these anions have a greater affinity for H3O+ , and 
reducing its overall activity (thus raising pH).   

✓ Return to the Isothermal stream in the Navigator  

✓ Add a new single point calculation and label it Fe-Anions 

 

✓ Click on the Fe-Anions object (if not already in focus) 
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✓ Enter FePO4.2H2O in the grid cell below FeCl3  

✓ Enter a value of 1 mole and set the FeCl3 inflow to zero 

 

Notice that the FePO4.2H2O cell is white.  This is because it was added at the calculation level, and not 
the stream level.  This inflow will be local to this calculation only and will not be transferred to other 
objects added to this stream. 

✓ Calculate (or press the <F9> key) 

✓ View the pH and solids in the summary section 

 

The pH is about 3; 1.5pH units higher than the FeCl3 case.  This is because the H3O+ concentration is 
~1/101.5 the concentration.  Move to the report and review the Species Output table. 

 

The table is quite long but most species are at low amounts and can be ignored.  The species with the 
highest amount is the solid, FePO4.2H2O; 99.8% of it precipitated.  This solid phase is identical to the 
inflow and so there is essentially no reaction/hydrolysis of water.  However, the next highest amount is 
Fe(OH)3 solid (0.00104 moles), and this phase creates three equivalents of H3O+1 as in the FeCl3 
calculation above.  The H3O+ amount is not 3 x 0.00104 moles, because the PO4

-3 that did not precipitate 
reacted with the acid to form H2PO4

-1 and H3PO4.  Thus PO4
-3, acts as a pH buffer, and “absorbs” the acid 

that is generated from the formation of Fe(OH)3 solid phase.  

✓ Save the file by selecting the save button in the tools ribbon  
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Follow-up Example #1 – Find the pH of Selected Solutions 

The table below contains common industrial chemicals. We want to determine the pH when 1 mole/kg 
of each component is added to water (1 mole in 55.508 moles H2O).  

The following steps outline one method of approaching this application.  

✓ Create a new stream, label it Example #1  

✓ Add the first component, HCl and set the inflow to 1 mole 

✓ Add a single point isothermal calculation, calculate and then note the pH  

✓ Create a new stream or type over HCl with the second component, H2SO4 

✓ Confirm that the flow is still 1.0 mole and calculate 

✓ Type over H2SO4 with H3PO4 and calculate 

✓ Continue until each component below is tested 

Some questions to consider:  

• Are there any unexpected results?  

• Why is the pH of HF much higher than HCl (and also HBr and HI)?  

• Boric acid’s, B(OH)3, chemical formula resembles a base, why is it acidic? 

• Why is there such a pH difference between MgOH2 and CaOH2?  

• The same question can be posed about the difference between Na2CO3 and CaCO3. 

Follow-up Example #1 – Find the pH of Selected Solutions 

Acid Chemicals pH @25C and 1 atm Base Chemicals pH @ 25C and 1 atm 

HCl  NaOH  

H2SO4  Ca(OH)2  

H3PO4  Mg(OH)2  

HF  NH3  

B(OH)3  CaCO3  

Citric Acid  Na2CO3  
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2.2 Bubble Point 

Overview 

Liquid boils when its vapor pressure exceeds its confining pressure. Boiling occurs by 
adding heat (isobaric boiling), or reducing confining pressure (isothermal boiling). Either 
way, the effect is the same: a vapor phase forms.   

The OLI Studio calculates this phenomenon using a calculation type called Bubble Point. 
Since the OLI does not assume an air phase, the confining pressure acts like a plunger on 
a liquid’s surface. The pressure the plunger exerts is the pressure entered in the grid. 

 

You will compute the Bubble Point of a 6% acetone solution by changing temperature (isobaric) and 
then pressure (isothermal).  

Starting the work 

✓ Add a new stream  

Use the inputs and parameters from the table below to create the stream’s composition. Most 
examples in this manual use similar tables. Certain default categories, such as the names, style and units 
set will require further adjustments, which will be described below.  

2.2 Bubble Point Stream Composition 

Stream Name:  Bubble Point Stream Amount 1 kg 

Names Style Display Name Temperature 25C 

Units Set Metric, mass fraction Pressure 1 atm 

Framework MSE (mixed solvent) Water 94 mass%  

  Acetone 6 mass% 

✓ Rename the stream Bubble Point, by click on the object and pressing <F2>, or click on the 
Description tab and enter the name there. 

 

✓ Select the Names Manager button in the toolbar  

✓ Select the Display Name radio button 

 

✓ Select the Units Manager button in the toolbar   

✓ Select Mass Frac from the third dropdown list 

6% acetone 

in 1kg water

1 atm

6% acetone 

in 1kg water

6% acetone 

in 1kg water

1 atm
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✓ Select the MSE button in the toolbar  

✓ Select the Definition tab  

✓ Enter Acetone in the Inflows cell below Water  

✓ Change the Acetone mass % to 6 (the water value automatically adjusts) 

 

Calculate the Bubble Point Temperature (isobaric) 

✓ Use the Add Calculation dropdown menu to add a Single Point Calculation  

 

A new calculation object appears under the Bubble Point stream 

✓ Label the stream Acetone BPT (BPT=bubble point temperature) 

 

✓ Select Bubble Point as the calculation type  

 

A Calculation Parameters section appears in the grid.  This section contains single option – the 
calculation variable, temperature or pressure to be changed.  Temperature is the default setting. 

 

There are also two dots to the left of the Temperature and Pressure rows. The yellow dot represents 
the “dependent” variable.  The temperature value, 25.000 is colored green. This value is now an initial 
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guess, since the final value will be computed.  The brown dot adjacent to the Pressure variable indicates 
that this potentially dependent variable is “fixed”. 

✓ Calculate or press the <F9> key 

✓ Review the Summary  

  

The temperature at the bubble point is computed to be 87.26C at 1 atm. Notice the vapor amount, 
1.78e-10 kg out of a total 1 kg.  This is by design, and is explained as follows: 

1) This stream is 1 kg.  

 
The software converts the 1 kg stream amount to apparent moles (this value can be found in the 
report) 

2) The software then sets the amount of vapor at 1/1010th the moles of the Stream Amount (top 
row of grid)  

 

3) Lastly, it varies the temperature until this amount of vapor mole is reached.  This computed 
temperature reported as the bubble point temperature. 

The software uses this same phase appearance technique for dew point and precipitation point 
calculations.  

Pressure at Bubble Point 

This next calculation computes the bubble point pressure for the same stream.  This is a simple switch.   

✓ Change the Calculate-Temperature row to Calculate Pressure  

 

The yellow buttons to the left of the Temperature and Pressure rows switch, and now the 1.000 atm 
pressure is green; the initial guess.  The 25 C temperature is fixed. 

✓ Calculate (or press the <F9> key) 

✓ Review the Summary  
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The bubble point pressure is 0.07089 atm.  Notice that the vapor mass differs.  It is 2.17e-10 kg in this 
case compared to 1.8e-10 kg in the bubble point temperature case.  The identical number of moles of 
vapor is present in both cases.  The reason this occurred is because the vapor composition changed.  In 
the bubble point temperature case, the fraction of acetone in the vapor is 66.9%.  in the bubble point 
pressure case, the acetone fraction in the vapor is 80.8%.  Since acetone weighs 58.1 g/mol vs water at 
18 g/mol the mass of vapor weighs more at the 25 C case than at the 87 C case. 

Follow-up Example #2a – Boiling Points of Common Organics/Inorganics 

Use the approach presented above to compute the boiling point temperature of the following solutions 
at 1 atm pressure. The abbreviated instructions are as follows:  

✓ Add a new stream  

✓ Change the units to Metric, mass fraction 

✓ Enter the component and give it a value of 6 mass % 

✓ Add a Single-Point, Bubble-Point calculation and select the temperature button 

✓ Calculate then record the temperature 

✓ Add another stream with the next component, and so on 

Follow-up Example #2a – Boiling Points of Common Organics/Inorganics 

Organic at 6 mass%  Boiling Point at 1atm  Inorganic at 6 mass  Boiling Point at 1atm  

Methanol  HCl  

Formaldehyde  NaCl  

Acetic Acid  CaCl2  

Ethylene Glycol  FeCl3  
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2.3 Dew Point 

Overview 

The purpose of this next example is to review the Dew Point calculation, 
and the properties and phase compositions computed by it.  The case is a 
sour natural gas (contains H2S) and the temperature at which this gas will 
condense, and potentially corrode the existing equipment.  The Dew Point calculation computes the 
initial condensation point of a stream.  This point is defined as when 1/106 of the existing system (or 1 
mole whichever is smaller) is in a liquid phase.   

The sour gas source is a dolomite reservoir in which sulfates have been reduced to form H2S.  This sour 
gas can create potential process and safety problems, and understanding its state is important to the 
engineer.   

The stream to be modeled contains 3% CO2 and 1% H2S.  It is a fairly acidic gas. 

2.3 Dew Point Stream Composition  

Stream Name Dew Point Temperature  120 C 

Units Set Metric-Batch-Mole Fraction Pressure 100 atm 

Names Style Formula H2O (calculated)  

Framework Aqueous (H+) CH4 94 mole % 

Stream Amount 1e6 CO2 3 mole % 

  H2S 1 mole % 

Starting the work 

✓ Add a new stream  and name it ‘Dew Point’ 

✓ Click on the down-arrow adjacent to the Names Manager button  (in the toolbar) and 
select the Formula view  

 

✓ Select the Units Manager button in the toolbar  and change the basis to Mole Frac. 

 

✓ Press OK to return to the Definition grid 

The Inflows should now be in mole % units.   

✓ Enter the data in the table above, starting with the Stream Amount (1.0e6 mol), Temperature 
(120C), and Pressure (100 atm).   Next add the inflows (94% CH4, 3% CO2 and 1% H2S)  
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✓ Select Single Point from the Add Calculation dropdown list  

 

✓ Select Dew Point as the Type of Calculation  

 

You will keep the Temperature radio button selected.  

✓ Calculate (or the <F9> key) 

✓ Review the Summary box and note the temperature 

✓ Select the Pressure radio button recalculate  

 

✓ Review the Summary box and note the pressure  

  

The calculated temperature is 113.5°C. The dew point pressure is 129.8 atm. These conditions create 
potential corrosion problems. How would we mitigate them?  

The aqueous phase is small relative to the total system size as seen in the Phase Amounts list of 
the Summary. OLI Studio computes the dew point by fixing the aqueous mass at a small value 
and adjusts the temperature or pressure accordingly until that amount of liquid is obtained.  
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✓ Click on the Report tab (do this AFTER you switch to Calculate-Pressure)  

✓ Scroll down to the Species output table 

 

The aqueous phase composition is shown in the center column.  The dissolved CH4, CO2 and H2S are is 
0.164, 0.051 and 0.046 mole %, respectively.  The gas-phase CO2 is three-times H2S, yet their aqueous 
concentrations are roughly the same.  This is because H2S solubility in water is about three times greater 
than CO2 at these conditions.   

Follow-up Example #3 – Dew Point pH of Acid Gases 

You will test the impact of acid gases and organic acids on dew point pH. You will enter the following 
gas compositions and calculate the dew point temperature and condensate pH. The pressure is 70 atm 
and the initial temperature is 120°C. Use mole fraction units for this example. 

Follow-up Example #3 – Dew Point pH of Acid Gases  

Name FE#3 FE#3-1 FE#3-2 FE#3-3 FE#3-4 FE#3-5 

Inflow (mol %)       

H20 1.5 1.5 1.5 1.5 1.5 1.5 

CO2 0 .01 .1 0 0 0 

H2S 0 0 0 .01 .1 0 

Acetic Acid 0 0 0 0 0 .0001 

Methane 98.5 98.49 98.4 98.49 98.4 98.4999 

Dew Point Temp? 96.8384      

Dew Point pH? 6.14237      

One way of approaching this example is with following procedure:  

✓ Add a new stream  ✓ Open the Units Manager and select Metric-Batch-Mole Frac. 

✓ Change the temperature to 120C and the pressure to 70 

✓ Enter CO2, H2S, Acetic Acid, and Methane as the Inflows  

✓ Keep the mole% values empty 

✓ Add a Single Point calculation  

✓ Select the Dew Point type and keep the Temperature radio button selected  

✓ Right-mouse click on the stream and select Copy 



2-18 Chapter 2: Single Point Calculations Tricks of the Trade 

 

✓ Right-mouse click on the Global Stream object and select Paste 

✓ Paste the stream five times so that you have a total of six duplicate streams 

✓ At the stream level of each new object, change the inflows to match the composition values 
(mole%) of the corresponding row from the table above (H2O computes automatically)  

✓ Select each of the calculation sub-streams and press the calculate button 

✓ Determine the dew point temperature and the dew point (condensate) pH 

The acidity of certain gas components is a function of ionization constants and water solubility.  

✓ Compare the streams named, “FE#3 -1” and “FE#3 -3” (the 0.01 CO2 and 0.01 H2S streams) 

✓ View the species output table in the report tab of each stream 

In the 0.01 H2S stream (FE#3-3), the condensed water H2S concentration is 3.34e-4 mol%. In the 0.01 
CO2 stream (FE#3 -1), The CO2 concentration is 1.10e-4 mol%, one-third that of H2S. However, since CO2 is 
slightly more acidic at this temperature, pKa (CO2) =6.34 vs. pKa (H2S) =6.98, the pH values are roughly 
the same.  

As for the acetic acid stream, at 1e-4 mole% (1ppmV), its concentration in water is 7.64e-3 mol%. This is 
23 and 70 times higher than H2S and CO2, respectively. Coupled with a stronger acidity (pKa(HAc)=4.94), 
it creates a much lower solution pH. 
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2.4 Vapor Fraction and Amount 

Overview 

The Vapor Fraction and Vapor Amount calculations are identical in nature to the Bubble Point 
calculation of Section 2.2, except that instead of the software defining the vapor amount at 1/1010 the 
total stream amount, the user defines the vapor size in either mole fraction units (Vapor Fraction) or 
mole units (Vapor Amount).   

You will evaporate boiler feed water (BFW) up to 95 % (a vapor fraction calculation).  The feed water 
composition has been created from a water analysis (see chapter 4) and the molecular flow is being 
used.  To assist the user in recognizing the BFW composition, a second table displaying the 
concentrations are also shown.  Seawater will be created using an already-prepared calculation object, 
plus the Add as Stream function.  

Starting the work 

The table below contains the BFW composition in molecular form.  These molecular flows do not 
represent any specific phases, rather they are the elements (and oxidation states) that are part of this 
stream.  The stream is 1,000 kg in amount. 

BFW molecular inflow in grams 

Inflow Grams Inflow Grams 

H2O 994869 MgO 0.160 

SiO2 44.77 Na2O 1207.3 

CaO 0.0674 NaCl 2985.9 

CO2 857.45 SO3 12.41 

K2O 23.86   

✓ Create a new stream and label it BFW 

✓ Set the framework to MSE FW -  

✓ Open the Units Manager and set the units to Metric-Batch-Mass 

 

✓ Set the pressure to 80 atm 

✓ Enter the inflows above 

When finished, the grid should look like the one below. 

  

This set of molecular inflows is based on the following water analysis.  This analysis is studied in a later 
chapter. 
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Evaporate BFW to 75%  

✓ Add a single-point calculation 

✓ Set the calculation type to Vapor Fraction 

✓ Set the fraction to 75%.  Be sure that the pressure is 80 atm. 

 

The software will convert the 1000 kg to mole units, and will put 75% of this in the vapor phase.  It then 
changes the temperature until that vapor amount is reached. 

✓ Calculate 

✓ Review the summary section 

 

The phase amounts are 74.8% in the vapor and 25.2% in the water phase.  This is slightly different from 
the 75% set point, and this is because the set point is in moles and the summary is in mass.  This will be 
seen next. 

✓ Select the Report tab and scroll down to the Total and Phase flow table 
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The Apparent moles (second row) are the molecular representation of the system. There is a total of 
55314.6 apparent moles in this system, of this exactly 75%, or 41486 moles is set to vapor.   

✓ Scroll down to the Scaling Tendencies table 

Two solids, brucite and pectolite are computed to be present, as their scale tendency is 1.0.   

 

The amount that precipitated is in the Species Output table.   

✓ Scroll down to the Species Output table and look for the phases in the Solid column.   

The brucite mass is 0.23 g pectolite mass is 0.2 g.  The remaining composition is less important since the 
main concern with boiler feed water is solids formation. 

 

✓ Scroll up to the Stream Parameters table and note the final temperature 

The equilibrium temperature at 75% evaporation is 296.8 C.   

 

Conditions at 90% evaporation 

✓ Recalculate the case at 90% evaporation and note the system temperature and the solids 
that formed  

The temperature is computed to be 297.95 C, which is about 1 C higher than the 75% evaporation 
state.  The reason for the increase is the increased water salinity which changes the vapor pressure of 
the liquid.   

 

Brucite and Pectolite reman the key minerals, and their mass changed very little.  This indicates that 
these minerals probably precipitated much earlier in the evaporation step.   
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Conditions at 1% and 99% evaporation 

Calculate this system twice more, at 1% and 99 % evaporation.  The purpose of this is two-fold, to 
calculate the temperature rise across the boiling range and to see if the two minerals are forming at low 
fractions of vapor. 

✓ Recalculate the case at 1% evaporation and note the system temperature and the solids that 
formed  

✓ Calculate again at 99% 

✓ Tabulate the results, temperature, solids, and ionic strength (molal-based) 

There is a significant temperature increase above 95% evaporation, and is due to the significant ionic 
strength (salinity) change.   

The plot below is the boiling temperature relative to the ionic strength.  The temperature-ionic strength 
relationship is fairly linear.  It took until about 95% evaporation before a significant change in the 
salinity, and therefore temperature, was observed. 

 

At 1% evaporation, the same brucite and pectolite minerals form with similar mass.  Thus, these solids 
are not a function of the evaporation process.  At 99% evaporation, CaCO3 and Na2CO3 are computed to 
form instead of the brucite and pectolite.   

Evaporation Temperature, C Ionic 
strength 
(molal) 

Mg(OH)2,  

(Brucite). g 

NaCa2Si3O8 
(Pectolite), g 

CaCO3 

(Calcite), g 

Na2CO3 

(Natrite), 
g 

1% 296.17 0.091 0.231 0.168   

10% 296.22 0.099 0.231 0.180   

75% 296.83 0.36 0.232 0.199   

95% 299.87 1.9 0.232 0.200   

99% 312.89 8.5   0.094 1178 
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2.5 Isochoric (Constant Volume) calculations 

Overview 

The Isochoric calculation sets the total system Volume and adjusts the temperature or pressure.  This 
can be understood in a gas-phase from the basis of the Ideal Gas Law P=nRT/V.  If temperature is the 
free variable, then T=PV/nR; and for a given volume, pressure, and gas moles, temperature can be 
obtained, Likewise for P and V, depending on what two variables, P, V, and T are defined.   

Also, since the final state is computed, the system enthalpy is also computed.  Thus, the total system 
state is computed simultaneously, provided that three of the five variables, P, V, T, H, or n are held 
constant. 

You will run a series of gas-phase calculations, in which the system mass and volume are defined 

Starting the work 

The table below contains the stream composition. 

✓ Add a new stream and label it Isochoric 

✓ Add the following components: N2, O2, CO2 and Ar 

✓ Set their compositions to 77, 21, 1, and 0.04 mol, respectively. 

 

This composition represents 1 kg water in about 100 moles of air.   

✓ Add a single point calculation and change it to Isochoric 

 

✓ Change the Calculate to Pressure and the total volume to 10 L 

 

✓ Calculate 

According to the calculation, 305 atm pressure is needed to compress the 154.548 moles of gas and 
liquid into a 10-liter volume at 25C.   

✓ Go to the Report tab and view the Total and Phase Flow table 
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The system is 10 L as defined (within the 1/106 tolerance).  The water phase makes up slightly less than 
1 L and the balance is vapor.   At this pressure, about 2 moles of water condenses, and it has a pH of 3.8.   

✓ Redo the calculation using the volume of 1000 L 

The total pressure is now 2.45 atm, and the pH is 4.71.   

 

There is an interesting difference in this calculation.  The higher pressure increased the CO2 partial 
pressure, and so the pH decreased to 3.8.  At the lower pressure, the pH is higher.  You can confirm this 
in the report.  There are two report variables, Gas-phase partial pressure and fugacity. 

✓ Click on the Report tab 

✓ Click the Customize button in the upper right of the window -  

✓ Press the Clear All button in the center right to deselect All the tables  -  

✓ Next, click on the Species Fugacity and Partial Pressure boxes  

 

This selects the two tables, Species Fugacities and Partial pressure.  The Center part of this window is 
for selecting tables.  The left part of the window is for formatting the tables.    

The two images below are for the 10L and 1000 L case.  
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Figure 1 - Calculated fugacities and partial pressures for the 10 L (left) and 1000 L (right) isochoric calculation.  The total 

pressure for the 10 L calculation is about 300 atm.  The total pressure for the 10 L case is about 2.5 atm 

✓ Return to the Definition tab and recalculate at 10 L.  

✓ Click on the report and view these fugacities 

The two tables above are the computed gas-component values.  The lower table, Partial pressure is an 
indication of how much pressure is in the gas phase (N2 is 237 atm and 1.9 atm for the two cases).  
Notice for the CO2, that the partial pressure and fugacity differ by about 33% (1.6 atm vs 3 atm).   This is 
not so in the 1000 L calculation; the partial pressure and fugacity are nearly identical.  H2O deviates in by 
about 50%.    

The cause of this deviation is the non-ideal effects of high pressures on gas molecules as they are forced 
closer together.  At low pressures, gas molecules are too far apart to interact.  As pressure increases, the 
average distance between two molecules decrease, until at short range, intermolecular attractive forces 
begin to impact the molecular properties.  The impact of this effect is quantified in the fugacity term.  
Notice that fugacity and partial pressure have the same units, atm.  Thus, when reviewing these two 
tables, the partial pressure is the idealized gas property extrapolated effects at higher pressures and in 
the absence of intermolecular forces.  The fugacity is the real gas property at this pressure.  The non-

ideal effect of pressure is therefore encapsulated in the relationship, ∅ =
𝑓𝑢𝑔𝑎𝑐𝑖𝑡𝑦

𝑃𝑎𝑟𝑡𝑖𝑎𝑙 𝑃𝑟𝑒𝑠𝑠𝑢𝑟𝑒
 𝑤ℎ𝑒𝑟𝑒 ∅ =

𝑓𝑢𝑔𝑎𝑐𝑖𝑡𝑦 𝑐𝑜𝑒𝑓𝑓𝑖𝑐𝑖𝑒𝑛𝑡,  At low pressures, a gas molecule’s (g) fugacity approaches its partial pressure 
𝑓𝑔 → 𝑃𝑔 𝑜𝑟 ∅ = 1.   
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2.6 Set pH 

Overview 

The Set pH calculation is a useful tool in analyzing or designing a process. It allows one to create a 
solution that conforms to a premeasured pH.  Other applications include designing a system to meet an 
operational pH or testing the impact of adding an acid or base to a system.   

You will fix the pH of water containing carbonates, to see the speciation and buffering that carbonates 
provide to natural water.  The system will contain three components, CO2, HCl and NaOH.  The CO2 will 
be the solution’s pH buffer, and HCl / NaOH are the strong acid and base to adjust the pH.   

Starting the work 

2.6a - Basic pH calculation 

The solution will be 1 kg water (default) with 0.001 moles CO2. The pH will then be adjusted to 4.3, 8.3, 
and 10.3.  These are key pH values in a carbonate system when at ambient conditions. 

2.5a - Basic pH Calculation 

Stream Name Carbonate Buffer Stream Amount (calculated) Inflows (mol) 

Name Style Formula Temperature 25 °C CO2 0.001 

Framework Aqueous Pressure 1 atm NaOH 0 

Units Set Default (moles)   HCl 0 

✓ Add a new stream and label it ‘Carbonate Buffer’  

✓ Enter the inflows from the above table 

✓ Add a Single Point calculation  

✓ Change the type to Set pH  

  

The Calculation Parameters category appears on the grid.  It contains four rows, the target pH, and 
three titrant specifications.   

 

Set pH to 4.3 

✓ Enter 4.3 in the Target pH cell in the grid 

The default titrants are HCl and NaOH (common) and so no additional settings/specifications are 
required except to set the pH. 
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✓ Calculate 

✓ Change the view to the Output tab and look at the amount of HCl added 

 

About 4e-5 moles HCl is added to reach 4.3.  The pH of 0.001 mole CO2 is about 4.6 (not calculated) and 
there is no bicarbonate alkalinity in the water. Thus, very little acid is needed to reduce the pH to 4.3 
because there are no species in the water to accept the H+ added.  

✓ Click the Report tab and scroll down to the Species Output (True Species) table 

 
Species Output at 4.3 pH 

Specs window – The set pH calculation can also be specified in the Specs window.   

 

The default acid and base are already set, so no additional work is required.  If a different acid/base is 

desired, then the New Inflow button can be used to find additional components.  
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This table contains the computed species in mole units, the amount of each species in water.  The CO2 
amount is 9.91e-4 moles; 99.1% the CO2 added is this form. The HCO3

-1 amount, is 9.05e-6 moles; 0.9% of 
the CO2 added.  The free H+ amount is 5.05e-5 moles, greater than the HCO3

-1 amount.   

The ~4.3 pH is an accepted endpoint for bicarbonate alkalinity, because 99% of all the carbonate is in 
the CO2

0 state and the H+ amount is greater than the available HCO3
-1.  Thus, adding more H+ does not 

change this. The following equilibrium equation illustrates this:  

𝐾𝐴1 =
𝐻+ ∗ 𝐻𝐶𝑂3

−

𝐶𝑂2
0 ∗ 𝐻2𝑂

= 10−6.3(@25𝐶) 

If the pH endpoint of 4.3, and we assume that the water activity is 1.0, then:  

𝐾𝐴1

𝐻+
=

10−6.3

10−4.3
=

𝐻𝐶𝑂3
−

𝐶𝑂2
0 ∗ 1

=
1

100
 

Thus, at a pH of 4.3, the HCO3
-1 content is 1% of the CO2

0 content. 

Set pH to 8.3 

✓ Select the Definition tab  

✓ Change the Target pH cell to 8.3 

 

✓ Calculate then view the Species Output (True Species) table in the Report tab 

 
Species Output at 8.3 pH 

At 8.3 pH, the HCO3
-1 content is 97.8% of the total carbonate, CO2

0 is 1.05%, and CO3
-2 is 1.02%. (ignore 

the small amount of NaHCO3
0 ion-pair for now).  Therefore, the 8.3 pH relationshjp with HCO3 is the 

same as the 4.3 pH relationship with CO2, aq.  The accepted endpoint for CO3
-2 titration to HCO3

-1 or CO2 
titration to HCO3

-1 is 8.3 pH.  From compositional relationship described in the first part of this 
paragraph, we can see why this pH is used.  

Set pH to 10.3 

✓ Select the Definition tab  

✓ Change the Target pH cell to 10.3 
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✓ Calculate then view the Species Output (True Species) table in the Report tab 

 

At 10.3 pH, the CO3
-2 and HCO3

-1 amounts are roughly equal.  The following equations illustrate why.   
The equilibrium constant for the HCO3

-1 – CO3
-2 reaction is 10-10.3 at standard conditions. 

𝐾𝐴2 =
𝐻+ ∗ 𝐶𝑂3

−2

𝐻𝐶𝑂3
−1 = 10−10.3(@25 𝐶, 1 𝑎𝑡𝑚) 

Therefore, at 10.3 pH, the CO3
-2:HCO3

-1 ratio is 1.  

𝐾𝐴2

𝐻+
=

10−10.3

10−10.3
=

𝐶𝑂3
−2

𝐻𝐶𝑂3
−1 =

1

1
 

At 12.3 pH the HCO3
-1 conversion to CO3

-2 is 99% complete, effectively the endpoint of HCO3-1 
conversion.  This however, is difficult to titrate because at 12 pH the OH-1 concentration is about 0.01 
mol/kg and so adding NaOH to convert HCO3-1 also produces free OH-1 ions.  You can test this 
relationship pH and confirm it is the case. 

2.6b – Neutralizing acetic acid 

In this example, you will compute the amount of base required to neutralize a 1 molal acetic acid 

solution. You will assume a neutral system at 7 pH and 25C.  

2.5c Neutralizing Acetic Acid 

Name: Neutralize Acid Temperature 25 C 

Names Style Formula Pressure 1 atm 

Framework Aqueous (H+) H2O 55.5082 

Unit Set Default (moles) CH3COOH 1 

✓ Add a new stream  and name it ‘Neutralize Acid’   

✓ Enter the stream specifications from the above table  

✓ Add a Single Point calculation and change the Calculation type to Set pH  
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✓ Enter 7.0 as the Target pH in the Calculation Parameters grid section 

The acid and base titrants default to HCl and NaOH, and therefore these components do not need to be 
added. 

 

✓ Calculate  

✓ View the summary and confirm the amount of NaOH or HCl added 

 

About 0.997 mole of NaOH is needed to neutralize 1 mole of acetic acid.  

✓ Click on the report and review the Species Output table 

 

At 7pH, nearly all the acetic acid is deprotonated and exists as either acetate-1 and NaAc0 (ion pair). 
There is 0.297% of the acetic acid (CH3COOH) not neutralized.  This is because as a weak acid, there is 
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attractive bonding between the H+ and Ac-1 such that at 7pH not all the H+ is removed.  This again is 
shown in the explanation below 

Explanation 

The assumption that 7pH is neutral is not entirely accurate. Neutralizing an acid or base, especially 
weaker acids and bases, is an asymptotically vanishing relationship.  The plot below is the remaining 
acetic acid (CH3COOH) content in water as pH increases.  The starting amount is 1 mole.  At 3pH, the 
system has about 1 mole of acetic acid (~100% of added). At 9pH, the acetic acid amount is 3e-5 moles.  

 

For practical purposes, an acid is neutralized when 99% is converted to the anion. This condition exists 
at 6.5pH for acetic acid (it is 99.9% neutralized at 7.5pH).   Thus, the 7 pH setpoint effectively neutralizes 
acetic acid, but it does not remove it entirely. 

To see why the content changes minutely when the pH changed by one, review the following chemical 
reaction: 

𝐶𝐻3𝐶𝑂𝑂𝐻 = 𝐻+ + 𝐶𝐻3𝐶𝑂𝑂− 

𝐾𝑎 =
𝐻+ ∗ 𝐶𝐻3𝐶𝑂𝑂−

𝐶𝐻3𝐶𝑂𝑂𝐻
 →  

𝐾𝑎

𝐻+
=

 𝐶𝐻3𝐶𝑂𝑂−

𝐶𝐻3𝐶𝑂𝑂𝐻
 

𝐿𝑜𝑔𝐾𝑎 − 𝑙𝑜𝑔𝐻+ = 𝑙𝑜𝑔 𝐶𝐻3𝐶𝑂𝑂− − 𝑙𝑜𝑔 𝐶𝐻3𝐶𝑂𝑂𝐻 

 

The value Ka is a constant, and at higher pH, CH3COO- is a constant relative to CH3COOH (nearly all of it 
is converted). Also, the term -log(H+) is essentially, pH. Therefore, we can write this as: 

𝑝𝐻 = − 𝑙𝑜𝑔 𝐶𝐻3𝐶𝑂𝑂𝐻 + 𝐶𝑜𝑛𝑠𝑡𝑎𝑛𝑡 
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When plotted on a semi-log plot, this creates the straight line with a slope of -1.0 (shown above). 
Therefore, at the high pH when CH3COO- is nearly constant, the content of acetic acid decreases log-
linearly with pH. There is more to this discussion, but let us leave it there for now.  

Follow-up Example #6 – Acidity and Basicity of Various Mixtures  

Let us look at other acids and bases. We will add these components to a stream with 55.508 moles (or 1 
kg ) of H2O. Then we will neutralize the solution to 7 pH using NaOH or HCl and note how much of either 
was used for neutralization.  

Follow-up Example #6 – Acidity and Basicity of Various Mixtures  

1 mole Acid 
 in 1Kg (55.508 
moles) stream 

NaOH added to 
achieve 7pH 

1 mole Base 
 in 1 Kg (55.508 
moles) stream 

HCl added to 
achieve 7pH 

HCl  KOH  

H2SO4 2 mol NH4OH  

H3PO4  CaOH2 2 mol 

HF  Na2CO3  

Formic Acid  Na3PO4  

Citric Acid  Na2B4O7  

FeCl3  ZnOH2  

✓ Add a new stream   

  

✓ Enter an acid or base from the table above then enter either NaOH or HCl 

✓ Give the acid or base a value of 1 mol 

✓ Add a Single Point calculation then change the type to Set pH  

  

✓ Enter 7.0 as the Target pH in the Calculation Parameters grid section 

✓ Click the Specs… button 

✓ Select the appropriate titrants  

The instructor can help guide you which titrants to select.  

✓ Press OK and Calculate  

✓ Record the amount of base or acid added to the solution  

A question that often arises is why FeCl3 behaved like a strong acid. We confirmed in the first section of 
this chapter that this component is in fact a weak Lewis acid. 

We can approach this problem in several ways. We can add a stream for each of the 
components then proceed with the steps below. We can add all of the components at once 
then go back and zero the component’s values out then add a value to the next component. Or 
we can complete the remaining steps below, then copy and paste the stream, replacing one 
component with the next 
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2.7 Precipitation Point 

Overview 

A precipitation point calculation computes the amount of material held in 
solution at given conditions. This is also called a solubility calculation.  The 
purpose of this calculation type is to find the solubility envelope of a particular solid 
phase.  A common example, is the solubility of a mineral like NaCl in pure water. 

The software computes this solubility envelope by forcing a very small amount of this 
solid to exist.  It then adjusts an inflow up or down until that amount of solid is formed.  

Starting the work 

Basic NaCl solubility calculation 

In this first example, you will instruct the software to compute NaCl solubility in pure water at 25C.  The 
number of steps required to compute this are few, making this an ideal example to test the tool’s 
capabilities. 

✓ Add a Stream and label it Precipitation Point 

✓ Open the Units Manager window and set the units to Metric-Batch-Mass Fraction 

 

✓ Add NaCl to the grid below water 

✓ Add a Single Point Calculation and label it Halite Solubility 

  

This manual will always refer to the solid phase that forms by its mineral name.  This is because there 
are a number of solid phases with the same composition but with different properties.  This is because 
they form different minerals – graphite / diamond (both C) is an example of this, as is calcite / aragonite 
(both CaCO3). 

✓ Change the calculation type to Precipitation Point 

A category called Calculation Parameters appears on the grid.  Set both the Adjusted Inflow and 
Precipitant to NaCl.  Notice that the precipitant includes the mineral name, to confirm that this is the 
crystal form being studied. 

 

Mixed solute 

NaOH 
pH 
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✓ Calculate and review the data in the Summary 

According to the software, NaCl has a solubility of 26.4 wt% in water.  Notice the small amount of solid 
that formed, 0.03µg.  This is the target or specification point on which the software converged the 
calculation.  

 

✓ Next, click on the Output tab at the bottom of the grid -  

 

This screen contains the final composition.  Notice that the stream amount is now 1.36 kg, and not the 
initial 1 Kg.  this is because 360 grams NaCl was added to saturate it in the 1 kg of starting water.  The 
final solution is 73.6% H2O and 26.4% NaCl.   

Saturating a salt water solution with calcite 

In this next example, you will compute the amount of NaOH needed to saturate calcite in a water 
containing Ca+2, Mg+2, Cl-, and CO2. You will add NaOH to raise the pH.  This converts CO2 to CO3

-2, which 
will cause calcite to precipitate.   

The calculation specifications are provided in the table below. 

2.4 Precipitation Point Stream Composition  

Stream Name: CaCO3 Precipitation H2O Calculated (ppm (mass)) 

Units  ppm (mass) Flowing CaCl2 10870 

Names Style Formula MgCl2 9325  

Framework Aqueous (H+)  CO2 431  

Temperature 25C NaOH 0  

Pressure 1 atm    

✓ Add a new single point calculation to the existing Precipitation point stream  

✓ Name it Calcite Saturation  
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You will modify the existing units to change the mass fraction units from Mass% to ppm (mass)  

✓ Select the Units Manager button in the toolbar  

✓ Click on the Customize button 

 

✓ Change the Mass fraction Basis Option from Mass% to ppm (mass) 

 

✓ Close the Units editor window. 

✓ Enter the composition from the table above  

 

✓ Change the Calculation type to Precipitation Point  

 

The calculate button is red. There is red text in the Summary box with instructions that additional 
specifications are needed before the calculation can continue.  

 

These specifications are defined in the Calculation Parameters grid section 

✓ Change the Adjusted Flow to NaOH 

✓ Change the Precipitant to CaCO3 (Calcite) 
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✓ Calculate  

✓ Review the Summary window 

  

The software calculated that ~259 ppm NaOH raises the pH to 6.09 which is sufficient to precipitate 
calcite.  The final composition can be confirmed in the Output tab 

 

It can also be observed in the Report tab 

✓ Select the Report tab and look at the Stream Inflows section (top of report) 

Specs window – The precipitation point parameters can also be set within the Specs window.  Each 

calculation has a set of specifications.   The specifications for precipitation point are the Precipitant 

and Adjusted Variable. 

 

The Precipitant refers to the independent variable – in this calculation, the phase selected is given as 

mole amount of 1/108 the total system moles.  The Adjusted Variable is the variable to be changed by 

the software until the target mole amount is achieved.  
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Notice that the concentrations have changed slightly.  This is to accommodate the additional 259 ppm 
NaOH needed to meet the calculation specifications. 

Follow-up Example #4 – Solubility of Pure Components in Water 

You will run a series of precipitation point calculations to determine the solubility of the following 
minerals.  Do the calculation three times, at 25° C and 95° C and again at 95° C and 1 mole NaCl. 

Follow-up Example #4 – Solubility of Pure Components in Water 

Material Solubility 

 @25°C @95°C @95°C & 1 mol NaCl 

KCl    

BaSO4    

CaCO3    

ZnOH2    

Ag2O    

Hg    

✓ Add a new stream  

✓ Add KCl as an inflow but do not give it a value yet 

✓ Add a Single Point calculation then change the type to Precipitation Point  

  

✓ Select the Specs button  

✓ Highlight KCl in the precipitant column and in the adjusted variable column 

 

✓ Press OK to close the window  

✓ Change the units to ppm(mass) flowing 
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✓ Press calculate and record the mass (or moles) of KCl that precipitated  

✓ Change the temperature to 95°C, recalculate, and record the KCl moles 

✓ Keep the temperature at 95°C, add 58350 ppm (1 mol) of NaCl then recalculate  

In this particular case, we can add NaCl at the Calculation level or at the Stream level. 

✓ Repeat the above steps for each of the other components from the table above but in the 
Calculation Options window, select that component as the Precipitant and Adjusted Variable  

Note that the inflow may not be the precipitate. For instance, the transition metals will probably 
precipitate as oxides not in the form they were entered.  

Follow-up Example #5 – Calcium Phosphate Solubility 

The phases created by precipitation point calculations are important to note. If nature were at 
equilibrium, then only the most stable solids would exist. Since nature is not at equilibrium, it is possible 
for unstable solids to exist. They exist because of kinetic and inhibition factors.  

Such is the case with the solids of calcium phosphate and calcium carbonate. Calcite can form four 
different solid phases while calcium phosphate can form seven. These solid phrases are listed below, 
from most to least stable: 

Solids Phases Formed from Calcite and Calcium Phosphate 

Calcium Carbonates (polymorphs of CaCO3) Calcium Phosphates (different Ca:P ratios) 

Calcite Hydroxyapatite [Ca5(OH)(PO4)3] 

Aragonite TriCalcium Phosphate [Ca3(PO4)2] 

Vaterite Octacalcium Phosphate [Ca4HPO4(PO4)2.2.5H2O] 

Ikaite Calcium Hydrogen Phosphate [CaHPO4] 

 Calcium Hydrogen Phosphate dehydrate [CaHPO4.2H2O] 

 Calcium dihydrogen Phosphate [Ca(H2PO4)2] 

Calcium phosphate has interesting chemistry. Many solids can form from the simple system, CaO-P2O5-
H2O. We will look at this system in the following example. We will add CaHPO4 to water and precipitate 
a list of solids. We do this by “turning off” all solids, except the target solid. We then run a precipitation 
point calculation and document the CaHPO4 concentration needed to form the solid.  

✓ Add a new stream  

✓ Name it ‘FE5 Calcium Phosphate Solubility’  

✓ Select the MSE button in the toolbar  ✓ Change the units to ppm (mass) Flowing  

✓ Add CaHPO4 as an inflow  

 

✓ Add a Single Point calculation then change the type to Precipitation Point  
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✓ From the menu bar, select Chemistry >Model Options>Phases  

     

✓ * In the phases tab, expand the CA(+2) category 

 

✓ * First uncheck the ALL button, then check the box next to CaHPO4 (Monetite) 

  

✓ * Press OK then select the Specs… button.  

✓ * Select CaHPO4 - Sol as the Precipitant and select CaHPO4 as the Adjusted Variable 

 

✓ * Press OK 

✓ * Calculate and record the CaHPO4 mass added 
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Repeat the starred steps but select the following species in the Phases tab instead of CaHPO4. The 
instructor will discuss what happens when we select Ca(H2PO4)2.  

Solid to precipitate Amount of CaHPO4 added (mass) 

CaHPO4 64.0088 

CaHPO4.2H2O  

Ca4HPO4(PO4)2.2.5H2O  

Ca3(PO4)2  

Ca5(OH)(PO4)3  

Ca(H2PO4)2  
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2.8 Composition Point 

Overview 

The composition point calculation is used to fix a species value.  If for example, the target amount of 
molecular H2S in water is to be set at 0.001 moles in 1 kg water, then this is the calculation tool that 
would be used. 

Presently, Version 9.5 (the time of this publication), allows only mole units for composition targets.  
Therefore, the examples provided here are based on these units. 

Starting the work 

2.8a - H2S, aq composition point 

✓ Create a new stream and name it Composition Point 

✓ Add a single point calculation and name it H2S, aq 

✓ Add H2S to the grid 

✓ change the calculation type to Composition Point 

The Calculation Parameters section appears in the grid.  It contains three rows, the Target species, the 
adjusted inflow and the target value.   

✓ Set the Target species to H2S-aq  

✓ Set the Target Value to 0.001 mole (that is 0.001 mol/kg water or 32 mg/kg) 

✓ Set the Adjusted Inflow to H2S 

✓ Calculate 

✓ Click on the Output tab at the bottom of the grid to view the calculated composition 

 

According to the software, 0.00101 moles H2S was required to create a solution with 0.001 moles of 
H2S aq.  The additional 0.00001 moles is the amount that converted to HS-1 at equilibrium.  The pH is 
5.0 (look at the Summary section).   
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This is ~1e-5 moles H+, which is consistent with the additional H2S.  

✓ Click the Report tab and view the Species output 

 

The molecular H2S is 1e-3 moles as specified in the calculation.  Notice that the H+ and HS- 
concentrations are nearly identical.  This is because the following reaction takes place: 

𝐻2𝑆 = 𝐻+ + 𝐻𝑆− 

One mole of H2S creates one mole each of H+ and HS-.  H+ is slightly higher, because a second reaction 
𝐻2𝑂 = 𝐻+ + 𝑂𝐻− also contributes to H+ formation. 

2.8b - HCO3-1 composition point 

The purpose of this example is to explore carbonate speciation and its relationship with pH.  In this 
case, you will start with a fixed amount of CO2 and then add NaOH to convert it to HCO3

-1 and CO3
-2.  You 

will monitor both the speciation of CO3
-2, HCO3

-1, and CO2, aq, and the pH. 

✓ Add another single point calculation to the Composition point stream 

✓ and name it HCO3-1 

 

✓ Add CO2 and give it a value of 0.001 mol 

Add NaOH to the grid 

✓ change the calculation type to Composition Point 

✓ Set the Adjusted Inflow to NaOH 

✓ Set the Target species to HCO3-1 
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✓ Set the Target Value to 0.0005 mole  

This converts 50% of the CO2 added to HCO3
-1.   

 

✓ Calculate 

✓ Click on the Output tab at the bottom of the grid to view the calculated composition 

 

As expected, 0.0005 moles NaOH is required to create 0.0005 moles HCO3
-1, simply because acid base 

reactions are stoichiometric, and this is a 1:1 reaction. 

𝐶𝑂2 + 𝑂𝐻−1 = 𝐻𝐶𝑂3
− 

✓ Click on the report.  View the pH,. 

 

The computed pH, in which 50% of the CO2 is converted HCO3
-1 is 6.3 (image below).  This is the same 

value as pKa1 (log acid dissociation constant of CO2,aq).   

 

The following equilibrium reaction is written in log space to show the relationship between pH and 
pKa1. 
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𝐾𝐴1 =
𝐻+ ∗ 𝐻𝐶𝑂3

−

𝐶𝑂2
0 ∗ 𝐻2𝑂

= 10−6.3(@25𝐶) 

𝐿𝑜𝑔𝐾𝑎1 − 𝑙𝑜𝑔{𝐻+} + 𝑙𝑜𝑔 {𝐻2𝑂} = 𝑙𝑜𝑔 {𝐻𝐶𝑂3
−} − 𝑙𝑜𝑔 {𝐶𝑂2} 

The curly brackets represent the activity of the species.  Since this is a water solvent, {𝐻2𝑂} is set to 1 
by definition.  Also, pH is defined in in this model as: −𝑙𝑜𝑔{𝐻+}.  Thus, the relationship is simplified and 
replacing log Ka1 with log(-6.3). 

−6.3 + 𝑝𝐻 = 𝑙𝑜𝑔 {𝐻𝐶𝑂3
−} − 𝑙𝑜𝑔 {𝐶𝑂2} 

At 6.3 pH, the activities of HCO3 and CO2 would be the same.  This is what is seen in the results.   

One note.  The term “activities” is introduced above.  This is required because the variable, 𝑙𝑜𝑔 {𝐻2𝑂} 
is not presented in this equation concentration unit, and if it were, the Ka1 value would be have a 
different value.   This may be new to the reader.  Activities will be discussed in later sections and 
chapters.  For now, if it is confusing, consider the solvent to not be in concentration units, and when 
developing equilibrium equations where the solvent is included, it can be set to 1, as a first assumption.   

2.8C – Oxidizing Copper 

This will be the first opportunity to use Oxidation-Reduction (REDOX) reactions.  It is OLI’s experience 
that REDOX reactions are considered arcane by non-chemists.  We hope to provide some simplifying 
explanation here.  Additional discussion is found in the Pourbaix Diagram chapters.   

The example here is copper oxidation.  Copper metal is stable in water (i.e. will not react), when air 
(oxygen) is not present.  When O2 is present, copper donates electrons to the oxygen.  This converts 
copper to an ion which dissolves in water, and the oxygen converts to OH+ ions.  Energy is released in 
the reaction which is why it occurs.  The reaction is below.  In fact, there are two sequential reactions 
because copper can donate one or two electrons and form Cu(+1) or Cu(+2), depending on the 
availability of oxygen. 

4𝐶𝑢0 + 𝑂2 + 2𝐻2𝑂 = 4𝐶𝑢+1 + 4𝑂𝐻−1 

4𝐶𝑢+1 + 𝑂2 + 2𝐻2𝑂 = 4𝐶𝑢+2 + 4𝑂𝐻−1 

These are also considered general corrosion reactions, where the corrosion label infers the rate at 
which these reactions will proceed.   

✓ Add a single point calculation to the Composition point stream 

✓ Name it Copper 

 

✓ Add Cu and give it a value of 0.001 mol 

✓ Add O2 to the grid 

✓ Turn on REDOX reactions using the Re button in the toolbar 

 

Notice the text in the Summary section “Redox selected”.  This ensures that oxidation-reduction 
reactions will be considered.  There are additional settings for redox, but they won’t be used in this 
example. 
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✓ Calculate,  

✓ Look at the Summary section for the ORP value (bottom) 

 

The value is -0.159 volt (SHE) 1.  As will be shown in this example, this value is slightly reducing; the 
system is relatively abundant in electron availability.  You will look at this several times in this case. 

✓ Open the Report and scroll down to the element balance table 

✓ Compare the amounts of Cu(0), Cu(+1) and Cu(+2)  

Virtually all the copper is present as a metal.  There are negligible amounts of Cu(+1) and Cu(+2).  

 

What we can conclude at this point is that elemental copper (copper metal) is present in the water, and 
the ORP of the water is -0.159 V (SHE).  The slight negative ORP (at 25C and 7pH water) means that the 

                                                           
1 The ORP, or Oxidation-Reduction potential is a voltage scale used to measure the availability of electrons in a 

system.  A low ORP (e.g., -2V, SHE), represents high electron availability.  These available electrons are not “free”, 

but rather held by materials like iron or copper metal. A high ORP (e.g., +2V. SHE), represents a low electron 

availability, or rather a high availability of electron vacancies.  Molecules like O2, contain electron vacancies.   

If electron-rich iron is in contact with electron-poor O2, electrons transfer from the iron to oxygen, and energy is 

released.   

The calculated ORP is therefore the relative scale of electron abundance.  A low ORP means that there is more iron 

than O2.  A high ORP means the reverse.  The scale’s reference point is the Standard Hydrogen Electrode, SHE.   

This ORP is also pH and temperature dependent, and so the scale is not a simple, linear relationship. 
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existing system is slightly reducing. (It is important to include the reference scale (i.e., SHE) when 
reporting ORP, since there are many reference scales (probes) used.) 

Redo the calculation using the Composition Point Calculation Type 

✓ Change the calculation type to Composition Point 

✓ Set the Adjusted Inflow to O2 

✓ Set the Target species to Cu (Copper) - Sol 

✓ Set the Target Value to 0.0005 mole  

 

The software will compute how much O2 is needed, for 50% of the copper to react away.  Elemental 
copper (electron donor) and oxygen (electron acceptor) are the electron transfer elements, as seen in 
the two expressions.  

4𝐶𝑢0 = 4𝐶𝑢+1 + 4𝑒−1 

𝑂2 + 2𝐻2𝑂 + 4𝑒−1 = 4𝑂𝐻−1 

If 50% or 5e-4 moles of copper is to react away, the according to the above reactions, one-fourth, or 

1.25e-4 moles O2 will be needed. 

✓ Calculate 

✓ Select the Output tab at the bottom of the grid 

According to the calculation, 1.25e-4 moles O2 is required; consistent with the above equations. 

 

✓ Click on the Report tab and scroll down to the Element balance table 

One-half of the elemental copper has reacted to form Cu(+1), in agreement with the first reaction.  
There is a small amount of Cu(+2), but it again is negligible compared to the Cu(0) and Cu(+1) amounts.   
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It is possible that copper could have donated two electrons and not one to oxygen. In that case twice as 
much O2 would have been required.  Instead, only one electron was transferred from copper.  This 
relates back to the ORP.   

✓ Return to the Definition tab 

✓ Look at the ORP value 

 

The ORP is higher, 0.035 V (SHE), meaning that the system is more oxidizing than the previous case.  

However, there is still elemental copper present, meaning that there are additional electrons to donate. 

Recalculate using a target value of 1e-6 moles Cu 

✓ Change the Target Cu amount to 1e-6  

A final elemental copper amount of 1e-6 moles means that 99.9%, or 9.99e-4 of the copper will have 
reacted away.  This should therefore mean that about 2.4975e-4 moles O2 is required to convert Cu(0) to 
Cu(+1). 

✓ Calculate 

Instead of using the Report tables, you will interpret the results using the Grid, since this is a convenient 
way to view the information. 

✓ Select the Output tab at the bottom of the grid -  

The calculated O2 amount is 2.4975e-4 moles, which is exactly the stoichiometric value of converting 
Cu(0) to Cu(+1).   

 

✓ Right mouse-click on the grid and Select Sections>MBG Totals>Totals 
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The output grid now displays the MBG Totals.  This is the Element Balance Table of the report, 
specifically the first column of that table.   

 

The remaining elemental copper is the targeted value of 1e-6 moles.  The remaining O2 is virtually zero, 
at 5.22e-56 moles (about one mole per earth).   

Since there is still excess copper metal (albeit small) and no remaining oxygen, the system is still slightly 
reducing.  Look at the ORP value to see what this slightly reducing condition is. 

✓ Review the summary section to find the ORP 

 

Recalculate using a different Target, Cu(OH)2. 

In this calculation, you will add sufficient O2 so that two electrons are donated by elemental copper to 
produce Cu(+2).   

Here the catch:  Cu(+2) is insoluble, and so the conversion reaction shown above is followed by a 
precipitation reaction.   

2𝐶𝑢0 + 𝑂2 + 2𝐻2𝑂 = 2𝐶𝑢+2 + 4𝑂𝐻−1 = 2𝐶𝑢(𝑂𝐻)2,𝑠𝑜𝑙𝑖𝑑  

Therefore, you need to find the appropriate target species to make the calculation do what you want.   

The Composition Point calculation has certain limitations.  The only target variables are solids, vapor 
species or dissolved liquid species.  If the goal is to convert Cu(0) to Cu(+2), then it’s a matter of finding a 
variable that will capture this transition.  The only variable in this case is Cu(OH)2, solid.  Cu(OH)2 is 
insoluble at neutral pH.  Therefore, nearly all the Cu(0) that gets converted to Cu(+2) will be in the form 
of Cu(OH)2.  If the pH was low, where significant Cu+2 dissolves, then we could not use this target.  Thus, 
it’s important to understand what the limitations of this (and other) calculations are.   

✓ Click on the Definition tab and change the target species to Cu(OH)2 (Spertinite) – Sol 
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✓ Set the value to 5e-4 moles 

 

✓ Calculate 

✓ Click on the Output tab 

✓ View the Oxygen requirements 

 

If 5e-4 moles of Cu(0) is converted to Cu(+2), then according to the reaction below, 2.5e-4 moles O2 is 

needed.   

2𝐶𝑢0 + 𝑂2 + 2𝐻2𝑂 = 2𝐶𝑢+2 + 4𝑂𝐻−1 

However, 3.75e-4 moles is required, or 1.25e-4 moles of additional O2 was added.  This difference is an 

opportunity to introduce another grid section, the Solids list. 

✓ Right-mouse-click on the grid and select Sections>Solid 

 

The grid now shows the Solids present in the output.   There is no longer any elemental copper present.  
All is converted to Cu(+1) and Cu(+2).  The additional 1.25e-4 moles O2 required was to convert Cu(0) to 
Cu(+1).   

 

What this means, albeit not obvious, is that Cu(0) and Cu(+2) does no coexist at these conditions.  Cu(0) 
and Cu(1) coexist, as do Cu(1) and Cu(2) as shown above. 

✓ Look at the MBG Totals section 
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The total amount of Cu(+2) is 5.002e-4 moles.  That 0.002e-4 moles additional Cu(+2) is the amount 
dissolved in the water.  This is small relative to the solid phase, which is why Cu(OH)2, solid could be 
used as a surrogate to compute the conversion of Cu(0) to Cu(+2).   

The oxygen content is still very low, ~10-37, and there is no longer any Cu(0) present.  So, this is neither 
a reducing or an oxidizing system.  The ORP for this calculation is 0.27 V SHE 
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2.9 Reconcile Alkalinity 
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2.10 Custom Calculations 

Overview 

With the calculations that we have seen so far, variables are predefined. For instance, we must select 
either temperature or pressure as a variable in the dew point calculation and we have to set select pH as 
the variable for set pH calculation. On the other hand, we can select from a wider variety of variables 
using the Custom single point calculation.  

For this calculation, we select which variables to fix or to free. We can select variables related to 
composition or fluid properties (e.g. pH, vapor fraction) as fixed or independent, while setting other 
variables as free or dependent (e.g. temperature, pressure). 

With a custom calculation, it is possible to calculate the precipitation point of NaCl and KCl in H2O at 
known temperatures. The precipitation point is where both NaCl and KCl solids coexist in solution, as 
represented in the figure below. NaCl and KCl coexist at the point where the two lines converge. 

 

When setting up a custom calculation for data like this, we would define the following variables:  

NaCl and KCl Solubility Custom Calculation Defined  

Fixed Variable Value  Adjustable Variable 

KCl (s) 1e-6 moles  KCl 

NaCl (s) 1e-6 moles  NaCl 

The value, 1e-6 moles, represents the mass of each solid in solution, i.e., the first crystallite of KCl and 
NaCl. Respectively, they amount to 79 kg and 58 kg of KCl and NaCl solid. Any number can be used, as 
long as it is small relative to the solution mass. We could also use 1e-7moles.  

In this section, we will work on three cases that involve custom calculations. The purpose of these 
examples is to demonstrate a few of the many possible applications of the custom calculation.  
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2.10a First Custom Calculation  

In the first example, we will run the calculation described above, which is to calculate the precipitation 
point of NaCl and KCl in H2O at known temperatures.  

2.10a First Custom Calculation  

Name: 1st Custom Calc Temperature 25 C 

Units Set Mass fraction Pressure 1 atm 

Names Style Formula H2O 100 mass % 

Framework MSE NaCl 0.0 

Stream Amount calculated KCl 0.0 

✓ Add a new stream and name it ‘1st Custom Calc’  

✓ Select the MSE button in the toolbar  

✓ Select the Units Manager button in the toolbar  

✓ Select Mass Frac. from the third dropdown list 

 

✓ Press OK then enter NaCl and KCl as inflows 

 

✓ Add a Single Point calculation then change the type to Custom 

  

Custom calculations require us to designate which variables to fix and which to free. Since we must add 
additional parameters, the Calculate button is red for now.  

✓ Select the “Specs…” button  

✓ Highlight the following Fix and Free variables  

2.10a Calculation Options 

Fix:  Free 

KCl (Sol) KCl 

NaCl (Sol) NaCl 



2-54 Chapter 2: Single Point Calculations Tricks of the Trade 

 

Note, the total number fixed and the total number of freed variables are two each, as reported in the 
field towards the bottom of the Calculation Option window. 

✓ Press OK 

After pressing OK, the Definition tab displays a new a new field called Calculation Parameters.  

 

 

Notice the Calculate button is red, which indicates that we have to add additional information.  

✓ Enter the following for the two Target variables in the  

2.10a Calculation Parameters  

Target 1: KCl 1e-6 

Target 2: NaCl  1e-6 

After entering the Target variables, the calculate button will turn green.  

 

✓ Calculate or press the <F9> key then review the summary box 

The values for the two freed variables are colored green. Green-colored values will be 
computed by the software but are also adjustable parameters. We will keep these blank.  
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Without entering initial inflows for KCl or NaCl, the custom calculation determined the specific masses 
the system would need to create the desired fluid properties of 1e-6 mol KCl and NaCl. To reach these 
targets, the system would need 11 mass % of KCl and 21 mass % of NaCl, as shown in the Summary box. 

Now we will see what happens when we run the calculation at a higher temperature. What are some 
predictions for the masses?  

✓ Change the temperature to 100C 

 

✓ Select the Calculate button  

✓ Review the Summary 

 

How much mass of KCl and NaCl does the calculation require to meet the 1e-6 mol targets?  
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2.10b Second Custom Calculation – Fixing the Gas composition  

This case examines a gas separator that contains two outlets: gas and water. The gas contains H2S and 
CO2, both of which affect H2O. We want to understand this effect. 

Gas-Water Separator
45C, 16 bara

 

Water

Gas to Scrubber
3% CO2
1% H2S

Inlet

I-3
I-3

S-7

Skimmed Oil

 

The custom calculation is the simplest way to model the effects of the gas on the water. We will create 
a scenario where the gas-phase CO2 and H2S partial pressures are fixed. To do this, we will need a gas 
and water phase. The total mass is unimportant because we want to evaluate the equilibrium condition.  

2.10b Second Custom Calculation  

Name: 2nd Custom Calc Inflows Mole% 

Units Set Mole fraction H2O 100 

Names Style Formula CO2 0 

Framework MSE H2S 0 

Temperature 45C CH4 0 

Pressure 15.7908 atm (16 bar)   

✓ Add a new stream and name it ‘2nd Custom Calc’  

✓ Select the MSE button in the toolbar  

✓ Select the Units Manager button in the toolbar  

✓ Use the third dropdown menu to select Mole Frac. Units then press OK 

 

✓ Enter the Stream Parameters (45C and 15.7908 atm) and inflows (CO2, H2S, and CH4)  
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✓ Add a Single Point calculation then change the type to Custom 

  

✓ Select the Specs button 

2.10b Specs … Calculation Options 

Fix:  Free 

CO2 (vap) CH4 

H2S (vap) CO2  

Moles (True) Vapor H2S 

✓ Highlight the Fix and Free variables as per the table above  

 

✓ Press OK then in the Calculation Parameters grid, enter these Targets 

2.10b Calculation Parameters  

Target 1: CO2 .03 

Target 2: H2S 1e-3 

Target 3: Moles (True) 1 

 

✓ Press <F9> or the Calculate button 

We will view the results of the calculation with the Output tab.  

✓ Select the Output tab below the Definition grid  

 

The system needs 7.09e-4 mole% CO2, 3.52e-5 mole% H2S, and 1.79 mole% CH4 to meet specified targets. 
This composition results in a 5.15 pH water phase, according to the Summary. 

✓ Save the file 
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2.10c Third Custom Calculation – Gypsum and Anhydrite  

This example considers the eutectic temperature between gypsum (CaSO4.2H2O) and anhydrite (CaSO4).  

Hydrates are solids containing chemically bonded water. An interesting example is FeCl3, which has five 
unique hydrated phases, whose stability is a function of temperature. As temperature increases, water 
dislodges, and hydration decreases. Once a certain temperature is reached, the solid dehydrates. 

In our case, the system has only one hydrate CaSO4.2H2O, and one dehydrated solid, CaSO4. The two 
solids meet at a single temperature where both are present. We want to determine this temperature. 

2.10c Third Custom Calculation  

Name: 3rd Custom Calc  Temperature 25 C 

Units Set Mass fraction Pressure 1 atm 

Names Style Formula H20 100 

Framework MSE  CaSO4 0 

✓ Add a new stream and name it ‘3rd Custom Calc’  

✓ Select the MSE button in the toolbar  

✓ Select the Units Manager button in the toolbar  

✓ Select Mass Frac. From the third dropdown list 

 

✓ Press OK  

✓ Enter CaSO4 as an inflow  

 

✓ Add a Single Point calculation then change the type to Custom 

  

✓ Select the “Specs…” button  

✓ Highlight the Fix and Free variables from the table below 
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2.10c Specs … Calculation Options  

Fix:  Free  

CaSO4.2H2O CaSO4 

CaSO4 – Sol Temperature 

 

✓ Press OK  

✓ Enter the following Target values  

2.10c Calculation Parameters  

CaSO4.2H2O 1e-6  

CaSO4 (s) 1e-6  

 

✓ Press <F9> or the Calculate button  

✓ Select the Output tab below the Definition grid  
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The temperature where both solids are at saturation simultaneously is about 40C and 0.2109 mass% 
CaSO4. We can see where this transition occurs at the inflection in the follow plot: 
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2.11 REDOX (REDuction/OXidation) Basics 

Overview 

REDOX is an OLI Studio option that activates a critical mechanism in electrolyte chemistry. All elements 
possess the ability to gain (reduction) or release (oxidation) electrons. When oxidation occurs, elements 
increase their oxidation state. When reduction occurs, the element decreases its oxidation state. The 
software’s REDOX option allows us to modify the oxidation state of a system so that we can better 
represent an actual process.  

. 

The REDOX option button in the OLI Studio menu bar.  

In this chapter, we will calculate five oxidation-reduction reactions, which are shown below: 

𝑁𝑎0 + 𝐻2𝑂 = 𝑁𝑎+1 + 𝑂𝐻− +
1

2
𝐻2 

𝐶𝑎0 + 2𝐻2𝑂 = 𝐶𝑎+1 + 2𝑂𝐻− + 𝐻2 

𝐹𝑒0 + 2𝐻2𝑂 = 𝐹𝑒+2 + 2𝑂𝐻− + 𝐻2 

𝐹𝑒+2 + 𝐻2𝑂 = 𝐹𝑒+3 + 𝑂𝐻− +
1

2
𝐻2 

𝑆𝑖0 + 4𝐻2𝑂 = 𝐻4𝑆𝑖𝑂4 + 2𝐻2 

Basic REDOX calculation 

In this example, we will prepare several samples to see how energy is released when metals are added 
to water. Then we will compare the amount of energy released as the element changes from group and 
period on the Periodic Table.  

 

✓ Add a new stream and rename it ‘REDOX Reactions  

✓ Enter the inflows from the table below 
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2.11 - Basic REDOX Calculation 

Stream Name Redox Reaction Stream Amount (calculated) Inflows (mol) 

Name Style Formula Temperature 25 °C H2O 55.508 

Framework Aqueous Pressure 1 atm Na 0 

Units Set Default (moles)   Ca 0 

Settings REDOX ON   Fe 0 

    Si 0. 

    Au 0 

✓ Turn the REDOX calculations button  

✓ Select the down arrow next to REDOX then place a check next to all the components   

 

✓ Add a Single Point calculation and confirm the type of Calculation is Isothermal  

 

✓ Calculate then select the Report tab and note the total enthalpy in the Stream Parameters 
section (incorrectly labeled Heat Duty in some versions of the software). 

 

✓ Add 1 mole Na and recalculate. ✓ Record the total enthalpy 

 

✓ Deselect Sodium in the REDOX menu then press <F9> to recalculate.  

 

✓ Record the Total Enthalpy 

 

The difference between REDOX on and off when Na is added is about 43 kcal. This is an example (albeit 
incomplete) of the energy released when Na element reacts with water to produce Na+, OH-, and H2.  

✓ Recalculate the case with Na REDOX on, and review the Species Output Table 

The reaction products result in one mole of Na+1, one mole OH-, and 0.5 moles H2. This is consistent 
with the overall redox reaction between Na and H2O shown above. 
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Species output with REDOX on and 1 mole of sodium 

✓ Select the Definition grid and zero the Na value and change the Ca value to 1 mole 

✓ Calculate 

✓ Document the Total Enthalpy and the species output 

 

 
Species output with REDOX on and 1 mole of calcium  

The Total Enthalpy change from pure water (and calcium) is about 100 kcal. We can deselect the Ca 
redox and confirm that the total enthalpy is -3.79195e6 cal. The species output table shows that the 1 
mole of calcium converted to Ca+2, H2, and OH-. In this example, the oxidized calcium reacted with OH- 
to produce lime (Ca(OH)2) 

✓ Recalculate the case using 1 mole of Fe and zero moles of Ca 

 

Elemental Fe oxidized into Fe+2 and Fe+3. Nearly all the iron is as Fe+3 and has precipitated to Fe(OH)3. 
These dissolved ions reacted with H2O to form various aquo- groups.  
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Species output with REDOX on and 1 mole of iron 

✓ Recalculate the case using 1 mole Si and zero moles of Fe 

 

Elemental silicon oxidized into Si+4. Nearly all of it has precipitated to SiO2. The remaining Si+4 reacts 
with H2O to form the oxy-acid, H4SiO4. This acid dissociates to H3SiO4

-1 and H2SiO4
-2. It also dehydrates to 

form SiO2, which is how it is reported below.  

 
Species output with REDOX on and 1 mole of silicon  

✓ Calculate the case one last time using 1 mole of Au (gold) instead of Si 

 

Virtually all the Au remains as the metal. Oxidization in water to Au+1 and Au+3 is negligible. Based on 
the table below, there are 10-32 moles Au+1 in water or about 1 atom in about 40 kilotons water. This is 
because gold does not oxidize in water. Hence, why gold is a “noble” metal.  
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Species output with REDOX on and 1 mole of gold  
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2.12 Air – Using Air in Analyzer Calculations 

Overview 

Open system calculations require air. Calculations require air for several reasons. For instance, the 
focus can be N2 as an incompressible gas, O2 for oxidation/corrosion, or CO2 acid-base reactions. 
Regardless, adding air to a calculation is an integral part of many OLI Studio applications.  

While the software does not a have a separate component called “air,” the OLI Studio does allow 
different ways to add an air stream. One approach is to select from a set of commonly used chemistries 
called Standard Objects. The objects library includes two air streams: a dry air and a moist air.  

 

Adding these streams to the calculation is simple. We simply have to select the object in the Objects 
panel then drag it to the Navigator panel. Once dragged to the Navigator panel, these objects become 
like any other stream. They can be used in mixers or as base streams for calculations. 

The alternative to using pre-designed streams is to add the air components to existing streams.  

 

A limitation to this approach is that we would have to know the exact compositions and amounts. We 
would have to add the correct fraction of each gas component. This amount has to be enough so that 
the vapor components do not dissolve and change the final gas fraction but not too much that the liquid 
water evaporates.  

These are among the limits of using “closed-system” software to model open systems.  

The following examples are ways to get around the problem of using closed-system calculations to 
model open systems. 

2.12a – Using the Air Stream in a Mixer 

The first example is the simplest. It involves mixing two streams using a Mixer block. The mixer block 
has not been presented yet (it is presented in a later chapter), but it is needed here. Therefore, we will 
keep the application simple. You will mix air with calcite-water and see how the seawater pH changes 
when in contact with atmospheric CO2. 

✓ From the menu bar, select File > New then save the file with an appropriate name 
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✓ Open the Object Library: Click on View>Toolbars>Object Library 

   

✓ When the Object Library opens, drag the Moist Air object to add it to the Navigator panel 

The Navigator now has the inserted object. We can view this object’s composition in the Definition grid.  

 

The Stream Amount is only 1 mole. The CO2 is 360 ppmV, lower than the current atmospheric value of 
400 ppm, but we can change this as we want.  At present, there is a total of 0.00036 moles CO2 in this 
stream (1 mole * 0.036%). This Air is a fixed-mass stream. 

 

✓ Add a new stream and rename it ‘CaCO3’Water’  

✓ Add CaCO3 as an Inflow give it a value of 0.001 moles 
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The purpose of this stream is to provide a base reaction for the acid gas in the air. The CaCO3 value of 
0.001 moles is sufficient to saturate calcite in the water. When the CaCO3-water reacts with atmospheric 
CO2, calcite will dissolve, to the extent that CO2 is available (remember OLI calculations are closed 
systems so the moles of CO2 added to the calculation will be fixed). 

✓ Create a mixer, by clicking on Add Mixer from the Action panel - .  

 

✓ Label it CaCO3-Water-Air -  

✓ Double click the CaCO3-Water in the Available Streams window to add to the Selected field 

 

✓ Calculate then view the Report tab  

A 10 pH at ambient conditions is expected when pure calcite is in equilibrium with water. You can 
confirm that CaCO3 solid is present by scrolling down to the scale tendency table. 

 

✓ Return to the Definition tab. 

✓ Add the Moist Air to the Selected field 

 

The details of the mixer are not taught here, but what we created is a mixer that will bring in 55.5092 
moles of CaCO3-water and 1 mole of Air. 

✓ Calculate and view the pH and also the PCO2 

 

✓ Scroll down to the Species Output table 

We will revisit the Mixer object in further detail in Chapter 5.  
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Notice that the vapor-phase CO2 moles is 8.7e-5 moles, and the total vapor is 1.01 moles. Now the PCO2 
is 87 ppmV instead of 360 ppmV. CO2 dissolved into the water and reacted with CO3

-2 to form HCO3
-1. 

The reaction is complete, but now the CO2 is no longer at atmospheric values.  

 
Mixer species output with Moist Air 

✓ Return to the definition tab and change the Moist Air Multiplier to 10 

 

This changes the Moist Air inflow to 10 moles.  

✓ Calculate, and look at the pH and vapor-phase CO2 then the Species Output table  

 

 
Mixer species output with 10x Moist Air 

The pH is closer to what we know fresh water lakes to be at, 8.3 pH. Also note that the CO2 vapor is 
3.16e-3 moles (divided by 10.15 vapor moles) or 311 ppmV. This is closer to the atmospheric value. 
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Raising the Air amount more will increase the PCO2 closer to its target value, however it will never be the 
exact amount simply because a certain amount of CO2 will dissolve. Adding too much, however, will 
dehydrate the water.  

✓ Return to the Definition tab 

✓ Change the Moist Air multiplier to 1000 

Now there will be 1000 moles of air in contact with 55.5 moles of liquid. At atmospheric conditions, 31 
moles H2O will be present in the air. Half of this is 15.5 moles H2O is part of the 50% moist air. The other 
15.5 moles will evaporate from the water. Confirm this by calculating. 

 

✓ Calculate and review the Total and Phase Flow table 

We started with 1L (1kg) of water. Now the volume is 0.726 L (724 grams). Therefore, one-fourth of the 
liquid water has evaporated. This concentrates all the dissolved components in the water phase, which 
changes the calculation.  

 
Mixer species Total and Phase Flows with 1000x Moist Air 

To fix this problem you would need to saturate the air with water and add slightly excess CO2 to the air 
so that when the air and water reach equilibrium, the PCO2 remains at the original value of 360 ppmV (or 
now 400 ppmV). 

2.12b – Using Makeup CO2 and H2O Streams with the Mixer 

There are options to correct this, and it involves manually editing the air stream composition, or adding 
separate CO2 and H2O makeup streams  

✓ Create a new stream – label it ‘Makeup H2O’ -  

✓ Change the H2O moles to 1, to make it easier to remember 

 

✓ Create another stream – label it “Makeup CO2” -  

✓ Add CO2 to the inflow and set the value to 0.001 mole  

✓ Set H2O to zero 
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✓ Return to the CaCO3-Water-Air mixer 

✓ Add the Makeup H2O and Makeup CO2 to the Selected Stream 

 

✓ We know that we are missing 15 moles H2O, so change the multiplier for H2O to 15.  

✓ We do not know how much CO2 is needed, so keep this multiplier at 1 for now 

 

✓ Calculate and view the Liquid water amount and the vapor-CO2 amount of the Species 
Output table 

The Total Aqueous phase is 55.18 (close to the original 55.51 moles), which is good enough. 
Furthermore, the vapor-CO2 is 0.36 moles in 1000 moles, which is conveniently 360 ppmV .  

 
Mixer species output table with Makeup H2O and CO2 

We can modify the multipliers for makeup CO2 and H2O to make it exact if needed. This method, 
however, requires manual iteration because it is not an automatic approach. 
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2.12c - Using Air Components in a Stream  

*Please note that this section may not work in certain versions of the software.  

The alternative to using an Air stream is to add each air component to a work stream. This has some 
advantages over the mixer object in that we have direct control over the air components. The drawback 
is that we will not be able to distinguish between the air and liquid masses because they would 
represent a total mass. 

We can compute air space using the custom calculation. This calculation will let us fix the vapor fraction 
components to the atmospheric values. There is one complication, and that deals with setting a gas 
volume. It is not possible to set all the gas phase components, since the gas-phase composition will 
change as H2O evaporates (with temperature). Thus, the best way to compute a gas phase is to fix n=2 
of the gas phase components and to fix the total volume. In this case n=5, including H2O, N2, O2, Ar, and 
CO2. Note that H2O cannot be fixed, because it is liquid. N2 cannot be fixed because the mole fraction of 
the gas needs to be 100%. Furthermore, without knowing H2O, N2 cannot be set.  

Therefore, the best way to model a system like this is using the following fix-free table. The values used 
are for air composition. The Total Volume of 2L is arbitrary, and could have been any value, but since we 
do not want to evaporate too much water, a 1L headspace is sufficient. 

✓ Click on the CaCO3-Water stream 

✓ Add a single point calculation 

✓ Enter the components N2, O2, Ar, and CO2 into the grid 

✓ Change the calculation type to Custom 

✓ Click on the Specs button and select the variables on the Variables to Fix and Variables to 
Free fields as defined in the above table  

 

Make sure that the Total fixed and Total Free variables are 4. 

✓ Press OK to close the window  

Fix Fix Value Free 

Ar – Vap .90% Ar 

CO2 - Vap .04% CO2 

O2 - Vap 20% O2  

Volume-Total 2 L N2 
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✓ Enter the Fix Values into the Calculation Parameters section (values are in the above table) 

 

✓ Calculate and view the Output tab (bottom of the grid) -  

We can see the input amount of each gas component. This amount creates a 2L system of gas and 
liquid.  

 

✓ Move to the Report tab and view the pH and Species Output 

 

It is difficult to see the vapor fractions using mole units, and we can change them to be more relevant.  
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✓ Click on the Units manager tab -  

✓ Click on Customize button -  

✓ Change vapor composition to mole fraction then press OK twice to return to the Report tab 

 

✓ We will need to refresh the Report screen by clicking off the Report and then back on.  

 

We can see that the CO2, H2O, O2 and Ar values that you entered into the Calculation Parameters 
section of the grid. Now we have a liquid phase in contact with air, and the amount of air is no longer a 
factor in the calculation.  

✓ Save the file  



 Survey Calculations – 
Single Surveys 

Introduction 

Survey calculations are single point calculations strung together in series. They are also referred to as 
multiple point calculations. These calculations allow the user to designate as independent, one or two 
variables. The resulting plots are then used to interpret the calculation results.   

The independent survey variables are listed below:  

 

This chapter contains instructions on how to perform the following survey calculations 

3.1 Temperature survey and Pressure survey of a four-phase mixture .............................................................2 

3.2 Composition survey –NH3-HAc-H2O ..............................................................................................................6 

3.3 pH Survey – CO2-NaOH-H2O ........................................................................................................................8 

3.4 pH Survey – Transition Metals ................................................................................................................... 12 

3.5 Vapor Fraction survey – Seawater evaporation ........................................................................................ 18 
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3.1 Temperature survey and Pressure survey of a four-
phase mixture 
The purpose of this first example is to present the basic Temperature and Pressure survey. The system 

composition will be basic, containing one primary phase component, H2O, CH4, Decane, and CaCO3.  Each 
component will partition each of the other three phases. 

Getting started 

✓ Create a new Stream and label it Phase vs Conditions 

✓  Set the framework to MSE -  

✓ Add CH4, C10H22, and CaCO3 to the grid 

✓ Set the H2O to 50 moles 

✓ Set the remaining inflows to 10 moles 

 

Temperature Survey 

✓ Add a Survey calculation and label it Temperature Survey 

✓ Calculate  

The default plot is a temperature survey from 25 to 100 C by 5 C increments. 

✓ Click on the Plot tab 
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The default plot is the phase amounts.  The above plot shows that as temperature increases, the mass of 
liquid-1 (aqueous) and liquid-2 (organic) decreases, evaporating to the vapor phase.  The solid phase mass 
remains constant. 

✓ Click on the Variables button in the upper right of the plot -   

✓ Delete all the variables from the Y1 axis (double click on each or highlight them and remove 
with the double arrow) 

✓ Expand the MBG Totals – Liquid-1 section 

o Add C(+4) Liq-1 to the Y1 axis 

✓ Expand the MBG Totals – Vapor section 

o Add C(+4) Vap to the Y1 axis 

✓ Expand the MBG Totals – Liquid-2 section 

o Add C(+4) Liq-2 to the Y1 axis 

✓ Expand the MBG Totals – Solid section 

o Add C(+4) Sol to the Y2 axis 

   

✓ Close the window and view the plot.   



3-4 Chapter 3 Survey Calculations Tricks of the Trade 

 

The inorganic carbon, C(+4) is present in the three mobile phases up to 90 C.  Above this temperature the 
system evaporates entirely and nearly all the carbon transfers to the solid phase. 

Pressure Survey 

✓ Return to the Phase vs Conditions stream and add a new survey 

✓ Name it Pressure Survey 

 

✓ Change the Survey by from Temperature to Pressure 

 

The default pressure setting is 1 to 10 atm by 1 atm increments.  You will use these settings for this 
calculation. 

✓ Calculate and click on the Plot tab 

The plot is unremarkable; each curve is a flat line.  This is because, in part, the y-axis range is wide, 0 to 
1400 g.  Instead of reviewing the data in this form, the alternative is to look at the actual data.  
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✓ Click on the View data button in the upper right of the plot -  

 

This results view can be more usable for some scenarios.  According to the results there is no change in the 
solid mass, and there are small changes, up to 16 grams, in the other three phases. 
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3.2 Composition survey –NH3-HAc-H2O 

Getting started 

✓ Add a stream and label it pH vs. Concentration 

✓ Add acetic acid to the grid and enter a 0.5 mole value 

✓ Add NH3 to the grid 

 

✓ Add a Survey calculation and label it Acetic Acid-NH3 

✓ Change the calculation type to Composition 

 

✓ Click on the Specs… button and highlight NH3 

 

✓ Close the window and Calculate 

✓ View the plot 

The resulting plot is a typical acid-base titration curve.  The base composition is 0.5 m Acetic acid.  NH3 is 
added at 0.1 m increments up to 1 m.  The inflection point for the titration is at 0.5 m, which is expected.   
Here, the independent variable is the molecular composition, and the dependent variable is the pH. 
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This composition survey differs from a standard laboratory titration in a significant way.  This titration is 
pure NH3.  By comparison, a laboratory titration would use a base titrant with a known strength e.g. 1 N.  
Also, size of the water sample is not considered in this calculation.  The stream amount is 56.0082 moles, 
and this is because of the H2O and HAc inflows.  By comparison, the water sample of unknown or 
incomplete composition is added to the titration apparatus (e.g., 100 ml or 100 g of water sample) and the 
titration is performed on this. 

A different approach to doing an acid-base titration/calculation is shown in the next case. 



3-8 Chapter 3 Survey Calculations Tricks of the Trade 

3.3 pH Survey – CO2-NaOH-H2O  
This case is a follow-up to the previous case, and to the set-pH calculation performed in Chapter 2.  In this 

survey calculation, a 1 molal CO2 solution is titrated with HCl and NaOH.  Instead of defining the amount of 
acid/base to add (as in the above case) the pH will be specified and the software will compute the amounts 
of HCl and NaOH needed.  

Getting started 

3.3 Bicarbonate Titration Composition 

Stream Name Bicarbonate Titration Stream Amount Calculated Inflows  

Name Style Formula Temperature 25 °C CO2 0.001 

Framework Aqueous+ Pressure 1 atm   

Units Set Default (moles)     

✓ Add a new stream  and name it Bicarbonate Titration  

✓ Enter the inflows from the table above  

✓ Add a Survey calculation and name it Titrate CO2, and select Survey by pH. 

  

The calculation can be run without modification.  The default titrants are HCl and NaOH, and there is a 
defaults pH range: 0 to 14 by 1 pH.   

 

This pH range however is too broad for the carbonate system, in which most of the speciation occurs 
between pH=4 and 12.   

✓ Click the Specs… button 

 

✓ Select the Survey Range tab 
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✓ Change the Start, End, and Increment values using data from the table below 

3.3 Survey Options 

Start 4 

End 12 

Increment 0.1 

This will produce a survey with 81 points 

 

✓ Press OK to exit the window  

✓ Press the <F9> key or select the Calculate button  

✓ Select the Plot tab 

The default pH plot is the amount of acid and base titrant used.  This is not the target variable and you will 
change it to display the carbonate-containing species.  

✓ Select the Variables button 

✓ Remove the variables from the Y1 Axis.  

o Click on the header to highlight all the variables then press the << button  

✓ Expand the Aqueous Section on the left-side of the window 

 

✓ Add the CO2, HCO3-1, CO3-2, and H+ to the Y1 Axis window  

The window should look like the image below. 
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✓ Press OK to close the window and view the plot 

The plot below is a typical acid-base speciation plot displaying the important carbonate species.  At low pH, 
CO2, aq is the dominant species, as pH increases it converts to HCO3

-1 which is the dominant species at ~8.3 
pH.  At higher pH, ~12 the CO3

-2 species dominates.   

 

 

You will next review the plot on a semi-log scale.   

✓ Select the Options button  

✓ Select Y Axis in the Category window 

✓ Click on the Logarithmic scale box 

The window should look like the following.  

 

✓ Press OK to close the window  
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✓ Before viewing the plot, add the OH-1 species to the plot 

o Click the Variables window, expand the Aqueous category and add OH-1 

 

✓ Close the Variables window and view the plot 

This is a busy but useful plot.  It contains the acid-base products for the Carbonate and water system.  The 

H+ and OH-1 curves are linear, and have a 
𝑚𝑜𝑙𝑒

𝑝𝐻
 slope of -1 and 1, respectively.  Note also between 6 and 10 

pH, where HCO3
-1 dominates the speciation, the CO2 and CO3

-2 
𝑚𝑜𝑙𝑒

𝑝𝐻
 slopes are also -1 and 1.   

 

At lower pH, where CO2 dominates the system, the HCO3
-1 slope is 1 and the CO3

-2 slope is 2.  Likewise, in 

the pH region where CO3
-2 dominates, the HCO3

-1 slope is -1 and the CO2,aq slope is -2.  These 
𝑚𝑜𝑙𝑒

𝑝𝐻
 slopes 

are based on the number of H+ ions added or removed in that chemical reaction.   

Note the pH where the CO2,aq and HCO3
-1 lines intersect (pH6.3), and where the HCO3

-1 and CO3
-2 lines 

intersect (pH10.3).  These pH values are the same as the pKa values (the equilibrium equations for that 
reaction). 

✓ Look at the curves above 11 pH 

As NaOH is added to convert HCO3
- to CO3

-2, a portion of the NaOH remains as free base, OH-1. This fraction 
increases at higher pH’s, and its concentration is reflected in the calculated pH.  A similar pattern is seen at 
pH below ~3 for HCl and H+.  This increasing H+ is the pH. 
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3.4 pH Survey – Transition Metals 
We just computed the pH curve of a weak protic- or Bronsted-Lowry acid. We will now look at the titration 

curve of a Lewis acid. The acidity of Lewis acids results from the donation of electrons from another 
molecule to the acid. Transition metals are typical Lewis acids; they react with H2O to form metal-hydroxide 
complexes. This reaction splits or hydrolyzes the water, resulting in released H+. In this example, we will 
follow the reactions between nickel and H2O, and see how the reactions change as acidity changes. 

Getting started 

3.4 Nickel Speciation Composition 

Stream Name Nickel Speciation Stream Amount Calculated Inflows (mol) 

Name Style Formula Temperature 25 °C NiOH2 0.02 

Framework Aqueous+ Pressure 1 atm   

Units Set Default (moles)     

✓ Add a new stream  and rename it ‘Nickel Speciation’ -  

✓ Enter the Inflows from the table above 

✓ Add a Survey calculation then change the type to pH  

  

✓ Click the Specs button  

 

✓ Select the Survey Range tab 

✓ Change the Start, End, and Increment values using the table below 

3.4 Survey Options 

Start 0 

End 14 

Increment 0.25 

The survey will contain 56 individul calculations.  
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✓ Press OK 

✓ Calculate then select the Plot tab  

For this and many other calculations, the y-axis values extend over a very large range of numbers. The 
default linear axis may not capture all the required details, so we will switch to a logarithmic scale.  

✓ Right-mouse click a number along the Y-Axis  

 

✓ Select the Logarithmic Scale and view the plot  
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The next step is to change the viewing variables.  This case focuses on nickel speciation vs. pH.  Therefore, 
the focus variables will be the total dissolved nickel and the nickel species/complexes.   

✓ Click the Variables button  

✓ Remove all variables from the Y1 axis 

✓ Expand the MBG Aqueous Totals category  

✓ Add Ni(+2) to the Y1 Axis 

 

MBG is an abbreviation for Material Balance Groups and shows the species’ sum in a phase. The curve 
below is the sum of all dissolved nickel species.  

✓ Press OK then view the plot 

 

Total dissolved nickel decreases by about six orders-of-magnitude between 7 and 11 pH.  The cause is the 
formation of an insoluble Ni(OH)2 solid phase. 

✓ Open the variables window again and expand the Aqueous category 

✓ Add the Ni-containing species to the Y1 Axis.  

Aqueous Category Ni(OH)2 
Ni(OH)3-1 
Ni(OH)4-2 
Ni+2 
Ni2OH+3 
Ni4(OH)4+1 
NiCl+ 
NiOH+1 

Y1 Axis  

✓ Press OK when done 
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The y-axis scale is 45-orders of magnitude in concentration.  Several of these species do not exceed 10-6 
mol/kg water, and can be removed without compromising the interpretation.  Removing variables is 
accomplishable from the plot view, by using the Right-Mouse-Click option. 

✓ Right-mouse-click anywhere along the Ni4(OH)4+4 curve – select Remove  

 

✓ Right-mouse-click anywhere along the Ni2OH+3 curve – select Remove  

 

The Ni(OH)4-2 species covers nearly 40-orders of magnitude concentration between 0 and 14 pH.  It is 
important at very high pH, but is largely irrelevant at neutral pH, and so it will be removed. 

✓ Right-mouse-click anywhere along the Ni(OH)4-2 curve – select Remove  
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Lastly, the NiCl+1 and the Ni(OH)2,aq species are also of limited significance within the pH region where 
they are important.  NiCl+1 is present at low pH, as HCl is added to reduce the pH.  However, it is small 
relative to the Ni+2 species, by about four-orders of magnitude.  The Ni(OH)2 phase is also several order-of 
magnitude less abundant than the several species at the moderate pH. 

✓ Remove the NiCl+ and the Ni(OH)2,aq species from the plot 

The remaining plot contains three aqueous species plus the total dissolved nickel.  Each of the dissolved 

species parallel the total dissolve nickel curve in certain pH ranges.  It is the stability of these species in fact 

that set the nickel solubility in water.   

 

Below 9 pH, the dominant species is Ni+2.  Its stability in water defines the overall nickel solubility in this 
region.  Between 9 and 11 pH, the NiOH+1 species dominates, and it is this species that defines the total 
dissolved nickel. Lastly, the Ni(OH)3-1 species controls nickel solubility above 11 pH.   

It is possible to focus on the upper region of the plot so that the y-axis scale is smaller.  This is done in the 

Options window. 

✓ Select the Options button  

✓ Click the Y Axis category and change the minimum value to 1e-12 

 

✓ Press OK to view the plot  
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The values of the final four variables in the dominant concentration region can now be viewed more 
clearly. 



3-18 Chapter 3 Survey Calculations Tricks of the Trade 

3.5 Vapor Fraction survey – Seawater evaporation 
This next application is as interesting for the chemistry it computes as it is for the capability of the tool.  It 

is a vapor fraction survey calculation.  The purpose of this calculation type is to set a specific fraction of the 
stream to the vapor phase, and compute the temperature or pressure required to achieve that state.  This 
application was explained in Chapter 2, as a single point, but now it will be done as a survey.  

You will evaporate seawater to dryness and look at the solids that form.  What is interesting is the number 
of phases that can be produced when seawater evaporates, giving you a sense of how certain natural 
systems build up sediment of a particular nature. 

Getting started 

✓ Open the Object Library window – from the menu, View>toolbar>Object Library 

 

✓ Drag the Seawater (Molecular inflows) stream to the navigation panel (drag it to either the top-
level stream or in the white-space below the other streams and calculation objects. 

 

✓ Add a Survey calculation  

✓ Change the calculation type to Vapor Fraction 

✓ Click on the Specs… button  

o change the survey End to 0.95 

o Change the increment to 0.05 
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✓ Calculate 

✓ View the plot 

The default Vapor Fraction plot is the dependent variable, Temperature.  It shows that seawater boils 
initially at 100 C, and at near complete evaporation (95%) the temperature is 109.4 C.   

 

The reason for the boiling point rise, is the salinity effects on the water (water activity).  As more ions fill 

the intermolecular spaces between the water solvent, the charges attract the negative or positive region of 

the water molecule, holding it tighter in the liquid phase.  This effect on the boiling point is seen in the 

water activity property. 

✓ Click on the Variables button. 

✓ Expand the Activity Coefficients – Aqueous (m-based) category 

✓ Add H2O to the Y2 axis 
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✓ Close the window and view the plot 

 

The boiling temperature and the water activity curves are mirror images, which is not coincidental.  At 
standard pressure, 100% of pure water boils at 100 C, there is no vapor-fraction curve (a pure component 
has a single boiling point).   

Dissolved ions like salts have the net effect of expanding the boiling point range from a single point to a 
curve.  Ions interfere with the inter-molecular attractive and repulsive forces that exist in pure water.  
These disrupted and modified forces in turn change water’s properties, like boiling point.  The impact is 
concentration-dependent.  The twenty points in the plot above are the water boiling point at different salt 
concentrations.  As the vapor fraction increase, the salt concentration in the remaining water increases.  
This increase in dissolved salt causes the increase in boiling point temperature. 

Another variable, labeled Osmotic pressure () is also related to the water activity and boiling point rise.   

✓ Reopen the Variables window.  

✓ Remove the Activity coefficient from the Y2 axis 

✓ Expand the Thermodynamic Properties category and add Osmotic Pressure to the Y2 Axis 
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A similar relationship is seen between boiling point temperature and osmotic pressure.  Osmotic Pressure 
is computed from the dissolved ion concentration, and so this plot is also not coincidental.  This variable is 
commonly reported when evaluating or designing the performance of reverse osmosis membranes.  This 
osmotic pressure is essentially the pump pressure required on the saline side of the membrane to force 
water through the membrane to the pure water side.   



 Survey Calculations 

Introduction 

Survey calculations are single point calculations strung together in series. They are also referred to as 
multiple point calculations. These calculations allow the user to designate as independent either one or two 
variables. The resulting plots are then used to interpret the calculation results.   

The independent survey variables are listed below:  

 

This chapter contains instructions on how to perform the following survey calculations 

3b.1 Temperature and Pressure Survey .............................................................................................................2 

3b.2 pH and Composition Survey – Ni(OH)2-NaCN-H2O (strong complexation).................................................7 

3b.3 Vapor Fraction-Pressure survey – Dead Sea water ................................................................................. 11 
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3b.1 Temperature-Pressure Survey 
In this example, two variables are adjusted simultaneously, temperature and pressure.  This type of survey 

creates a matrix of results, which can then be interpreted using the plot function in a few ways. 

This example is  

Getting Started 

✓ Create and new Stream, and name it Dual Survey 

✓ Change the units to Metric-Batch-Mass 

✓ Add NH3 and N2 to the grid 

✓ Add a Survey Calculation and name it NH3-N2-H2O T/P Survey 

✓ Enter the following composition 

H2O 1000 g 

NH3 10 g 

N2 100 g 

✓ Change the Then by survey type from None to Pressure 

 

✓ Calculate  

The default temperature survey is 25 to 100 C by 5 C increments.  Likewise, the default Pressure survey is 1 

to 10 atm by 1 atm increments.  This produces a 160-point matrix. 

     

✓ View Plot 

The default plot is the mass of four potential phases.  This is not the plot that will be useful to review. 

✓ Click on the Variables button and remove the Y1 Axis variables 

✓ Expand the Vapor category and add NH3 to the Y1 Axis 
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The resulting plot is the NH3 mass partitioned to the vapor phase.  It can be expected, that at lower 
pressures and higher temperatures more NH3 is vaporized.  At 1 atm and 100 C, all 10 g of NH3 is vaporized.  
(it is also certain that all the H2O is vaporized, and this can be checked as well). 

 

✓ Return to the Definition tab 

✓ Open the first Specs… window  

✓ Change the Start to 0 C and the increment to 2 C  

 

✓ Click on the Var. 2 Pressure Category 

 

✓ Change the increment to 0.2 atm 

 

✓ Calculate  
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There are now 2346 calculation points.   

 

✓ View the Plot 

There are now forty-six curves on the plot, and if you attempt to resize the Legend, it will cover the 
complete plot area.   

 

This amount of data may be important and so reducing the total number of points may be a diminishing 
compromise.  Therefore, alternative viewing and data options are embedded into the plot.  You will look at 
three options here. 

These next options require that a spreadsheet tool exist in your computer.   

Save as CSV 

✓ Right-mouse-click on the Plot.  Select Export CSV.. 

 

✓ Save the file and open it in a spreadsheet software 
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Copy-Paste from plot 

✓ Click on the plot area 

✓ Press Control-C (standard Windows copy) 

✓ Open a spreadsheet (or word document) 

✓ Press Control-V 

As with the CSV export, the copy-paste from plot option transfers a data matrix to the receiving software. 

 

Viewing and copying from the View Data table 

✓ Click on the View Data button in the upper right of the plot -  

The table shown is the Array form of the data.  This table contains 2346 rows, sorted by Pressure and then 
Temperature.  This table can be copied entirely, by clicking on the upper-left gray cell, or by clicking on 
specific columns and rows and then using the Copy function. 

  

Viewing a (Pixilated) Contour diagram 

✓ Return to the plot by clicking on the View Plot button in the upper right -  

Switching to the plot is not necessary but it makes the plot easier for initial users. 
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✓ Click on the colorized Contour button adjacent to the View Data (or View Plot) button - 

 

The resulting plot is now a pixilated color plot showing the NH3 vapor mass at each T and P value.  The 

amount is characterized by a different color that is shown in the legend.   

 

You can mouse over any location in the plot and the value will be shown in the marquee.   

 

The legend scale can also be optimized by either right-mouse-clicking on the Legend and selecting Plot 
Options or clicking on the Options button in the upper right and selecting Contour.  Both open to the 
Contour options window, where the color and range can be modified. 

   

With respect to the calculation results, 10 g NH3 is in the system.  This 10 g is in the vapor phase at 1 atm 

and 100 C.  Mouse over the lowermost right point to confirm this.  Most of the plot is shaded blue, which is 

less than 1 g NH3 in the vapor.   
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3b.2 pH-Composition Survey – Ni(OH)2-NaCN-H2O 
(strong complexation) 
Overview 

In this example, we will add a complexing factor, cyanide, to the previous survey and stream. Cyanide is a 
strong electron donor and therefore competes with H2O to complex with transition metals. We want to 
know how much cyanide the system can take before we look for alternative separation methods.  

✓ In the Navigator pane, right-mouse click the Nickel Speciation stream  

✓ Select copy from the drop-down list 

 

✓ Right mouse click the Global Streams icon  then select paste 

 

✓ Change the name of the new stream to ‘pH Survey with CN’   

✓ Select the Definition tab  

✓ In the Inflows grid, enter HCN 

HCN is a convenient way for us to add cyanide. We could have also used NaCN. 
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When we copied the stream, we also copied the survey. Since the first survey calculation in this example 
uses most of the same parameters as the previous survey, we will not need to add a new survey.  

✓ In the Navigator, select the survey for the pH Survey with CN stream 

 

✓ On the top right of the Definition tab, use the Then by dropdown list to select Composition  

 

✓ Select the top Specs button 

✓ Select Var. 1 – pH and make sure the acid is HCl and the base is NaOH 

 

✓ Select Var. 2 – Composition and highlight HCN in the Component List 

 

✓ Select the Survey Range tab change the end points according to the following: 

3.5 Var. 2 Survey Range 

 

Start 0.0 

End 5e-5 

Increment  1e-5 
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✓ Press OK to then Calculate 

✓ View the Summary box 

 

The Summary indicates that the survey will have 28 pH calculations with 5 composition calculations each, 
for 174 single-point calculations.  

✓ Select the Plot tab 

✓ Right-mouse click a point along the Y1 Axis then select the Logarithmic Scale 

✓ Select the Variables button  

✓ Select the Y1 Axis header to highlight all the variables then press the << button  

✓ Expand the MBG Aqueous Totals category and double-click NI+2 to add it to the Y1 axis 

 

✓ Press OK when finished then save the file  

 

The plot contains six curves, one for each HCN concentration. We can see the original MBG Aqueous nickel 
curve when HCN is at 0.0 mol. The other curves show the HCN impact on nickel solubility. The Ni+2 content 
is 4.9e-5 mol at 8pH or about 10,000 times higher than the minimum concentration in the absence of 
cyanide. Since the atomic weight of nickel is 58670mg/mol, the minimum solubility is 2.42 mg/kg (or ppm). 
Even when CN-1 is at a low concentration of 10ppm, the system is unable to maintain the soluble Ni 
requirements. Why is this?  
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Optional Steps 

The following steps are optional: 

✓ Copy and paste the pH Survey with CN stream   

✓ Change the HCN concentration from 0.0 to 3.7e-4 mol  

✓ In the Navigator panel, expand the stream then select the survey  

✓ Change the survey Then by option from Composition to None  

✓ Press <F9> to calculate then select the Plot tab then the Curves button  

✓ Select the Y1 Axis header to highlight all the variables then press the << button  

✓ Expand the Aqueous category then add the following components to the Y1 Axis 

Ni(OH)2 Ni(OH)3-1 Ni(CN)4-2 Ni+2 NiOH+1  

✓ Press OK then right mouse click on the Y1 Axis and select the Logarithmic Scale  

 

Considerations 

In the presence of CN-1 and above 7.5 pH, the dominant aqueous species is Ni(CN)4
-2. This very stable 

complex increases overall Ni solubility by 10,000 times. Given this stability, we can estimate Ni solubility by 
knowing how much CN we add. The atomic weight of Ni is 58.67; the CN formula weight is 26.02. The 
complex Ni(CN)4

-2 is comprised of 58.67 g Ni and 104.08 g CN. That means for every 10ppm CN in solution, 
up to 5.64ppm Ni dissolves. If CN concentrations exceed a few ppm, the plant will never be able to maintain 
Ni content below 1 ppm. Let us assume that 10ppm CN is entering the stream and there is no way to stop 
it. We will need some new ideas to remove nickel to below 1ppm. 



Tricks of the Trade Chapter 3 Survey Calculations 3-11 

3b.3 Vapor Fraction-Pressure survey – Dead Sea water  
The purpose of this example is to show how boiling / evaporating water from brines at different 

temperatures can affect the product solids that form.  Dead Sea water is a hypersaline solution of sodium, 
potassium, magnesium, chloride and bromide.  These elements form temperature-dependent double-salt 
and hydrated solids.  As a result, evaporating Dead Sea water at low temperature (under a vacuum) will 
produce a different set of minerals than evaporation at atmospheric pressure. 

Getting Started 

The table below is the Dead Sea water composition in molecular form.  These molecular inflows do not 

represent any specific phases.  Rather these combinations of elements at their specific oxidation are an 

efficient way to create a system composition. 

Dead Sea water  

Stream Name Dead Sea Water H2O 890.27 KCl 14.59 

Name Style Formula SiO2 0.02 MgCl2 172.36 

Framework MSE (H3O+) B2O3 0.158 NaBr 6.82 

Units Set Metric-Batch-Mass CaCl2 47.49 NaCl 95.27 

Temperature 40 °C CaO 0.066 SO3 0.067 

  CO2 0.034 CaCO3 0.0086 

✓ Create a new Stream object and name it Dead Sea Water 

✓ Enter the composition from the table  

When completed, the grid should look like the image below.   

   

The next step is to create the Vapor Fraction survey with the secondary Pressure survey.  The following are 
the specifications that will be used  

✓ Add a Survey calculation and label it Vapor Fraction / Pressure 

 

✓ Change the First Survey option to Vapor Fraction 

✓ Set the Then by (Optional) to Pressure 
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✓ Click on the first Specs… button  

✓ Change the Start vapor fraction to 5 % 

✓ Set the increments to 5 % 

 

✓ Click on the Var.2 – Pressure category 

 

✓ Select the Point List radio button 

✓ Add two points to the grid 

✓ Enter pressures of 0.01, 0.1, and 1 atm 

 

✓ Close the Specs window and Calculate 

✓ Click the Plot tab 

The plot below is the default Temperature curves as the vapor fraction of the sample increases.  Each curve 

represents a different pressure condition.   The top curve is the atmospheric pressure condition, and the 

software computes that the boiling temperature range is between 110 and 250 C.  The bottom curve is the 

low pressure (0.01 atm) condition and the boiling temperature range here is between 13 and 120 C.  Note 

that the curves start at the 5 % vapor fraction that was selected.  The curves end however at 90% vapor 

fraction and not the 100 % that was set.   
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The reason that the 95% and 100% condition failed is because the Dead Sea brine is only 92% water.  The 
rest is salt.  Therefore, these vapor fractions were not feasible.  Note also, that the software computed a 
temperature reduction from 85% to 90% for the low-pressure conditions.  Changes like this sometimes 
reflect the technical limits of the software or thermodynamic database and are worth questioning further 
before conclusions are drawn. 

✓ Return to the Definition tab 

✓ Change the Vapor fraction to end at 90% 

 

✓ Recalculate 

Studying the solids forming 

✓ Click on the Plot tab  

✓ Open the Variables window (Click on the Variables button) -  

✓ Remove the Temperature from the Y1 Axis 

✓ Expand the Solids section 

There are about fifteen solids computed to be stable during the evaporation study.  This is too many to 
add at once, given that three pressure surveys are run.  Therefore, the approach is to look at the most 
significant solids and then focus in on specific solids. 

✓ Add the Dominant Solids to the Y1 Axis field 
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✓ Close the window and view the plot 

The Dominant Solids plot displays the five most significant solids in the survey calculation.  These are NaCl, 
CaCl2.MgCl2.H2O, MgCl2.4H2O, MgCl2.2H2O, and KClMgCl2.6H2O.  There are fifteen curves in total three for 
each phase.   Since this plot is too confusing to review, the Data Table will be used instead.  

 

✓ Click on the View Data button -  

The table contains a multi-column solids list sorted by temperature and pressure.  At lowest pressures, the 

five dominant solids are the five phases listed above.  Halite is present in all calculations.  The other phases 

however, are present only at specific evaporation fractions (or at specific temperatures).  Carnallite, 

KCl.MgCl2.6H2O, is computed to form between 40 and 75% vapor fraction at 0.1 atm.  This phase is 

computed to form at 75% vapor fraction only when the pressure is 1 atm. 
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✓ Open the Variables window and remove the Dominant solids 

✓ Plot all the MgCl2-containing solids.  There should be six of them. 

 

✓ View the Data 

At 0.01 atm, 1.965 g of MgCl2-containing solids form.  At 1 atm, this amount is 0.967 g.  The primary 
difference is MgCl2.6H2O, where at 0.01 atm, 0.514 g is computed to form and 0 g forms at 1 atm.  

Additional interpretation can be done with this data.  If you are interested, consider looking at the water 
(H2O) activity, the remaining amounts of dissolved element (element balance table), the cation-anion 
complexes that form (Speciation table), and the gas-phase components (Speciation table).   

 



 c. Survey Calculations 
with embedded single points 

Introduction 

This chapter contains several survey calculations that contain an embedded single point calculation.   

3c.1 Solubility vs. Temperature ..........................................................................................................................3 

3c.2 Composition Survey with Bubble Point: Acetone-H2O ............................................................................ 11 

3c.2 Composition Survey with Dew Point: Ethanol:H2O .................................................................................. 16 

3.4a Temperature & Pressure Surveys ................................................................ Error! Bookmark not defined. 

The first two sections of this chapter presented single and dual surveys.  In addition to adjusting these 
survey variables, a user can select one of several single point calculations embedded within the survey.  The 
embedded single point calculations include 

 

• Isothermal – default 

• Bubble, Dew Point, Vapor Amount and Fraction – This is used when a specific 

fraction/amount of material is in the vapor.  It is not used when the Vapor Fraction/Amount 

survey is selected 

• Set pH – the user fixes the pH at a single value throughout the survey.  This is not used with 

pH Survey 
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• Precipitation point – the user can model for example a solid solubility vs temperature or 

composition 

• Composition Point – A user can fix the aqueous or vapor composition of a specific species as 

the survey is run 

• Isochoric – A user can fix the total volume of the system at a single value during the survey. 

• Custom – A user can fix one or more variables and free an equal number of variables within 

the survey. 
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3c.1 Solubility vs. Temperature  
A very common application is calculating the solubility of a solid as temperature and pressure vary.  This is 

a thermodynamic solubility phase diagram, and when presented in two- and three-dimensional plot, 
provides insight into the physical- chemical properties of a solid phase.  Several examples will be run, to 
provide general insight into the behavior of many solid phase types.  

✓ Create a new file  

✓ Save the file with a name such as “Chapter 3c” (and save often) 

✓ Add a new stream and name it ‘Mineral Solubility’  

✓ Change the framework to MSE 

Add nothing to the Inflows grid (all will be added in the individual surveys) 

Getting Started - Halite  

Halite solubility vs. Temperature 

✓ Add a Survey calculation and name it Halite 

✓ Add NaCl to the grid 

✓ Select the Specs button  

✓ Set the temperature range from 0 to 100 C by 5 C increments 

 

✓ Select the Calculation Type category  

 

✓ Change the Type of Calculation to Precipitation Point 

✓ Select Halite for the solid and NaCl for the Adjusted. 

✓ Close the window  
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The screen should look like the one above. There are a few points to note.  First, the Inflow, NaCl does not 
mean that halite is being added.  Rather, NaCl inflow is the efficient way of adding Na(+1) and Cl(-1) to the 
system.  Only the solid phase, Halite, is defined.   

Secondly, depending upon the version you use, the main screen may contain the options to change the 
calculation type selection and the solid phase, the inflow selections. 

✓ Calculate 

✓ Click on the Plot tab 

The default plot is the dependent variable, the amount of NaCl add to 1 kg of H2O before halite 
precipitates.  This variable is called NaCl (Inflow).  The default units are moles. 

 

Halite solubility increases slightly with temperature, about 10%.  This relative increase is small compared 
to other minerals, however, the overall soluble amount is high, at 6.1 to 6.7 moles/kg H2O.   

Halite solubility vs. Temperature and Pressure 

The effects of pressure on mineral solubility is generally less important than temperature.  There is still an 
effect that can be observed.   

✓ Return to the Definition tab 

✓ Change the Then By (optional) calculation to Pressure 

✓ Click on the second Specs… button 

✓ Change the scale to Log, the End pressure to 500 (atm) and the Steps to 3 
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✓ Calculate 

✓ Review the plot 

 

The effect of pressure is significant between 100 and 1000 atm relative to the effects between 1 and 100 
atm.  The range between the 0 C, 1 atm condition (6.1 moles/kg) and the 100 C, 1000 atm condition (7.8 
moles/kg) is about 28%. 

Halite Solubility using Contour Diagram 

This last procedure will include several hundred points to create a surface or contour plot of its solubility. 

✓ Return to the Definition tab 

✓ Click on the Specs… button 

✓ Change the maximum temperature to 150 C and change the increments to 2 (75 steps) 

 

✓ Click on the Var. 2 - Pressure category  
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✓ Change the survey to Linear, the start to 20 atm and the increments to 20 atm (49 points) 

 

This produces a matrix of 75 steps x 49 steps for a total of 76 temperature and 50 pressure points, or 3800 

points in total.  This calculation will take a few minutes to compute. 

✓ Click on the Plot tab 

✓ Click on the Variables button, remove the existing variables 

✓ Expand the Inflows category and add NaCl (inflow) to the Y1 axis.  Close the window 

 

✓ Change the plot type to Contour -  

 

The solubility is shown to increase as temperature and pressure increase.  The increase is up to 50% from 
the low values.  A few of the points failed to converge at the low temperature and high pressure conditions.   
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Zabuyelite (Li2CO3)  

Solubility vs. Temperature and Pressure 

Li2CO3 is an important intermediate chemical in the lithium battery manufacturing process.  Lithium is 

obtained from salt flats and lakes in what is called the Lithium Triangle of the Andes.  These lakes contain 

Li+1 concentrations that are high relative to other surface waters.  Lithium is recovered through a series of 

evaporation and precipitation processes and the product transported from the mining region is Li2CO3.  The 

purpose of this example is to compute this mineral’s solubility. 

✓ Add a new Survey calculation to the Mineral Solubility stream 

✓ Name the survey Zabuyelite (Li2CO3) 

✓ Add Li2CO3 to the inflow grid 

 

✓ Open the Specs window and change the Temperature Specifications to start at 0 C and end at 
100 C by 5 C increments. 

✓  Click on the Calculation Type Category and change the type from Isothermal to Precipitation 
Point 

✓ Select Zabuyelite as the solid and Li2CO3 as the inflow 

   

You will modify the units before calculating 

✓ Click on the (mol) hyperlink in the Inflows grid category -  

✓ Change the Inflows basis to Mass Fraction - 

 

✓ Change the Aqueous and Total Composition basis to Mass Fraction - 
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✓ Change the Mass fraction units from mass% to ppm (mass) 

 

✓ Calculate and view the plot 

Zabuyelite solubility is computed to decrease by a factor of about 2.5x as temperature increases from 0 to 

100 C.   

 

Extending the Lithium removal using a second Composition survey 

The simulation above is the normal solubility of Li2CO3 in pure water.  This would not be an optimal way to 
recover lithium.  A more efficient method to increase lithium yield is to increase the dissolved CO3

-2 
concentration relative to Li+1.  This can be done by adding Na2CO3 or another carbonate source. 

You will start by first displaying the dissolved Li+1 concentration and then make the inflow change 

✓ Open the Variables window and remove the existing Y1 Axis variable 

✓ Expand the MBG Total – Liquid-1 category and add Li+1 to the Y1 Axis 

 

The resulting plot is the dissolved lithium ion (separate from the carbonate).  Its concentration is 2900 ppm 
at 0 C and 1300 ppm at 100 C. 
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✓ Return to the Definition tab 

✓ Add Na2CO3 to the inflow Grid -  

✓ Change the second (Optional) survey to Composition  

✓  

✓ Click on the 2nd Specs… button 

✓ Select Na2CO3 as the Inflow -  

✓ Click on the Survey Range button and change the survey to Point List 

✓ Add the following concentrations, 0, 1000, 10000, and 100000 ppm 

 

✓ Close the window and calculate 

✓ View the plot 



3-10 Chapter 3 c. Survey Calculations Tricks of the Trade 

Based on the calculations, the amount of Li+1 remaining in the water phase can be decreased by up to 50% 
if the process fluid is high in CO3

-2.  There is a limit to the amount of Na2CO3 that can be added, because at 
low temperature, Na2CO3.10H2O precipitates (the kink in the curve at 0 to 10 C). 

 

  



Tricks of the Trade Chapter 3 c. Survey Calculations 3-11 

3c.2 Composition Survey with Bubble Point: Acetone-
H2O 
The next task is to explore the boiling point of water when miscible organics are added to it.  The organics 

are common materials, acetone, ethylene glycol and methylamine.   

Getting started 

✓ Add a new stream   

✓ Select the <F2> key or Description tab to rename it ‘Boiling Point Curve’  

✓ Select the Names Manager in the toolbar and switch to Display Name  

✓ Select the MSE button in the toolbar  

✓ Select the Units Manager button in the toolbar  and change it to Mass Frac  

 

✓ Press OK then return to the Definition tab  

✓ Enter Acetone, MEG, and methylamine to the Inflows grid  

 

Acetone-Water curve 

✓ Add a Survey calculation and name it Acetone -  

✓ Change Survey to Composition -  

The calculation button is red, which indicates that the survey needs more specifications.  

✓ Click the Specs … button on the top right  

✓ Select Acetone from the Component list  

  

✓ Click on the Survey Range tab, then enter the following values: Start 0, End 100, Increments 2 



3-12 Chapter 3 c. Survey Calculations Tricks of the Trade 

 

✓ Select the Calculation Type category, then change the calculation to Bubble Point 

 

✓ Press OK to and Calculate or press the <F9> key 

✓ Select the Plot tab  

 

The pure component boiling points are the far left and far right points on the curve.  Mouse over these 
points to identify the values.  H2O is 100 C and acetone is 56.2 C at 1 atm. 

  

The water boiling point decreases as the acetone fraction increases (far left of the plot).  Likewise, the 
acetone boiling point increases as the water content increases (far right of the plot).  The curve would be a 
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straight line at ideal conditions.  However, because of the disruption of molecular interactions cause by 
mixing the two components, it is a non-linear curve.   

MEG-H2O Boiling 

✓ Add a Survey calculation and name it Ethylene Glycol -  

✓ Change Survey to Composition 

 

The calculation button is red, which indicates that the survey needs more specifications.  

✓ Click the Specs … button on the top right  

✓ Select 1,2-Ethanediol (ethylene glycol) in the Component list  

  

✓ Click on the Survey Range tab, then enter the following values: Start 0, End 100, Increments 2 

 

✓ Select the Calculation Type category, then change the calculation to Bubble Point 

 

✓ Press OK to and Calculate or press the <F9> key 

✓ Select the Plot tab  
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Ethylene glycol has a higher boiling point than water, and therefore the curve is a mirror image of the 
acetone water plot.   

Methylamine-H2O boiling Point 

Instead of creating and formatting a new survey, you will use the copy-paste shortcut programmed in the 
software. 

✓ Right-mouse-click on the Ethylene Glycol survey and select Copy 

✓ Right-mouse-click on the Boiling Point Curve stream and select Paste 

   

✓ Rename the new survey Methylamine -  

✓ Open the Specs… window and change the Component inflow to Methylamine 

 

✓ Close the Specs… window and calculate. 

The resulting plot is a fairly linear curve that extends from 100 C (pure water) to -7 C (pure methylamine).  
This is an example of a miscible solution of two components with a wide boiling point difference.   



Tricks of the Trade Chapter 3 c. Survey Calculations 3-15 

 



3-16 Chapter 3 c. Survey Calculations Tricks of the Trade 

3c.3 Composition Survey: Azeotrope 
This case is similar to the previous case.  A dew point and bubble point calculation will be run using ethanol 

and water.  The two data sets will then be transferred to a spreadsheet where the curves are plotted 
together to locate the azeotrope. 

You will need a spreadsheet software to compete this case 

Getting Started 

✓ Add a new stream   and label it Azeotrope 

✓ Select the Names Manager and switch to Display Name  

✓ Select the MSE button  

✓ Set the Units  to Mass Frac  

 

✓ Enter the following components, Ethanol, HCl, and HF  

 

✓ Add a Survey calculation and name it EtOH Azeotrope -  

✓ Change the Calculation type to Composition 

Calculating the Ethanol-Water dew point 

✓ Select the Specs… button  

✓ Select Ethanol from the list in the Component Tab and enter the Start, End, and Increments of 
0, 100, and 2 % 

   

✓ Click the Calculation Type Category and change from isothermal to Dew Point  
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✓ Press OK and Calculate  

✓ Select the Plot tab 

 

✓ Right-mouse-click on the white region of the plot to open the Drop-Down menu  

✓ Select Copy  

 

✓ Open the Spreadsheet software and paste the data 

Calculating the Ethanol-Water bubble point 

✓ Return to the Definition tab  

✓ Open the Specs… window and select the Calculation Type category 

✓ Change the calculation to Bubble Point 
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✓ Recalculate 

✓ Click on the Plot tab 

 

✓ Copy this data to the spreadsheet 

✓ Plot the two temperature curves and format the plot as needed  

The Azeotrope occurs at about 95% ethanol where the two curves intersect.   

 

HCl-H2O Azeotrope 

✓ Repeat the above procedure and use HCl as the adjustable component 

✓ Instead of creating a new survey, make a copy of the Ethanol Azeotrope survey and modify that 

✓ Bring the data to the spreadsheet and plot 
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The azeotrope occurs at 21% HCl, and the two curves should intersect at this point. It is likely that that 

there are multiple calculation failures at the high HCl fractions.  Non-aqueous solutions can be difficult to 

converge, and this problem is compounded by HCl’s volatility at high purity. 

 

HF-H2O Azeotrope 

✓ Repeat the above procedure and replace HF as the adjustable component  

  

✓ Bring the data to a spreadsheet and plot 

 

The azeotrope is computed to exist at 40 C at 1 atm.  Below and above this temperature, there is 

composition separation between the dew point and bubble point for the same temperature. 

✓ Save the file  
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3c.4 Custom Calculation in a Survey 
The Custom calculation option used in Chapter 2 enables users to fix one or more variables and then adjust 

other variables in turn.  In this case, the custom calculation will be used within an H2S-H2O composition 
survey.  The H2S concentration will be increased from 0 to 10,000 mg/l.  At the same time the amount of 
NaOH required to neutralize the pH to 7 will be computed, and lastly the bubble point pressure of the 
mixture will be calculated. 

Getting Started 

✓ Add a new stream and label it H2S-H2O System 

✓ Change the framework to MSE -  

✓ Change the units to Metric-batch-conc -  

✓ Enter H2S and NaOH to the grid -  

✓ Add a survey calculation and label it 0 to 10,000 mg/l H2S 

✓ Set the Calculation type to Composition 

✓ Enable Custom calculations by selecting the Tools menu at the top of the page, and choose 
Options.  At the bottom of the new dialog box, check the option under Advanced to “Enable 
custom calculation within survey.” 

✓ Open the Specs… window 

✓ Highlight H2S and set the range: 0 to 10000 by 500 mg/l –  

   

✓ Click on the Calculation Type category 

✓ Change the type to Custom 

 

✓ Click on the Specs… button 

✓ Fix two variables: pH and Moles (True) – Vapor  

✓ Free two variables: NaOH and Pressure 

✓ Close the windows and return to the Definition tab 
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A new grid section appears, Calculation parameters. It contains four rows, one for each of the fix and free 
variables just selected.   

✓ Set the Target: Moles (True) Vapor to 1e-6 

✓ Set the Target: pH to 7 

 

✓ Calculate 

✓ Click on the Plot tab 

✓ Change the variables.   

o Add to Y1 axis - Pressure (in Stream Parameters category)  

o Add to Y2 axis - NaOH (in the Inflows category) 

 

The resulting plot is somewhat unremarkable containing two straight lines.  The bubble point at 7 pH is 
computed to increase from 0.031 atm (pure water vapor pressure) to 1.3 atm at 10,000 ppm H2S (total).   
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The amount of NaOH added starts at zero (pure water has a 7 pH) up to 6860 mg/l NaOH at 10,000 mg/l 
H2S.  The maximum amount of material added is 16,860 mg/l or about 1.7%.  

✓ Remove the existing variables 

✓ Add the following Liquid-1 variables, H2S, Liq 1 and HS-1 to the Y1 axis 

 

✓ Add the following Activity coefficient Liquid-1 (m-based) variables, H2S, Liq 1 and HS-1 to the 
Y2 axis 

 

✓ Close and view the plot 

The interpretation of this plot is as follows.  As H2S is added, the HS-1 concentration increases faster than 

the H2S concentration.  This is despite the fixed pH of 7, which when using a simple concentration 

relationship should fix the HS-1/H2S concentration ratio (the brackets represent concentrations).   

𝐾𝐴,𝐻2𝑆

[𝐻+]
≈

[𝐻𝑆−1]

[𝐻2𝑆]
≈ 𝑐𝑜𝑛𝑠𝑡𝑎𝑛𝑡 𝑎𝑡 𝑐𝑜𝑛𝑠𝑡𝑎𝑛𝑡 𝑝𝐻 𝑎𝑛𝑑 𝑇 
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`  

The Y2 axis of curves explain the reason for this disparity.  As H2S and the neutralizing NaOH is added, the 

salinity increases.  This increased salinity affects the behavior of all species, but mostly the charged ions.  As 

a result, the activity coefficient for HS-1 decreases, while the H2S activity coefficient remains constant.  This 

effect is the difference between the two concentrations at each point.   
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3c.5 – Iron Oxidation 
This case presents another bubble point pressure scenario, in which elemental iron is added to water.  The 

Fe and H2O react spontaneously, producing H2 gas. This gas exerts a vapor pressure and the vapor pressure 
value is computed using the Bubble Point calculation.  Oxygen is added using a composition survey.  It will 
also react with iron and does so preferentially to water (more energy is released).  Therefore, as more O2 is 
added, less H2S is produced, which has the net effect of lowering the vapor pressure.  Eventually the iron is 
consumed, and any excess O2 added exerts a vapor pressure which is again computed by the software. 

Getting Started 

✓ Add a stream and label it Iron Oxidation 

✓ Change the framework to MSE -  

✓ Add Fe and O2 to the grid -  

✓ Turn on Redox by clicking on the Re button -  

✓ Add a Survey calculation and label it O2 titration 

✓ Set the iron amount to 0.1 mole 

✓ Change the calculation to Composition 

✓ Open the Specs… Select O2 as the component to vary 

✓ Set the range:  Start = 0, End = 0.2, Increment = 0.005 moles 

  

✓ Change the Calculation type from Isothermal to Bubble Point and select Pressure as the 
calculated variable 

 

The grid should now look like the following.  The 0.1 mole Fe, will produce 0.1 mole H2 in pure water, and 
this H2 will exert a vapor pressure.  The total pressure will be adjusted to match this exerted vapor 
pressure. 
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✓ Calculate and view the plot 

The default plot is Pressure, since this is the dependent/adjustable variable.  The V-shape is evidence of 
the initial existence of dissolved H2, its reduction and eventual elimination as O2 is added, and finally the 
excess O2 after the iron is completely oxidized. 

 

✓ Open the Variables window. 

✓ Expand the Liquid-1 category and add H2 and O2 to the Y2 axis 

 

The resulting plot contains the dissolved H2 and O2 amounts.  These curves follow the outline of the bubble 
point pressure curve.   



 

 Water & Oil Analyses  

Introduction 

In this chapter, we will learn how to enter cations and anions using the OLI Studio:  Stream Analyzer object 
called Water Analysis. We can add a water analysis from the Menu bar by selecting Streams > Add Analysis 
or by selecting its icon from the Actions pane: 

  

Large Icon View 

 

 

 

Small Icon / List View 

Using this object, we will learn about automatic and manual alkalinity measurements, create a PVT 
analysis, and input customized data or pseudocomponent properties into a stream.  

Calculation List 
4.1 Entering Data into a Water Analysis .............................................................................................................2 

4.2a Creating a High Calcium/Barium Water ......................................................................................................3 

4.2b Creating a High Bicarbonate/Sulfate Water ...............................................................................................8 

4.3 Exploring Reconciliation Options ............................................................................................................... 10 

4.4 Automatically Reconcile for Alkalinity ....................................................................................................... 19 

4.5 Manually Reconcile for pH & Alkalinity ..................................................................................................... 20 

4.6 Crude Oils ................................................................................................................................................... 24 

4.7 Entering a PVT Analysis .............................................................................................................................. 25 

4.8 Entering Pseudocomponents to a Stream ................................................................................................. 31 
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4.1 Entering Data into a Water Analysis 

Background 

OLI Studio: Stream Analyzer was developed to accept two input types, molecular and ionic inflows. 
Chapters 2 and 3 focused on molecular inflows and this chapter will focus on ionic inflows. 

 

A populated Water Analysis screen 

The OLI database contains on average seven synonyms for each species. This provides flexibility on how 
any species name is added to the grid.  For example, the ions Na+ and CH3COO-1 can be added in the 
following ways:  

Cation (e.g., sodium)  Anions (e.g., acetate) 

Na+ NAION Natrium ion(+1)  C2H3O2- C2H3O2-1 C2H3O2(1-) 

Na+1 Sodium ion   C2H3O2(-) Acetate ion(-1)  

Na(+) Natrium ion   C2H3O2(-1) ACETATEION  

In total, the database has approximately 2,000 ions (and 15,000 synonyms).  Therefore, just about any 
species of importance can be added.   

The Water Analysis grid also contains search aids to find a specific cation or anion.  The first search aid is 
the drop list located in each the cation, anion, and neutral grid sections.  The list is alphabetic, and is 
activated using the drop-down arrow within the cell, after the first few letters of the ion is typed. 

 

The database dropdown box 

 

If a name is misspelled or if the text is unrecognized, then a red ‘X’ appears to the left of the name. this 
name needs to be corrected or the row deleted before proceeding. 

  

Mistaken identity  
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4.2a Creating a High Calcium/Barium Water 
Sections 4.2a and 4.2a are part of the same project.  You will create two water analyses and then perform 

a reconciliation calculation on each.  These two waters are mixed in the next chapter.   

The water in this section is high in divalent cations, calcium and barium, and low in their precipitating 
anions, HCO3

-1 and SO4
-2.  This water is purely hypothetical, and is created to extend the concept of water 

incompatibility.  

The table below shows the water composition. The stream volume is 1 L, the temperature is 25 C, and the 
sample is at 1 atm pressure.  

4.2a – High Calcium/Barium Water Composition  

Analysis Parameters Neutrals mg/L Cations mg/L Anions mg/L 

Default SiO2 25 Na+1 10000  Cl-1 21000 

Recorded Properties   K+1 350 Br-1 150 

Total Dissolved Solids (mg/L) 35000    Ca+2 2000 HCO3-1 26 

pH 6.3   Mg+2 800 SO4-2 0.5 

Density (g/ml) 1.025   Sr+2 300   

    Ba+2 150   

✓ Create a new file.  Save it as “Water Analysis Mixer” or another name to recall later. 

You will use this file in the next chapter, and so be certain to save the data once completed.   

✓ Add a new Water Analysis to the file  

✓ Name it “High Calcium/Barium”  

 

✓ Enter the Recorded properties, pH, alkalinity, etc. from the above table 

✓ Enter the composition including the neutrals, cations, and anions 

Make sure to include the charge symbols + or - while entering the data.   

The screen should look like the one below.  Be certain that there are no red x’s in the neutrals section.  
This would indicate that a species was not recognized.  
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✓ Select Add Reconciliation from the Actions pane or the top right of the screen  

✓ Name the stream – Reconciled Ca/Ba 

 

The software opens to a tab called Reconciliation, which has a grid that looks the same as the initial grid. 

 

The upper-right calculation section contains three ways to adjust the calculated fluid properties. These 
options will be discussed in detail throughout this chapter.  

The default calculation is No reconcile. This option means that the software will compute the water 
properties based on the current concentration of cations, anions, and molecular species. The calculation 
will not use the measured pH or the measured alkalinity.  

✓ Click on the Calculate Alkalinity button -  

✓ Press the <F9> key or click the Calculate button 

Contents of the Summary Section 

✓ View the Summary section 

 

After selecting Add Reconciliation, the Navigator panel displays a substream 
called Reconcile as a branch to the initial water analysis object. We can change 
the reconcile substream name in the Description tab or by pressing the <F2> key.  
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The Summary section contains several pieces of information. The top section contains the charge balance 
information showing the total equivalent charge (positive and negative), and the charge imbalance. 

Below the charge balances, the Summary panel displays the calculation type the software used. In our 
example, the software performed a default isothermal calculation at 25 C and 1 atm. If we selected other 
calculation specifications, they would appear here.  

The Summary also contains the Phase Amounts. This particular analysis contains a single water phase.  The 
last section is the computed pH, ionic strength, and density. The measured pH is 6.30 and the computed pH 
is 6.99. 

This case has a positive imbalance of 0.0239 equivalents of positive charge, which corresponds to 848.9 
mg/L of Cl-. The software adds this amount of chloride to the water. We can see this by selecting the 
calculated tab at the bottom of the grid. 

 

Viewing the Molecular Basis Tab  

✓ Click the Molecular Basis tab 

The Molecular Basis tab is one of several tabs of the Reconciliation object. The information contained in 
this tab is the molecular composition that the water analysis created.   

 

This molecular form can be exported to a standard OLI Studio stream, or it can be exported to separate 
software like Flowsheet: ESP, Aspen Plus1, UniSim Design2, or other simulators. 

This molecular representation is one of many molecular configurations that the software can devise. The 
configurations may differ depending on the order in which the ions were entered. For example, the top row 
shows BaCl2 - 227.448 mg/l. Barium and chloride could also be added as Ba(OH)2 and HCl at their respective 
concentrations. Two alternative configurations are shown below:  

                                                           
1 Aspen Technologies, Cambridge MA. 
2 Honeywell Corporation, Calgary AB 
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Molecular Basis – Configuration 1 Molecular Basis – Configuration 2 

The software generates molecular concentrations based on two priorities. The first priority is to create the 
least number of molecular inflows. This example contains twelve inflows (plus H2O not shown). The second 
priority is that the least number of total moles be created. Moles are not shown here, since the units are 
mg/l. The moles are shown in the report tab. 

Viewing the Report Tab 

✓ Click on the Report tab 

 

The Report tab is slightly different from the Single Point report described in Chapter 2. This Report 
contains three additional tables, all of which are located at the top. These tables are the Reconciliation 
Summary, Stream Inflows, and Charge Balance. 

The Reconciliation Summary table confirms the selected calculation type, conditions, and any calculated 
property that needs to be compared to a measured property. This calculation was run at 25C and 1 atm. 
The two measured properties shown are pH and density. 

 

The Stream Inflows table represents what we entered in the initial water analysis grid. 
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The Charge Balance table contains the concentrations entered and the final balanced values.  In this case 
only the chloride concentration was changed. This table is provided because when the prorating balance is 
selected, several concentrations are changed. 

 

The remaining tables in the Report tab are the same as those found in the Single Point calculation report. 

✓ Save the file 
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4.2b Creating a High Bicarbonate/Sulfate Water 
The water analysis in this case contains a high concentration of sulfate and bicarbonate and low 

concentrations of divalent cations.  It is incompatible with the first water (solids will precipitate) which is its 
purpose.  As with the first water, this water is hypothetical.  

✓ Add a new Water Analysis and name it ‘High Bicarb/Sulfate’ 

✓ Use the table below to complete the Water Analysis’s composition:  

4.2b – High Bicarbonate/Sulfate Water Composition  

Analysis Parameters Neutrals mg/L Cations mg/L Anions mg/L 

Default SiO2 10 Na+1 23000 Cl-1 35000 

Recorded Properties   K+1 200 SO4-2 2000 

TDS (mg/L) 61000   Ca+2 25 HCO3-1 950 

pH 7.8   Mg+2 15   

Alkalinity (mg/l HCO3) 900   Sr+2 10   

Density (g/ml) 1.042   Ba+2 .05   

The screen will look like the one below:  

 

✓ Add a Reconciliation object from the Actions panel  

Before proceeding, you will enable an important calculation option for this case.  

✓ Click on the Calculation Options button in the Toolbar ribbon  

✓ Check the box for Pre-scaling Tendencies, and keep the Estimated method. Press OK 
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✓ Calculate (or press the <F9> key)  

The calculated pH is 7.6 and the density is 1.04 g/ml. There are no solids forming in this sample; the Solids 
Amount is zero g. Additional information on the solids scaling tendencies is in the Report. 

 

✓ Click on the Report tab and scroll down to the Scaling Tendencies table 

This table should contain two columns, the Post-Scale and Pre-Scale tendencies. The column names are 
not optimal, and will be modified in future versions. These columns represent the saturation ratio of each 
potential solid phase.  

 

The first column is the saturation ratio (or scaling tendency) after all potential solids come to equilibrium. 
This is the true equilibrium condition (time=∞).  The second column is the pre-scale tendency and 
represents the condition before any solids are allowed to form. This is a non-equilibrium condition and can 
be viewed as the condition where time equals 0. 

In this case, the pre- and post-scale tendency values are the same, because no solids are at risk of forming 
– A solid is at risk of forming when the scale tendency value is greater than 1.0.  

✓ Save the file then close it by selecting File > Close 
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4.3 Exploring Reconciliation Options  
This section starts a new file.  It includes a basic water analysis, from which the various reconciliation 

options can be studied.  

✓ Create a new file and save it with a name that can distinguish it from the file created for the first 
two cases. 

Setting up a New Water Analysis  

4.3 – Water Analysis Composition  

Analysis Parameters Neutrals mg/L Cations mg/L Anions mg/L 

Default SiO2 16  Na+1 10000  Cl-1 19000 

Recorded Properties   Ca+2 500 SO4-2 2700 

TDS (mg/L) 36500    Mg+2 1200 HCO3-1 145 

pH 7.8   Sr+2 200 AsO4-3 12 

Alkalinity (mg/l HCO3) 160   Ba+2 5 CHO2-1 20 

Density (g/ml) 1.013    Fe+2 5 C2H3O2-1 50 

✓ Add a new Water Analysis and name it “4.3 WaterAnalysis”  

✓ Use the table above to input the water analysis’s composition  

Despite zero values, HCl, a strong acid, and NaOH, a strong base, will adjust the pH for our first calculation. 

 

Reconciliation #1 – Reconcile sample with a fixed pH and solids allowed to form 

✓ Select Add Reconciliation and name it Reconcile #1 

✓ Turn on the Pre-Scale Tendencies using the Calculation Options window 
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✓ Click the Specs button 

  

Selecting the Specs button opens the Reconciliation Data menu. We do not have to adjust the 
reconciliation specifications yet but will look at some of the options available.  

Reconciliation Data options – Types of Balance 

 

Dominant Ion – The highest species concentration of the deficient charge is 
added. In our example, Na+ ion is added since there is excess negative charge.  

Prorate - An equal portion of every deficient ion is added. 

Prorate Cations –All cations are adjusted up or down equally 

Prorate Anions – All anions are adjusted up or down equally 

Na+/Cl- - Sodium is added when there is an excess of negative charge. 
Chloride is added when there is an excess of positive charge. 

Make-up Ion – User selects an ion to increase or decrease. There is no 
software check to ensure that sufficient concentration exists to decrease 

User Choice – Analyzer determines if an anion or cation is needed to balance 
the solution and the user choses the specific ion. 

✓ Keep the default option, Dominant Ion, as the balance type then press OK 

✓ Click on the Reconcile pH radio button  

 

You will next instruct the software to calculate alkalinity. Calculating the alkalinity requires a second 
calculation.  After completing the reconciliation, the software adds H2SO4 (or another acid) until the pH 
reduces to 4.5. The software then converts the amount of additional acid to alkalinity. 

✓ Check the Calculate Alkalinity box 
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✓ Press the <F9> key or the Calculate button  

✓ View the Summary 

Although the Report tab, which we will look at later, has more detail, the Summary shows several 
important points about the reconciliation:  

1) The software added 748.9 
mg/l Na+ to balance the 
charge 

2) To fix the pH at 7.8, the 
software added 58.6 mg/l 
NaOH  

3) The calculated alkalinity is 
260.8 mg/l as HCO3/L 

4) The reconciliation predicts 
that 0.49 g of solids will 
form  

 

✓ Click the Report Tab  

✓ Scroll down to the Scaling Tendencies Table  

Scaling tendencies are essentially saturation ratios. When the scaling tendency for a species is 1.0, it 
indicates that this species is in equilibrium with water. In other words, the species is in the solid phase. A 
scaling tendency below 1.0 indicates sub-saturation and that the solid phase will not form. 

 

The table shows the presence of three solids SrSO4, CaCO3, and BaSO4. What the table does not show are 
the amounts of each solid. To see solid mass, we will review a different table within the Report tab.  

✓ Scroll down to the Species Output (True Species) table 

The Species Output list is extensive and is sorted by concentration. You can filter this list to focus on the 
phases of interest. In this case it is the solid phase column. 

✓ Click on the Species Output (True Species) heading (it is hyperlinked) 



Tricks of the Trade Chapter 4 Water & Oil Analyses 4-13 

 

The hyperlink opens to a customization menu. Most tables have similar options. We can customize tables 
by clicking their headers or by selecting the Customize button and selecting the table from the Category list.  

✓ Click the Phases tab 

 

✓ Uncheck all the boxes, except for the Solids phase 

 

✓ Press OK  

✓ Scroll down to the Species Output table  

The table, now contains the concentrations of predicted solids.  

 

Two of the solids, SrSO4 and BaSO4 are salts of a strong acid, H2SO4. This means that these solids are not 
pH-sensitive and the predicted masses will be the same regardless of the water sample’s pH. By 
comparison, the 145 mg/l CaCO3 solid is pH-sensitive. If a different pH is set, then the CaCO3 mass will 
change. 

The next task is to study the water composition, and so the complete Species Output table will be 
reviewed.  To eliminate unneeded rows, the table will be filtered to show only values greater than 8 mg/l  

✓ Click the header for the Species Output (True Species) header 
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✓ Click the Phases tab  

✓ Click the Select All button  

 

✓ Click the Options tab  

✓ Select the button for “Only rows where any value is greater than”  

✓ Enter a value of 8.0 to show species only greater than 8.0 mg/l 

 

✓ Press OK then scroll down to the Species Output (True Species) table 

We will focus on the dissolved carbonate species, CaCO3
0, MgHCO3

+, NaHCO3
0, and HCO3

-1.  Carbonates are 
part of all natural waters because CO2 is a key atmospheric component and calcite mineral is a component 
of many rocks. Carbonates are also critical pH buffering species in surface waters, rivers, lakes, and oceans.   
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The measured or initial HCO3
-1 concentration was 145 mg/l. After reconciliation, only 31 mg/l exists as the 

the dissolved species because the rest has precipitated or complexed: 1.7 mg/l CaCO3
0, 20.0 mg/l MgHCO3

+, 
10.2 mg/l NaHCO3

0, 31.1 mg/l HCO3
-1, and 145.1 mg/l CaCO3 (s).  

✓ Save the file  

Reconciliation #2 – Reconcile sample with a fixed pH and solids not allowed to form 

The goal of this next calculation step is to see how the chemistry changes when solids are prevented from 
forming. Such a scenario would exist if the solids are supersaturated by for example, addition of a scale 
inhibitor. We will assume the pH is correct but that the solids are supersaturated and metastable.  

 

✓ Click on Reconcile #2  

✓ From the menu bar, select Chemistry > Model Options  

 

✓ Select the Phases tab 

 

✓ Remove the check from the Solids box in the Include Phases field 

 

✓ Make sure that the Calculate Scaling Tendencies box is checked  

Before proceeding, it may help to organize the Navigator Pane. The following steps are optional.  

✓ Right-mouse click on the Reconcile #1 object and select Copy  

✓ Right-mouse click the 4.3 WaterAnalysis stream, then select Paste 

  

✓ Repeat this step two more times  

The 4.3 WaterAnalysis should now have four reconcile objects.  

✓ Rename each Reconcile #1, Reconcile #2, Reconcile #3, and Reconcile #4 
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✓ Press OK  

The steps above show the longer way to turn off solid formation. A quicker way is to deselect the Solid 

phases button in the toolbar.  

✓ Press the <F9> key or the Calculate button  

✓ Select the Report tab  

✓ Scroll down to the Scaling Tendencies table 

 

The software predicts five solids have saturation ratios greater than 1.0. This means that all five solid 
phases can potentially form at time equals 0:00. What actually forms will depend on nucleation rates, 
crystal growth rates, and thermodynamic equilibrium (i.e., minimum free energy conditions). When we 
turned solids off, we also turned these factors off so they are reflected in the scaling tendencies table. 
However, this table provides technologists who deal with solids buildup, such as, fouling, scaling, 
crystallization, etc., with an indication of the thermodynamic driving force for each phase to form.   

✓ Select the Reconciliation Tab and review the Summary  

 

In the previous calculation, the software added 58.7 mg/l of NaOH to set the pH to 7.8. In this calculation, 
the software added 2.6 mg/l of NaOH. The reason is calcite was not allowed to precipitate, and therefore 
CO3

-2 remained in solution. Since CO3
-2 is a weak base – it pairs with H+ ions to form HCO3

-1:  
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𝐶𝑂3
−2 + 𝐻+ = 𝐻𝐶𝑂3

−1  

This reduces the H+ concentration and increases pH. Therefore, less NaOH is needed to meet the 7.8 pH. 

Another effect of eliminating solids is the carbonate speciation.  

✓ Select the Report tab 

✓ Scroll down to the Species Output (True Species) table 

The table will maintain the customization of showing only species above 8.0 mg/l that we made earlier.  

 

The carbonate concentrations are 80 mg/l HCO3
-1, 51 mg/l MgHCO3

+1, and 26 mg/l NaHCO3
0. The 

concentrations increased by a factor of approximately 2.5 when comparing with the previous 
concentrations. 

Reconciliation #3 – Reconcile sample without fixed pH and solids not allowed 

Next, we will see what the pH would be if NaOH is not added  

✓ Select the Reconcile #3 object and click on the Reconciliation tab  

✓ Make sure solids are turned off or deselect the Solid phase box in the toolbar  

✓ Select No Reconcile  -  

✓ Calculate then review the pH in the Summary box 

The calculated pH is 7.63. Since this pH is close to the measured pH of 7.8, it prompts the question of 
whether the water sample’s pH was measured before any solids formed.  
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Reconciliation #4 – Reconcile sample without fixing pH and solids allowed to form 

The question to be asked in this final example is: what would the pH be if the solids were allowed to form?  

✓ Select Reconcile #4; and click on the Reconciliation Tab  

✓ Select No Reconcile  

 

✓ Select Chemistry > Model Options > Phases to turn Solids back on or select the Solid button in 
the Quick Access Ribbon  

 

✓ Press <F9> to calculate then Review the pH in the Summary box 

  

The pH is 7.35, lower than the measured value.  Adding the 58.6 mg/l NaOH (in Reconcile #1) will increase 
this pH to the reported value of 7.8. 

✓ Save the file 

 

Summary 

The preceding calculations are examples of how the measured properties, in this case pH, can vary based 
on reconciliation settings. For instance, if carbonates are predicted to form, then allowing or disallowing 
solid formation will affect the calculated results.  

By comparison, if the pH is forced to a measured value (7.8 in this example), then acid or base will be 
added. Adding such components changes the stream composition. The software added 58 mg/l NaOH in 
the first calculation, which increased the Na+ concentration by ~35 mg/l Na+. Although this concentration is 
small relative to the initial Na+ concentration of 10,000 mg/l, the additional species added or removed may 
not always be so insignificant.  
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4.4 Automatically Reconcile for Alkalinity 
Water analyses often involve alkalinity measurements. An alkalinity measurement determines the amount 

of acid a water sample can absorb before its pH drops below 4.5. The 4.5 value, widely regards as the buffer 
capacity, represents the endpoint between the reaction of bicarbonate and free acid at 25 °C. 

While the alkalinity measurement has a historical legacy, it is not applicable in every situation. This is 
because alkalinity is a measurement of all ions that will buffer a solution such as phosphate, borate, organic 
acids, etc. and not just carbonates and bicarbonates. However, alkalinity is still reported in bicarbonate 
units, as is the case within the OLI Studio. Therefore, we need to rethink our interpretation of this value.  

For this example, we will work with the previous water analysis. We will convert the 𝐻𝐶𝑂3
−1 concentration 

to an alkalinity. We will then see how this changes the speciation and scale tendencies of the system 

✓ Return to the 4.3 WaterAnalysis stream and select Add Reconciliation 

It may be helpful to rename the new reconciliation object to ‘Reconcile #5’ 

✓ Select the Reconcile pH/ Alkalinity button 

This reconciliation option opens a new grid section called Calculation Parameters  

✓ Change the Measured Alkalinity-Aqueous quantity from 0.0 to 145 mg/L 

 

✓ Calculate then review the Summary  

   

The results differ from previous calculations. To achieve a 7.8 pH and 145 mg/l alkalinity, the software 
removes 44 mg/l CO2 (1.0 mmol/l) and adds 17 mg/l HCl (0.475 mmol/l). Removing 44 mg/l CO2, reduced 
the dissolved carbonic acid concentration by 1 mmol/l. This reduces total dissolved carbonate AND 
increases the pH. To counteract the higher pH, the software adds 0.475 mmol/l H+ (as HCl). 

Summary 

The software has a pathway that allows us to use measured pH and alkalinity values in water analyses.  
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4.5 Manually Reconcile for pH & Alkalinity 
In the previous case, the software automatically reconciled for alkalinity by adjusting the carbonate inflow 

until the calculated alkalinity equaled the measured alkalinity. It also automatically adjusted the pH by 
adjusting NaOH/HCl.  

In this example, the pH is adjusted manually. You will adjust the  𝐻𝐶𝑂3
−1 concentration until the calculated 

value matches the measured value.  You will also adjust the H+ or the OH- concentration until the pH is 
matched properly.  This is an iterative process, and may take several steps.  The manual reconciliation 
enables more user control over the chemistry.  

✓ Return to the 4.3 WaterAnalysis stream and select Add a new Reconciliation 

✓ Name it Reconcile #6 

✓ Add H+ to the Cations grid 

✓ Add OH- to the Anions grid 

✓ Add CO2 to the Neutral grid 

✓ Check the Calculate Alkalinity box 

✓ Calculate then review the Summary box 

 

The pH is 7.35 and the alkalinity is 171.369 mg/l as HCO3
-1, the same as the previous calculation. You will 

change some or all of the following concentrations, CO2, HCO3-1, OH-1, and/or H+ until the pH is 7.8 and 
the alkalinity is 160 mg/l as HCO3

-1.  We will set it manually by adjusting the HCO3
-1 concentration and either 

the H+ or the OH-1 concentrations.  

The difference between the Calculated and Measured alkalinity is ~12 mg/l, and the difference between 
the measured and calculated pH is -0.45. Therefore, you will start by reducing the HCO3-1 by 25 mg/l and 
by adding about 15 mg/l OH.  

✓ Reduce the HCO3-1 value in the anion grid from 145 mg/l to 133 mg/l. 

✓ Increase the OH-1 from 0 to 15 mg/l 
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✓ Calculate  

✓ View the Summary section, specifically the calculated Alkalinity and pH 

 

The Alkalinity increased to 214 mg/l, and the pH to 7.63.  The OH-1 added had two effects.  It increased the 
pH, and it also increased alkalinity.  For every 17 mg/l OH- added, the alkalinity increases by 61 mg/l HCO3-
1.  The following simplified equation for alkalinity illustrates this effect. 

𝐴𝑙𝑘𝑎𝑙𝑖𝑛𝑖𝑡𝑦 = 𝐻𝐶𝑂3
−1 + 𝐶𝑂3

−2 + 𝑂𝐻− − 𝐻+ + 𝑜𝑡ℎ𝑒𝑟𝑠 … 

We really don’t know how much OH- or HCO3-1 to add or remove, so you will take another guess.  

✓ Keep the OH- concentration at 15 mg/l and reduce the HCO3-1 to 80 mg/l. 

✓ Calculate and review the Summary  

 

The pH increased to 8.1 and the alkalinity 163 mg/l is near the target value.  The next step should be a 
lower OH-1 concentration with a higher HCO3-1.  Since the mass ratio of OH-1 to HCO3-1 is 17 mg to 61 mg, 
every mg OH-1 removed requires 3.6 mg/l HCO3 be added to maintain alkalinity.  Before adding any more 
HCO3 however, we can drop the alkalinity to 160 by reducing OH-1 by 1 mg/l 

✓ Reduce the OH-1 concentration to 14 mg/l  

✓ Calculate  
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The pH is now 8.02 and the alkalinity is 159 mg/l as HCO3
-1. These numbers are closer to the target values. 

Perhaps a little less OH and more HCO3 will achieve the desired target.   

✓ Increase the HCO3-1 concentration to 88 mg/l and reduce the OH-1 to 12 

✓ Calculate 

 

The alkalinity is now at 160 mg/l as HCO3
-1, and the pH dropped slightly to 7.86.  At this point, the results 

are close to the target values, and probably close enough to continue on to the next task.   

✓ If you like, complete the manual adjustment to reduce the error further. 

Summary 

This case study presents a method to set the pH and alkalinity by manually adjusting inflow compositions.  
It is much more labor intensive than the automatic method, but it has the advantage of enabling the user to 
manipulate what they want and not relying on the automatic calculation. 
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Follow-up Example #1 – Arabian Gulf Seawater Analyses  

This example reinforces the concepts from the earlier sections. We will run this example using two 
different water analyses. The first one is seawater from the Middle East. The other is a groundwater with a 
unique composition. We will build the two samples and perform two reconciliations on each: a basic 
equilibrium, then a pH reconciliation. We want to keep track of the amount of additive required to achieve 
the set pH and also track the solid content in each reconciliation. 

Name Middle East Seawater 6,000 M Well 

Stream Amount (L) 1  1 

Temperature (C) 30  15  

Pressure (atm) 1 1 

Recorded Properties 

TDS(mg/L) 42,528  211,197 

pH 8.2 4.6 

Density(g/ml) 1.029  1.09 

Conductivity(mho/m) 5   

Neutrals 

H2O Calculated Calculated  

B(OH)3 31 43 

SiO2 2 300 

Cations (mg/L) 

Li+ 0.25  

Na+ 13,440 55,895 

K+ 485 9,730 

Ca+2 520 17,163 

Mg+2 1,765 473 

Sr+2 1 121 

Ba+2 0.08 630 

Fe+2 0.008 469 

Pb+2  3.6 

Zn+2  1.3 

Anions (mg/L) 

F- 1.5 3.1 

Cl- 24,050 126,700 

SO4-2 3,380 9.2 

HCO3-1 165 1.1 

CO3-2 88 --- 

   

Basic Equilibrium Reconciliation   

Amount of additives to set pH:    

Amount of total solid phase:   

pH Reconciliation   

Amount of additives to set pH:    

Amount of total solid phase:   
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4.6 Crude Oils 
Crudes oils are complex groups of organic molecules containing, perhaps, thousands of pure components. 

Modeling crude oils using pure components is impractical because analyzing for each pure component is 
cost prohibitive and the number of species would make calculations overwhelming. A convenient 
workaround is to create pseudocomponents. 

The properties of a crude oil are characterized by its distillation curve.  The complete boiling point range is 
a progression of molecular weights, densities, solubilities, viscosities, and other molecular properties. It is 
reasonable for low boiling point molecules to be low molecular weight, low density, low viscosity, and more 
soluble in water. This boiling point curves can be sliced into temperature ranges, and well-accepted 
characterization methods are used to create pseudocomponents.  These pseudocomponents when 
combined represent the aggregate properties of the whole oil.  Below is an example of a distillation curve 
that is segmented into 10 pseudocomponents.  
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4.7 Entering a PVT Analysis 
You will create a simple PVT analysis using the data from the table below. This is done by creating an Assay 

Editor within the inflow grid.   

4.6 Crude Oil Analysis Composition  

Stream Name Crude Oil Assay Data Type ASTM D86 

Unit Set Default Average Bulk Density Type API Gravity 

H2O 55 mol API Gravity 40 

Inflow name ASSAY Distillation Cuts 10 

Inflow amount (mol) 1000  Distillation Data  (see table below) 

  Thermo Method API-8 

✓ Add a new stream  and change the name to ‘Crude Oil’  

✓ Select the 2nd Liquid phase button in the toolbar  

 

✓ In the Inflows Grid, type ASSAY then press Shift + Enter  

The <Shift + Enter> action instructs the software to create an Assay rather than look for a species or pure 
component from the database. The sub-grid menu that opens is straightforward. 

✓ Use the table above to complete the initial grid  

 

✓ Click the Edit button in the Distillation Data  

This opens a new menu.   

 

✓ Enter the following data from the following table  
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ASSAY Distillation Data   

Percent Distilled  Temperature, C 

1 20 

5 30 

10 50 

20 60 

40 80 

60 120 

80 150 

90 180 

95 200 

99 220 

100 240 

Pressing the <Tab> or <Enter> key advances to the next empty cell.  

 

✓ Press OK when done 

✓ Add a Single Point calculation and keep the type as Isothermal  

  

✓ Press the <F9> key or the Calculate button 

We will review the results in the Output tab.  

✓ Click the Output tab at the bottom of the grid  

 

The Output grid shows 10 pseudocomponents, corresponding to each distillation cut of the crude.  
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The name of each cut is the combination of the oil name (ASSAY) plus its boiling point in Kelvin. The + sign 
adjacent to each Assay is a sub table containing the critical properties of each cut. 

✓ Expand the first pseudocomponent by clicking on the + button adjacent to ASSAY_243K 

 

The grid expands to show the pseudocomponent properties boiling point, density, and molecular weight.  
Also shown is the thermodynamic method used to create the properties. 

✓ Click on the Report tab and scroll down to Species Output 

 

The pseudocomponents are distributed between the aqueous and second liquid. The aqueous solubility 
decreases with each increasing boiling point. The computed range is over five orders of magnitude.  

We will now look at the vapor associated with the assay using the Vapor Fraction calculation. This single-
point calculation distributes the mass (in terms of moles) evenly across the vapor and liquid phases.  

✓ Return to the Crude Oil object 
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✓ Add a Single Point calculation and set the calculation to type to Vapor Fraction  

  

 

✓ Change the framework to MSE 

✓ Make the Vapor Fraction value 50 mol% 

 

✓ Calculate then view the Summary  

 

✓ Select the Report tab and scroll to the Total and Phase Flows (Amounts) table  

 

✓ Scroll down to the Species Output table  
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Follow-up Example # 2 

The OLI Studio computes the critical properties of pseudocomponents using one of the three models 
discussed above. To see this data, we will need to open a temporary file generated by the software using 
Notepad or a similar program. To determine the name of the file, we will have to enable the File Viewer 
plug-in and select Trace File from the drop-down menu. A more detailed procedure is provided in the 
appendix. For now, the instructor will walk through this process.  

Below is the formatted text that shows the critical generated properties of a pseudocomponent. This is a 
snapshot of a particular case so your data may not be the same. Our interest is to look at the available 
variables.  

 

Name: Assay_301K  

General Information Vapor Level Aqueous Level 

IDNO 9001 ACEN 1.652281E-01 HREF -1.187195E+05 

FORM C4H8 TCRI 4.943862E+02 GREF -1.754773E+05 

CHEM C4H8 PCRI 5.677158E+06 SREF 2.406714E+02 

MOLW 58.3910 VCRI 2.255796E-04 CPRE 1.485803E+01 

MATC 8800 BOIL 3.012723E+02 VREF 0.000000E+00 

STOI 1.0 CP -1.305125E+01 
3.066628E-01  
-3.051758E-03 -

1.318545E-04 
 -3.885781E-15 

HKF 0.0 0.0 0.0 0.0 -
3.412494E+02 
1.724216E+06 -
1.968107E+06 

  HREF -1.261644E+05 ZRAC 2.732220E-01 

  GREF -1.963413E+05   

  SREF 3.103500E+02   

  CPRE 6.665928E+01   

  EQUA PVTCu_294KVAP= 
PVTCu_294KAQ 

  

 

The General Information category describes the created pseudocomponent(s). In this case, it is a C4H8 
molecule with a 58 amu molecular weight. The MATC is a material code identified by the software and STOI 
is the stoichiometry of this material (1 moles of 8800 or 1 mole of C4H8). The thermodynamic properties 
for the vapor and aqueous species are as shown above. Critical temperature (TCRI) is 494K (221°C) and 
critical pressure (PCRI) is 5.67e6 Pa (~56 atm). See the end of the chapter for a more detailed explanation of 
each term in the generated critical properties file.  

Our task now is to regenerate these pseudocomponents using the Lee Kessler and the Cavett models.  

How do the results differ? 
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4.8 Entering Pseudocomponents to a Stream 
Many clients have their own PVT analysis models with pseudocomponent properties. Clients can enter this 

information using OLI Studio: Stream Analyzer’s pseudocomponent entry option, which is the focus of this 
section. We will enter three properties - boiling point, molecular weight, and density. The software will use 
one of four thermodynamic models – API-8, API-5, Cavett or Kessler-Lee – to calculate critical properties. 

4.7 Crude to Stills Composition  

Stream Name Crude to Stills Pseudocomponent  PC1 PC2 PC3 PC4 PC5 

Stream Amount (calculated) Inflow (mol) 100  200  250 250 180 

Temperature 15C Thermo Method API-8 API-8 API-8 API-8 API-8 

Pressure  1 atm Boiling Point (C) 33°C 60 100 140 190 

H2O 20 mol Specific Gravity 0.72 0.76 0.8 0.85 0.9 

✓ Add a new stream  and change the name to ‘Crude to Stills’  

✓ Select the 2nd Liquid phase  button in the toolbar  

 

✓ Change the Temperature to 15 C 

✓ Change the H2O inflows 20 moles 

✓ In the Inflows grid, enter the name ‘PC1’ in a blank cell then press <Ctrl+Enter> 

The CTRL-Enter action instructs the software to create a pseudocomponent rather than look for a species.  

✓ Repeat the previous step four more times with the following names PC2, PC3, PC4, and PC5 

✓ Use the table above to complete the details for each pseudocomponent  

The screen will look like the one below 
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✓ Add a Single Point calculation and keep the type as Isothermal  

  

✓ Calculate  

✓ Select the Report tab then scroll down to the Species Output table  

 

As with the PVT analysis, below are critical properties that were created for the pseudocomponents. Here 
is what the first pseudocomponents look like. Compare your results and see if they differ: 

 

General Information Vapor Level Aqueous Level 

IDNO 9001 ACEN 1.971444E-01 HREF -1.161440E+05 

FORM C5H4 TCRI 4.869634E+02 GREF 9.132121E+03 

CHEM C5H4 PCRI 4.693782E+06 SREF 2.396181E+02 

MOLW 70.3287 VCRI 2.710277E-04 CPRE 2.462721E+02 

MATC 8501 BOIL 3.061500E+02 VREF 0.000000E+00 

STOI 1.0 CP -1.018304E+02  
8.012371E-01  
2.297224E+06  
-7.714722E-04  
3.384218E-07 

HKF 0.0 0.0 0.0 0.0 
3.812119E+01 -
2.436481E+04 -
2.426621E+03 

  HREF -1.284117E+05 ZRAC 2.928183E-01 

  GREF -9.686262E+03   

  SREF 3.438813E+02   

  CPRE 1.033026E+02   

  EQUA PC1VAP=PC1AQ   
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Follow-up Example #3 

As a last follow-up, we will run a whole fluid calculation. We will assume that the case in question is a gas-
condensate-black oil fluid being produced from a newly developed field. The field produces 50,000 bbl/day 
oil and 3MM of gas. We have a whole fluid analysis that includes pure component data, a PVT curve and 
pseudocomponents. In addition, the new well produces 1000 bbl/day of brine. This is what the data looks 
like. This is an actual sample, so do not be surprised if it takes you a long time to work on this. 

 

Water Analysis Whole Fluid Analysis Flow Rates 

pH 4.7 Pure Component Mole % Pseudocomponents Water  100 bwpd 

Density 1.01 H2O … PC1 (mole%) 10.6 Oil/Gas 1000 bopd  
(1314 kgmol) Calc type pH only N2 0.32 NBP, C 270 

Neutrals ppm CO2 0.106 MW 212 

SiO2 12.7 H2S 0.001   

B(OH)3 38.3 C1 51.5 PC2 (mole%) 8.4 

Cations ppm C2 3.0 NBP, C 340 

Na+ 2700 C3 2.5 MW 282   

K+ 30 iC4 1.5   

Mg+2 169 nC4 1.5 PC3 (mole%) 5.1   

Ca+2 3200 iC5 1.10 NBP, C 400 

Sr+2 7.9 nC5 1.0 MW 350   

Ba+2 6.6 C6 1.0     

Mn+ 1.1 C7 1.1 PC4 (mole%) 3.1   

Zn+ 1.8 C8 1.1 NBP, C 450 

Fe+3 28 C9 0.8 MW 420 

Anions ppm C10 0.9   

Cl- 10150 Balance Mole% PC5 (mole%) 2.4 

HCO3-1 46 PC1 12.6 NBP, C 520 

SO4-2 13 PC2 8.4 MW 560 

  PC3 5.1   

  PC4 3.1   

  PC5 2.4   

 

 



 Mixers  

Introduction 

In this chapter, we will look at how Stream Analyzer mixes two or more streams. The object is called Mixer 
and you will familiarize yourselves with its three mixing options, Multiplier, Ratio, and Volume. It should be 
noted that in previous software versions, the Multiplier option was called Ratio and the Ratio option was 
labeled Proportion. If you are familiar with Versions 4 and earlier, you will note this difference.  

We will also mix two incompatible waters using the Water Analysis objects that were created in Chapter 4. 
Lastly, we will perform a titration experiment using the Mixer feature. As in previous chapters, these 
lessons are designed around real-world situations. 

The Mixer object or block can be accessed from the Menu Bar by selecting Calculations > Add Mixer or by 
selecting the Add Mixer in the Actions Pane as shown below:  

  

Large Icon View 

 

 

Small Icon / List View 

The Mixer should not be confused with the Studio ScaleChem object called Mixing Water:  

Calculation List 
5.1 Mixing Two Incompatible Waters .................................................................................................................2 

5.2 Simple Mixer Calculation ..............................................................................................................................8 

5.3 Neutralizing Two Streams .......................................................................................................................... 12 

5.4 Creating a Titration Curve .......................................................................................................................... 23 
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5.1 Mixing Two Incompatible Waters 

Overview 

This case was begun in Chapter 4, where two water analyses, High Ca/Ba and High HCO3/SO4 were 
created.  These waters will be mixed in this case.  The potential solid phases are Ca+2, Sr+2, and Ba+2 forms of 
SO4

-2 and CO3
-2.  The exact phase that forms depends on the mixing fraction of each water. 

Procedure 

✓ Open the file that contains the ‘High Calcium/Barium’ and the ‘High Bicarb/Sulfate’ analyses 

 

Each object should have a distinct label.  This will be important in the next step 

✓ Add a new Mixer from the Actions Pane or from the menu bar Calcualtions > Add Mixer 

  

✓ Rename the mixer ‘Incompatible Waters’ 

 

✓ Select the Definition tab of the new mixer 

There should be two streams in the Available field, Reconcile Ca/Ba and Reconcile HCO3/SO4.  These are 
the two Reconcile objects.  By comparison the Water Analysis objects are not present, because no charge 
balance or calculation was done at that level. 

✓ Highlight both streams and add them to the Selected section.  
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The grid should now look like the one below.  Two streams are in the mixer.  Each has an inflow of 1 L.  
Their inflow conditions are 25 C and 1 atm.  These flows and conditions cannot be edited because they are 
set in that reconcile object.   

The Current Mixer conditions (the value column) is 25 C and 1 atm.  These conditions can be adjusted. 

 

The top row is the multiplier.  This row is used to multiply up or down, the stream inflow.  The default 
values is 1, and so each stream enters the mixer at 1 L.  These multipliers can also be modified using the 
Mixing Method option in the upper right of the mixer 

✓ Select Ratio as the Mixing Method  

 

The Ratio option mixes between 0% and 100 % of one stream to the other.  The first calculation contain 0% 
of Stream A and 100% of Stream B. The last calculation contains 100% of Stream A and 0% of Stream B.  

The calculation button is red.  A stream needs to be selected as being adjusted relative to the other.  In 
fact, both streams are adjusted;  

✓ Click on the Specs… button 

✓ Highlight the ‘High Bicarb/Sulfate Reconcile’ stream  

 

✓ Click on the Survey Range tab 

The default setting is to start at 0 fraction of Reconcile HCO3/SO4 and end at a 1 fraction of this stream.  
The increments are 0.1. 

✓ Click on the Calculation Options Category 

✓ Check the Pre-scaling Tendency box if not already selected 

 

✓ Press OK to close the Specs Window 

The Multiplier cell for the Reconcile HCO3/SO4 is now yellow, it is no longer editable, since it will be 
adjusted automatically by the Ratio selection.  The Reconcile Ca/Ba multiplier is still adjustable, but this has 
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the net effect of changing the total amount of flow to the system, and not just this stream, since the mixing 
is still based on fraction. 

✓ Calculate 

✓ Select the Plot tab 

 

The plot will be blank, because there is no default variable set.  You will select variables next. 

✓ Select the Variables button  

✓ Remove any variables from the Y1 Axis  

✓ Expand the Pre-Scaling Tendencies category  

✓ Double-click Dominant Pre-Scaling Tendencies to add it to the Y1 Axis  

 

✓ Press OK and view the plot 

The resulting plot is a typical fluid incompatibility.  The two waters when mixed equally are predicted to 
reach maximum supersaturation with barite. Notice that other curves are present, but their shape cannot 
be seen because of the high barite value.  

 

✓ Select the Curves button  

✓ Double-click Dominant Pre-Scaling Tendencies to remove it from the Y1 Axis  

✓ Expand the Pre-Scaling Tendency category 

✓ Add CaCO3 (Calcite) and SrSO4 to the Y-Axis 
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✓ Press OK and view the plot 

These two phases display the characteristic bell-shapes, meaning that the two waters are also 
incompatible with respect to these phases. The mixing ratios where the solids reach maximum risk are 
different. 

 

✓ Select the Curves button  

✓ Select the Y1 Axis header then select the << button to remove all the variables  

✓ Expand the Solid category and double-click Dominant Solid to add it to the Y1 Axis  

 

✓ Press OK and view the plot  
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The maximum scale mass occurs at 3 different ratios, 5% for BaSO4, 50% for SrSO4, and 75% for CaCO3.  The 
units are in moles, which is useful when looking at absolute values. In this case, however, concentration 
units will be more useful. 

✓ Select the Units Manager button in the toolbar  

✓ Select the Customize button 

 

✓ Change the Solids Composition row from Moles to Concentration 

 

✓ Press OK twice to close the Units windows 

✓ Refresh the plot by clicking a different tab (for example click on the Definition tab) then click 
back on the Plot tab 
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The curves have similar shapes, but now the high formula weight of BaSO4 makes this curve more 
pronounced. The ratio where the barite amount is at maximum is at 5% of the High Bicarb/Sulfate stream. 
We can see this comparing the Ba+2 and SO4

-2 concentrations in their respective waters (view the table 
below). The amount of Ba+2 and SO4

-2 in the two waters are 0.00109 and 0.0208 moles/kg respectively. They 
therefore are equivalent in moles, when the High Calcium/Barium water is 19.1 times greater than the High 
Bicarb/Sulfate water. 

Barium and Sulfate concentrations  

 mg/l Molal Mole Ratio 

High Calcium/Barium 150 mg/l Ba+2 0.00109 1 

High Bicarb./Sulfate 2000 mg/l SO4
-2 0.0208 19.1 

Likewise, the calcium to carbonate molar ratio in the two waters is 3.2 moles Ca+2 to 1 mole CO3-2. 

Therefore, the maximum mas should occur at 
3.2

3.2+1
= 76% of the High Bicarb/Sulfate water. 

Calcium and Carbonate concentrations  

 mg/l Molal Mole Ratio 

High Calcium/Barium 2000 mg/l Ca+2 0.0499 3.20 

High Bicarb./Sulfate 950 mg/l CO3
-2 0.0156 1 

Lastly, the strontium to sulfate molar ratio is 1 to 6.12, which, of using the same logic would result in 

maximum SrSO4 mass forming at 
6.12

6.12+1
= 86% of the High Calcium/Barium water. However, it instead 

occurs at 50% mixture. A question to consider: why does this happen?  

Strontium and Sulfate concentrations  

 mg/l Molal Mole Ratio 

High Calcium/Barium 300 mg/l Sr+2 0.0034 1 

High Bicarb./Sulfate 200 mg/l SO4
-2 0.0208 6.12 

✓ Save the file  

Summary 

This case is an example of how we can test the incompatibility of two waters using the ratio mixing option. 
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5.2 Simple Mixer Calculation 

Overview 

This is a simple two-step calculation. First, we will create two new streams, 0.1 HF and 0.1 CaCl2. We will 
perform a single point calculation on each. Then, we will mix them in equal amounts. Our goal is to 
determine the new mixture’s pH.  

✓ Select File > New then select File > Save As … and enter ‘Chapter 5’ as the name 

1st Stream  2nd Stream 

Name 0.1 HF  Name 0.1 CaCl2 

Unit Set Default  Unit Set Default 

Names Style Formula  Names Set Formula 

Framework Aqueous  Framework Aqueous 

Temperature 30 C  Temperature 30 C 

Pressure 1 atm  Pressure 1 atm 

H2O calculated  H2O calculated 

HF 0.1 mol  CaCl2 0.1 mol 

✓ Add two new streams with the compositions from the table above 

  

✓ Add a single point, isothermal calculation on each stream  

  

✓ Calculate  

The Navigator contians the two streams and their single point calculations. We can now mix the streams.  

✓ Highlight the Global Streams icon in the Navigator  

 

✓ Add a new Mixer  

✓ Press the <F2> key to rename the mixer ‘HF CaCl2 Mixer’  

✓ Select the mixer’s Definition tab  
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✓ Highlight 0.1 HF and 0.1 CaCl2 in the Available Streams column 

✓ Click the double arrows >> to move them to to the Selected column 

 

✓ Select Single Point Mix as the Mixing Method 

✓ Select Isothermal as the Type of Calculation 

 

✓ Press the <F9> key or select the Calculate button  

✓ Select the Report tab then scroll down to the  

✓ In the Report tab, scroll down to the Stream Parameters section 

 

The pH is 1.44. Does this seem like unusual pH behavior? Mixing an acid and a base should result in a 
neutralized solution. In this case, the pH is lower than the starting streams. 

Mixer Changes 

✓ Select the Definition tab  
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✓ Change the Mixing Method from Single Point Mix to Multiplier 

 

✓ Click the Specs button  

✓ In the Category field, select Variable-Multiplier  

✓ Select 0.1 CaCl2 in the Selected Stream field  

 

✓ Select the Survey Range tab  

HF CaCl2 Mixer Survey Range 

Start 0 

End 10 

Increment 0.1 

✓ Change the survey range according to the table above 

 

✓ Press OK then Calculate  

✓ Select the Plot tab then select the Curves button  

✓ Press the Y1 Axis header then the << button to remove any variables  
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✓ Expand the Additional Stream Parameters category then double click pH Aqueous  

 

✓ Press OK to view the plot  

 

What does this plot indicate about the pH?  

✓ Save the file 
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5.3 Neutralizing Two Streams 
In this section, we will learn more about the Volume, Ratio, and Multiplier mixing methods. We will create 

two refinery wastewaters, a spent caustic, and a spent sulfuric acid. A third stream will contain air. We will 
mix the streams and study their speciation. 

✓ Create three new streams  

✓ Set to formula view or Name view, depending on ease of use 

✓ Set all streams to Aqueous Framework  

✓ Change the Units Manager based on the settings provided for each stream  

5.3 Spent Caustic 

 
 

Name Spent Caustic 

Units Metric Mass Frac 

Amount 1000 kg 

Temp 50 C 

Pressure 1 atm 

H2O (mass%) balance  

NaOH 0.9 

Methyl mercaptan 0.2 

NaCl 0.2 

H2S 0.5 

Phenol 0.2 

Naphthenic acid 0.15 

NH4Cl 0.07 

5.3 Spent Acid 

  

Name Spent Acid 

Units Metric, Mass Frac 

Amount 1500 kg 

Temp 42 C 

Pressure 1 atm 

H2O (mass%) balance 

H2SO4 1.5 

Na2SO4 0.5 

Na2S2O3 0.3 

Lauric acid 5.2 

5.3 Air* 

 

 

Name Air 

Units Metric Mole Frac 

Amount 3500 mol 

Temp 25 C 

Pressure 1 atm 

H2O (mole%) balance 

N2 76.85  

O2 20 % 

CO2 0.04 % 
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✓ Add a new Mixer and rename it ‘Waste Tank’  

✓ Add the Spent Caustic and Spent Acid to the Selected field 

✓ Select Multplier as the Mixing Method  

 

✓ Click the Specs button  

✓ Select Spent Acid as the adjustible stream 

 

✓ Select the Survey Range tab  

Multiplier survey range 

Start 0 

End 1 

Increment 0.01 

✓ Change the survey range according to the table above 

 

✓ Close the window and Calculate 

✓ Select the Plot tab then select the Curves button  

✓ Press the Y1 Axis header then the << button to remove any variables 

✓ Expand the Additional Stream Parameters category then double click pH Aqueous  
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✓ Press OK then view the plot 

 

The steep slope (inflection points) are at about 7.3 pH, 5.1 pH, and 2.9 pH. These pH values are the ends of 
the buffering regions created by the the the weak acids and bases in the two waters. The pH buffering 
regions are at the shallow sloped areas.  

There are a number of variables to review in a multicomponent mixing calculation like this, and several 
plots will be studied herein. Remember to clear any variables before proceeding. Click the top double arrow 
buttons to add or removes curves to or from the X Axis. Click the bottom double arrow buttons to add or 
remove curves to or from the Y2 Axis.  

✓ Change the Names manager so that it displays Formula View -  

You will want to toggle among names view as you study the various chemical systems, inorganics are 
generally easier to interpret in Formula view. 

H2S speciation during mixing 

✓ Select the Curves button  

✓ Change the plot variables to the following  

Category Curve Axis 

Aqueous  HS-1, H2S, S-2 Y1 Axis 

Vapor H2S Y1 Axis 
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 or   

✓ Press OK and view the plot  

As Spent Acid is added to Spent Caustic, the sulfide speciation shifts to molecular H2S.  At about 0.25 

Multiplier of the spent acid, an H2S bubble forms as the nearly all the sulfide present in the system is 

converted to H2S.  This H2S vapor is present until about 0.43 multiplier.   The shallow decline of the H2S 

vapor is the result of dilution as more liquid is added.  Eventually the overall H2S concentration reduces 

enough to where the vapor phase collapses under the 1 atm confining pressure. 

 

This can be confirmed by plotting the total dissolved sulfur using concentration units. 

✓ Open the Units Manager and select the Customize button.   

✓ Set the Aqueous composition to Concentraiton 

 

✓ Open the Variables window.  Expand the MBG Totals - Aqueous category 

✓ Add S-2 to the Y1 Axis 

✓ Remove the H2S Vap from the Y1 Axis 

 

✓ Close the window and view the plot 

The updated plot shows all the aqueous concentration  
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The amber triangles is the total dissolved sulfide.  Its value is 4755 mg/l in the ~1000 L spent caustic that is 
present in the mixer.  As the Spent acid is added, the total dissolved H2S decreases linearly.  At 0.25 
multiplier, which is about 400 L, there is a sharp concentration drop as H2S partitions to the vapor phase.  
Eventually sufficient liquid is added at 0.45 multiplier (~650 L) to where the H2S redissolves and continues 
to decrease in concentration as the total mixer volume increases.  Once all the spent acid is added, the final 
volume is about 2400 L, and so the total dissolved H2S decreases to about 1960 mg/l. 

It is also possible to study the results using pH as the x-axis, rather than the Spent Acid Multiplier.   

✓ Open the Variables window and change the x-axis to pH 

 

The HS-H2S curves cross at about 6.6 pH.  This is the maximum pH-buffering region for the 
reaction:𝐻𝑆−1 + 𝐻+ = 𝐻2𝑆 (𝑎𝑞).   
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The dissolved H2S-aq curve increases steadily from 9 to 6 pH, after which it levels abruptly.  This is because 
any additional H2S that is created as the pH decreases partitions to the vapor phase.   

Organic acid speciation during mixing 

✓ Select the Curves button and change the plot variables to the following  

Category Curve Axis 

Additional Stream Parameters  pH Aqueous  X Axis  

Aqueous  C12H23O2-1,  C12H24O2  Y1 Axis 

 

✓ Press OK and view the plot 

 

Lauric acid (C12H2402 (aq)) – also known by its more formal name dodecanoic acid – comes in with the 
Spent Acid. As pH decreases, the concentration increases. Note that the crossover occurs at 4.6 pH.  

Phenol speciation during mixing 

✓ Select the Curves button and change plot variables to the following then press OK 

Category Curve Axis 

Additional Stream Parameters  pH Aqueous  X Axis  

Aqueous  C6H5O-1,  C6H5OH Y1 Axis 
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The phenol-phenolate crossover occurs at a high pH of 9.39. Thus, as the spent acid mixes with the spent 
caustic, this reaction will create the buffering at high pH. 

Methyl mercaptan speciation during mixing 

✓ Select the Curves button and change plot variables to the following then press OK 

Category Curve Axis 

Additional Stream Parameters  pH Aqueous  X Axis  

Aqueous  CH3S-1,  CH4S Y1 Axis 

Vapor  CH4S Y1 Axis 
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The Mercaptan reaction 𝐶𝐻3𝑆−1 + 𝐻+ = 𝐶𝐻3𝑆𝐻 (𝑎𝑞) also occurs at a high pH of 10. This will be the first 
H+ adsorption reaction that occurs when the spent acid mixes. These curves cross at different pH levels. The 
crossing points are called equivalence points and are where buffering is the greatest. 

Next Step – H2S Safety 

The next step in this case is to review the H2S aqueous-vapor partitioning. The existence of an H2S vapor 
below 6 pH is a safety hazard. Therefore, the properties of the mixture will be investigated further.  The 
first calculation will be to determine the vapor pressure of the mixture.  The confining pressure is 1 atm, the 
default value.  Now however, the software will compute what the confining pressure needs to be so that no 
vapor forms 

Pressurized system 

The first calculation is consisten with what is already computed, except in this next step the vapor pressure 
of the mix will be computed.   

✓ Select the Definitions tab 

✓ Change the Type of Calculation to Bubble Point  

✓ Change the Calculate cell from Temperture to Pressure  

 

✓ Calculate  

✓ Plot the Total pressure (Stream Parameters category) on the Y1 axis against either the pH, 
which is the default, or gains the Waste Acid multiplier (Survey Variables) 

The resulting plots show that the maximum confining pressure is about 1.1 atm.  At 5.5 pH or at about 0.28 
multiplier (~400 l) the H2S vapor pressure reaches a maximum.   Thus, according to this calculation, the 
mixing tank will need to be closed with at least a 1.2 atm positive pressure to eliminate degassing. 
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Or 

 

Case 2 – Atmospheric system 

The purpose of this example is to estimate the amount of H2S in the nearby air if the tank is open to the 
atmosphere.  The Air stream amount is 3500 moles.  This occupies a volume of 85.6 m3. This is an arbitrary 
value, and represents the airspace 5 m high above a tank with a radius of 2.3 m. 

✓ Return to the Definitions tab 

✓ Start by editing the units – Change the Vapor Composition from moles to mole fraction 

 

✓ Next, change the Mole fraction units from mole % to ppm (mole) 

 

✓ Add Air to add it to the Selected column 
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✓ Change the Type of Calculation back to Isothermal  

 

✓ Calculate 

✓ Select the Plot tab and change the plot varialbes  

o Change the x-axis to Multiplier – Spent Acid (Survey Variables category) 

o Change the y1 axis to H2S – vapor  

 

✓ Press Ok and view the plot 

 

Air, or a headspace, is now present in all mixing points, and not only when H2S form the headspace.  As a 

result, H2S is in the air and the fraction increases as the Spent acid amount increases.  it reaches a 

maximum value of ~38000 ppmV at the 0.25 multiplier and remains relatively constant thereafter.  Thus 

virtually any mixture of these two waste stream when open to the atmosphere will present an H2S safety 

hazard. 
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Summary 

The mixing results are secondary to the objective of comparing the different mixing scenarios. The list 
below summarizes the mix types.  

Multiplier Survey – This survey calculation adjusts the inflow mass of the selected stream only. Its mass is 
multiplied by the multiplier value.  

𝑆𝑡𝑟𝑒𝑎𝑚 𝑀𝑎𝑠𝑠 ∗  𝑀𝑢𝑙𝑡𝑖𝑝𝑙𝑖𝑒𝑟 =  𝑇𝑜𝑡𝑎𝑙 𝐼𝑛𝑓𝑙𝑜𝑤 𝑀𝑎𝑠𝑠 

The second (third, fourth, etc.) stream inflows are kept constant. 

Volume Survey – This survey calculation adjusts the inflow volume while keeping the other stream 
volumes constant. 

Ratio Survey – The Ratio survey calculation adjusts both inflow streams using the following rule 

𝑆𝑒𝑙𝑒𝑐𝑡𝑒𝑑 𝑆𝑡𝑟𝑒𝑎𝑚 𝑀𝑎𝑠𝑠 ∗  𝑅𝑎𝑡𝑖𝑜 =  𝐼𝑛𝑓𝑙𝑜𝑤 𝑀𝑎𝑠𝑠 

𝑆𝑢𝑚 𝑜𝑓 𝑂𝑡ℎ𝑒𝑟 𝑆𝑡𝑟𝑒𝑎𝑚 𝑀𝑎𝑠𝑠𝑒𝑠 ∗  (1 − 𝑅𝑎𝑡𝑖𝑜)  =  𝑂𝑡ℎ𝑒𝑟 𝑀𝑎𝑠𝑠 

 

In this survey calculation, the overall inflow mass is kept constant. 
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5.4 Creating a Titration Curve 

Overview 

A titration curve shows the mixing of two reagents, typically an acid and base. The software can mix two or 
more reagent streams and model typical acid-base or other potentiometric titrations. In this example, we 
will titrate seawater down to 4.5 pH to compute its alkalinity.   

Getting started 

Adding the seawater analysis 

There are several Seawater objects installed with the software.  They are found in the Object library with 
several other standard streams.  So, instead of starting from a laboratory analysis, you will add the 
Seawater object from the library to the Navigator pane.   

✓ Open the Object Library if it is not opened at the right of the screen–  

o Click on View-Toolbars-Object Library (from the menu) 

 

✓ Drag the Standard Seawater Analysis object to the Navigator Panel 

 

Seawater is at the bottom of the Object Library.  When you drag it to the Navigator panel, drag to the top-
most Streams or to below the last object in the panel.  

✓ Add a Reconciliation object and name it Reconciled Seawater 

 

✓ Calculate 



5-24 Chapter 5 Mixers Tricks of the Trade 

Adding the 1N H2SO4 reagent 

✓ Add a new stream and give it a name, 1 N H2SO4 (1ml) -  

✓ Change the units to Metric-Batch-Molar Conc 

 

✓ Change the Stream amount to 0.001 L (1ml) 

✓ Add H2SO4 to the grid and enter a value of 0.5 mol/l 

 

Adding the titration apparatus 

✓ Add a new Mixer and rename it ‘Titration Apparatus’  

✓ Add the Reconciled Seawater and 1N H2SO4 to the Selected section 

 

✓ Select Multiplier as the Mixing Method  

✓ Open the Specs button and 1N H2SO4 as the Adjusted stream 

 

✓ Set the Survey:  Start at 0, end at 10 (ml) with increments of 0.1 (ml).  

 

✓ Calculate 

✓ Cick on the Plot tab and plot the pH in the Y1 axis 
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The resulting pH titration curve is the standard approach for measuring total alkalinity.  The alkalinity 
endpoint is 4.5 pH, and the corresponding H2SO4 multiplier is 2.8, or 2.8 ml.   

 

The conversion from ml H2SO4 to mg/l Alkalinity as HCO3 is straight forward: 

𝐴𝑙𝑘𝑎𝑙𝑖𝑛𝑖𝑡𝑦 𝑎𝑠 𝐻𝐶𝑂3
−1  (

𝑚𝑔

𝑙
) =

𝑣𝑜𝑙 𝐻2𝑆𝑂4 (𝑚𝑙) ∗ 𝑁 𝐻2𝑆𝑂4 (
𝑒𝑞
𝑙

)

𝑣𝑜𝑙 𝑆𝑎𝑚𝑝𝑙𝑒 (𝑚𝑙)
⁄ ∗ 61000 (

𝑚𝑔

𝑒𝑞
)   

𝐴𝑙𝑘𝑎𝑙𝑖𝑛𝑖𝑡𝑦 𝑎𝑠 𝐻𝐶𝑂3
−1  (

𝑚𝑔

𝑙
) =

2.8 (𝑚𝑙) ∗ 1 (
𝑒𝑞
𝑙

)

1000 (𝑚𝑙)
⁄ ∗ 61000 (

𝑚𝑔

𝑒𝑞
) = 170.8

𝑚𝑔

𝑙
𝑎𝑠 𝐻𝐶𝑂3

−1   



Chapter 6a Interpreting Stability 
(Pourbaix) Diagrams 

Overview 
Stability diagrams are graphic tools that contain two independent variables, Electrochemical Potential 

(EH), and pH. The dependent variable is the area range of the major solid phases that are stable over the EH 
and pH region. They are represented by the shaded region within the plot area. Stability diagrams were 
described in the mid-20th century by Marcel Pourbaix for conditions at 25°C and zero molal salinity. 
Technology has enabled the expansion of his seminal work into higher temperatures and salinities. The plot 
below is a stability diagram of elemental Fe at 25°C and zero molal salinity (or ionic strength).  

 

Figure 1 - Fe stability diagram at 25°C and 0 molal salinity 

Real-Solution Stability Diagrams  

The diagrams generated by OLI software are real-solution diagrams, in contrast to the diagrams that 
appear in the text “Atlas of Electrochemical Equilibria in Aqueous Solutions” (Pourbaix 1966)1. The primary 
difference is that diagrams developed by Pourbaix assume a species activity of 1, whereas OLI’s real-
solution diagrams factor in activity coefficients. Furthermore, the OLI diagrams can be generated to the 
temperatures and pressures supported by the OLI thermodynamic engine. The OLI diagram also considers 
the four-phase equilibrium. These improvements create a more predictive diagram.  

                                                           
1 Pourbaix, M.1966. Atlas of electrochemical equilibria in aqueous solutions. Houston, Tex.: National Association of 

Corrosion Engineers 
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Diagram Construction 
Pourbaix diagrams are composed of the following sections: 

• X-axis, with a range of 0 to 14 pH.  

 

Figure 2 - The x-axis of the stability diagram is pH. pH is modified by adding an acid (HCl) or base (NaOH) to the fluid 

• Y-axis, with a range of -2 to 2 Volts. The voltage references the Standard Hydrogen Electrode and its 
value is 0 volts (axis shown below is tilted 90o).  

 

Figure 3 - The y-axis of the stability diagram is the Electrochemical Potential (E, SHE). The SHE term refers to the Standard 
Hydrogen electrode. E is adjusted using a potentiometer. 

• A calculated bulk solution pH shown as a vertical red line (shown below tilted 90o).  

 

Figure 4 - The initial or natural pH line of the water sample. This is the water’s computed pH before it is adjusted using with acid 
or base (x-axis above) to create the diagram. 

• A calculated bulk solution electrochemical potential (red circle).  

 

Figure 5 – The circle represents the initial electrochemical potential of the water phase. This is the value before being adjusted 
using the potentiometer (y-axis above). 

• A gray shaded area that represents the base metal stability region. Elemental iron, Feo is the base metal 
in the above plot. It is stable when the electrochemical potential is below -0.66V, and when the pH is 
between 0 to 14.  

 

Figure 6 - The gray shaded area of the plot is the pH and E region in which the base metal (e.g., carbon steel) is stable, i.e., it will 
not corrode. 

• A Green-shaded area that represents any solid phase produced by oxidation of the metal. In the above 
plot, the shaded areas are solid phases of Fe+2 and Fe+3, which are the oxidation products of Fe0. The 
phases include Fe2O3 (Hematite) which is stable at high EH conditions and moderate to high pH and Fe3O4 
(magnetite), which is stable between 9 and 14 pH and moderate EH. 
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Figure 7 - The green-shaded area of the plot is the pH and E region in which a solid-phase corrosion product forms. In some cases, 
these corrosion products protect the metal from further corrosion, or its presence reduces the corrosion rate. 

• A negative-sloped line, labeled “a.” 

 

Figure 8 - The water reduction line. Below this line, water reacts to form H2 (gas) and OH- ions. Water is unstable below this line. 

This line represents the water reduction reaction:2𝐻2𝑂 + 2𝑒− = 𝐻2  +  2𝑂𝐻− . If EH/pH conditions are 

below this line, then water decomposes to form 𝐻2 gas and the pH is increasing. If the reducing agent is 

an external source (i.e., an electrical current) and not a chemical species, then the EH remains constant 

and the solution pH migrates rightwards. If the reducing source is a metal or other consumable, then 

the pH migrates right and the EH slowly migrates upwards until all the material is consumed. At this 

point the EH/pH point should be along or slightly below the “a” line, depending on the soluble H2 

concentration. The actual location depends on the final pH.  

• A negative sloped-line, labeled “b.” 

 

Figure 9 - The water oxidation line. Above this line, water reacts to form O2 (gas) and H+ ions. Water is unstable above this line. 

This line represents the water oxidation reaction: 2𝐻2𝑂 = 𝑂2  +  2𝐻+ + 2𝑒− If EH/pH conditions are 

above this line, then water decomposes to 𝑂2, and the pH is decreasing simultaneously.  

If an oxidant like NaClO4 is added to the liquid the reaction products are O2, NaCl, and H+. The new 

equilibrium point will have a higher EH and a lower pH.  

• The white areas represent EH-pH conditions where no solid phase is stable. These are areas where the 
material will dissolve and form no solid-phase corrosion product.  

 

Figure 10 - The white region of the stability diagram is the pH and E region in which no potentially protective solid phase can 
form The iron that corrodes does not precipitate. 

If kinetics are not limiting, then we can infer that the white region of the plot is where Fe will corrode 

and not be protected by any solid-phase film.  
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Boundary lines 
Vertical lines are the changes in acid base chemistry that are independent of EH  

• Dashed vertical lines represent transitions between dominant dissolved (e.g., Fe(OH)2
+ to Fe(OH)3

0, not 
show in above plot).  

 

Figure 11 - the dashed, vertical dotted lines are the transition lines for the dissolved ions. 

• Solid vertical line represent solid-phase boundary within the same oxidation state (e.g., Fe+3 to 
Fe(OH)3 at 2.5pH). 

 

Figure 12 - The solid, vertical lines are the solid-liquid boundaries for metals (e.g., iron) with the same oxidation state. Solid 
Fe2O3 forms if the pH is above this line.  

• Horizontal lines are the changes in oxidation state that are independent of pH.  

- Dashed horizontal lines are oxidation state boundaries of dissolved species (e.g., Fe+2 to Fe+3 
between 0 and 2 pH). 

 

Figure 13 - Dashed, horizontal lines are the boundaries between oxidation states of the metal. Fe+2 is converted by oxidation to 
Fe+3 as the water’s E moves above the line. 

- Solid horizontal lines are oxidation state boundaries of solid phases (e.g. Fe0 to Fe2+ at -0.66V 
when below pH 6) 

 

Figure 14 - Solid lines separating gray areas is the boundary between a stable metal and a corroding metal. below this line, the 
meral is stable. Above this line, the metal is at risk of corroding. 

• Sloped lines are changes in both oxidation state and acid base chemistry 

- Sloped, dashed lines are oxidation/pH boundaries between dissolved species of different oxidation 
states (e.g., Fe+3 to FeO4

-2 between 0 and 2 pH or Fe+2 to Fe(OH)3
0 above 5 pH). Multiple lines are 

shown below. 
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Figure 15 - Sloped, dashed lines are similar to the vertical dashed lines in that they represent transitions from one species or 
oxidation states to the ext, but in these cases, the transition varies with pH AND with E. 

- Sloped solid lines are solid-phase boundaries that are pH and EH dependent (e.g., Fe+2 to Fe2O3 
between 2 and 6 pH).  

 

Figure 16 - Sloped lines between the green shaded areas and the white area are the solubility boundaries. The difference in this 
case is that the solubility is a function of both pH AND E. 

In the more general case, the lines slope, since both E and [H+] or [OH−] affect the Redox process.  

Titrants  
The x-axis value is varied using a strong acid, HCl and a strong base, NaOH. They are used because sodium 

and chloride ions do not form strong complexes with many dissolved species nor do they precipitate at low 
concentrations.  

Passive films  
Passivity results when certain metals and alloys form very thin, oxidized, protective films on their surfaces 

in corrosive solutions. Most commercially available corrosion resistant alloys depend on passive films for 
their resistance. For instance, Fe3O4 is a passivating film that forms on iron surfaces in oxidizing aqueous 
environments. This film dramatically reduces the corrosion rate by acting as an transport barrier. It acts as 
an electric insulator, slowing the rate of electrons transfer from the metal to the water. It also blocks 
reaction sites on the surface preventing further corrosion. Jones (1996) observed that the corrosion rate is 
reduced substantially by the forming films even when there is no visible evidence of the film.  

Limitations 
Some limitations of stability diagrams include:  

• These diagrams provide no information on corrosion kinetics  

• The diagrams are for a specific temperature and pressure.  

• In areas where a stability diagram shows oxides to be thermodynamically stable, these oxides are not 
necessarily of a protective (passivating) nature.  

• Dealloying cannot be predicted from the diagram alone. 

• Everywhere on the plot, the activity of the Fe+2 and Fe+3 species are fixed at 10-6. In concentration units, 
this is ~56 ppb of the free Fe+2 and Fe+3 ion. It also means that Total Fe concentration is not constant, 
since in some EH/pH conditions, Fe+2 may represent a very small fraction of the total Fe in solution.  
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Water Stability 
The base layer of a Pourbaix diagram is the water stability lines. Water-stability lines are found on all 

diagrams computed by the OLI software. On top of this layer are the metal stability regions described in the 
previous section. 

 

Figure 17 - First layer of the Pourbaix diagram. 

As described above, the b-line in the diagram is the water stability boundary under high oxidizing 
conditions. Above this line, H2O decomposes into O2 gas and H+ ions. This does not happen in natural 
waters, because strong oxidants are required (i.e., bleaches or some other laboratory created chemical). 
Thus, anything above the b-line can generally be ignored when reviewing these plots.  
Also described above is the a-line, the water-stability boundary under reducing conditions. Below this line, 

water decomposes into H2 gas and OH- ions. This reaction is common in natural waters, and is the key 
reaction in the corrosion process. A strong reducing agent is required to make this reaction occur. In 
production operations, the reducing agent is metallic Fe, Cr, and Ni in steels. Therefore, the area around the 
a-line (both above and below) is important to production chemistry.  

Stability of Naturally Occurring Waters 
Naturally occurring waters tend to lie within a pH range of four to nine. Well-aerated natural waters near 

the surface contain enough dissolved oxygen to get close to the reduction of water to O2. Eutrophic lake 
water contains sufficient dissolved organic matter to approach closely the Hydrogen reduction line. Ocean 
waters are relatively basic and may be oxidizing if saturated in O2 or reducing if saturated in organic matter 
(i.e. in stagnant lagoons, etc.). Fresh waters are considerably more acidic (because of dissolved carbon 
dioxide), but they can be oxidizing if saturated in oxygen, or reducing if too much organic matter is present. 
This acidity is greatly enhanced in bogs and organic laden soils due to high humic acid content. (Humic acids 
are complex organic acids occurring in the soil and in bituminous substances formed by the decomposition 
of dead vegetable matter). The following figure shows the oxidation/reduction ability of several waters.  
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Figure 18 - Oxidation/Reduction potentials and pH ranges of several natural waters (Morgan, 1993) 

Stability Diagrams 
The diagram below represents the thermodynamic condition that exists when the Block 0/14 combined 

gas is in contact with carbon steel at 4C and 200 bar. It also represents conditions where a condensed water 
is present, and the CO2 and H2S gas concentrations are 2.5 mol% and 5500ppmV, respectively. 

 

Figure 19 - A complete Pourbaix Diagram. The Diagram works like a map, in which pH and E are the coordinate. The map then 
shows were the metal or solid corrosion products are stable. The circle displays where the pH and E coordinates for the water 

being tested. 

The above diagram works like a map, containing three layers.  
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Water Stability lines 

The water stability lines described in the previous section can be considered as the first layer of a diagram. 
It shows the region within the plot where water is stable. Since water is the conducting material that 
enables the corrosion process to exist, the region between the a- and b-line is the target area.  

pH and EH of the Existing Water 

The next layer is the vertical line and circle which represent pH and oxidation/reduction potential of the 
bulk water.  

 

Figure 20 - The Pourbaix Diagram showing the natural pH and E of the water only. 

In the above plot, the dotted red line and circle intersect at ~3.9 pH and ~0.6 V (SHE) 

Iron (Steel) Stability 

The last layer is the stability regions of the solid phases. Carbon steel is used in the figure below. The gray 
area represents the region where the carbon steel is stable. Note that the gray region never intersects the 
a-line (water reduction line). This is because carbon steel and water cannot co-exist at equilibrium. Either 
100% of the carbon steel corrodes or 10% of the H2O reduces to H2 gas. The green area represents the 
region where the iron corrosion products are stable. When carbon steel corrodes in H2S-containing water, 
FeS film forms as long as the pH near the surface is between 5 and 8. The white areas are regions where no 
solid is present. 
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Figure 21 - The Pourbaix diagram in which the solid phases are shown. 

The default concentration of the dissolved iron in solution is ~56 ppb, or essentially, a low concentration 
that represents the initial condensed water phase. This is representative of the above plot.  

Combining Each Overlay to Interpret Pipeline Results 

The stability plot below is the Block 0/14 combined gas on carbon steel pipe at 4C and 200 bar. The gas 
contains 2.5% CO2 and 5500 ppm H2S. The condensed water that forms on the steel contains no salts or 
dissolved iron. It contains dissolved gases only.  

 

Figure 22 - The Pourbaix diagram in which the natural pH/E of the water, the stable solid phases, and the important dissolved 
species are shown. 

The red circle sits on the solid phase FeO(OH). It is a corrosion product, a form of rust. Thus, the condensed 
water as it sits on the bare metal will corrode it and form this phase.  
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Continuing Contact Between Condensed Water and Pipe 

As corrosion proceeds, there is buildup of the reaction products: H2, OH- (actually loss of H+), and Fe+2. The 
H2 buildup has the effect of lowering the circle towards the a-line and shifting the natural pH to the right 
(higher pH). Furthermore, the Fe+2 concentration increase in the near surface water making corrosion 
oxides and scales likelier.  
The next plot is a snapshot of the water-metal contact sometime later in the corrosion process as the 

concentration of corrosion products at the liquid-solid boundary increase: H2 is 1ppB, Fe+2 concentration is 
6ppm, and 1ppm H+ ion is consumed.  

 

Figure 23 - A Pourbaix diagram of a water in which dissolved Fe+2 has increased through corrosaion. the increasing Fe+2 
concentration increases the saturation of FeS (solid). Thus the pH/E region where FeS solids can form is larger than the plot 

above. 

The resulting plot shows that the green phase boundaries increased because Fe+2 concentration increased. 
In addition, the higher H2 concentration reduced the E-value to ~-1V, or just above the a-line. Lastly, the 
consumption of H+ increased the pH to ~4.2. The combination of all three reactions produces a system in 
which the steel surface can now be protected by an FeS film. 



Chapter 6b Applications of 
Stability Diagrams  

Introduction 

In this chapter, we will practice using the OLI Studio: Corrosion Analyzer objects on practical examples.  

Sections 
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6.2 Temperature effects on Iron Stability ..........................................................................................................8 

6.3 Composition effects on iron stability ......................................................................................................... 13 
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6.5 Iron Stability in Multiple Solvents .............................................................................................................. 23 
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6.1 Alchemy: Creating Precious Metals from Electrons 
We will first see how to use OLI Studio: Corrosion Analyzer to create a gold stability diagram.  

✓ Start a new file then give it a unique name  

✓ Add a new stream and rename it ‘Noble Metals  

Gold Stability Diagram 

✓ Add a Stability Diagram from the Action panel or the  

  

✓ Name the object ‘Gold’  

✓ Type Au in the new grid section labeled Contact Surface  

 

Make sure to enter Au or Gold to the contact surface grid (the software will automatically add it to the 
neutrals grid). The calculation will not proceed until a contact surface is selected. 

 

✓ Calculate (press the <F9> key)  

✓ Select the Stability Diagram tab 

The plot contains all gray shading with some white areas at high EH.  The gray shading is the gold stability 
region.  It is here where gold is stable (it does no corrode or dissolve).  The white region is where elemental 
gold is unstable and is present as Au(+3).   
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According to the plot, elemental gold is stable between 0 and 14 pH and up to between 0.7 and 1.2 V 
(SHE).  Underneath the gold stability fields are the water stability lines.  Water is represented by two sloped 
lines, labeled a and b.  the b-line is the water oxidation line. The upper boundary of Au is above the b-line at 
all pH’s except 1 and below.  This means that water will oxidize to O2 before Au oxidizes to Au+3 unless the 
pH is less than 1.   In this pH region, water is stable where gold decomposes.   

This is why gold does not dissolve or corrode. Its stability makes it, among other metals (which we will see 
later) popular in electronic and medical applications.  

✓ Select the Customize button to the top right of the diagram  

✓ Select the Show ORP box 

 

✓ Press OK 
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If gold does not corrode in water, then a suitable chemical approach is required to dissolve gold so that it 
can be processed.  The approach is to add cyanide to water.  Cyanide destabilizes gold to form a soluble 
Au(CN)2- complex in water.   

✓ Select the Definition tab 

✓ Add HCN to the Neutrals grid and enter a value of 0.1 mol 

 

✓ Press <F9> to calculate  

✓ Click the Stability Diagram  
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The diagram shows that the 0.1 m CN-1 cause elemental gold to become unstable, and the Au(CN)2-1 
complex dominates the system over all pH’s and at low and high electrochemical potentials.  Now, Au(CN)2 
is stable over all regions where water is stable, meaning that gold can now be processed in water at a 
variety of conditions. 

Platinum Stability Diagram 

✓ Select the Noble Metals stream  

✓ Add a Stability Diagram and name it ‘Platinum’  

✓ Add Pt to the Contact Surface grid 

 

✓ Calculate or press the <F9> key  

✓ Select the Stability Diagram tab 

 

Platinum is also stable at wide pH ranges, and at moderate oxidizing conditions. Only under strong 
oxidizing and acidic (HCl) conditions, does platinum corrode forming a dissolved PtClx, and Pt(OH)2 
complexes.  

Zirconium Stability Diagram 

✓ Add a new stream and rename it ‘Reactive Metals’  

✓ Add a Stability Diagram and rename it ‘Zirconium’  

✓ Type Zr or Zirconium in the Contact Surface  

✓ Calculate then click the Stability Diagram tab 
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Zirconium metal is highly reactive and unstable under natural conditions. It reacts with water to form 
zircon, ZrO2 and H2.  

The stability diagram calculates both the dominant solid phase and aqueous species. The dotted lines 
represent the stability boundaries for each dominant aqueous species. At high pH, >6.2, Zr(OH)5 is the 
dominant aqueous phase. Between 4.5 and 6.2, Zr(OH)4

o dominates. Between 3.3 and 4.5, Zr(OH)3
+ 

dominates, etc. To see this better, we will create a pH survey plot and view the speciation for a fixed 
Zr(OH)4 concentration. The aqueous lines are useful, but sometimes confuse the plot with too much 
information. They can be removed.  

✓ Select the Customize button  

✓ In the Plot Options menu, select the button next to No Aqueous Lines 

 

The Appendix explains other plot options for the stability diagram.  

✓ Press OK and view the diagram 
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✓ Save the file 

Follow-up Examples 

Create three new stability diagram calculations within the current Reactive Metals stream. Compute the 
stability diagrams for the following metals: Aluminum, Sodium, and Titanium  
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6.2 Temperature effects on Iron Stability 
In this section, you will create Stability Diagrams of iron at different temperatures. The goal is to view the 

temperature effects on iron stability. These results will give us an idea of how boilers, heat exchangers, and 
other surfaces behave.  

Fe diagram vs temperature and phosphate 

Add a new stream and rename it ‘Fe Diagram’  

✓ Add a Stability Diagram calculation  

 

✓ Type Fe or iron into the Inflows grid 

✓ Calculate and view the Stability Diagram (tab) 

The diagram is an overlay of Fe phase stability on H2O stability (this is described in detail in Chapter 6a). 
Elemental iron (gray section) is stable from -2  to -0.67 V (SHE). It is in fact also stable at much more 
negative voltages, but this is where the calculation started. At a potential greater than -0.67 V, Fe0 oxidizes 
to Fe+2. If the pH is above 10, the boundary is at a lower potential for example, -0.93V at 14 pH.  

 

The software computes that Fe3O4 (magnetite) is stable between a pH of ~8.3 and 14. This is a well-known 
Passive Film that protects the iron surface from active corrosion. At higher potentials, the software 
computes Fe2O3 (hematite). Hematite is the dehydrated form of Fe(OH)3 and FeOOH, two forms of rust. 
These phases provide less corrosion protection the iron surface than the magnetite. 

Also shown on the diagram in lighter letters and dashed lines, are the dominant iron-containing, dissolved 
species in the electrolyte solution (in this case water). The species with the largest range is Fe+2 (this is the 
white section of the plot on the left side). The software computes stability for this species from -0.67 V to 
0.75V, at low pH, and vanishes at about 10 pH.  Fe+2 is the iron corrosion product. Within the white region 
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where Fe+2 dominates, no protective films are computed to form. Thus, active corrosion of the iron surface 
is predicted if the pH is between 0 and 8. The actual corrosion rate cannot be predicted from this plot, nor 
can the pH of the water film (diffusion layer) in contact with the iron surface. Therefore, the pH range of 0 
to 8 is a guideline and not a direct prediction.  

✓ Return to the Definition tab 

✓ Add Na2HPO4 to the inflow list and add 0.001 moles (95 mg/l total phosphate) 

✓ Calculate and view the stability diagram 

Adding the alkaline buffer, Na2HPO4, influences the diagram in several ways. First, it raises the solution pH 
from 7 to 9. The raised pH places the electrolyte phase in a region where Fe3O4 is stable as the iron surface 
corrodes. The software computes a new phase, FePO4.2H2O, exists at a lower pH. This phase is more stable 
than Fe2O below a 3.7 pH, and its stability extends to 1.5 pH. Lastly, the FeHPO4

+1 complex is computed to 
be the dominant species between 2.5 and 5 pH (see dotted-line trapezoid surrounding the FeHPO4

+1 name). 

 

Protecting iron surfaces with phosphate is a known application, often used in automobile rust-proofing.  

✓ Change the total pressure to 30 atm and the temperature to 100C 

✓ Calculate and view the Stability Diagram (tab) 

The diagram boundaries have shifted to the left. Note for example that the natural pH of the liquid is ~8 
instead of 9. This is due in part, to the thermal effects on water’s ionization constant. (Pure water has a pH 
of 6.1 100C compared to 7.0 at 25C). 

The Fe3O4 passive film is now computed to be stable between 7 and 12 ph. The phosphate-buffered water 
has a pH, which will enable the Fe3O4 to be stable when formed.  
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Note the changes to the diagram. First, FeClxz aqueous complexes are computed to exist and be the 
dominant iron-containing species at a low pH. Also, an FeO phase, the anhydrous form of Fe(OH)2, is 
computed to exist at alkaline pH. This phase is harder to see and is just behind the Fe3O4 text. 

✓ Change the temperature to 250C 

✓ Change the pressure to 60 atm 

✓ Calculate and view the Stability Diagram (tab) 

The resulting plot contains more text and it is difficult to read. Therefore, we will remove the Dominant 
Aqueous layer from the plot and study the solid phase layer first. 

 

✓ Click on the Customize button in the upper left of the diagram 

✓ Click on the No Aqueous lines Radio button then close the window. 
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The diagram now displays five corrosion phases, Fe2O3, Fe3O4, FeO, Fe3(PO4)2, and NaFeO2. 
Thermodynamically, this iron should be protected from corrosion when put into service at 250 C, because 
the Fe3O4 phase is computed to be stable, in the water that is present in this system. 

 

The concentration of phosphate in this water is 95 mg/l and this would be the continuous concentration 

added. If the phosphate concentration were 5 mg/l, then the Na2HPO4 inflow would be 5.5e-5 moles.   

✓ Change the Na2HPO4 inflow to 5.5e-5 moles 

✓ Calculate and review the diagram 

The resulting diagram containing 5 mg/l total phosphate differs from the higher phosphate in that the 
Fe3(PO4)2 phase is no longer stable. The buffered pH remains in the magnetite stable region, which would 
be an indication that at this concentration of phosphate buffer, the system will still be protected from 
corrosion. 
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Tricks of the Trade Chapter 6b: Stability Diagrams 6b-13 

6.3 Composition effects on iron stability 
The composition effects on a Pourbaix (stability) diagram impact the dissolved species and the phases that 

form. To understand how this occurs, it is necessary to know how these diagrams are developed.  In each of 
these calculations, you have not entered a concentration for the contact surface.  That is because the 
contact surface and its corroding ion are pre-set by the software.  

Setting the species activities affects the calculation in the following ways.  First, it means that the total 
concentration of the focus element, e.g., total dissolved iron, is not constant across the plot area.  This is 
because the activity of the key species, Fe+2 and Fe+3 are held constant at 1e-6, about 56 ppB at ideal 
activity.   

 

Another affect is on the solid-liquid and solid-solid boundary lines.  The activity of the solid phases are set 
to 1 (ideal). Setting the pure solid phase activity to unity thermodynamically correct, and is not a 
simplification. It nonetheless simplifies the plot lines.  
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Composition effects 

✓ Create a new stream and name it Fe Diagram-Composition  

✓ Add the following components to the grid, H2S, NH3, and H4EDTA1 

✓ Add a Stability diagram calculation  

✓ Add Fe to the contact surface cell 

✓ Add 1 mole to the NH3 inflow value 

 

✓ Calculate and view the diagram 

A strong Fe(NH3)2
+3 and Fe(NH3)3

+3 complex exists between 8 and 11 pH. This reduced the stability range of 
the Fe0, F2O3, and Fe3O4 phases. Iron is now unstable at alkaline pH. 

 

✓ Remove the NH3 value and add 1 mole H4EDTA 

✓ Calculate and view the plot 

                                                           
1 Ethylenediamine tetraacetic acid 
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The chelant, EDTA-4 forms a strong complex with Fe+2 and with Fe+3. This complex caused the stability of 
each solid phase to decrease. There is now a greater electrical potential difference between H2O reduction 
and Fe oxidation: the energy released from the corrosion reaction is now greater than the case with no 
EDTA. 

 

Both cases of adding NH3 and EDTA results in the formation of strong aqueous complexes with Fe+2 and 
Fe+3. This results in the elemental iron surface of being less stable in water and also the reduction in the 
stability of any protective film. Both cases would result in active corrosion. 

✓ Remove the EDTA value and add 0.1 mole H2S 

✓ Calculate and view the plot 

The H2S (S-2) forms a relatively insoluble precipitate with Fe+2. This precipitate has the potential to cover 
the metal surface and enhance the pH region where iron is protected from the water.  
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✓ Click on the down arrow in the Redox button and select Sulfur  

✓ Recalculate 

Sulfur is OFF by default in redox calculations. When it is turned on, the software will compute H2S 
oxidation S(0) and higher sulfur oxidation states. The plot now shows that FeS2 (marcasite or pyrite) form at 
the electrochemical potentials around the water reduction line.  Therefore, during the corrosion process, 
some of H2S will oxidize to elemental sulfur. This sulfur reacts with Fe+2 and S-2 to form the insoluble 
precipitate. 
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6.4 Why Rust Forms & Why Stainless Steel is Stainless 
In this section, we will use Stability Diagrams to visualize and answer the two age-old questions. 

Why Rust Forms 

The previous case presented the iron stability regions, and also the regions where the products of iron 
oxidation forms.  Iron (Feo) is thermodynamically unstable in water it reacts spontaneously to form Fe+2 and 
H2.  When O2 is present, it oxidizes further to Fe+3.  

Iron oxidation produces include FeO(OH), Fe2O3, and Fe3O4. Under atmospheric conditions, the oxide is 
most likely FeOOH, a form of rust, the crystalline nature of which makes it a poor protective layer.  Thus 
corrosion continues through the layer that forms. When FeO is alloyed with Nio and Cro, different surface 
precipitates accumulate, including Ni3O4, NiFe2O4, and Cr2O3.  These oxides are more impervious and once 
formed, these precipitates protect surfaces from further corrosion. We will see from the following example 
that that FeO is inherently unstable in water. This instability is captured using a relatively simple diagram 
called an EH-pH diagram. 

✓ Add a new stream and rename it ‘Alloy Diagram’  

✓ Enter Fe in the inflow grid 

 

The procedure is to run a series of equilibrium calculations to determine the stability of the different iron 
oxide phases.  The phase, FeO(OH), is thermodynamically less stable relative to other iron oxides. By 
comparison, a more thermodynamically stable phase is hematite (Fe2O3). The software allows phase 
inclusion/exclusion through the chemistry model.  The following calculations will explore this phase 
stability. 

✓ Select Chemistry > Model Options from the menu 

 

✓ Move Corrosion from the Available databanks to Selected Databanks 
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✓ Select the Redox tab and select save when prompted 

 

✓ In the Redox tab, place a check next to Include Redox Chemistry  

 

✓  Select the Phases tab and select save when prompted  

 

✓ Expand the Fe(+3), then uncheck Fe2O3 

 

Hematite / FeO(OH) has now been removed as a potential solid.  Therefore, the next stable solid forms.   

✓ Press OK  

✓ Add a Stability Diagram and rename it ‘Fe Stability’  

✓ Type Fe in the Contact Surface  
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✓ Press <F9> to calculate then select the Stability Diagram tab  

✓ Click on the Customize button and select the No Aqueous lines radio button 

 

The plot shows the iron stability similar to previous plots, except that the FeO(OH) phase is now the 
dominant phase for Fe+3. 

 

The complete plot is represented as follows: 

• The gray area is the region where elemental iron is stable. Iron is stable over all pH ranges when EH 
is below -0.6 V (SHE).  

• The green area are the oxidized iron phases. Two phases are present in this calculation: magnetite 
(Fe3O4) at 8 and 14 pH and goethite (FeOOH) at 3 to 14 pH when Fe is in the Fe+3 oxidation state. 

• This white region is where no iron phases are present.  This is the active corrosion region.  
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Stainless Steel  

✓ Click back on the Alloy Diagrams stream  

✓ Change the Names Manager to Display name  

✓ Add a new Stability Diagram and name it ‘304 Stainless Steel’  

✓ Click on the bottom right corner of the empty grid in Contact Surface section and select 304 

 

✓ Press <F9> to calculate  

✓ Select the Stability Diagram tab  

The initial stability diagram contains several lines and equations. We will clean this up.  

✓ Select the Customize button  

✓ Select No Aqueous line  

✓ Uncheck Nickel and Iron in the Display box  

 

✓ Press OK 
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The large green wedge in the middle of the plot is the Cr2O3 stability zone. As Cro reacts with water Cr2O3 
precipitates (forming a protective layer on the steel surface.  The phase stable between 4 to 14 pH, 
providing acid protection.  

✓ Click the Customize button  

✓ Uncheck Chromium and select Nickel then press OK 

 

The mixed metal oxide, NiFe2O4 is computed to be stable between 5 and 14 pH and up to oxidation states 
where water is unstable.   

 

✓ Click the Customize button and change the display subsystem (metal) to Iron. 
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The iron oxide phase that forms is different from carbon steel.  Here, two mixed metal oxides, NiFe2O4 and 
FeCr2O4 form.  These phases are similar in structure to Fe3O4, the film that forms and protects carbon steel 
from corrosion at neutral pH. 

 

The Cr2O3 and NiFe2O4 phases that form from the reaction between stainless steel and water are the key 
contributors to this alloy’s stability, and protects the surface from further attack. 
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6.5 Iron Stability in Multiple Solvents 
This is an interesting case because it extends concept of metal stability in electrolytes. This case will 

investigate the thermodynamic stability of iron in methanol, ethanol, and ethylene glycol. By changing the 
solvent, the OH- species is eliminated under acidic conditions, and therefore, the oxides observed in the 
water phase do not exist.  

 

✓ Add a new stream and rename it ‘Solvents’  

✓ Select the MSE button in the toolbar  

✓ In the Inflows section, set the Water value to 0 

✓ Add the following species in the Inflows grid: methanol, ethanol, and ethylene glycol  

 

✓ Add a Stability Diagram and rename it ‘MeOH’  

✓ Set the Methanol inflow to 100 moles  

✓ Enter Iron as the Contact Surface 
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✓ Calculate or press the <F9> key then select the Stability Diagram tab  

 

✓ Add another Stability Diagram and rename it ‘EtOH  

✓ Select the Definition tab and change the Ethanol rate to 100 moles 

✓ Add Iron as a contact surface  

✓ Calculate or press the <F9> key then select the Stability Diagram tab  

 

✓ Add another Stability Diagram and rename it ‘MEG’  

✓ Select the MEG diagram 

✓ Select Description tab, change the Ethylene Glycol (1,2-Ethanediol) rate to 100 moles 

✓ Add Iron as a contact surface  

✓ Calculate or press the <F9> key then select the Stability Diagram tab  
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✓ Add new stream and rename it ‘Ethanol Stability’  

✓ Select the MSE button in the toolbar  

✓ In the Inflows section, set the Water value to 0  

✓ Enter Ethanol as an inflow with 100 moles  

 

✓ Add a Stability Diagram and rename it ‘EtOH Stability ’  

✓ Select 304 as the contact surface  

 

✓ Calculate or press the <F9> key then select the Stability Diagram tab  
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✓ Add a second Stability Diagram and name it ‘Stability in H2O 

✓ ’  

✓ Select the stability diagram’s Definition tab  

✓ Change the Ethanol value to 0 moles and change the Water value to 100 moles  

✓ Enter 304 as the Contact Surface grid 

✓ Calculate or press the <F9> key then select the Stability Diagram tab  

 

You will review the Ni, Cr, and Fe sub-systems in Ethanol and compare them to the water solvent.  Through 
the analysis, the key difference will be the existence of the oxide film above 7 pH.  Above this pH, NaOH is 
added to raise the pH.  This is the source of OH-1 and O-2 which converts to the metal oxides and 
hydroxides. 
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✓ Set both diagrams to display the Cr subsystem  

 

Chromium in Ethanol  Chromium in Water 

✓ Set both diagrams to display the Ni subsystem  

 

Nickel in Ethanol  Nickel in Water 

✓ Set both diagrams to display the Fe subsystem  
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Iron in Ethanol     Iron in Water 



 

 

Chapter 7a- Interpreting 
Polarization Curves  

Overview 
The polarization plot is a useful tool that displays in a single diagram why a material is corroding. It 

illustrates the chemical reasons for corrosion and quantifies the impact of each corroding material. In this 
particular system, the main causes of corrosion would be H+ (acid) corrosion, CO2 corrosion, H2S corrosion, 
H2O corrosion, and some remote O2 corrosion. The polarization plot shows what the contribution of each 
potential corrodant is to the corrosion of a given surface.  
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Polarization Curves Plots 

The Purpose of the Polarization Plot 
The purpose of creating the polarization curve is to determine how fast the metal/alloy will give up 

electrons and how fast the dissolved species will accept them. It shows what species are responsible for 
corrosion and what amount these species contribute to corrosion. Polarization curves are a replacement of 
the experimental procedure of determining corrosion rates. The benefit of using polarization curves, among 
other things, is to perform a hypothetical experiment in a system that would be difficult to do in the 
laboratory or would be very expensive. What the user gets out of polarization diagrams is an understanding 
of why a material is corroding and what species are contributing to the corrosion process.  

Polarization Diagram Layout 
The diagram below is a simplified polarization plot. The plot contains a positive-sloped anode curve, one or 

more negative- sloped cathode curves, and a corrosion potential triangle, which indicates the steady-state 
corrosion rate. The y-axis reflects the electrochemical potential, and the x-axis describes the electron 
current density.  

 

Figure 1 - Simplified Polarization Curve showing the Fe+2 oxidation curve, the H+ reduction curve, and the corrosion potential 
triangle (steady-state corrosion rate). This diagram represents the corrosion of a 10cm carbon steel (G10100) diameter pipe by a 

5pH solution at 25C/1atm. The solution also contains 55 µg Fe+2 and 61 µg HCO3
-and flows through the pipe at 2 m/s. 

The corrosion reaction can be described by the following equations for a metal and alloy (anode curve): 

𝐹𝑒0𝑚𝑒𝑡𝑎𝑙
𝑟𝑎𝑡𝑒
⇔  𝐹𝑒+2𝑎𝑞𝑢𝑒𝑜𝑢𝑠 + 2𝑒

− 

316𝑆𝑆0𝑎𝑙𝑙𝑜𝑦
𝑟𝑎𝑡𝑒
⇔  𝑥𝐹𝑒+2𝑎𝑞𝑢𝑒𝑜𝑢𝑠 + 𝑦𝑁𝑖

+2
𝑎𝑞𝑢𝑒𝑜𝑢𝑠 + 𝑧𝐶𝑟

+3
𝑎𝑞𝑢𝑒𝑜𝑢𝑠 + (𝑥 ∗ 2 + 𝑦 ∗ 2 + 𝑧 ∗ 3)𝑒

− 

The corroding atoms release electrons (2𝑒−). The above reactions are called half-reactions, because the 
electrons are part of the equation. 
The electrons released by the metal combine with electron-accepting species, dissolved in water, and 

adjacent to the metal surface. An example of this is the half-reaction for H+, which is converted to H2 gas 
(cathode curve). 

2𝐻+ + 2𝑒−
𝑅𝑎𝑡𝑒
⇔  𝐻2𝑔𝑎𝑠 
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These reactions are combined to form a complete REDOX reaction1, because electrons are consumed in 
the reaction. The 2e- cancel each other out and the resulting equation takes the form of a generic corrosion 
reaction: 

𝐹𝑒0𝑚𝑒𝑡𝑎𝑙 + 2𝐻
+

𝐶𝑜𝑟𝑟𝑜𝑠𝑖𝑜𝑛 𝑅𝑎𝑡𝑒
𝑇,𝑃,𝑒−𝑡𝑟𝑎𝑛𝑠𝑓𝑒𝑟 𝑟𝑎𝑡𝑒
⇔               𝐻2𝑔𝑎𝑠 + 𝐹𝑒

+2
𝑎𝑞𝑢𝑒𝑜𝑢𝑠 

We should keep in mind two rules about corrosion that cannot be broken: 
1) For corrosion to occur, both electron-producing (anode) and electron-accepting (cathode) reactions must be 

present. 

2) The number of electrons produced must equal the number of electrons accepted (corrosion potential 

triangle): 

∑𝑒−𝑟𝑒𝑙𝑒𝑎𝑠𝑒𝑑 =∑𝑒−𝑐𝑜𝑛𝑠𝑢𝑚𝑒𝑑 

The combination of these two rules plus the complete REDOX reaction, like the one above, is the observed 
corrosion rate. This rate depends on the concentrations, or activities, of the reactants (Fe, H+), the products 
(H2, Fe+2), conditions (T, P), and the base electron transfer rate. The corrosion rate observed in the field is 
the time-averaged rate defined in the above equation and quantified in the diagram.  
What then does the polarization curve try to accomplish? The purpose of the polarization curve plot, and 

the experiment that is performed in the laboratory to create it, is to put values on these reactions and to 
uncover any side reactions that may occur during corrosion.  

The X- and Y-Axes 
The two axes on the plot are the electrochemical potential and the current density. These terms appear 

arcane but in fact are straightforward concepts. What makes these terms confusing is that they represent a 
procedure that takes place in a laboratory, and so the reader would need some kind of experience with this 
experiment. Therefore, to explain the x- and y-axes, we will explain the experiment. 

Experimental Setup 

We start with a water solution at a constant temperature, salinity, and pH. The solution also contains a 
constant concentration of the corroding species, such as dissolvedCO2 and H2S. This water represents the 
corroding solution. The solution is created with a bubbler, such as the one shown in the diagram below. 

 

Figure 2 – An experimental solution kept at a constant composition of dissolved gasses.  
Source: Science Direct http://goo.gl/m9jUR 

A piece of metal (e.g. carbon steel) is added to this water. This metal is polished, shaped like a cylinder, 
and has a known surface area, such as 1cm2. The metal is generally attached to a motor that rotates it a 
given rpm. This metal represents the corroding surface. This metal is called the active electrode, or anode. 
If the metal contacts the water, an uncontrolled corrosion reaction will begin. However, we do not want 

this to happen because we want to know what controls the reaction.  

                                                           
1 The English words oxidation and reduction do not have a physical significance. These terms originally described two specific reactions; 2𝐹𝑒0 +
3

2
𝑂2 = 𝐹𝑒2𝑂3 (oxidation- oxygen being added to metal) and 𝐹𝑒2𝑂3 + ℎ𝑒𝑎𝑡 = 2𝐹𝑒

0 +
3

2
𝑂2 (reduction in the mass of solid). In modern vernacular, 

oxidation and reduction (or REDOX) are both general terms that describe reactions in which electrons are transferred. 

http://goo.gl/m9jUR
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What is done instead is the following: 
1) The metal is attached to a wire that is connected to a potentiostat, an electrical apparatus that provides a 

voltage.  

2) A second wire leaves the potentiostat and is attached to a non-reactive, carbon electrode. This electrode is 

called the counter electrode. 

3) A third wire is attached to a reference electrode. This electrode is used to set the reference voltage.  

All electrodes are kept in the same water.  
The diagram showing this system is below.  

 

Figure 3 – A potentiostat attached to a rotating metal and two electrodes.  
Source: Center for Research in Electrochemical Science and Technology: http://goo.gl/4t1AF 

4) The operator sets the voltage output of the potentiostat to very negative values (e.g., -2V) and scans up to 

high values (e.g., +2V).  

As the voltage scans upwards, the operator reads the electric current produced as electrons flow from the 
rotating disk metal to the counter electrode. This is reflected in the x-axis. 
The resulting plot is the electrochemical polarization curve.  

 

Figure 4 – The experimental results are reported in a plot of the electrochemical potential over current density. This is a 
polarization diagram for a passivable system with active, passive and transpassive regions. 

Source: NACE Resource Center http://goo.gl/yqaZE 

http://goo.gl/4t1AF
http://goo.gl/yqaZE
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First Layer of the Diagram: 
Corrosion Potential or Steady-State General Corrosion Rate 
The first layer displays the corrosion rate (x-axis) and the corresponding electrochemical potential of the 

solution at the metal surface (y-axis). The triangle in the plot below is at the coordinates of -0.5 V and 

4.47
𝜇𝐴

𝑐𝑚2
. This means that the water-metal interface has a corrosion potential of -0.5 V, and the rate at 

which electrons leave the surface is 4.47
𝜇𝐴

𝑐𝑚2
.  

An explanation of the two axes and their practical significance is provided in the next section.  

 

Figure 5 – The first layer contains the corrosion potential triangle. This corrosion potential represents the steady-state flux of 
electrons from the corroding metal (or alloy) into the corroding solution. This triangle represents how fast general corrosion 

occurs. The Corrosion Density units are A/m2, which can be converted into grams metal/alloy corroded per m2. 

X-Axis: Current Density (µA/cm2) 

The current density is the flux of electrons leaving the corroding surface and entering the liquid. The 
current density units are Amperes/area (e- /s-area), which are units of flux.  

 

Figure 6 –A flux of electrons leaving a corroding surface (unit area) and entering the liquid.  

The current density is converted to the corrosion rate using a standard equation: 

𝐶𝑜𝑟𝑟𝑜𝑠𝑖𝑜𝑛 𝑅𝑎𝑡𝑒 (𝑚𝑝𝑦) =  𝐶𝑢𝑟𝑟𝑒𝑛𝑡 𝐷𝑒𝑛𝑠𝑖𝑡𝑦 (
𝜇𝐴

𝑐𝑚2
) ∗

0.1288(
𝑚𝑝𝑦 𝑔
𝜇𝐴 𝑐𝑚

)

𝑎𝑙𝑙𝑜𝑦 𝑑𝑒𝑛𝑠𝑖𝑡𝑦 (
𝑔
𝑐𝑚3

)
∗

𝐴𝑊 (
𝑔
𝑚𝑜𝑙𝑒

)

𝑛 (
𝑒𝑞𝑢𝑖𝑣𝑎𝑙𝑒𝑛𝑡𝑠
𝑚𝑜𝑙𝑒

)

2 

For the above scenario, the corrosion rate is computed to be 2.0 mpy. 

𝐶𝑜𝑟𝑟𝑜𝑠𝑖𝑜𝑛 𝑅𝑎𝑡𝑒 (𝑚𝑝𝑦) =  𝐶𝑢𝑟𝑟𝑒𝑛𝑡 𝐷𝑒𝑛𝑠𝑖𝑡𝑦 (
𝜇𝐴

𝑐𝑚2
) ∗
0.1288(

𝑚𝑝𝑦 𝑔
𝜇𝐴 𝑐𝑚

)

7.85 (
𝑔
𝑐𝑚3

)
∗
55.85 (

𝑔
𝑚𝑜𝑙𝑒

)

2 (
𝑒𝑞𝑢𝑖𝑣𝑎𝑙𝑒𝑛𝑡𝑠
𝑚𝑜𝑙𝑒

)
= 4.47 (

𝜇𝐴

𝑐𝑚2
) ∗ 0.458 = 2.0 𝑚𝑝𝑦 

                                                           
2 Derived from the text, the Standard Practice for Calculation of Corrosion Rates and Related Information from Electrochemical Measurements. 

ASTM Publication G 102 – 89. K is the conversion constant that is based on the units used in the equation. “n” is the number of electrons in each 
corroding metal atom, AW is the atomic weight of the metal. 
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Y-Axis: Electrochemical Potential 

The electrochemical potential is the energy state that exists in the system. Its units are volts. When volts 
are combined with electron flux, the units become energy (joules=volts*coulombs). The electrochemical 
potential axis will have greater meaning when we review the second and third layers of the diagram. 
The electrochemical potential of water is a property of the water composition. For instance, O2-saturated, 

7pH water at 25C has an electrochemical potential of 0.8 V.  

Second Layer of the Diagram: Rate at Which the Surface Corrodes 

The second layer is the anode curve. The anode is the metal surface that corrodes, or chemically speaking, 
releases electrons. The anode curve represents the following corrosion reaction: 

𝐹𝑒0𝑐𝑎𝑟𝑏𝑜𝑛 𝑠𝑡𝑒𝑒𝑙

𝑟𝑒𝑎𝑐𝑡𝑖𝑜𝑛 𝑟𝑎𝑡𝑒 𝑜𝑟 
1

2
∗𝑐𝑢𝑟𝑟𝑒𝑛𝑡 𝑑𝑒𝑛𝑠𝑖𝑡𝑦

⇔             𝐹𝑒+2𝑎𝑞𝑢𝑒𝑜𝑢𝑠 + 2𝑒
− 

The anode curve shown below indicates how many electrons flow from the surface for a given 
electrochemical potential value. As you review this plot, use the y-axis as the fixed or known variable and 
the x-axis as the value that is calculated or measured. 

 

Figure 7 – The second layer of the diagram describes the rate at which the surface corrodes. The yellow line describes how many 
electrons flow from the surface at a given electrochemical potential. The y-axis here is the fixed or known variable and the x-axis 

is the value that is calculated or measured.  

When the electrochemical potential (y-axis) is at -0.86 volts, the x-axis value of the anode curve is 1e- 8 
𝜇𝐴

𝑐𝑚2
 

(see far left of plot). This converts to a corrosion rate of 4.58e- 9 mpy, which is a negligible corrosion rate: 

𝐶𝑜𝑟𝑟𝑜𝑠𝑖𝑜𝑛 𝑅𝑎𝑡𝑒 (𝑚𝑝𝑦) =  1𝑒−8 (
𝜇𝐴

𝑐𝑚2
) ∗ 0.458 = 4.58𝑥10−9 𝑚𝑝𝑦 

As the potential increases to -0.35V, the anode line increases to 6000
𝜇𝐴

𝑐𝑚2
, which converts to a corrosion of 

4580 mpy, which is an extremely high corrosion rate:  

𝐶𝑜𝑟𝑟𝑜𝑠𝑖𝑜𝑛 𝑅𝑎𝑡𝑒 (𝑚𝑝𝑦) =  6000 (
𝜇𝐴

𝑐𝑚2
) ∗ 0.458 = 4,580 𝑚𝑝𝑦 

At a potential of +1V, the anode curve shifts back to the left and becomes vertical. Its x-axis coordinate is 

6.7
𝜇𝐴

𝑐𝑚2
, which is a corrosion rate of 3.1 mpy, which is a moderate corrosion rate: 

𝐶𝑜𝑟𝑟𝑜𝑠𝑖𝑜𝑛 𝑅𝑎𝑡𝑒 (𝑚𝑝𝑦) =  6.7 (
𝜇𝐴

𝑐𝑚2
) ∗ 0.458 = 3.1 𝑚𝑝𝑦 
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Relating to Real Systems  

In a real system, if the electrochemical potential at the water/steel interface is -0.78V, the corrosion rate 
would be negligible. Such a scenario would exist if electrons were being pumped into the system from an 
external source, like with an Mg, Al, or Zn sacrificial anode or an impressed cathodic protection device.  
As the electrochemical potential increases, or moves up the y-axis, the availability of electrons decreases. 

Consequently, the rate of the corrosion reaction equations accelerates. In other words, more electrons will 
leave the metal surface, which creates a positive slope. Thus, the current density and therefore corrosion 
rate increase. In a real system, this would exist when the system has a high concentration of dissolved 
species that attract electrons (e.g., O2). 

Third Layer: Rate at Which the Solution Accepts Electrons from the 
Corroding Surface 
The third layer contains the cathode curves. Physically, the cathode lines are the corrodants, O2, HCl, H2S, 

CO2, etc. They are represented by the following half-reactions. 

𝐻+ + 𝑒−
𝑅𝑎𝑡𝑒
⇔  

1

2
𝐻2𝑔𝑎𝑠  

2𝐻2𝑂 + 2𝑒
−
𝑅𝑎𝑡𝑒
⇔  𝐻2𝑔𝑎𝑠 + 2𝑂𝐻

− 

2𝐻2𝑆 + 2𝑒
−
𝑅𝑎𝑡𝑒
⇔  𝐻2𝑔𝑎𝑠 + 2𝐻𝑆

− 

2𝐻𝑆 + 2𝑒−
𝑅𝑎𝑡𝑒
⇔  𝐻2𝑔𝑎𝑠 + 2𝑆

− 

2𝐻2𝐶𝑂3
− + 2𝑒−

𝑅𝑎𝑡𝑒
⇔  𝐻2𝑔𝑎𝑠 + 2𝐻𝐶𝑂3

− 

1

2
𝑂2𝑑𝑖𝑠𝑠𝑜𝑙𝑣𝑒𝑑 + 2𝐻2𝑂 + 2𝑒

−
𝑅𝑎𝑡𝑒
⇔  2𝑂𝐻− 

These curves have negative slopes because as the potential decreases, more electrons are available. 
Consequently, the rate at which the reactants in the above equations accept electrons increases. The plot 
below contains the five cathode half reactions shown above.  

 

Figure 8 –The third layer of the diagram shows 7 total curves. All but one (H2O), suddenly drops below a particular 
electrochemical potential. These curves become vertical because there is an insufficient concentration of the species at the 

surface to accept electrons at a faster rate. H2O is available in abundance.  

Note that each curve has the same negative slope. This is because as the potential decreases, the reactants 
in the above equations accept electrons at an equal and faster rate. Note that all the curves except H2O 
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become vertical below a particular electrochemical potential. When this happens, it means that there is an 
insufficient concentration of the species at the surface to accept electrons at a faster rate. The H2O curve 
continues with the negative slope because H2O is the solvent and available in abundance. 

Combining the Curves to Create the Complete Diagram 
When the three layers are combined, the resulting plot is generated. It shows the contributions of all the 

cathodes accepting electrons as compared to the anode donating electrons. Recall that the following 
condition must be true: 

∑𝑒−𝑟𝑒𝑙𝑒𝑎𝑠𝑒𝑑 𝑏𝑦 𝑎𝑛𝑜𝑑𝑒 =∑𝑒−𝑐𝑜𝑛𝑠𝑢𝑚𝑒𝑑 𝑏𝑦 𝑐𝑎𝑡ℎ𝑜𝑑𝑒 

The point where this reaction is satisfied is the inverted red triangle. This point then becomes the 
instantaneous corrosion rate or current density (x-axis), and the electrochemical potential existing at the 
corroding surface (y-axis). 

 

Figure 9 – Complete Polarization cure showing all the cathodic and anodic curves and the previous three layers.  

One of the important aspects of this plot is that it quantifies the contribution of each cathodic reaction. 
Here is how it works. The liquid-surface interface will have a single instantaneous corrosion potential. The 
y-axis is the value associated with the inverted triangle. If you draw a horizontal line from the triangle to the 
y-axis, you will cross the cathode curves. The diagram below is a zoomed-in version of the plot above and 
centers on the sections where the cathode reactions cross the liquid-surface electrochemical potential. 

 

Figure 10 – The completed polarization diagram with drawn in lines (illustration software). The dashed horizontal lines represent 
the electrochemical potential of the liquid-surface interface. The dashed vertical lines represent the intersection points for each 

cathode curve. The x-axis point where the intersections occur is the rate at which these species accept electrons.  
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The dashed horizontal line is the electrochemical potential of the liquid-surface interface. As we move 
from right-to-left across the dashed line, the cathode curves intersect. The dashed, red vertical arrows are 
the intersection points for each cathode curve with this line. The x-axis point where these curve intersect is 
the rate at which these species are accepting electrons. This is their individual contribution to corrosion. 
We can see that the curve that accepts the most electrons (farthest to the right) is the blue H+ ion.  

This is the dominant corrodant in this system. It intersects the x-axis at ~3.7
𝜇𝐴

𝑐𝑚2
.  

The next important is the vertical O2 line, which intersects the horizontal line at 1
𝜇𝐴

𝑐𝑚2
.  

The third most important corrodant is the aqua H2O line, which intersects at 0.03
𝜇𝐴

𝑐𝑚2
.  

Therefore, we can conclude that there are two important corrodants, H+, which is responsible for ~80% of 
the corrosion rate, O2 is responsible for ~20%, and the remaining corrodants contribute 1% or less to 
corrosion. The table below contains this cross-reference list of corrodants. 

Table 1 – A description of corrodants with their current densities, corrosion rates, and corrosion contribution percentage.  

Cathode Curve Current density (
𝜇𝐴

𝑐𝑚2
) Corrosion Rate (mpy) Contribution to corrosion (%) 

H+ 3.2 1.46 72 

O2 1.2 0.55 27 

H2O 0.04 0.02 0.9 

HS- 0.009 0.004 0.2 

H2CO3 0.006 0.003 0.15 

H2S 0.001 0.0005 0.02 

Total 4.47 2.04 100 

 
Notice that the O2 and HS- lines cross the horizontal Electrochemical Potential line with a vertical slope. 

These species are diffusion limited, meaning that they cannot accept more electrons because they cannot 
get to the surface fast enough. If the fluid were flowing faster, creating a thinner diffusion later, then these 
vertical lines would be shifted to the right, and these species would accept more electrons (contribute more 
to corrosion).  

Summary 
Generating a polarization curve on a computer has two purposes. The first is to predict the general 

corrosion rate of a material under process conditions. The second is to determine what chemistry is causing 
the corrosion and, when there are multiple corrodants, the contribution of each corrodant to the total 
corrosion rate. 
The polarization plot also computes when the material surface may be in an area of passivation, i.e. when 

a surface oxide film has formed and protects the surface for accelerated corrosion (the vertical section of 
the anode curve).  
Lastly, the plot shows the effects of flow rate on the corrosion rate. By plotting the cathodic reactions and 

showing where they bend to a vertical slope the user can see how the flow rate (and therefore diffusion 
layer thickness) affects overall corrosion. 



 

 

Chapter 7b Polarization Curve 
Applications 

Introduction 

In this chapter, we will continue to explore features of the OLI Studio: Corrosion Analyzer specifically 
looking at corrosion rates and polarization curves with practical examples.  

Sections 
7b.1 Corrosion in a Water-Filled Carbon Steel Tank ..........................................................................................2 

7b.2 Corrosion in a Pipe Carrying Acids ........................................................................................................... 10 
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7b.5 Gas Condensate Corrosion ...................................................................................................................... 24 
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7b.1 Corrosion in a Water-Filled Carbon Steel Tank 

Overview 

This case is a 10m3 tank (3.2cm high and 2m in diameter) that is filled to the top with water. The tank has a 
variable speed mixer with a rotation speed between 0 and 12,000 rpm. The tank is static at times (mixer 
off) and is fully mixed at other times. At certain instances, the tank is sealed and there is no air ingress. At 
other times, the tank is open to the atmosphere.  Each interval will be studied to compute the corrosion 
risk.  

 

Getting started 

✓ Create a new file and give it a name such as “Chapter 7”  

✓ Add a new stream,  and rename it ‘10m3 Water Tank’  

✓ Open the Units Manager then use the Quick List button to select Metric, concentration 

 

✓ Press OK 

✓ Change the Stream Amount to 10,000.00 L (or 10m3) 

Pure water, static flow, closed to the atmosphere, ambient conditions 

This requires no data entry, only the mouse. 

✓ Add a Corrosion Rates calculation, label it ‘Static Flow, 25C’ 

   

✓ Press the <F9> key or select Calculate  
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✓ Click on the “1” tab at the bottom of the grid 

 

The Corrosion Rate is 7.1e-3 mm/yr. This is a negligible rate, for if the tank wall’s thickness is ½ inch (~12.7 
mm) then corroding half the wall thickness would take about 900 years.  

 

Pure water, turbulent flow, closed to the atmosphere, ambient conditions 

✓ Add a nerw Corrosion Rates and rename it ‘Turbulent Flow, 25C’  

 

✓ Select on the Static cell in the Flow Type and change to Complete Agitation 

 

✓ Calculate  

✓ Select the “1” tab at the bottom of the grid 
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The corrosion rate increased 0.019 mm/yr, still a relatively low value. 

Pure water, varying flow, closed to the atmosphere, ambient conditions 

The next step is to compute the flow across the tank wall.  The software contains four flow types, Pipe, 
Disk, Cylinder, and Shear Stress. The best option is probably the Rotating Cylinder, which would be the tank 
moving relative to the water.  

✓ Add a new Corrosion Rates and rename it ‘Varying Flow, 25C’ 

 

✓ Change the Survey by to Rotating Cylinder 

 

✓ Change the Rotor diameter to 200 cm 

 

The vertical dimensions of the tank are unimportant. We will assume that the tank can be modeled like a 
rotating cylinder.  The propeller rotates at 1200 rpm, although it is not expected that the wall velocity w will 
approach this value, and so a lower value will be used (we still want it to be high enough to see the effects 
of shear). The next step is to set the speed of the mixer. 

✓ Select the Specs button.  
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Varying Flow, 25C Survey Range 

Start 0  

End 300 

Increment 10 

✓ In Var1 – Rotator Rotation category, change the Survey Range according to the table above 

 

✓ Press OK then Calculate 

✓ Select the General Corr. Rate tab then select the Curves button  

✓ Double-click pH-Aqueous in the Y2 Axis to remove it  

✓ Press OK then view the plot  

 

The corrosion rate is computed to increase as the bulk liquid velocity increases from 0 to 300 rpm near the 
wall surface.   The reason is straightforward; The higher velocity reduces the static water film thickness on 
the metal surface. This Diffusion Layer film limits the mass transfer of corrosion products and bulk 
chemicals to and from the surface.  As the liquid velocity (and therefore shear force) increases, the film 
thickness decreases, and the concentration gradient increase.  This increases the flux of materials to and 
from the surface, which increase corrosion rates.  
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Pure water, static flow, aerated (O2 only), ambient conditions 

Open steel tanks are in contact with oxygen in the air and in some cases atmospheric salts. Oxygen 
accelerates corrosion through the reaction: 

1

2
𝑂2, 𝑎𝑞 + 𝐻2𝑂 + 2𝑒− = 2𝑂𝐻− 

𝐹𝑒0 = 𝐹𝑒+2 + 2𝑒− 

-------------------------------------------------------- 

1

2
𝑂2, 𝑎𝑞 + 𝐻2𝑂 + 𝐹𝑒0 = 𝐹𝑒(𝑂𝐻)2

0 

The chlorides in the salt will also affect the surfaces ability to inhibit the corrosion reaction. 

✓ Add a Corrosion Rate  and label it ‘O2 Effects’  

✓ Add Oxygen (O2) to the inflow grid -  

✓ Change the Survey to Composition  

✓ Select the Specs … button and Select Oxygen as the inflow  

✓ Select the Survey Range as follows, Log Scale, Start=1e-6, End=10, Steps=10 

 

✓ Press OK then Calculate 

✓ Select the General Corr. Rate tab  

✓ Right-mouse click the X Axis and change to Logarithmic Scale -  

✓ Right-mouse-click on the pH curve and select Remove  

The resulting plot shows the impact of oxygen on the corrosion rate. Corrosion increases by a factor of 20 
once the concentration increases beyond 100 µg/l. Aerated water contains approximately 8 mg/l O2. 
Corrosion on the tank wall is 0.16 mm/yr. At this rate, 50% of the 12.3 mm wall will be dissolved in 40 years.  
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Air also contains carbon dioxide, which will corrode steel. Its impact is studied in the next calculation. 

Pure water, static flow, aerated (O2, CO2), ambient conditions 

The atmosphere contains ~400 ppmV CO2. At this concentration 0.6 mg/l CO2 is dissolved in water as 
molecular CO2, this CO2 hydrolyzes (splits) water to form the following reactants.  

𝐶𝑂2 + 𝐻2𝑂 = 𝐻+ + 𝐻𝐶𝑂3
− 

The resulting pH is about 5.6 at ambient conditions.  

The impact of CO2 on corrosion is two-fold, as two separate reactions occur at the metal surface 

𝐻+ + 𝑒− =
1

2
𝐻2 

𝐻𝐶𝑂3
− + 𝑒− =

1

2
𝐻2 + 𝐶𝑂3

−2 

To test the CO2 impact, you will recalculate the corrosion rate using two CO2 concentrations: 0 and 0.6 
ppm. 

✓ Copy the existing O2 effects calculation and paste it back to the 10 m3 Water Tank stream.   

o Right-mouse click on the calculation and select Copy 

o Right-mouse click the 10 m3 Aerated Water Tank, and select Paste 

✓ Rename the duplicated object ‘CO2 Effects’  

 

✓ Change the Names Manager to Formula view -  

✓ Add O2 and CO2 to the Inflow grid (the O2 may not have copied over) 

✓ Change the Then By (optional) option from None to Composition 
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✓ Select the lower Specs button  

✓ Select CO2 as the inflow -  

 

✓ Click on the Survey Range button and check the Point List button 

✓ Create two points, with values of 0 and 0.6 mg/l 

 

✓ Close the window and Calculate 

✓ Select the General Corr. Rate tab 

✓ Change the X and Y axes to log scale  

✓ Remove the pH curve (right-mouse-click and remove series) 

✓ Select the Curves button and remove any variable in the Y2 Axis then press OK 

The effects of CO2 are small, particularly in relation to the oxygen effects. The Corrosion rates at low O2 
content is about 0.0071 mm/yr with no CO2 and 0.0083 mm/yr with 0.6 mg/l CO2; a small difference 
between two small rates. At 10 mg/l O2 the corrosion rate is 0.16 mm/y and it is the same with and without 
CO2. Thus, CO2 has no effect on corrosion at high O2 concentrations meaning that the surface is corroded by 
oxygen and small concentrations of CO2 does not change this rate. 
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Pure water, 300 cycles/min flow, aerated (O2, CO2), ambient conditions 

Lastly, you will look at the effects of shear rates on the tank in contact with CO2 and O2. 

✓ Select the Definition tab  

✓ Change the Flow type from Static to Rotating Cylinder 

✓ Set the Rotor Diameter to 200 cm 

✓ Set the Rotor Rotation to 300 cycles/minute 

 

✓ Calculate then select the General Corr. Rate tab to review the plot 

 

The 0.6 mg/l CO2 curves shifted at low O2 concentrations.  The rate is 0.048 mm/yr compared to 0.008 
mm/yr at static conditions. The effect of shear at high O2 concentrations (right side of the plot) is also 
pronounced.  Corrosion is still dominated by O2 attack, but the rate is now over 10 mm/yr. about 100x 
greater than the static conditions. 

✓ Save the file  
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7b.2 Corrosion in a Pipe Carrying Acids  
Some of the more common commercial acids include muriatic acid (20% HCl), Aqua Regia (25% HNO3:75% 

HCl), Battery Acid (30% H2SO4), commercial grade nitric acid (68% HNO3), and fuming HCl (37%). 

In this example, the metallurgy within a vacuum HCl tower will be studied.at HCl production. Fuming HCl is 
purified from feedstock through distillation. The HCl-H2O mixture however, forms an Azeotrope at 20% HCl 
and 110C. Consequently, multiple distillation sequences are needed to achieve the 37% mixture. In this 
case, the conditions within the first towe are investigated.  Here the feedstock is at vacuum pressures (0.3 
atm).  

Vacuum HCL Tower 

Stage T, C HCl %  H2O %  

1 78.1 25 75 

2 77.6 24 76 

3 77 23 77 

4 76.3 22 78 

5 75.4 21 79 

6 74.4 20 80 

7 73.6 20 80 

8 72.8 19 81 

9 68.7 12 88 

Carbon steel tower 

✓ Add a new stream ; rename it ‘Vacuum HCl Tower’  

✓ Open the Units Manager then use the Quick List button to select Metric, Flowing, Mass 
Fraction 

 

✓ Set the Stream Amount to 12500 kg/hr  

The Stream Amount does not have to be changed, but to keep this stream consistent with the process, the 
conditions and compositions will be included.  

✓ Change the pressure to 0.3 atm 

This is the tower pressure, which in fact decreases from 0.3 to 0.25 atm (bottom to top of tower). 
However, it is not practical to adjust the pressure when changing temperature and HCl% content, so we will 
leave the value at the tower bottom pressure  

✓ In the Inflows grid, enter HCl  

✓ Add a Corrosion Rate calculation and name it Carbon Steel -  

✓ Change the Survey by to Temperature 

✓ Change the Then by (optional) to Composition 

✓ Select the Together button just above the Calculate button 

✓ Select the top Specs button 
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✓ Click the Point List button 

✓ Create nine points and enter the temperatures from the table above 

 

✓ Click on the Var. 2 Composition Category and select HCl as the inflow to be adjusted 

 

✓ Click the Survey Range tab and click on the Point List button 

✓ Add eight more points to the list and enter the %HCl values from the table above 
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✓ Press OK then Calculate 

✓ Select General Corr. Tab 

✓ Remove the pH curve – Right-mouse-click and select Remove 

Corrosion rates increase from 270 mm/yr at the top of the tower to 2760 mm/yr at the bottom. At these 
rates, the 1” thick (254 mm) carbon steel plate at the tower bottom will dissolve in about 30 hours!  

 

Another material of construction is needed. We will test these out now. 

316 stainless steel tower 

✓ Copy the Carbon Steel corrosion calculation and paste it twice to the Vacuum HCl Tower  

✓ Name the new calculation Stainless Steel 316 -  
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✓ Change the Contact Surface to Stainless Steel 316 

 

✓ Calculate then select the General Corr. Tab 

✓ Remove the pH 

The Corrosion rates for 316 stainless are about 10 times lower than carbon steel. The rates vary from 22 at 
the tower top to 310 mm/yr at its bottom. This is still a very high value, as a 254 mm wall at the tower 
bottom would dissolve in nine months. 

 

Corrosion using a Duplex Stainless 2205 (high chrome) 

✓ Rename the third calculation object Duplex 2205 (copied) 
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✓ Change the Contact Surface to Duplex Stainless 2205 -  

 

✓ Calculate then select the General Corr. Tab 

Corrosion rates are considerably smaller, one-thousandth the rates observed with carbon steel and up to 
100 times less than 316 stainless.  

 

At these rates, which are roughly the same across the tower (1.1 to 1.26 mm/yr), a 25 mm duplex steel 
wall will lose one-half its wall thickness in 20 years.  



 

Tricks of the Trade Chapter 7b: Polarization Curve Applications 7b-15 

7b.3 Corrosivity of Soda Pop 
In this example, you will compute the corrosion rate of soda on an aluminum can. Aluminum cans are 

internally coated with an epoxy resin to prevent corrosion.1 In this exercise, you will compute the corrosion 
rate without this coating   Below are some properties for various soda brands. These soda products contain 
phosphoric or citric acid and is pressure is carbonation (CO2), this produces a low pH.  

You will create soda properties by adding H3PO4 to lower pH and CO2 to raise the bubble point pressure. 
You will then compute the corrosivity of this liquid on aluminum. You can alternatively test the effects of 
citric acid on corrosivity, and figure out how much tooth enamel (calcium flurophosphate) will dissolve in 12 
ounces (355 ml) of soda. 

7b.3 Corrosivity of Soda Pop 

Soda2 pH Pressure, atm Corrosion Rate 

Coke 2.53 4.7@23C3  

Diet Coke 3.29   

Pepsi 2.53 2.7@16C4.  

Diet Pepsi 3.03   

Dr. Pepper 3.17 3.0 @50F5  

RC Cola 2.39   

Mountain Dew 3.23   

Diet Mountain Dew 3.37   

7-up 3.20 3.2 @4C6  

Sprite 3.71   

Mug Root Beer 4.04   

The first step is to calculate the amount of acid (CO2 and H3PO4) in the soda. This is done using the Custom 
calculation. The second step is to run the Corrosion Rate calculation using the calculated amount of CO2 and 
H3PO4. You will need to manually enter the CO2 and H3PO4 calculated in the first step into the second step 
calculation.  

Calculate the amount of H3PO4 and CO2 in the soda 

The Custom calculation will be used to fix the soda pH and the can pressure (specifications) and adjust the 
amount of CO2 and H3PO4 needed to meet these specifications. With Coke for example, the pH is set to 
2.525 and the pressure to 4.7 atm.  

The custom calculation works slightly different from other single-point calculations.  Custom calculation 
specifications require an entered value.  For example, the standard Bubble Point calculation fixes the vapor 
amount at 1e-10 the total stream amount.  In the Custom calculation, the user needs to enter this value.  
You will enter a small amount (e.g, 1e-6 moles). This ensures that a vapor is present, which will allow the 
calculation to continue.  

The instructions below are for the Coke example. 

✓ Add a new stream ; name it ‘Coke’  

✓ Open the Units Manager then use the Quick List button to select Metric, concentration 

                                                           
1 http://en.wikipedia.org/wiki/Beverage_can 
2 http://quittingsoda.com/post/the-acidity-ph-of-soda-pop 
3 http://hypertextbook.com/facts/2000/SeemaMeraj.shtml 
4 ibid 
5 http://goo.gl/pzk4G4 
6 *38F is estimate, report states “refrigerated” 

http://en.wikipedia.org/wiki/Beverage_can
http://quittingsoda.com/post/the-acidity-ph-of-soda-pop
http://hypertextbook.com/facts/2000/SeemaMeraj.shtml
http://hypertextbook.com/facts/2000/SeemaMeraj.shtml
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✓ Add H3PO4 and CO2 to the grid 

✓ Change the Stream amount to 0.355 L (12 ounces) 

✓ Change the temperature to 23C 

✓ Change the pressure to 4.7 atm 

✓ Add a Single Point calculation then change the type to Custom 

  

✓ Select the Specs button  

✓ Open the Specs window  

✓ In the Variables to Fix column, select Moles (True)-Vapor and pH  

✓ In the Variables to Free column, select CO2 and H3PO4 

    

✓ Press OK  

The Calculation Parameters Section of the grid is active and it contains four rows, two target specifications 
and two adjustable variables.  The Target specifications require values.  The adjustable variables can benefit 
from adding initial guesses, since it can speed up the calculation.  You will add initial guesses in this case. 

✓ Add the following Values to the Calculation Parameters Section 

7b.3  Calculation Parameters  

Target 1: Moles - Vapor 1e-4 

Target 2: pH – Aqueous 2.525 

Variable 1: CO2 (mg/l) 100 

Variable 2: H3PO4 (mg/l) 100 

✓ Calculate 

✓ Click on the Output tab at the bottom of the grid 
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The software computed that to achieve this pH and can pressure, this beverage contains 431 mg/l H3PO4. 
and 7077 mg/l CO2 (if these were the only two ingredients in the product). 

Calculate the Soda corrosion rate on Aluminum 

✓ Return to the Coke stream 

✓ Add a Corrosion Rate calculation  

✓ In the Inflows grid, enter H3PO4 with a 431 mg/l value 

✓ In the Inflows grid, enter CO2 with a 7077 mg/l value 

✓ Change the Contact Surface to Aluminum 1100 

 

✓ Calculate then select the “1” tab at the bottom of the grid to view the results 

 

The calculated corrosion rate on the aluminum can wall is 0.03 mm/yr (30µm/yr). According to Wikipedia, 
the can wall thickness is ~80 µm7. If we assume this is correct, then a coke will dissolve in less than three 
years. Thankfully, the epoxy coating keeps the beverage from tasting like aluminum. 

                                                           
7 http://en.wikipedia.org/wiki/Beverage_can, they provide no citation. 

http://en.wikipedia.org/wiki/Beverage_can
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7b.4 Corrosion of Steel Pilings in Seawater 
Steel pilings are driven into seawater beds to retain soil, control erosion, provide wave breaks, docks, 

supports the weight of piers, etc. However, the combination of salt and oxygen corrodes, and the sand in 
waves erodes the steel. We are interested in studying the effects of seawater and oxygen on general 
corrosion. 

 
Figure 1 - Photo from http://www.gimrock.com/images/Ocean%20Ave%20Demo4.jpg, showing sheet piles driven into sediments 
during construction of a bridge in Palm Beach Fl. 

The purpose of this case is to compute the corrosion of these steel pilings as a function of depth.  Steel 
exposed to the surface is in contact with oxygen.  Steel within the seabed sediments will not, and the lack 
of flow should also impact overall corrosion.  Therefore, the output of this calculation is a corrosion profile.  
Its accuracy will depend on the software ability to include key corrosion factors. 

The two conditions tested will be cold, anoxic conditions under static flow (below sediment) and warm, 
aerated conditions with some flow (surface conditions). 

Getting started  

✓ Open the Object Library by clicking on View>Toolbars>Object Library 

 

✓ Drag the Standard Seawater Analysis object to the Navigation Pane 

http://www.gimrock.com/images/Ocean%20Ave%20Demo4.jpg
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✓ Add O2 to the list of Neutrals and enter a value of 8 mg/l  

The concentration of oxygen at the surface of seawater is about 8 mg/l. As depth increases, the 
concentration decreases because O2 is consumed faster than it can be replenished. 

✓ Add HCl and NaOH to the Neutrals list 

 

✓ Enter the following values into the Recorded Properties section 

7b.4 Recorded Properties  

Total Dissolved Solids 34500 mg/l 

pH 7.6  

Alkalinity 145 mg/l HCO3 

Density 1.026 g/ml 

Conductivity @25C 0.039 1/ohm-cm 

✓ Add a Reconciliation calculation 

✓ Select Reconcile pH/Alkalinity 

✓ Calculate 

✓ Select the Calculated tab at the bottom 

✓ Select the Add as Stream at the bottom  
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✓ Name the Exported stream Seawater and press OK 

 

This creates a new stream called Seawater. This stream contains the molecular composition of the analysis 
we reconciled. Converting the water analysis to a stream format makes available the standard calculation 
objects, like Single Point, Survey, Corrosion Rates.  

 

Corrosion between 10 and 30 C and in static flow 

The first scenario is to compute the general corrosion rate as temperature changes. Seawater temperature 
varies with location (near shore, offshore), depth, latitude, and season. In our case, we are interested in 
near-shore water, perhaps 10 meters deep, where the water temperature range is 10 to 30 C.  

✓ Add a Corrosion Rate Calculation  to this new stream  

 

✓ Change the Survey by to Temperature 

✓ Open the Specs window and set the Start=10, End=30, and Increment=1 C 

 

✓  

✓ Press OK and Calculate 

✓ Select the General Corr. Rate tab then the Curves button  

✓ Remove the pH from the plot using the right-mouse-click option.  
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The corrosion rates vary range from 0.080 to 0.140 mm/yr under static conditions. Notice that a few of the 
calculations failed (the zero values). Calculation failures occur at time, and when it does, ignore the values if 
we can as long as it does not detract from the interpretation. With respect to the corrosion rate, a steel 
pilings 12.7 mm thick will last up to 80 years (50% wall loss). 

 

Corrosion between 10 and 30C in liquid flowing  

If the water is flowing, then the situation is different. Modeling waves moving against the pilings is not 
simple, and there is no Flow Type (flow model) in the software that mimics it. We can attempt a guess.  

We assume that the water flows across the surface at a rate at which a person walks, ~5 km/hr. This is 
about 1.5 m/s. Next, we need to consider the shape of the surface. The software does not have a flat plate, 
but perhaps a pipe with a large diameter would suffice. We can try several diameters, 1.000 or 10,000 
meters for example (the arc would approach a flat plate). 

✓ Return to the Definition tab 

✓ Change the flow type to Pipe Flow 

✓ Change the Pipe Diameter units to meters 

   

✓ Set the pipe diameter to 10000 meters  

✓ Change the Pipe Flow Velocity to 1.5 m/s 

✓ Calculate and View the Plot 

The corrosion rate increases by a factor of 10x, decreasing the piling life to about 8-10 years.  
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Compare to Field Data8 

An NBS monograph written in 1977 provides some reference for our 
evaluation. The adjacent plot contains the wall loss on unlined steel 
pilings driven into the soil. A portion of the pipe is exposed to wave 
action, tide changes, sand movement, and quiescent pore waters.  

The mean seawater salinity is 26.8 ppt, lower than the 34.5 g/l value 
used in our calculation. In addition, the mean sweater temperature is 
14.4C  

The piles are 30’ long (9.1m) and 0.7” (18mm) thick. They were driven 
into the sand to 19 ft. The wall loss occurs on two sides of the pilings. 
Therefore the wall loss is effectively double the corrosion rate.  

The pilings were exposed to this environment for six years. They were 
inspected annually using electrochemical and visual methods. They 
were removed after six years for inspection. 

The authors reported several distinct corrosion sections, from below 
the mud line to the splash and atmospheric section (adjacent plot). 
The highest corrosion was above the Mean High water, where 
corrosion rates were between 8 to 12 mpy.  

Below the high water mark, the corrosion was between 4 and 8 mpy 
on average. At the Mudline, which is the erosion zone, the rate 
averaged 9 mpy, and shifted because of the shifting mud-line 
elevation.  

                                                           
8 Escalante, E.; Iverson, W. P.; Gerhold, W. F.; Sanderson, B. T. & Alumbaugh.1977. Corrosion and Protection of Steel 

Piles in a Natural Seawater Environment. Washington D.C.. UNT Digital  
Library. http://digital.library.unt.edu/ark:/67531/metadc13190/.  

http://digital.library.unt.edu/ark:/67531/metadc13190/
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Below the mud line (<15ft) the corrosion rate decreased 
to 1-3 mpy, and some of the observed corrosion was 
pitting.  

The adjacent diagram shows the environmental impact of 
seawater, wave action, and sand movement on the piling. 
We can only model the chemical aspect of corrosion, so 
when we compare numbers, it is important to recognize 
this. 

Comparing Values 

We ran two corrosion rate calculations, one at static 
conditions and one in which we considered movement 
across a flat surface. The corrosion rate for both at 14C 
(the average seawater temperature in the above paper) is 
0.09 mm/yr at static conditions and 1 mm/yr under 
flowing conditions. 

 

 

 

 

Location Reported rate, mpy (mm/yr)) Computed Rate, mpy (mm/yr) [flow type] 

Mean High water (Splash-
Atmosphere) 

8 to 12 mpy (0.2 to 0.3 mm/yr)  

Mean Low water 4 to 8 mpy (0.1 to 0.2 mm/yr) 40 mpy (1 mm/yr) [flowing] 

Mudline 9 mpy (0.23 mm/yr)  

Mud, sand 1 to 3 mpy (0.025 to 0.075 mm/yr) 3.6 mpy (0.09 mm/yr) [static] 

   

Fluid is static and the pore water is isolated from the bulk seawater. Pore water properties will change as 
corrosion progresses. For example, higher Fe+2 and pH are reaction products. In addition, the 
concentrations of corrodants cannot be replenished. They should therefore decrease. As a result, the wall 
loss is about 0.03” (0.8mm) over the six-year life. The annual corrosion rate is:  

0.8𝑚𝑚 ∗
1

2 𝑠𝑖𝑑𝑒𝑠
∗

1

6 𝑦𝑟𝑠
= 0.066

𝑚𝑚

𝑦𝑟
 

This value is similar to the static conditions computed above, but that may be entirely coincidental. 

The high wall loss at the mud line is associated erosion, which cannot be modeled by the software. Within 
the Mean Low Water section (~23 ft) seawater is constantly present. The wall loss is approximately 0.1” 
(2.54mm) over the six-year time span. This is a rate of 0.21 mm/yr. Above the surf line in the Splash and 
Atmospheric section, the wall loss is 0.2” (5.5mm), which converts to a corrosion rate of 0.5 mm/yr.  
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7b.5 Gas Condensate Corrosion  

Overview 

An alkanolamine gas sweetening plant has corrosion problems in the condensed overhead gas. 
Diethanolamine is used to neutralize an acid gas containing carbon dioxide and hydrogen sulfide. The 
diethanolamine is regenerated and the acid gases are driven off in a stripper. The off gas from this stripper 
is saturated with water vapor. As these gases cool, they will condense. This condensate can be very 
corrosive. The plant’s service life can be shortened considerably due to these condensed acid gases. In this 
example, you will calculate the gas dew point temperature, remove the condensed aqueous phase and 
perform a Corrosion Rate calculation with the condensed water.  Lastly, you will consider mitigation 
strategies for the pipes. 

You are introducing fluid velocity and liquid condensation into the calculation. The software uses a 
diffusion layer model to compute mass transfer to and from corroding surfaces. Higher rates produce 
thinner layers, resulting in faster mass transfer rates, and thus higher corrosion rates. The liquid 
condensation point is straightforward; it calculates the temperature (or pressure) where the first liquid 
drop forms. 

Gas Condensate 

Start by creating a gas condensate stream. Note that the units are mole fraction. When using these units, 
the water’s mole percentage is automatically calculated from the sum of the other inflow components. Yoy 
may see error messages if your inflows’ concentrations cause the water mole percentages to be negative.  

7b.5 Gas Condensate Corrosion  

Name Gas Condensate H2O  Calculated (mole %) 

Names Style Formula CO2  77.4 

Units Metric, mole fraction N2  0.02 

Stream Amount  1 e5 mol (100 kgmol) H2S  16.6 

Temperature 38C CH4  0.50 

Pressure  1.2 atm C2H6  0.03 

  C3H8  0.03 

✓ Add a new stream ; name it ‘Gas Condensate’  

✓ Change the Units Manager to Metric, batch, mole fraction 

 

✓ Use the table above to complete the stream’s composition 

Now that the gas condensate stream is created, the next task is to isolate the condensed water at the dew 
point temperature.  

✓ Add a Corrosion Rate calculation 

✓ Name it CSG10100 

✓ Set the Flow Type to Pipe Flow with Pipe Diameter=10cm, Pipe Flow Velocity=2 m/s 

✓ Use the default contact surface of carbon steel G10100 

✓ Keep the default Survey by of Single Point  

✓ Select the Specs button 
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✓ Select the Calculation Type category  

✓ Change the calculation type to Dew Point.   

 

✓ Press OK  

 

✓ Calculate then select the select the Polarization Curve tab 

 

Before interpreting this plot, it will be formatted for easier viewing. 

✓ Click the Options button to change the axis minimum and maximums  

 

✓ Select the X-Axis category  

✓ Check to see that the X Axis minimum is 1e-6 and the max is 1e6 

✓ Change the Y Axis minimum to -1.5 and the max to 1.5  
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✓ Press OK  

✓ Click on the Variables button 

✓ Remove following variables by unchecking them 

2𝐻2𝑂 = 𝑂2 + 4𝐻(+) + 4𝑒 

𝐹𝑒(3 +) = 𝐹𝑒(2 +) − 𝑒 

𝐻2 + 4𝐻(+) = 2𝐻2𝑂 − 4𝑒 

𝑃𝑒𝑎𝑘 𝐶𝑢𝑟𝑟𝑒𝑛𝑡 𝐷𝑒𝑛𝑠𝑖𝑡𝑦 

𝑁𝑒𝑡 𝐶𝑢𝑟𝑟𝑒𝑛𝑡 𝐷𝑒𝑛𝑠𝑖𝑡𝑦 

✓ Press OK view the plot 

 

This is a measured potential vs. current density plot.  It shows the flux of electrons moving from the metal 
or to the corrodant as the electrochemical potential changes.  The two sets of curves have increasing slopes 
or decreasing slopes.  The increasing slopes is the metal (anode) and decreasing is the corrodent (cathode).  
The anode is the carbon steel.  There are several cathodes, H+, H2CO3, H2S, HS-1.  The sum of the cathode 
curves adds up to the anode curve at a single point.  This point is the inverted triangle.  At this point the 
release of electrons from the metal equals the consumption of the electrons by the cathodes.   

The cathodic reaction that contributes the most to corrosion is H2CO3.  Its line nearest to the triangle when 
a horizontal line is drawn from the triangle to the Y-axis (see plot below).  The next contributors are H2S and 
HS-1, equally.  After that is H+.  

2𝐻2𝐶𝑂3(𝑎𝑞)  + 2𝑒−  =  𝐻2 +  2𝐻𝐶𝑂3
− 
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2𝐻2𝑆(𝑎𝑞)  + 2𝑒−  =  𝐻2 +  2𝐻𝑆− 

2𝐻𝑆−1 +  2𝑒− =  𝐻2 + 2𝑆−2 

2𝐻2𝑂 + 2𝑒 =  𝐻2  +  𝑂𝐻− 

Water reduction contributes the least to corrosion. 

 

✓ Click the Report Tab and scroll down to the Calculated Rates and Stream Parameters tables 

The contribution of each corrodent contributes to the final corrosion rate and that steady-state rate is 
linked to a specific electrochemical potential.  Both are shown in the report as the Rate and Potential.   

 

The corrosion rate is approximately 0.70 mm/yr.  The dew point is 37.6 oC, and the dew point pH is 3.9.  

 

Mitigation  

We have several mitigating solutions to this corrosion problem. One is adding insulation to prevent 
temperature drops. The dew point is very close to the overhead gas temperature so this may not be a 
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suitable option. Adding heat to keep the temperature above the dew point is usually considered along with 
insulation. Changing the chemistry to change the partial oxidation and reduction processes is also an 
option. Furthermore, changing alloys could mitigate the corrosion problem. 

Adjusting the solution chemistry 

The condensate pH is approximately 3.9. We can try to add a base to increase the pH. In this section, we 
will add Diethanolamine to raise the pH to 7.5.  

✓ Click on the Gas Condensate stream  

✓ Add a Single Point calculation then rename it DEA  

✓ Type DEA in the first available inflow cell 

 or  

✓ Select Set pH from the Type of calculation  

✓ Enter 7.5 or pH 

✓ Click on the dropdown arrow for the pH Base Titrant and select DEA (or the corresponding 
name that appears: N,N-Diethanolamine or HN(C2H4OH)2. 

 

The program is now set up to adjust the amount of DEA to match a target value of pH = 7.5. 

✓ Calculate  

✓ Review the Summary box 
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The pH is set to 7.5 and the inflow of DEA to the total gas is approximately 6.1e-4 mole %. The DEA 
concentration in the condensing water and the amount remaining in the vapor phase can both be viewed in 
the report section. 

✓ Click on the Report tab and view the Total & Phase Flows and Species Output and tables  

 

✓ Change the units to whatever is easiest to interpret  

The units might be different, so use whichever are easiest to interpret. To achieve 7.5 pH, the gas-phase 
DEA needs to be 6.1e-4 mole % or about 15.6 ppm (mass). Since the condensing water mass is extremely 
small relative to the gas (view the total flow section further up the report), the overall mass is still small. 
How would the DEA requirements change if the temperature dropped well below the dew point? 

Recalculating the Corrosion Rate with DEA 

We now can recalculate the corrosion rate with DEA in the stream. This represents some DEA entrained in 
the vapor phase as the gas leaves the regenerator.  

✓ Return to the CSG10100 calculation  

✓ Enter DEA to the grid and give it the value computed in the previous calculation. 

 

✓ Calculate and click on the Report tab to view the rates, dew point temperature, and pH 

The corrosion rate has decreased from 0.7 to 0.48 mm/yr. If we run this at static flow, the values reduce 
from 0.4 to 0.27 mm/yr. 
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The pH is 7.6, similar to the target value of 7.5.  Therefore, neutralizing the pH had a partial effect on 
corrosion reduction. 

 

Alloys 

Since treating the acid gas with a base is probably not a good idea for metal hydroxides, perhaps we can 
change the alloy. We will add a new corrosion rates calculation and test different alloys. 

✓ Copy the CSG10100 calculation back into the stream  

o Right-mouse-click on the CSG10100 object and select Copy.  

o Right-mouse-click on the Gas Condensate stream and select Paste 

✓ Rename it ‘13% Cr’  

✓ In the Contact Surface grid, Select 13%Cr stainless steel  

✓ Change the flow conditions from Static to Pipe Flow, keeping the other default values  

 

✓ Calculate  

✓ Click on the Report and view the corrosion rates 

The corrosion rates are an order of magnitude lower at ~60 um/yr.  This is consistent with the use of 13% 
Cr to protect against CO2 corrosion. 
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✓ Select the Polarization Curve tab  

 

The curve has changed in two ways, first the 13%Cr curve has shifted upwards. It is 0.51 V instead of 0.67 V 
(a smaller relative driving force to oxidize). Second, because of the anode curve being shifted upwards, the 
intersection between the anode and cathode reaction (mixed potential) shifted to the left (lower current 
density).  

The next step is to repeat with Stainless Steel 304.  

✓ Copy the CSG10100 calculation again to create a new corrosion calculation 

✓ Name it ‘SS304’  

✓ Calculate 
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✓ Click the Report and view the results 

The corrosion rate is now ~3um/yr, a negligible value.   

 

✓ Click on the Polarization Curve plot 

Thus, sour gas regeneration corrosion can be remedied using a higher-grade alloy. 
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Follow-up example 

The effect of double-layer thickness on corrosion rates is evident from the previous case. The sudden 
change in slopes of the cathodes from slight negative to vertical is the result of the inability of those species 
to reach the surface at a high enough rate to accept the electrons that the surface is willing to provide it. If 
we consider the terms associated with diffusion to and from the surface, we can estimate these diffusion 
properties.  

First, we know the maximum rate, or more specifically, flux at which each species is transported to the 
surface. It is the value in A/m2 on the polarization where the vertical line crosses. Using the last plot we 

created (304SS), the values are 𝐶𝑂2 −  0.35
𝐴

𝑚2
 , 𝐻 + − 4.14

𝐴

𝑚2𝑎
 and 𝐻2𝑆 –  190

𝐴

𝑚2
 

 

✓ Return to the report and find the concentration for these species 

Your results may differ: 𝐶𝑂2 –  1011𝑝𝑝𝑚 (
16.3𝑚𝑚𝑜𝑙𝑒

𝑘𝑔
𝑠𝑜𝑙𝑢𝑡𝑖𝑜𝑛), 𝐻 +  − 0.12𝑝𝑝𝑚 (0.12

𝑚𝑚𝑜𝑙

𝑘𝑔
𝑠𝑜𝑙𝑢𝑡𝑖𝑜𝑛) 

and 𝐻2𝑆 –  521.2𝑝𝑝𝑚 (15.33
𝑚𝑚𝑜𝑙

𝑘𝑔
𝑠𝑜𝑙𝑢𝑡𝑖𝑜𝑛).  

The half reactions for the corrodants are 𝐶𝑂2 + 𝐻2𝑂 + 𝑒−=  ½ 𝐻2 +  𝐻𝐶𝑂3−, 𝐻 + +𝑒− =  ½ 𝐻2 and 𝐻2𝑆 +

𝑒−=  ½ 𝐻2 +  𝐻𝑆, where e- in this case is one mole of electrons. Remembering, 𝐴 =
𝐶

𝑠
= 𝑒 −

𝑠
 (𝐴 = 𝐴𝑚𝑝𝑒𝑟𝑒, 𝐶 = 𝐶𝑜𝑢𝑙𝑜𝑚𝑏), we can first calculate the maximum moles of each species that can reach 

the surface each second. Since each species consumes a single mole of electrons in their reaction, then 

resulting flux of species to the surface is 𝐶𝑂2 =  0.35
𝑚𝑜𝑙𝑒𝑠

𝑠

𝑚2
, 𝐻+ =  4.14

𝑚𝑜𝑙𝑒𝑠

𝑠

𝑚2
 and 𝐻2𝑆 =  190

𝑚𝑜𝑙𝑒𝑠

𝑠

𝑚2
.  

If the system in question is a 1m3 cube filled with this solution, and if we assume a 1 g/cc density then the 

total moles of each species becomes: 𝐶𝑂2 −  16.3
𝑚𝑜𝑙𝑒𝑠

𝑚3
𝑠𝑜𝑙𝑢𝑡𝑖𝑜𝑛, 𝐻 +  − 0.12

𝑚𝑜𝑙𝑒𝑠

𝑚3
𝑠𝑜𝑙𝑢𝑡𝑖𝑜𝑛 and 𝐻2𝑆 −

 15.3
𝑚𝑜𝑙𝑒𝑠

𝑚3
𝑠𝑜𝑙𝑢𝑡𝑖𝑜𝑛. 

Dividing the concentration by its maximum flux yields: 𝐶𝑂2 –  46.6
𝑠

𝑚
 0.0214

𝑚

𝑠
, 𝐻 + − 0.029

𝑠

𝑚
 34.5

𝑚

𝑠
 

and 𝐻2𝑆 –  0.805
𝑠

𝑚
 12.4

𝑚

𝑠
. Pull the species mobilities from the report: 𝐶𝑂2 −  2.63𝑒 − 9

𝑚2

𝑠
, 𝐻 +

 − 1.13𝑒 − 8
𝑚2

𝑠
 and 𝐻2𝑆 −  2.45𝑒 − 9 𝑚.  
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 Refinery Applications  

Introduction 

This section contains refinery and production applications of the OLI Studio.  

 

Contents 
 Refinery Applications .........................................................................................................................1 
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List of amines and amine hydrochlorides in the existing OLI V9.5.2 database 

Descriptive name Chemical formula OLI Formula OLI Tag Cation name Amine Hydrochloride name OLI Tag Name for 
hydrochloride 

Alkyl amines       

Methylamine CH3NH2 CH3NH2 MEAMINE MEAMINEHION Methylamine hydrochloride MEAHCL 

Dimethylamine (CH3)2NH C2H7N DMEA DMEAHION Dimethylamine hydrochloride DMEAHCL 

Trimethylamine (CH3)3N C3H9N TRIMEAMINE TRIMEAMHION Trimethylamine hydrochloride TMEAHCL 

Ethylamine CH3CH2NH2 C2H7N ETAMINE ETAMINEHION Ethylamine hydrochloride EAHCL 

Diethylamine CH3CH2NHCH2CH3 C4H11N DIETHYLAMN DIETHYLAHION Diethylamine hydrochloride DEAHCL 

Propylamine CH3(CH2)2NH2 C3H9N PROPYLAMN PROPAMHION n-Propylamine hydrochloride PROPAMHCL 

Butylamine CH3(CH2)3NH2 C4H11N BUTYLAMINE BUTYLAMHION Butylamine hydrochloride BUTAMHCL 

2-Butanamine CH3CH2CH(CH3)NH2 C4H11N SECBUTYAMN SECBUAHION 2-Butylamine hydrochloride SECBAHCL 

Cyclohexylamine c-(CH2)5CHNH2 C6H13N CYCLHEXAMN CHEXAMNHION Cyclohexylamine hydrochloride CHEXAHCL 

Ethylenediamine H2N(CH2)2NH2 C2H8N2 ENAMN2 ENAMN2HION Ethylenediamine dihydrochloride ENAMN2HCL 

       

Alkanolamines       

Ethanolamine HO(CH2)2NH2 NH2C2H4OH MEXH MEXH2ION Ethanolamine hydrochloride MEXHCL 

Diethanolamine HO(CH2)2NH(CH2)2OH  HN(C2H4OH)2 DEXH DEXH2ION Diethanolamine hydrochloride DEXHCL 

Dimethylethanolamine  (CH3)2N(CH2)2OH C4H11NO DMEXH DMEXH2ION   

Diglycolamine HO(CH2)2O(CH2)2NH2  NH2C2H4OC2H4OH DGXH DGXH2ION   

Dimethylisopropanolamine HOCH(CH3)CH2N(CH3)2 C5H13NO DMIPA DMIPAHION Dimethylisopropanolamine 
hydrochloride 

DMIPAHCL 

Methyldiethanolamine CH3N(C2H4OH)2 C5H13NO2 MDEXH MDEXH2ION   

       

Oxygenated amines       

3-Methoxypropylamine H2N(CH2)3OCH3 C4H11NO MOPA MOPAHION 3-Methoxypropylamine hydrochloride MOPAHCL 

Morpholine c-(CH2)2O(CH2)2NH C4H9NO MORPHOLN MORPHHION Morpholine hydrochloride MORPHHCL 

N-Methylmorpholine c-(CH2)2O(CH2)2NCH3 C5H11NO NMM NMMHION N-methylmorpholine hydrochloride NMMHCL 

N-Ethylmorpholine c-(CH2)2O(CH2)2NC2H5 C6H13NO NEM NEMHION N-Ethylmorpholine hydrochloride NEMHCL 
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8.1 – NH4Cl Vapor Solid equilibrium 

Overview 

The following example will illustrate one of the elements associated with overhead corrosion, salting of 
components from the vapor phase to form a solid.  In this simple example, you will precipitate ammonium 
chloride, NH4Cl, from a vapor by cooling a gas.  This salting mechanism is also called desublimation. 

Creating the Process 

Add the stream 

✓ Double-click on the Add Stream object in the Actions Panel -  

✓ Name the stream Salting – press F2 to edit the name -  

✓ Change the thermodynamic framework to MSE.  Do this by clicking on the MSE-FW button in 

the toolbar -  

✓ Enter the following components to the grid, NH3 HCl, and CH4. 

✓ Set the NH3 and HCl values to 1 mole, the CH4 to 100 moles and the water to zero. 

 

The reason for adding the methane is to create a vapor phase.  The NH3 and HCl will then represent partial 
pressures in this methane vapor.  In this case NH3 and HCl are each 1/102 or 0.0098% of the total inflows, 
and if the calculation is 100% vapor, then their partial pressures will be 0.0098 atm (that the total pressure 
is 1atm). 

Note also, that water (H2O) is set to zero.  This prevents a water phase from condensing and dissolving any 
NH4Cl salt that may form.  Thus, the only phases possible for these inflows are a vapor and a solid phase. 
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Calculate conditions at 25 C 

✓ Add a Single point calculation by double-clicking on Add Single Point in the Action panel. 

 

✓ Press the Calculate button. 

✓ Click on the Report tab to view the results. 

✓ Scroll down to the Total and Phase Flows (Amounts) table. 

The software computed that 1 mole of solid (specifically, 0.999999) and 100 moles of vapor are present.  
Under these conditions the NH4Cl solid phase is stable, and nearly all the NH3 and HCl added is present as a 
solid phase 

 

✓ Scroll down further to the Species Output (True Species) table. 

There are four components.  The two main phases are methane gas and ammonium chloride solid.  There is 
also NH3 and HCl in the vapor phase but virtually all of it has precipitated.  The remaining amount of NH3 
and HCl in the vapor is small, about 1/106 the total moles added.   

 

Thus, at 25C, the fraction of NH3 and HCl in the vapor phase is 9.84e-7 moles.  The total vapor moles is 100. 

The NH3 and HCl vapor fraction is 9.84e-9 mol/mol, or PNH3=PH2S=9.84e-9 atm when in equilibrium with the 

solid phase at 25C and 1atm. 
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Calculate conditions at 250 C 

✓ Return to the Definition tab. 

✓ Set the temperature to 250 C. 

✓ Calculate. 

✓ Return to the Report tab and scroll down to the Species Output (True Species). 

The system is now all vapor and 100% of the NH3 and HCl are in the gas phase.  The partial pressures are 
0.098 atm for each. 

 

Thus, we can compute the temperature dependence of NH4Cl stability.  At 25C, NH3 and HCl have stable 
partial pressures of ~1e-6 atm.  at 250 C, the stable partial pressures are at least 0.0098 atm.  It may be 
higher, because there is no NH4Cl solids present.  In other words, the NH3 and HCl partial pressures can 
increase further before a solid forms.  The exact increased amount would need to be computed. 

Calculate conditions at 25 C when excess water is present 

✓ Return to the Definition tab. 

✓ Set the temperature to 25 C. 

✓ Enter a water value of 10 moles. 

 

✓ Calculate. 

✓ View the Summary section of the screen – note that the Phase Amounts are now Aqueous and 
Vapor.  There is no longer a solid phase. 
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Note that the pH is low, 3.58.  This is for two reasons.  First, dissolved NH3 and HCl is a solution of a weak 
base and a strong acid.  What this means is that the amount of H+ generated from HCl is greater than the 

amount of OH generated from NH3.  Consequently, the pH is low: pH-log(H+). 

 

Second, HCl is more soluble than NH3 in water.  Therefore, the H+ concentration is further increased.  

✓ Click on the Report tab and view the HCl and NH3 amounts in the vapor phase. 

 

The NH3 amount in the vapor is 1.64e-5 moles.  By comparison, the HCl amount is 6.2e-8 moles, nearly 1000 
times less.  This is evidence of the solubility difference in water 

Calculate conditions at 25 C when limited water is present 

✓ Change the water value to 3 moles. 

 

✓ Calculate. 

✓ View the Summary section of the screen – There are now three phases. 

 

✓ The pH is also lower, 3.0. 

 

The pH is lower because the solution is more concentrated with NH3 and HCl.   

✓ Click on the report tab and view the Species Output table 

The NH3 and HCl in the gas, liquid, and solid phase are in equilibrium with each other.  The amounts of NH3 

and HCl in the gas phases is 4.6e-6 and 2.2e-7 moles.  The total gas amount is 102.5 moles, and thus their 
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partial pressures is 4.6e-8 and 2.2e-9 atm, respectively.  These partial pressures are in equilibrium with the 

0.933 moles of NH4Cl that formed and with the dissolved NH3 and HCl.   

 

✓ Save the file with the name Chapter 8 – Refinery cases 

Summary 
This is the basis of the amine-hydrochloride salting from the vapor and the subsequent dissolving in water 

when that phase becomes present. 
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8.2 – NH4Cl solubility in water vs. temperature 

Overview 

The following example illustrates the temperature effects on amine-hydrochloride solubility and its impact 
on the salt dew point and the resulting pH.   

Creating the Process 

Study NH4Cl solubility in water  

✓ Create a new stream and label it NH4Cl Solubility -  

✓ Change the framework to MSE  -  

✓ Add NH4Cl to the inflow grid.  Give it no value. 

✓ Click on the Units Manager button in the Toolbar -  

✓ Change the units to Metric – Batch – Concentration   

 

✓ Add a Survey calculation  

✓ Name it Solubility vs. T -  

✓ Click on the Specs button in the upper right -  

✓ Click on the Calculation Type category -  

✓ Change the Type of Calculation to Precipitation Point -  

✓ Select Sal Ammoniac as the solid to precipitate and ammonium chloride as the material to add - 
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When complete, the screen should look like this: 

 

✓ Click OK and calculate. 

✓ Click on the Plot tab – the plot will be the NH4Cl solubility. 

✓ Click on the Variables button and expand the Additional Stream Parameters category. 

✓ Add the pH to the Y2 axis.  

The dissolved NH4Cl concentrations increases with temperature from 300,000 mg/l at 25C to about 

460,000 mg/l at 100C  The pH decreases from 4.1 down to about 2.8 over the same range.   

 

The calculation you ran is called a Precipitation Point.  You instructed the software to add sufficient 

molecular NH4Cl to the water until a small amount of NH4Cl solid forms (~20 g/l).  The amount of NH4Cl 
added is the saturation concentration, and is what gets plotted.   

Investigate the water composition more deeply 

✓ Click on the Variables button to access the Plot Variables 

✓ Remove everything from the Y1 and Y2 axes 

✓ Expand the Liquid-1 category 

✓ Add the Cl-1 to the Y1 axis and NH4+1 to the Y2 axis 



8-10  Chapter 8 Refinery & Other Applications Tricks of the Trade 

 

✓ Close the window and view the plot 

The concentrations of the Cl-1 and NH4
+1 ions increase proportionally.  Because of the mole weight 

difference (Cl-1 = 35.45 g/mole and NH4
+1=18.04 g/mole), the dissolved chloride is about twice the 

concentration of ammonium.   

 

The plot instructions will stop here, but you are welcome to investigate further the variables that are 
available to plot.  

Try amines important to your process 

✓ Click back on the Definition tab. 

✓ Change the Names manager selection to OLI Tag -  
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✓ Enter one of the amine-hydrochlorides from the list on the second page.  Add it to the cell below 
the NH4Cl inflow.    

The last column of the Page 8-2 table contains the OLI Tag Name for the amine hydrochloride.  This is the 
most convenient way (fewest letters) to enter the names.  So, it is our recommendation that you enter the 
names this way to minimize potential error. 

The amine used in the images below is MEAHCl.   

 

✓ Change the Adjusted Inflow and Precipitant to match the component you added. 

 

✓ Calculate. 

✓ Click on the Plot.   

✓ Open the Variables window  -  

✓ Remove the existing Y1 and Y2 axis variables. 

✓ Open the Inflows category and move the component you added to the Y1 axis. 

  

✓ Add pH to the Y2 axis if not there.  It is found in the Additional Stream Parameters category. 

✓ Close the window and view the amine-HCl solubility and solution pH. 
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In the example above, MEAHCl solublity in water is between 1.05x106 and 1.65x106 mg/l.  This may seem as 
unrealistic, initially, however since the density of this fluid is well above 1, it is reasonable to have 
concentrations above 106 mg/l.  Confirm this now 

✓ Return to the Variables window, and remove the pH variable from the Y2 axis 

✓ Expand the Liquid-1 category and add H2O to the Y2 axis. 

The H2O concentration in the liquid decreases from 827,000 mg/l to 478,000 mg/l.  At 25C, for example the 
total mass of MEAHCl and H2O in the liquid is 827000+1470000 
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✓ Click on the View Plot button in the upper right to view the calculated data   

At each temperature, the total concentration per liter is the sum of the MEAHCl and H2O.  These values 

approach about 1.8e6 mg/l.  That puts the density of the liquid at about 1.8 g/ml. 

 

✓ Confirm this.  Reopen the Variables list and expand the Additional Stream Parameters category 

✓ Add the Density, Liquid-1 to the Y1 axis. 

✓ Close the window and view the results  

You can see that the density varies from 1.8 g/l to 2.2 g/l, a fairly dense electrolyte liquid. 

 

✓ Repeat these step for some of the other amine hydrochlorides.    



8-14  Chapter 8 Refinery & Other Applications Tricks of the Trade 

8.3 – NH4Cl Salting in an Overhead Stream 

Overview 

The following example uses a 1-kg hydrocarbon gas phase containing NH3 and HCl to show how the 
software computes the NH4Cl precipitation. The dew point temperature of this stream is about 102 C.  
Above this temperature a dry NH4Cl solid precipitates.   Below this temperature liquid water forms and the 
NH4Cl solids that formed dissolve in it.  As a result the plots generated from this calculation show a 
transition from a dry solid to a wet salt (ionic liquid) and eventually to a dilute boot water stream. 

Creating the overhead stream 

8.3 NH4Cl Salting in an Overhead Stream 

Stream Name CTO Inflow Mass %  Inflow Mass %  

Names Style Display NH3 0.001 Hexane 8 

Units Set Mass Fraction HCl 0.001 Heptane 11 

Framework MSE Propane 2 Octane 10 

Stream Amount (kg) 1  butane 5 Nonane 10 

Temperature (C) 125 Pentane 6 Decane 11 

Pressure (atm) 1   Dodecane 13 

✓ Add a new stream  

✓ Rename the stream ‘CTO’  

✓ In the toolbar, select the 2nd Liquid phase and the MSE button. 

 

✓ Select the Units Manager  then use the third dropdown list to select Mass Frac. 

 

✓ Press OK. 

✓ Change the Temperature to 125 C. 

✓ Enter the components and inflows (mass%) from the table above.  

✓ Save the file. 
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CTO streeam with the Formula View and standard Display Name view  

✓ Add a Survey calculation  

In this calculation, we will fix the temperature and vary the total system energy. To see what phases form, 
we will look at a broad temperature range. Later, we will focus on specific production conditions. 

✓ Press the <F2> key to rename the survey object ‘Temperature Survey’  

The screen looks identical to the original stream, except the inflow cells are now colored yellow (un-

editable) and there is a calculations section in upper right.   

The default survey is temperature.  The default temperature range is 25 C to 100 C by 5 C increments (see 

the summary section).   

 

This will be modified to start at 125 C and decrease to 60 C. 

✓ Select the Specs button and change the Survey Range to: 

Temperature Survey 

Start 125 

End 60 

Decrement  0.5 

Your window should look like the following: 
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✓ Press OK then Calculate. 

✓ Select the Plot tab. 

✓ Right-click on the Y1 Axis and select the Logarithmic scale. 

 

The plot that is produced contains the calculated mass of each phase.  Gas is the dominant phase at high 
temperatures and oil dominates at low temperatures.  The water phase increases exponentially over a 
twenty-degree range (105 C to 85 C). 

’ 

According to the calculations, a solid phase forms at 107 C and disappears (dissolves into the water) at 102 
C.  A water phase (Liquid-1) condenses at 102 C forms.  As temperature decreases, the water mass 
increases from ~1.5e-5 kg (@102 C) to ~0.232 kg (@60 C). 
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The Naphtha phase (Liquid-2) condenses at 122.5 C and increases as temperature decreases.  Likewise the 
gas flow decreases as it cools.   You can also view the calculated data instead of the viewing the plot using 

the View Data button.    

The solids phase is NH4Cl although it is not obvious from this plot.  So we will change the variables.   

Saving to the Plot Template Manager  

Before changing the plot, save the current plot parameters as a template for later use.  

✓ Enter the name Tower Overhead Flow in the Plot Template Manager panel (lower left panel)   
and press the Save button. 

   

Modifying the plot 

✓ Click on the Variables button in the upper right   

✓ Remove all the variables from the Y1 axis. 

✓ Expand the Solid category and add Ammonium chloride to the Y1 axis.   

✓ Expand the Additional stream parameters section and add pH to the Y2 axis. 

  

The Y1 and Y2 fields should look like this: 

 

✓ Press OK and view the plot. 

✓ Change the Y1 axis back to linear by right-mouse-clicking on the axis and selecting Logarithmic 
Scale (it is checked and this will uncheck it). 



8-18  Chapter 8 Refinery & Other Applications Tricks of the Trade 

 

The plot isn’t that convenient to look at because the solids units are mass%, which is mass% of the total 
solid mass.  To view it with more clarity you will change the Solids units to mass.   

✓ Click on the Units Manager button in the Toolbar ribbon -  

✓ Click on the Customize button  

✓ Then change the Solids Composition from Mass Fraction to Mass  

 

✓ Close the windows to view the plot. 

✓ Click OFF the Plot (e.g. to Definition) and Click back on again – this is needed to update the plot 
units. 

 

As temperature decreases the NH4Cl mass increases until water starts to condense.  At this point, the 
NH4Cl dissolves into the water phase.   
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At the water condensation temperature (102 C) the computed water pH is 2.5, acidic.  The pH increases 
slightly to about 4 as the temperature decreases to 91 C.  Then it increases sharply below this temperature.  
The cause of the sharp increase is the exponential increase in water mass which dilutes the dissolved HCl. 

✓ Save the file  . 
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8.4 – Creating an Accumulator Inlet Stream 

Overview  

The purpose of this section is to show you how to create the overhead stream. An overhead stream is 
created by combining the exit streams from the accumulator.  These streams include the Naphtha, Off Gas, 
and Boot Water. The composition and flow rate of each stream is required for this procedure to work.    

You will create three analysis objects; a gas, an oil and a water.  You will also use the Studio: ScaleChem 
analysis tools; Add Gas, Add Oil and Add Brine.   

Creating the Brine Analysis object – The boot water analysis 

✓ Click on the Add Brine Analysis object in the Actions panel - .   

✓ Label the object Boot Water. 

✓ Click the MSE framework button   in the menu bar. 

✓ Select the So and 2nd buttons -  in the menu bar. 

✓ Type in NH4+ in the first available cation cell and enter a value of 25 mg/l. 

✓ Enter Cl-1 concentrations of 49 mg/l. 

✓ Select the Show Non-zero button. 

The screen should look like the one below. 

 

✓ Click on the blue Reconcile tab (it’s a vertical tab) 

✓ Click on the Allow Solids to form button 

✓ Press the Calculate button 
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The software computes that this simple ammonium chloride salt solution is slightly acidic.  

Adding the Off-Gas analysis 

✓ Add a new Gas Analysis  

✓ Rename it ‘Off-Gas’. 

 

✓ Make sure the MSE button is selected   

✓ Click on the Standard button in the Template Manager and change to to Expanded. 

    

The Expanded Template contains a larger hydrocarbon list.  This eliminates the need to enter all the 
component names manually.  But you will have to add Hydrogen to the bottom of the list. 

✓ Enter the following Off Gas composition: 

Gas Composition  (mole %)  Gas Composition  (mole %) 

Hydrogen 2.5  Isobutane 9.7 

Nitrogen 4.6  n-Butane 16 

Carbon dioxide 2.5  Isopentane 5.3 

Hydrogen sulfide 0.5  n-Pentane 4.3 

Methane 19.4  n-Hexane 3.45 

Ethane 12.35  n-Heptane 0.3 

Propane 19.  n-Octane 0.1 
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✓ Click on the Reconcile tab and press Calculate. 

✓ Look to the right of the screen at the Summary table – confirm that the system is 100% vapor. 

Adding the Naphtha analysis 

✓ Add a new Oil Analysis  

✓ Rename it ‘Naphtha’. 

 

✓ Make sure the MSE button is selected. 

✓ Enter the following Naphtha composition: 

Naphtha Composition  (mole %)  Naphtha Composition  (mole %) 

Methane 0.12  n-Hexane 17.5 

Ethane 0.3  n-Heptane 18.4 

Propane 0.78  n-Octane 15.2 

Isobutane 2.5  n-Nonane 15.4 

n-Butane 1.7  n-Decane 12.2 

Isopentane 4.9  Carbon dioxide 0.2 

n-Pentane 10.7  Hydrogen sulfide 0.1 

✓ Click on the Reconcile tab and press Calculate. 

✓ Look to the right of the screen at the Summary table – confirm that the system is 100% liquid-2. 

Create an Accumulator 

✓ Add a Saturator object and rename it ‘Accumulator’  

✓ Add the following boot water, off-gas, and naphtha flows to the Inlets grid: 

Phase type Phase Name Flow Rate units 

Brine Boot water 400  m3/day 

Gas Off-gas 30  std E3m3/day 

Oil Naphtha 15000  std m3/day 

Your screen should look like the one below. 

 

✓ Set the Accumulator conditions to 55 C and 1.7 bar. 
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✓ Calculate. 

✓ Review the Report. 

 

According to the calculations, the boot water pH is 4.4 and the calculated gas and liquid volumes are 
consistent with what was added.  Review the phase volumes and compare it to what you added.   

Phase  Input  
volume 

Calculated  
volume 

Units 

Boot Water 400 393.3 m3/day 

Off Gas 30 34.1 Std E3m3/day 

Naphtha 15000 15010 Std m3/day 

The boot water volume has decreased and the off-gas and naphtha increased.   This is the result of water 
partitioning to the vapor and oil phase.  The input H2O for off gas and naphtha is 0%.  The computed 
fraction is shown in the table below.  This partitioning contributed to the calculated H2O volume reduction 
and hydrocarbon volume increase.  It is a small, but quantifiable change. 

Phase  Input  
H2O  

Calculated  
H2O 

Units 

Off Gas 0 9.3 mole% 

Naphtha 0 0.24 mole% 

By comparison, the hydrocarbon components also partition to the water phase.  According to the software 
calculation the boot water has as much dissolved organics (~32 mg/l), H2S (55 mg/l), and CO2 (as 123 mg/l 
HCO3-1), as the measured NH4+ and Cl-.  

 

All this is to explain that what may be measured in a standard analysis can be an incomplete 
representation.   
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Modeling the overhead cooling process 

✓ Add a Scale Scenario object and name the object Overhead. 

✓ Add the Accumulator output to the Overhead as follows: 

o Type=Whole Fluid, Name= Accumulator, and Flow= <Automatic> 

 

This brings in the output from the Accumulator into the overhead.  Essentially, we are modeling the flow in 
reverse.  But, since mass is presumed to be conserved from the top of tower (or from a wash water point) 
to the accumulator outlet, this is an acceptable approach. In this scenario we assume that there is no wash 
water and that mass is conserved from the top tray to the accumulator. 

✓ Click on the Conditions Tab. 

✓ Label the first condition Top Tray (type this name) and set the conditions to 130 C and 2.1 bar. 

✓ Label the second condition Accumulator (type this name) and set the conditions to 55 C and 1.7 
bar. 

 

✓ Set the Auto Step field to 75  and click on the Go button. 

This will put 75 calculations between the two conditions, and set the temperature decrement to 1 C and 

the pressure decrement to ~0.053 bar. 

 

✓ Click on the Solid tab and Check the All box 

 

✓ Calculate. 
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The software will now compute the properties at each temperature, and we will look to see how the phase 

amounts change and if any solids form. 

✓ Click on the Plot tab. 

The default plot is the “Scale Tendencies” of any potential solids.  A scale tendency is the driving force for a 
solid to form.  If the value is greater than 1, then the solid can precipitate.  If it is below 1, the solid is 
subsaturated and will not form. 

According to these results, one form of NH4Cl is computed to be supersaturated (S>1) and will form, given 
enough time. 

 

It is impractical to know at what condition the NH4Cl is occurring because the x-axis is the Location name, 
and they are bunched together.  Therefore, we will need to change the X-axis variable to temperature. 

✓ Click on the Variables tab in the upper right  -  

✓ Expand the Stream Parameters category – the Temperature variable is there - 

 

✓ Highlight the Temperature variable and add it to the X-axis using the >> double arrows. 

 

✓ Close the window and review the plot. 

✓ Mouse over the highest point of the NH4Cl curve. 

The marquee above the plot will display the point information.  The NH4Cl solid has a saturation of 1.17 at 
103 C.  It is at this temperature that the software predicts that NH4Cl will precipitate. 
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✓ Click on the Variables button again -  

✓ Delete the existing variable in the Y1 axis by double-clicking on it. 

✓ Expand the Phase Flow Properties category and select the Mass for all four phases, Liquid-1, 
Liquid-2, Solid, and Vapor (do not select Total)   

  

✓ Close the window. 

 

The four phases are shown, however they have different magnitudes.  Therefore, the plot is better viewed 
with a logarithmic Y-axis.    

✓ Right-mouse-click over the y-axis values (any value, but it must be within that vertical field).   

✓ Select Logarithmic Scale.  
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It is now easier to see the progression between the NH4Cl solids and the water phase.  According to the 
software, the critical temperatures begin at 103 C and end at 92 C.  At 91 C, the water volume increases 
exponentially, essentially flushing the system. 

This temperature range is more substantive if the pH is plotted along with it.  Therefore, you will plot the 
pH on the Y-2 axis. 

✓ Open the Variables window again and expand the Additional Stream Parameters category.. 

✓ Add pH to the Y-2 axis.  

  

✓ Close the window and view the plot. 

This plot shows that at 103 and 102 C, a dry NH4Cl solid phase is present.  Below 102 C, water condenses 
and the NH4Cl solid dissolves. 
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This plot also shows that between 101 C and 93 C the pH is flat at 2.2 and as the temperature drops to 91 C, 
the pH increases to 3.7.  Thus, it is this lower end of this reverse S-shaped curve that is the potential region 
for aggressive corrosion.  Below 92 C, there is substantial condensation, diluting of the dissolved ions, and 
increasing the pH. 

This can be seen again by plotting the dissolved NH3 and HCl- concentrations. 

✓ Open the Variables window again. 

✓ Remove all the variables from the Y-1 axis. 

✓ Scroll to the bottom of the Category list to the Molecular apparent – Liquid 1.  

✓ Open it and add NH3 (ammonia) and HCl (hydrogen chloride) to the Y-1 axis. 

  

The new plot shows that between 103 C and 93 C, the concentrations of NH3 and HCl are above 100,000 
mg/l.  When the system cools to 91 C, the concentrations have dropped to about 400 mg/l.   Thus, it is this 
high concentration (saline) and low pH condition between 101 C and 93 C where the water is aggressive to 
carbon steel. 
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8.5 – Overhead case using an Assay for Naphtha 

Overview 

This case uses OLI Studio: ScaleChem objects. The Studio ScaleChem tool was designed to work with 
upstream oil and gas production. However, we have found that it is useful as a tool for refinery applications 
as well.  

The calculation objects we will use are the Brine, Gas, and Oil Analysis and the Saturator. We will start by 
creating accumulator output analyses (off gas, boot water, and naphtha). We will combine these analyses 
at their proper flow rates into the saturator object. At that point, we will transfer the results to another 
Studio ScaleChem object, the Facilities calculation, to complete the remaining work.  

Available Data 

The table below contains the compositions for the three phases we will use in this section. The table shows 
hydrocarbons as displays names and with their Names Dictionary names (if enabled).  

Table 1 - Compositions of Brine (left), Gas (middle), and Oil (right) analyses 

Boot water mg/l  Off Gas mole%  Naphtha Values 

Cations   Nitrogen 4.5  Name Naphtha 

NH4+ 36  Carbon dioxide 1.7  Mole% 100 

Anions   Hydrogen sulfide 1.2  Type ASTM D86 

Cl-1 30  Methane 5.7  Thermo  API-8 

SO3-2 32  Ethane 6  Density 63 

HS-1 6  Propane 22  Density units API Gravity 

HCO3-1 15  Isobutane 12  No. of Cuts 13 

Neutrals   n-butane 26  Volume% Temp. C 

Propionic acid 10  Isopentane 8  1 45.8 

n-butanoic acid 25  n-pentane 7  5 67.4 

Ethylenediamine (ENAMN2) 15  n-hexane 5  10 81.3 

2-Dimethylaminoethanol (DMEXH) 15  Hydrogen 0.3  20 102.4 

2-Aminoethanol (MEXH) 30  Ethene 0.2  30 119.8 

3-Methoxypropylamine (MOPA) 5  Propene 0.15  40 135.4 

   Trans-2-butene 0.02  50 151.7 

   1-butene 0.04  60 169.5 

   Cis-2-butene 0.02  70 188.6 

   Isobutylene 0.17  80 209.1 

      90 232.5 

      95 247.9 

      100 255. 

Adding the Boot Water analysis 

✓ Continue working in the Chapter 8 file or start a new file called ‘Crude Tower Off Gas’. 

✓ Add a new Brine Analysis by selecting the icon from the Actions pane or 
from the menu bar Streams > ScaleChem > Add Brine. 

✓ Rename the brine Boot Water  

✓ Click the MSE framework button   in the menu bar. 
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We should not have to select the MSE button again. However, we should check to see it is enabled while 
adding other objects.  

✓ Select the So and 2nd buttons -  in the menu bar. 

✓ Type in NH4+ in the first available cation cell and enter a 36 mg/l value. 

✓ Enter the remaining anion concentrations (Cl-1 at 30mg/L, HCO3-1 at 15mg/L, SO3-2 at 32 
mg/L, and HS-1 at 6 mg/L). You will have to add the SO3-2 anion to the list. 

✓ Add the neutral species and their concentrations from Table 1. 

✓ Select the Show Non-zero button. 

The screen should look like the one below. 

  

Adding the Off-Gas analysis 

✓ Add a new Gas Analysis  

✓ Rename it ‘Off-Gas’. 

 

✓ Make sure the MSE button is selected   

✓ In the Design tab, change the Template Manager to Expanded. 

 

✓ Select the Normalize Options button and change to Prorate. 
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✓ Change the Display button to Display Name. 

 

✓ Enter the Off Gas composition from above. 

✓ Stop at n-Hexane [nc6]. 

We will need to type in the names of the last seven inflows. 

✓ Type in the component names from Hydrogen to Isobutylene from Table 1. 

✓ When finished, select the Show Non-zero Only button. 

  

Adding the Naphtha analysis 

✓ Add a new Oil Analysis  

✓ Rename it ‘Naphtha’ 

 

✓ Make sure the MSE button is selected.  
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In some versions of the OLI Studio: ScaleChem, an inconvenience occurs when switching from the Aqueous 
to the MSE frameworks. There will be red x’s, which are components not recognized in the MSE database. 
These inflows have to be deleted before proceeding. 

✓ Select the Combined tab if not already there  

✓ Select each of the red x’s and press the delete key.  

 

We can now proceed with our work. 

✓ Select the Assay tab.  

 

✓ Enter the name ‘ASSAY’ in the Component cell and give it a value of 100%. 

 

✓ Enter the data from Table 1. 

The screen should look like the one below: 

 

✓ Select the Display Assay Cuts button. 

The calculated Assay properties are generated. The data shown in the main table are the critical properties 
the boiling point, density, and molecular weight for each cut. The name, e.g., NAFTA_254K is constructed 
from the name you entered plus the normal boiling point in Kelvin.   

There are a series of tabs below this table. These tabs contain the thermodynamic properties for each assay 
cut. We can select any of these tabs to view this data in more detail. 
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At this point, we should have entered all of the experimental data. Now we will create a representative 
overhead gas. 

The process to model 

The simple schematic below is the process to be modeled. The diagram contains the flow rates for each 
output and the naphtha reflux. The diagram also shows the estimated output temperature and pressure at 
each process point. 

 

Creating a Saturation object to model the accumulator 

The Studio ScaleChem Saturator object works effectively as an isothermal mixer. It accepts volumetric flows 
from multiple inlet streams and generates a single output. This is what the Accumulator represents if it 
were to be modeled in reverse flow. 

✓ Add a Saturator object and rename it ‘Accumulator’  

We will now modify the units. 

✓ Select the Units Manager object -  

o Select the Customize button. 

o Select the Parameters tab.  

o Change the Pressure units to bar.  

 

o Change the time units to day. 

 

o Select the Inlets tab -  

o Change ALL the flows to match the table below: 

 

✓ Press OK twice to exit the Units Manager (some clients may have to restart the software to 
enable the new units). 



Tricks of the Trade  Chapter 8 Refinery Applications 8-35 

✓ Use the Type, Name, and Flow cells to enter the three outlets as inlets to the accumulator: 

Type Name Flow Units 

Oil Naphtha 600 Std m3/day 

Gas Off Gas 1.5 Std E3m3/day 

Brine Boot Water 15 m3/day 

The screen should look like the one below:  

 

✓ Enter the accumulator output conditions of 60 C and 1.6 bar.  

 

We are not creating a custom refinery units set in this chapter. Creating such units would eliminate the 
constant clicking on the Units Manager button. The instructor can detail how to create custom refinery 
units after this application. 

✓ Select the Solids tab and then check the All box  

 

✓ Press the Calculate button.  

The software will first compute reconciliation and other calculations for the Brine, Gas, and Oil analysis 
objects. Once these objects converge, the Saturator object will calculate.  

As each object is calculated, a green check will appear next to its icon in the Navigator pane. This assures 
that the calculations are complete. 

 

✓ Review the Report.  The summary and properties should look like the following: 
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Notice that in this case, the calculated off-gas volume is different from the value entered.  This is in part 
because of mixing between the vapor and the liquid. 

✓ Save the file. 

Studying the overhead gas properties across the production line 

The mass does not change from the tower overhead to the accumulator in this simple process. Such a 
simplification enables us to limit the modeling complexity. We will continue with the simulation by using 
the Facilities object to model different points in the production line. We are now modeling the following 
section of the process. The temperature and pressures are now annotated on the diagram. 

 

Simulate the cooling using the Facilities Calculation object 

The Facilities calculation object is a pseudo-process simulator. This object allows the user to add and 
separate streams at various process points. This object is ideal for the case we are studying.  

The facilities object uses the term Node to represent different locations in a process. A node can represent 
a specific process unit or simply a location along a pipe. Nodes are isothermal calculations. Node Outputs 
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can be set up as a separator, in which each phase moves to a different location, or it can be set so that all 
phase remain together. 

✓ Add a Facilities object and label it ‘Overhead’. 

 

✓ Select the 2nd Liquid button (it may already be checked) - .  

✓ Confirm that the volumes are in m3 and pressure in bar.  If not, the select the Units Manager 
and choose Scale Metric-Flowing-Conc.  If you are using an OLI Studio version below V9.3.2 
then you may need to do additional units editing through the Customize window. 

We are ready to add the process nodes to the object. 

✓ Select the Add button to add the first Node -  

✓ Double-click the node box change its name to ‘Tower Top’.  

 

✓ Enter the temperature and pressure of the tower top in the cells provided. 

 

✓ Select the Type cell and select Whole Fluid. 

✓ Select Accumulator [MSE] as the Name. 

✓ Keep the <Automatic> flow.  

The screen should look like the one below: 

 

✓ Create a new Node and rename it ‘Fan Inlet’. 

✓ Enter the temperature and pressure of the fan inlet – 155 C and 2.4 bar. 

✓ Enter the Fan Inlet streams.  

o Select the Type cell and select Whole Fluid From. 

o Select Tower Top as the Name. 

This action takes the fluid from the Tower Top node and sends it to this node. The screen should now show 
that the Tower Top stream is flowing into the Fan Inlet.  
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The lower section should look like this. The type is Whole Fluid from and the Name is Tower Top.  Notice 
the units are unimportant here, since the flow rate is defined in the tower top object. 

 

✓ Add a new node and rename it ‘Fan Outlet’. 

✓ Enter the conditions 120 C and 2.1 bar. 

✓ Select Whole Fluid from in the Type Cell and Fan Inlet in the Name cell. 

The top of the screen should now look like the one below:  

 

The grid section should look like this:  

 

✓ Repeat the steps for the three remaining nodes, Trim Cooler Inlet, Trim Cooler Outlet, and 
Accumulator.  

This is the screen after the Trim Cooler Inlet is complete: 

 

 

This is the screen after the Trim Cooler Outlet is added:  
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This is the screen after the Accumulator inlet is added. Notice that the Separate Gas, Oil, and Solids boxes 
are checked, and that four arrows exit the node. 

 

 

✓ Select the Solids button.  

✓ Select the ALL button, so that any solid that can precipitate will form. 

 

✓ Save the file. 

We are now ready to calculate. 

✓ Calculate.  

✓ View the Report tab. 
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✓ Scroll down the report and view the phase property table, specifically the solids mass.   

Some report sections contain a solids column, and others will not.  For example, the tables below are for 

the Fan Inlet location.  The software computes 0.32 kg/day of Ethylenediamine-HCl solids at this location. 

 

The Fan outlet report shows that there is a water phase present.  Its pH is 3.5 and there are still solids that 
form; 0.25 kg/day.  
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Perform the same calculation using a multi-point survey 

There is a more intensive way to run this calculation, but additional information is obtained.  You will create 

a stream from the accumulator calculation, and add a Survey calculation to it.  Then you will set this survey 

calculation to perform one hundred calculations and small temperature changes.  

✓ Right-mouse click on the Accumulator and select Add as Stream.  

✓ Click on the new stream and change the units to Metric-Flowing-Mass. 

Then click on Customize and change the Mass to Kg, the volume to m3, time to day, and pressure 
to bar. 

  

✓ Add a Survey calculation. 

✓ Change the Then-by survey to Pressure. 

✓ Click the Together Vary button. 

 

✓ Click on the first Specs button in the upper right. 

o Set the starting temperature at 170 C. 

o Set the end temperature to 60 C. 

o Set the decrement to 1 C. 

✓ Click on the Pressure category. 
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o Set the starting Pressure to 2.5 bar. 

o Set the end temperature to 1.6 bar. 

o Set the number of steps to 110. 

 

✓ Close the window and Calculate. 

✓ Click on the Plot tab. 

✓ Change the Y-axis to a log scale.  Right-mouse-click on the axis and select Logarithmic Scale.  

 

The plot displays the amounts of the four phases.  A solid phase (ethylenediamine-HCl) starts forming at 

164 C, and continues to 117 C.   At 125 C, the water phase forms.  

✓ Click on the Variables window, expand the Additional Stream Parameters category and add the 
pH to the Y2-axis.  

 

The pH of the condensing water is about 3.4.  Therefore in this case the aggressive corrosion risk would be 

between 125 C and 100 C, where water is present and the pH is relatively low. 
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8.6 – Kmetz-Truax curve 

Overview 

This case uses the Survey object in OLI Studio: Analyzer to study the carbonate, ammonia, sulfide, and 
polysulfide speciation associated with Alkaline Carbonate Stress Corrosion Cracking, ACSCC.   

Information provided by authors reported in NACE 341081 are contained in the following table.  These are 
the compositions/conditions where materials are susceptible to ACSCC and also conditions where ACSCC is 
avoidable.  The report was clear that the controlling conditions had not been confirmed in the field. 

Author pH CO3-2 (ppm) H2S  Polysulfide  
(active sulfide) 

Temperature,  
F 

ECorr (SCE) 

Kmetz and Truax 

 >9 >100     

 8 to 9 >400     

      -500 to -600  

Schutt 

 >9 >800 <0.5% (total S)    

  >1200 >0.5% (total S)    

API 581 

 7.6  >50 ppm    

Med risk 7.6 to 8.4 >1000     

Med risk >9 100 to 500     

High risk 8.4 to 9 >1000     

High risk 9.0 >400     

API RP-571 

 7.6  50 ppm    

 >9 >100     

 8 to 9 >400     

Schutt – Controlling ACSCC 

 >8   25 ppm <150  

 >8   25-250 ppm 150-230  

 >8   250 ppm <230  

       

The plan in this section is to model the speciation of ammonia, sulfide, carbonate, and polysulfide as a 
function of pH and temperature.  These plots were also referred to in the NACE publication and provided as 
appendices.   

The plot below is a reference to the speciation to be created and its comparison to the reported pH and 
carbonate associated with ACSCC.  The plan is to use speciation to examine this plot more thoroughly.  

                                                           
 

 

1 Review and Survey of Alkaline Carbonate Stress Corrosion Cracking in Refinery Sour Waters.  NACE Publication 

34108.  Task Group 347 Petroleum Refineries, Environmental Cracking: Reviews of Carbonate Stress Corrosion 

Cracking. (2008). 
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Getting Started 

✓ Create a new stream – label it Kmetz-Truax curve -  

✓ Add the following components, (NH4)2CO3, CO2, H2S, NH3, NaOH, Na2S5. 

✓ Set the units to Metric – Batch – Mass Fraction.  Then select the Customize button to change 
the Mass Fraction units from mass% to ppm. 

Your screen should look like the one below. 

 

✓ Add a Survey Calculation. 

✓ Change the First Survey by from Temperature to pH. 

✓ Set the second pH survey to Composition. 
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✓ Click the Together button in the Vary field. 

 

✓ Click on the first Specs. Button. 

✓ Click on the Use Single Titrant box. 

✓ Set the titrant to NH3. 

✓ Click on the Survey Range tab. 

✓ Set the Survey type to Point List. 

✓ Add five points and set them to 10, 9.6, 9.2, 8.8, 8.4 

  

✓ Click on the Var. 2 – Composition category. 

✓ Set the Component inflow to CO2. 

✓ Click on the Survey Range tab.  

✓ Set the Survey type to Point List. 

✓ Add five points and set them to 2.5, 45, 750, 10000, and 125000. 
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✓ Close the window. 

✓ Calculate. 

✓ Click on the Plot tab.    

✓ Click on the Variables button. 

✓ Remove the existing variable from the Y1 axis. 

✓ Expand the Aqueous category and put CO3-2 species on the X-axis. 

✓ Expand the Additional Stream parameters category and add pH to the Y1 axis. 

 

✓ Close the window. 

✓ Right-mouse-click on the x-axis and change to Logarithmic scale. 

✓ The plot will look like the following.  It is the basic form of the Kmetz-Truax plot displayed above.  
It is a semi-log plot of pH and carbonate concentration.  (Actually is it is a Log-Log plot, since 
pH is a log scale of Hydronium+ activity). 

 

Viewing the dissolved concentrations of carbonate and ammonia 

The next step is to overlay the various dissolved species on the plot.  You will first overlay the dissolved 

inorganic carbon species. 

✓ Open the Variables window. 

✓ Expand the Aqueous category. 
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✓ Add the following species to the Y2 axis: HCO3-1, CO2, and NH2CO2-1. 

 

As the CO3
-2 concentration increases, and as the pH decreases, the total inorganic carbon concentration 

must increase, and it does substantially.  For example, if the dissolved CO3
-2 concentration is measured at 

1000 ppm, and the measured pH is 8.8 (fourth symbol on the pH curve), the the dissolved H CO3
-1 

concentration is approximately 11,000 ppm, roughly 11 times the CO3
-2 concentration.  Furthermore, if this 

is part of a Sour Water stripper system, and NH3 is regulating pH, then the carbamate ion concentration 

(NH2CO2
-1) is computed to be about 900 ppm.   

 

You can see the computed concentrations by selecting the View Data button in the upper right of the plot 

✓ Click on the View Data button in the upper right of the plot -  
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These are the dissolved inorganic carbon concentrations associated with the Kmetz-Truax boundary 

between ACSCC and no ACSCC.  Please note this is the case at 25C. 

✓ Return to the Definition tab and raise the temperature to 60 C and recalculate. 

If the pH can be scaled properly (pH is affected by temperature), then this is what the plot and 

concentrations would look like at the elevated temperature.  The carbamate concentration is computed to 

increase relative to the other species. 

 

Next you will overlay the ammonium-containing species. 

✓ Click on the Variables tab. 

✓ Remove the CO2 and HCO3-1 from the Y2 axis. 

✓ Add NH3 and NH4+1 to the Y2 axis. 
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✓ Close the window and view the plot. 

 

The plot is similar in scale and trend as the inorganic plot.  The concentrations of all NH3-containing species 
increase as CO3

-2 increases AND as pH decreases.  These are the compositions that are computed to exist if 
the field-measured carbonate is in fact CO3

-2 and the pH is controlled by NH3 and no other species.   

Adding some H2S to the system 

According to the NACE report 34108, H2S concentrations above 50 ppm also play a factor.  This will be 

added next.  Before doing so, however, recognize that the 50 ppm concentration of H2S is several orders of 

magnitude lower than the ammonia and inorganic carbon concentrations for much of this curve.  

Therefore, we should expect negligible change to the right-side of the plots that were just created.  

✓ Return to the Definition tab and add 100 ppm H2S. 

✓ Calculate. 

✓ View the existing plot of the dissolved ammonia species. 
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There is a slight shift in concentration on the far left.  This is because additional NH3 is needed to raise the 
pH, since adding 100 ppm H2S adds acid to the system. 

✓ Change the plot variables.   

✓ Remove the NH3 and NH4+1 from the Y2. 

✓ Add CO2 and HCO3-1 to the Y2 axis. 

 

There appears to be a negligible shift in the curves here as well.  Therefore, if these plots accurately 
represent the solution composition that promotes ACSCC, and if H2S is involved in ACSCC, then it does not 
appear to be due to its effect on the bulk solution chemistry. 

✓ Change the H2S concentration to 1000 ppm and see how this affects the plot. 

Summary 

The purpose of this section is to look at the bulk solution chemistry for dissolved carbonates and ammonia 

when the solution conforms to the Kmetz-Truax Curve.  This curve represents an approximate boundary for 

ACSCC.  At higher carbonate concentrations and lower pH, the right-side of the plots studied above, the 
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concentrations of dissolved carbon and ammonia increase exponentially, reaching concentrations that 

exceed 10,000 ppm.  This again, is true only if the x-axis of the Kmetz-Truax is the dissolved CO3-2 species 

(phenolphthalein alkalinity) and that there are no other alkaline species (e.g., OH, mercaptans, etc.) 

contributing to the x-axis.  This is also true, only if the source of alkalinity to raise pH is NH3, and not NaOH 

or other alkaline sources.  Therefore, because of the uncertainty posited between what you computed and 

what may exist in the plant, it is advisable to determine the exact nature of the dissolved carbonate 

measured, and if there are other species of significant in the sour water recirculating in the Stripper 

pumparound. 
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8.7 – Sour Water Chemistry and Corrosion 

Overview 

There are multiple references to corrosion occurring in equipment processing sour water.  The purpose of 
this case file is to study the chemical composition of the gas and fluid phases flowing through the 
separation unit.  This case will use both the Flowsheet ESP and OLI Studio software.  The Flowsheet 
software will be used to create the stripping process and to compute the composition in each stream and 
on each column stage.  The OLI Studio tool will be used to study the stream composition further, to 
compute corrosion rates and to test effects of changing compositions and conditions. 

Getting Started 

The image below is the process flowsheet that will be studied.  It represents a generic stripping column in 
which heated sour water is injected into the fourteenth stage of a of a twenty-stage tower.  Tower 
overheads are cooled and the liquid reflux returned to the top of the column.  The remaining gas exits the 
process.   

 

Creating the chemistry model 

Start by adding the necessary chemical components to the chemistry model.  The components are fairly 
basic, gases plus salts.   

✓ Click on the Chemistry tab -  

✓ Click on the Databanks sub-tab and Select the Aqueous (H+ ion) framework - 

 

✓ Click on the Inflows subtab and add the components shown in the screenshot below 
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You are done with the Chemistry build step.  There are no additional changes, such as redox reactions, 

kinetics, or solids selection. 

Setting the Units 

✓ Click on the Units manager button in the toolbar -  

✓ Set the units to Metric-Flowing-Mass -  

✓ Click on the Customize button to edit the existing units -  

✓ Make the following changes to the units, there are several 

 

Building the Process 

Add the sour water stream  

✓ Click on the Add Stream button from the toolbar -  

✓ Create a stream and label it Sour Water 
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✓ Unclick the Add Stream, button -  

✓ Double-click on the new stream you created to enable the name editor and change the name to 
Sour Water 

Next you will enter the Sour water composition in the Properties panel 

✓ Enter the conditions and compositions shown in the image below.  Confirm that your Total flow 
units are kg/hr and Inflow units are ppm(mass). 

  

✓ Set the Normalization to Makeup with Water – in that way the H2O is entered automatically. 

Add the Heat exchanger 

✓ Double-click on the Heat Exchanger icon in the Library to add it to the process 

 

✓ Select the Sour as the inlet in the Properties Panel-  

✓ Type in the outlet name, Heated Sour Water -  

✓ Set the Process Stream Spec. type to Discharge Temp -  

✓ Set the Discharge T to 80 C 

The Properties panel should look like the one below when finished 
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Add a Reflux stream to be used in the Stripper 

✓ Click on the Add Stream button and create a new stream 

✓ Label it Reflux -  

✓ Enter the following initial guess to the reflux composition 

 

This composition is an initial guess, because it will be the outlet of the reflux drum and will become an 
internal (calculated) stream, once the case is finished. 

Add the Stripper column 

 

The stripper object contains a number of settings, so make sure that you complete each step.  
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✓ Double-click on the Stripper object in the Library panel and add it to the process  

✓ Name it Sour Water Stripper 

✓ Move to the Properties panel and make the following changes 

✓ Set the Calculation method to Equilibrium 

✓ Set the Number of stages to 20 

✓ Set Include condenser to No 

✓ Open the Inlets window  

✓ Use the down arrows to add the Heated sour water to Stage 14 and the Reflux stream to stage 
20 

 

✓ Click on the Outlets window 

✓ Enter the name Bottoms to the Liquid Outlet and Overhead to the Vapor Outlet 

 

✓ Open the Spec./Controls Editor window 

✓ Click on the Add button to create a new tower Specification 

Specification section 

✓ Select Liquid Composition for Spec. Variable 

✓ Set the stage # to 1 

✓ Set the value to 5e-4 mass%.  If mass% is not available, then use 5 ppm. 

     

✓ Select the component H2S from the popup window that appears. 

If the component popup window does not appear after pressing Enter, then click on the Select Components 

button  

Control section 
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✓ Select Exchanger duty  

✓ Select Stage 1 

Your windows should look like the one below 

 

 

✓ Close the Specifications window 

✓ Click on the Heat Exch. Duties editor button -  

✓ Set the initial guess for the Stage 1 (Reboiler) heat duty to 6e7 cal/hr 

 

✓ Click on the Pressure Profile editor button -  

✓ Set Stage 20 to 1.88 atm and stage 1 to 1.95 atm 

 



Tricks of the Trade  Chapter 8 Refinery Applications 8-59 

Add the Overhead Coolers  

 

✓ Add another Heat Exchanger object and name it Coolers 

✓ Use the Properties panel to link the Overhead stream to the Process Stream Inlet field 

✓ Type the name Cooled Overhead in the Process Stream outlet field 

  

✓ Set the Process Stream Spec. Type to Discharge Temperature  

✓ Set the discharge Temperature to 85C 

✓ Set the Pressure Spec. to Absolute Pressure 

✓ Set the Pressure to 1.3 atm 

 

Add the Reflux Drum 

 

✓ Add a Separator object to the case and label it Reflux Drum 

✓ Use the Properties panel to select the Cooled Overhead as the Inlet stream 

✓ Click on the front-end of the Reflux stream and drag it to the liquid outlet of the Reflux drum 

        

✓ Type the name To Burner to the Vapor Outlet 
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✓ Keep the existing Equilibrium Calculation Properties 

  

At this point, you may want to rearrange the blocks and streams at this time to keep the flowsheet 
organized. 

Adding the Bottoms filter 

✓ Add another Separator block and label it Bottoms Filter 

✓ Link the Bottoms stream to the Inlet 

✓ Create two outlet streams – Bottoms water in the Liquid outlet and Solids in the Solids outlet 

  

✓ Open the Entrainment editor -  

✓ Set the Liquid to Solid ratio in the Solids stream to 4 

 

This action will add four grams of liquid to every gram of solids that flow.  It is essentially a solids slurry 
containing 80% water. 

Set the Reflux stream as the Recycle/Tear Stream 

✓ Right mouse-click anywhere along the Reflux stream to activate the drop-down menu 

✓ Select the Set Tear option 

 

✓ Save the file – label it Stripper-Sour Water. 

Calculate the case 

✓ Press the Calculate button -  
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✓ View the Convergence monitor.  It will provide a quick view of the calculation progress 

I may take many iterations before the process converges.  The monitor will show if the existing error is 
decreasing or increasing (calculation unstable).   

 

Reviewing the calculations 

✓ Right-mouse-click on the Reflux stream and select Add Callout 

 

✓ Double-click on the callout table that appears to edit the variables 

✓ Remove the pressure from the existing variable list 

✓ Expand the Liquid-1, Apparent field and select CO2, H2S, and NH3 

 

According to the calculation, this is the concentration of sour components in the reflux stream.  Use this 
data plus the pH to evaluate whether corrosion is possible at these conditions.   

✓ Add other callout tables where you think that corrosion may be a problem in your process and 
review the composition at these locations. 

Summary 

The purpose of this example was to create the steady-state conditions within a sour water stripper unit.  
Once the simulation is converged, the compositions and temperatures at locations within the process can 
be reviewed so that corrosion can be assessed. 
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8.8 – HF Regeneration 



 Autoclave 
Calculations 

Introduction 

An autoclave is a high pressure, high temperature hydrometallurgy unit with carefully controlled 
conditions. From an OLI Software perspective, it is an isochoric (constant volume) calculation in which 
mass, pressure and temperature are allowed to vary. 

In this chapter, you will simulate autoclaves using three general approaches. The first is to use Custom 
calculation.  This calculation type allows you to select variables to fix and to free.  The second type is the 
Autoclave calculation type.  This fixes temperature and partial pressures, and calculations initial/final 
pressures and gas inflow amounts.  The third option is using the Mixer set to isochoric.  This option 
calculates temperature or pressure, and the user manually adjust the inflow rate of a given stream. 

Contents 
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9.1 Basic Autoclave #1 – Using Inert Gas 
In this case, you will add 1 kg water to a 2 L autoclave and then fill the void with N2. The conditions are 

ambient, 25 C and 1 atm. The N2 is presumed to be the gas that remains in the autoclave headspace 
after sparging (O2 removal) is completed. 

The amount of N2 added is the the combination of N2 vapor filling the headspace, and N2 that dissolves 
in the water (N2 aqueous). Since N2 has a low water solubility, this second amount is negligible.  H2O also 
evaporates, so the headspace will be a mixed gas, N2 and H2O.  

We can use the Ideal Gas Law to estimate the amount of N2 needed to fill the headspace: 

𝑃 ∗ 𝑉 = 𝑛 ∗ 𝑅 ∗ 𝑇 

1 𝑎𝑡𝑚 ∗ 1 𝐿 = 𝑛 ∗ 0.082057 
𝐿−𝑎𝑡𝑚

𝐾−𝑚𝑜𝑙
∗ 298.15 𝐾 

𝑛 = 0.040874 𝑚𝑜𝑙𝑒𝑠 

Although this estimate does not consider the H2O that is in the 1 L headspace or the amount of N2 
dissolved in water, it is still an easy approach to get a reasonable estimate.   You will compare this 
equation to the results at several points in this case.  You will also review the results in greater detail in 
this case, because part of the goal of this first case it to show where the important variables and 
properties are that impact an autoclave calculation.   

Getting Started 

✓ Start a new file and give it a name such as Chapter 9 Autoclaves  

✓ Create a new stream and rename it Basic Autoclave – Inert Gas 

✓ Change the framework to MSE  

✓ Make sure the units are set to Metric-Batch-Moles 

✓ Add N2 as an inflow  

✓ Add a Single Point Calculation then select Autoclave as the calculation type  

 

The basic grid should look like the one below 
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If you do not see the Autoclave then follow the instructions in the insert below. 

 

✓ Click the Specs button 

✓ Highlight N2 in the gas field then press OK 

 

 

✓ Change the Vessel volume to 2 L 

✓ Change the final temperature to 25 C and Final Pressure to 1 atm  

At this point the system contains, 1 kg H2O (55.508 moles), the initial temperature is 25 C and the final 
temperature and pressure will be 25 C and 1 atm.   

 

✓ Calculate 

The software will perform two calculations, one at ambient (initial) conditions and one at final 
conditions.  It will compute the amount (in moles) of N2 needed to create a 1 atm pressure at final 
conditions.  It will then use this N2 to compute the pressure at ambient conditions.  The calculation 
pathway image below shows this.   

✓ Select Tools > Options ✓ Select the Enable Features box 

 

 

✓ Press OK.  

If Autoclave option does not appear in the single point Calculation Type list, then restart software 
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✓ View the Summary section 

 

The calculated ambient pressure is 1 atm.  It is identical to the final pressure, which is not surprising, 
since the ambient and final temperatures are also identical, and by design, the autoclave calculation 
uses the identical inflows for ambient and final conditions. 

The final N2 partial pressure is computed to be 0.9687 atm.   

✓ Click on the Output tab -  

The amount of N2 added is 0.04007 moles.  This produces the 0.9686 atm partial pressure. 

 

✓ Review some of the remaining data 

 

The size of the liquid phase, in moles, is 55.508 and the vapor is 0.407, or a 1364:1 ratio.  The volumes 
are nearly identical: 1 L liquid and 1 L vapor.   
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✓ Click on the Report tab 

✓ Scroll down to the last table, Element Distribution 

The last row is N (molecular nitrogen).  The distribution is 98.5% in the vapor and 1.5% in the liquid 

phase.  Conversely, 0.0023% of the water has evaporated (note the H(+1) and O(-2) rows).    

 

These results infer two effects: as the final pressure increases, additional N2 will dissolve in the water, 
shifting the fraction of nitrogen to the liquid; As the total autoclave volume increases relative to the 
input liquid, additional water will evaporate, shifting the water to the vapor.  This will be shown next. 

Setting the Vessel volume to 5 L and 10,000 L 

You will compute this case using larger autoclave volumes.  The case above is a 2 L autoclave containing 

1 kg (~1 L) water.  The moles of liquid is computed to be 55.5076.   

✓ Click on the Input tab and change the Vessel volume to 5 L  

 

✓ Calculate 

✓ Click on the Output tab and view the Phase amounts 

 

The moles of liquid is now 55.5037.  The reduction of 0.0039 moles is because this amount of H2O 
evaporated into the larger headspace. 

✓ Scroll down to the Inflow grid and view the N2 inflow 

The grid shows the amount of N2 required to fill the 4-L headspace.  The amount is is 4-times greater 

than the first case, which is expected for gas with a low water solubility. 

 

✓ Return to the Input tab and change the volume to 10000 L.    

This creates a 9999 L headspace.  The Liquid moles is now 42.69, and the 12.818 mole reduction is 
evaporation. 
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This phase distribution is important to modeling the autoclave system properly, especially at elevated 
conditions as will be seen in the next example. 

Testing the 5 L case at 1 atm and 100 C final temperature 

The purpose of this example is to raise the H2O partial pressure relative to N2.  In the 5 L case above, 
the N2 inflow is 0.1634 moles.  As temperature increases, the H2O vapor pressure increases, and the 
amount of N2 required to fill the vapor void will decrease.   

✓ Change the Final Temperature to 100 C 

✓ Change the vessel volume to 5 L 

 

✓ Calculate 

✓ View the Output tab and the Summary section 

 

The amount of N2 added is zero (no value is shown).  This is to be expected, because the vapor 
pressure of pure water at 100 C is 1 atm.  Therefore, no N2 is needed to raise the pressure.  Notice also 
that the ambient pressure is 0.0313 atm.  This is the vapor pressure of pure water at 25 C.  Therefore, 
the autoclave will have a vacuum pressure at ambient temperatures, and when heated to 100 C will 
reach atmospheric pressure.  This, by the way is the principle of the double-expresso pot in reverse.  

 

The water is added into the lower chamber.  The pot is sealed at ambient pressures and is heated.  The 
water boils and condenses in the upper chamber.  When taken off the stove, the lower chamber cools, 
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producing a vacuum, this vacuum pulls the condensed water through the coffee.   The system has two 
temperatures, two pressures, and one composition.  

Testing the 20 L case at 50 atm final pressure and 100 C final temperature 

This scenario contains two different sets of T, P conditions.   The calculation approach however, is the 
same: the final T and P are known, and the N2 inflow amount is computed.  This N2 amount is added to 
the Ambient calculation, and PT,A is calculated. 

 

✓ Change the Final temperature and Pressure to 100 C and 50 atm 

 

✓ Calculate 

✓ View the Summary section 

 

The computed ambient pressure PT,A is 38.437 atm.  Of this total, 38.404 atm is N2 (PN2=38.404) and 
0.033 atm is H2O (PH2O=0.033 atm).  Thus, to create a 50 atm final pressure, the autoclave would need to 
be charged with N2 at a regulator pressure of 38.437 atm.   

✓ Click on the Output tab and view the results 
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According to the calculation, the amount of N2 in the autoclave is 29.759 moles.  This amount of N2 plus 
the 55.508 moles of H2O produces a final pressure of 50 atm in a 20 L autoclave at 100 C.   

Summary 

The purpose of this case was to display the inter-dependence of the two calculations that are part of an 
autoclave calculation.  The further purpose was to show the user where to find the relevant data. 
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9.2 Basic Autoclave #2 – Using Reactive Gas 
You will modify the Case 9.1 approach by using a reactive gas, CO2, to fill the headspace.  You will then 

modify the case further by adding NaOH so that additional CO2 dissolves in water to form bicarbonate.  
This increases the gas requirement   

Getting Started 

✓ Create a new stream and rename it Basic Autoclave – Reactive Gas 

✓ Change the framework to MSE  

✓ Make sure the units are set to Metric-Batch-Moles 

✓ Add CO2 and NaOH to the inflow list 

 

✓ Add a Single Point Calculation, then select Autoclave as the calculation type  

✓ Click the Specs button 

✓ Highlight CO2 in the gas field, then press OK 

 

 

✓ Set the final temperature to 25 C  

✓ Set the final Pressure to 1 atm  

✓ Set the Vessel volume to 2 L 

✓ Change the Compute results at which condition to Final 

 

✓ Calculate  

✓ Click on the Report tab and review the Stream Inflows table 
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This table displays the Input and Output inflows.  The 0.072 moles CO2 added is computed by the 
software to set the autoclave pressure to 1 atm.  For comparison, the same scenario in Section 9.1 
required 0.04 mole N2.  The difference is the amount of CO2 that dissolved in the water.  CO2 is more 
soluble than N2 in water. 

✓ Scroll down to the Element Distribution table 

This table contains three rows, H(+), O(-2), and C(+4).  These are the elements of H2O and CO2.  

✓ Compare the C(+4) in the liquid and vapor 

 

About 45% of the CO2 dissolved in the water phase.   By comparison, 1.5% of the added N2 dissolved in 
water at the same condition.   

✓ Scroll up to the Element Balance table to view the moles C(+4) in each phase. 

 

 

The table below is the comparison between the Ideal Gas law calculation, and the N2 and CO2 autoclave 
calculations. 

T P VolT Moles Gas in 1L Moles of N2  mixed with 1kg H2O Moles of CO2 mixed with 1kg H2O 

C atm L Ideal Gas Law Calculated (total) Calculated (vapor) Calculated (total) Calculated (vapor) 

25 1 2 0.041 0.040 0.039 0.072 0.040 

Testing with 0.1m NaOH  

You will repeat the study with NaOH added to the water.  NaOH reacts with CO2 to form HCO3
-1 and 

CO3
-2, increasing overall CO2 solubility.  

✓ Click on the Input tab 

✓ Add 0.1 moles NaOH to the input grid 
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✓ Calculate 

 

The CO2 inflow is approximately 0.17 moles.  This is 0.1 mole more than the first calculation and results 
from the acid-base reaction with the 0.1 moles of NaOH. 
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9.3 Basic Autoclave #3 - Using Air 
The previous case represents an example of how to create autoclave and how the results compare to 

the Ideal Gas Law. In the next case, we will use air. Dry air has a composition of 78.08% N2, 20.95% O2, 
0.93% Ar, and 0.04% CO2

1. The composition of H2O-saturated air is ~3.1% less, or 75.7% N2, 20.3% CO2, 
0.90% Ar, 0.039% CO2, and 3.1% H2O. Since CO2 is a reactive gas that dissolves in water, this will create a 
calculation deviation from the ideal gas law. 

Getting Started 

✓ Add a new stream and rename it Air Autoclave 

✓ Change the framework to MSE 

✓ Select the Units Manager button  and make sure the units are Metric-Moles, then:  

✓ Click the Customize button  

✓ Change Aqueous Composition to Concentration 

✓ Change Vapor Composition to Mole Fraction 

 

✓ Press the OK button twice to exit the Units Manager 

✓ In the Inflows grid, add the components N2, O2, CO2, and Ar  

 

✓ Add a Single Point Calculation then change the calculation type to Autoclave 

✓ Click the Specs button 

✓ Highlight Ar, CO2, N2, and O2  

 

✓ Click OK to exit the window 

                                                           
1 Taken from http://en.wikipedia.org/wiki/Gas_composition.  This is reportedly from the 1997 edition of the CRC handbook.  The 0.04% CO2 is 
not from this reference, it is obtained from NOAA http://www.esrl.noaa.gov/gmd/ccgg/trends/. 

http://en.wikipedia.org/wiki/Gas_composition
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✓ Change the Vessel Volume to 5 L 

✓ Change the Final Temperature to 25 C 

✓ Change the Final Pressure to 1 atm 

✓ Set the pressures for Ar, CO2, and O2 gases to 0.009, 0.00039, and 0.203 atm, respectively  

 

The N2 partial pressure is not set. This is because the total pressure and the partial pressures of the the 
other gas components are fixed.  One variable must be adjustable and it cannot be PH2O, because that is 
a product of the water phase calculation. 

𝑃𝑇 − 𝑃𝐴𝑟 + 𝑃𝑂2 + 𝑃𝐶𝑂2 + 𝑃𝐻2𝑂 = 𝑃𝑁2 

The values on the left side of the equation are known. The PH2O is computed from the vapor pressure of 
liquid water. Therefore, PN2 must be the difference variable. 

✓ Change the Compute results cell to Final 

The purpose of the Compute Results cell is to instruct the software on what results to display in the 
Report tab.  Presently, there is a single report tab and only one set of conditions, Ambient or Final can 
be displayed (a software limitation).   

✓ Calculate 

✓ Click the Output tab below the grid to view the results 

The calculated PN2 is 0.756 atm.  The PH2O is not shown, because it was not defined.  It can be computed 
by subtraction of the partial pressures from 1 atm total pressure:   

𝑃𝐻2𝑂 = 1 − 0.009 − 0.00039 − 0.7562 − 0.203 = 0.314 𝑎𝑡𝑚. 
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The moles of gas added is shown in the inflows.  How these gases are added to the system is not 
explained in this calculation.  However, it can be simply a matter of creating a bottle gas with the four 
components at the moles (or mole ratios) in the grid below.   

 

𝑇𝑜𝑡𝑎𝑙 = 0.12404 + 0.03342 + 7.934𝑒−5 + 1.483𝑒−3 = 0.1590255 𝑚𝑜𝑙𝑒𝑠 

%𝑁2 =
0.124038

0.1590255
∗ 100 = 77.999% 

%𝑂2 =
0.0334252

0.1590255
∗ 100 = 21.019% 

%𝐴𝑟 =
0.001483

0.1590255
∗ 100 = 0.933% 

%𝐶𝑂2 =
7.93442𝑒−5

0.1590255
∗ 100 = 0.050% 

The above values would be the bottle gas composition that would create an air composition in the 
autoclave at 1 atm and 25 C.  This mixture is also dependent on the headspace to liquid ratio, because 
each gas has a different solubility in water.   

✓ Click on the Report tab and review the Stream Inflow, Stream Parameters, Total and Phase 
Flow, and Species Output tables 

The Stream Inflows table shows the same information as the Inflows grid. The H2O content, 55.508 is 
the initial amount. The additional material is what the software added to match our specifications. 

 

The computed pH is 5.6. This is consistent with rainwater pH.  

 

The total volume is 5 L. The liquid volume is slightly higher than 1 L because the computed volume of 
the 1 kg H2O at STP is 1.0029 L. Therefore, the gas is slightly less than 4 L. 
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The vapor and aqueous composition are in the Species Output table. The vapor fractions should be 
consistent with the defined values for O2, Ar, and CO2.  The N2 and H2O fractions are computed. The 
dissolved CO2 is 0.58 mg/l and this value is consistent with surface waters around the globe.  

 

Summary 

The purpose of this example was to introduce multiple gas components to an autoclave calculation.  
The software does not limit the number of gases that can be fixed, although this does make the 
calculation more difficult to converge. 
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9.4 Basic Autoclave #4 – CO2/H2S/CH4 in seawater 
This example will use the standard seawater analysis object to create the brine for the autoclave.  Then 

the gases will be added.  The hypothetical is that seawater is being injected into a reservoir, and its 
reaction with the reservoir gas is being studied. 

The training purpose of this case is to incorporate several calculation objects into the autoclave study.  
You will start by bringing in the seawater analysis from the object library, then you will create a new 
stream from it.  Lastly, you will run the autoclave calculation. 

Getting Started 

Bringing in the Standard Seawater analysis from the Object library and reconciling it 

✓ Open the Object Library panel using the Menu action: View>Toolbars>Object Library 

    

✓ Drag the Standard Seawater Analysis object from the Standard Objects Panel to the 
Navigator panel 

✓ Complete the Seawater reconciliation by Adding a Reconciliation object -  
- and calculating. 
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Convert the Reconciled Seawater to a Stream object and running the Autoclave calculation 

✓ Click on the Add as Stream object at the bottom of the grid -  

✓ Change the Name of the saved stream to 1L Seawater  

 

✓ Press OK to create the new Stream -  

✓ Click on the 1 L Seawater stream 

✓ Open the Units Manager and change the units to Metric-Batch-Mass 

 

✓ Add H2S and CH4 to the grid (the CO2 is already there) 
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✓ Add a Single Point calculation  

✓ Change the calculation type to Autoclave 

✓ Open the Specs window and select CO2, H2S, and CH4 

 

✓ Set the Final Temperature to 100 C 

✓ Set the final pressure to 100 atm 

✓ Set the vessel volume to 1.5 L 

✓ Set the CO2 partial pressure to 2 atm 

✓ Set the H2S partial pressure to 0.1 atm 

✓ Calculate 

✓ Click on the Report and scroll down to the Stream Parameters Scaling Tendencies table.  
Note the pH and saturated solids 

According to the calculation, the sweater pH decreases to 4.9 at reservoir conditions (it is 7.5 at the 
surface).   



Tricks of the Trade Chapter 9 Autoclave Calculations 9-19 

 

Also, barite is the only mineral computed to be saturated.  The solids amount is small, according to the 
Phase and Flows table.  Its computed to be about 0.04 mg. 

 

Summary 

The purpose of this case was to incorporate several Studio objects into an autoclave study.  The key 
aspect is recognizing that the stream created has a known size, 1 L, and this size needs to fit in the 
autoclave volume entered.  Also, the units needed to be changed to mass, because keeping volume 
units in the Stream Amount row, causes calculation problems for the autoclave. 
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9.5 Basic Autoclave #5 - Calculating the Material 
Needed for a Sour Gas Experiment  
A common autoclave application is testing corrosion in a high pressure/temperature gas production 

well. In such a case, the CO2 and H2S partial pressures are known at the HPHT conditions, and the 
laboratory is required to create an experiment that meets the PCO2 and PH2S values. Since it is difficult to 
measure the gas composition at the HPHT testing conditions, we would need to perform gas-phase 
calculations to predict the amount of CO2 and H2S needed for the pressure vessel.  

The simulation is a gas well with bottom-hole conditions are 150 C and 400 atm and the CO2 and H2S 
partial pressures are 20 and 1 atm. The carrier gas is a mixture of light hydrocarbons (C1 - C6) plus N2 
and H2 (for safety reasons, flammable gases, C1 - C6 and H2, are not used, and N2 is the only additional 
gas). The client has a brine analysis, including the laboratory measured pH and alkalinity.  

Getting started 

The table below contains the water analysis. This is entered in a water analysis object, and sent to a 
stream where the autoclave calculation is run.  It is the same procedure as the previous case, except you 
will start with a blank water analysis instead of the completed seawater.  

Properties Neutrals, mg/l Cations, mg/l Anions, mg/l 

TDS 71500 SiO2 56 Na+1 26570 Cl-1 42800 

pH 6.5 B(OH)3 78 K+1 525 SO4-2 84 

Alkalinity 490   Ca+2 570 HCO3-1 420 

Density 1.04   Mg+2 250 B(OH)4-1 0.0 

    Sr+2 41 HS-1 0.0 

    Ba+2 16 C2H3O2-1 144 

    Fe+2 0.0 CHO2-1 27 

✓ Add a new Water Analysis from Actions pane icon   

✓ Name it object Gas Well Water 

✓ Select the MSE framework  

✓ Change the Stream Amount to 0.5 L 

✓ Enter the measured properties in the grid 

✓ Enter the cation-anion data into the grid 

✓ Select the Add Reconciliation button, then select the Reconcile pH/Alkalinity button 
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✓ Calculate then view the information in the Summary  

✓ Confirm that the measured pH and Alkalinity values were duplicated by the software 

The software added 94.6 mg/l CO2 and also added 2.2 mg/l HCl to generate the measured pH and 

alkalinity values.   

       

The water analysis is completed and is ready to be used in the autoclave 

Convert the water analysis to the Autoclave Input water 

✓ Click on the Add as Stream button on the bottom of the grid and give it a name Gas Well 
Autoclave #1 –  
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✓ Add CO2, H2S and N2 to the Inflows grid  

The CO2 will already be there, but by typing it again, the software will place it at the bottom of the grid 
with the H2S and N2.  This will make it easier to review the gas inflow after the calculation is completed. 

✓ Change the units to Metric-Batch-Moles 

 

✓ Select the Customize button then make the following changes to the Inflow and composition 
variables 

✓ Inflows   moles 

 

✓ Aqueous Composition  Concentration 

✓ Vapor Composition  Mole Fraction 

✓ Solids Composition  Concentration 

✓ 2nd Liquid Composition Mole Fraction 

 

You will use Mole units in this case, because it makes it easier to determine the mole fraction of N2, 

CO2, and H2S needed in the gas phase.  The moles of the other water components are not important 

here, and so the values shown in the grid for these components can be ignored. 

✓ Add a Single Point > Autoclave calculation 

✓ Click the Specs button 
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✓ Highlight CO2, H2S, and N2 and then press OK 

 

✓ Set the following Calculation Parameters 

✓ Final Temperature = 150 C 

✓ Final Pressure = 400 atm 

✓ Vessel Volume = 1 L 

✓ CO2 partial pressure = 20 atm 

✓ H2S partial pressure = 1 atm 

✓ Compute results = Ambient 

 

✓ Calculate 

✓ Select the Report tab and view the Input table, specifically the CO2, H2S, and N2 values 

 

 

Compare the CO2 output value to the input. The difference is the amount needed to create the 20 atm 
partial pressure at test conditions. Also, note the pressures that is required at ambient conditions. This is 
the charging pressure needed to create the 400 atm test pressure.  

✓ Scroll down to the Properties table 
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The Ambient Pressure is 226 atm. This is the gas charging pressure. In other words, after the CO2, H2S, 
and N2 are added to the autoclave at the amount shown in the above calculation, the final pressure is 
computed to be 226 atm. 

✓ Scroll to the Total and Phase flow table 

 

 

The total volume is 1 L, as designed. The Aqueous volume is slightly larger than 0.5 L due to density 
changes. There is also 12 mg barite solid present (see Scale Tendency table), but this does not affect the 
calculations, because the mass is relatively small.  

Summary 

This case is similar to the previous case, except that more work is done to create the water stream.  
Also, instead of creating a gas phase and equilibrating the gas with the water as to inlet streams (as 
done in ScaleChem), the Autoclave calculation is used to create the reservoir fluid. 



Tricks of the Trade Chapter 9 Autoclave Calculations 9-25 

9.6 Basic Autoclave #6 - Dense-phase liquid in an 
autoclave 
This example is similar to previous cases, except that the pressure is very high, 1000 bar, and the gases 

added reach a dense-phase state.  The purpose of this example is to show that the software works the 
same, whether the gas added remains as a gas phase or compresses to a supercritical state. 

Getting Started 

✓ Add a new Stream and label it Supercritical gas 

✓ Turn on the 2nd Liquid Phase -  

✓ Set the framework to MSE 

✓ Open the Units Manager 

✓ Set the units to Metric-Batch-Mass 

✓ Customize the Output as follows 

✓ Vapor Composition = Mole Fraction 

✓ 2nd Liquid Composition = Mole Fraction 

 

✓ Add the following inflows to the grid, NaCl, NaHCO3, N2, CO2, and H2S 

✓ Set the NaCl to 60 g and the NaHCO3 to 1 g 

 

Supercritical CO2 

✓ Add a Single Point calculation and label it CO2 Dense Phase 

✓ Change the calculation type to Autoclave calculation 

✓ Open the Specs window and select N2 and CO2 

 

✓ Enter the following settings 

✓ Final Temperature = 180 C 

✓ Final Pressure = 1000 atm 

✓ Vessel Volume = 1.5 L 
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✓ Partial Pressure CO2 = 10 atm 

✓ Compute Results = Final 

 

✓ Calculate 

✓ Click on the Report tab and review the Species Output table 

 

The Liquid-2 column contains the supercritical gas composition.  It is dominated by N2 (92%), H2O (7%) 
and CO2 (1%).  There are also low concentrations of dissolved ions (an aspect of the MSE framework) 
that can be ignored.  The 1% CO2 @1000 atm PT is the 10 atm partial pressure.  Therefore, you can see 
that in this case, the partial pressure as it relates to a dense/liquid phase is also computed. 

Supercritical H2S  

✓ Add a Single Point calculation and label it H2S Dense Phase 

✓ Change to Autoclave calculation 

✓ Open the Specs window and select H2S 
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✓ Enter the following settings 

✓ Final Temperature = 40 C 

✓ Final Pressure = 100 atm 

✓ Vessel Volume = 1.5 L 

✓ Partial Pressure CO2 = 10 atm 

✓ Compute Results = Final 

 

✓ Calculate 

✓ Click on the Report tab and review the Species Output table 

The Liquid-2 column is 98.2% H2S, this is the supercritical phase.  There is also a small amount of H2O 
dissolved in this dense phase. 

 

✓ Scroll up to the Thermodynamic Properties table 

The densities of each phase is shown.  The supercritical H2S is computed to have a density of 0.77 g/cc.  
the bulk density of the system is 0.96 g/cc (Total) 

 

Summary 

This is a very simple case, with the new aspect being that instead of fixing the pressures in the vapor 
phase, the dense/critical fluid phase becomes the target phase.   
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9.7 Basic Autoclave #7 - CO2 Sequestration  
A proposed CO2 sequestration process is to inject CO2 gas into rock rich in alkali-silicate minerals. These 

silicates react with CO2 in the following way 

𝑀2𝑆𝑖𝑂4 + 2𝐶𝑂2 = 𝑀𝐶𝑂3 + 𝑆𝑖𝑂2 

where M is Ca+2, Mg+2 or Fe+2.  The rates at which the CO2 dissolves the silicates and precipitates into 
carbonates is important to the sequestering process, but it will not be considered in this example.  

Getting Started 

✓ Create a new stream and rename it CO2 Sequestration 

✓ Change the framework to MSE 

✓ Add the MSE Geochemical database 

 

✓ Open the Units Manager then change the units to Metric-Batch-Mass 

 

✓ Add the following inflows and values to the grid:  

Inflow Grams 

H2O 950 

NaCl 50 

Fe2SiO4 500 

Mg2SiO4 500 

Ca2SiO4 500 

CO2  

The vessel contains 1 kg of 5% NaCl solution and 1.5 kg of minerals that are found in basalt rock.  These 
minerals will react with CO2 via the acid-base reaction shown above. 

 

✓ Add a Single Point Calculation and label it HP CO2-Rx reaction  

✓ Change the Calculation type to Autoclave  
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✓ Set the Final Temperature to 200 C  

✓ Set the Final Pressure to 300 atm 

✓ Set the Vessel volume to 2.0 L 

✓ Change the “Compute results at which condition” cell to Final 

✓ Click the Specs button and Highlight CO2  

 

The grid should look like the following.   

 

✓ Calculate 

✓ Click the Output tab and view the Inflows at the bottom of the grid 

The composition added to the Autoclave is show in the screenshot below. This composition creates a 2 
L mixed-phase system at 200 C and 300 atm.  

 

Nearly 900 grams CO2 is added to this autoclave.  Although this does not indicate whether all of it has 
reacted, since some gas must be present to create the 300 atm pressure   

✓ Click the Report tab and scroll down to the Element Balance table 

The table below is a portion of the element balance.  The row C(+4) represents the CO2.  The 235.464 

grams carbon in the Total column is the 862.762 grams CO2 that was added to the grid.   
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Of the 235.46 g C(+4) added, 198.376 g (84.3%) reacted to form solids. The rest dissolved in water (8%), 
or remained unreacted in the vapor (7.8%).   

✓ Scroll up to the Species Output table and view the Solids column 

The table below is the bottom portion of the Species Output table were solid phases are.  According to 
the software, the silicates reacted with CO2 to form quartz and talc.  The metals formed carbonates. 

 

The above minerals are the phases in the Geochemical database that are computed to be the most 
thermodynamically stable at these conditions.  Since this calculation does not include reaction 
pathways, the minerals that form, for example dolomite, may not form initially, but rather over time.   

✓ Lastly, scroll up to the Total and Phase Flows table 

The case started with 1500 g of minerals (Fe2SiO4, Mg2SiO4, and Ca2SiO4).  The final solid mass is 2233 g.  
The 733 g is nearly all the sequestered CO2.   

 
 

 

Summary 

This is an example where the Autoclave tool is used to develop a chemical chemical conversion process.  
In this case, the main reaction components are the minerals, and the purpose of the autoclave was to 
reach the proper final pressure using CO2 as the gas stream.   
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9.8 Intermediate Autoclave – Calculating the 
incremental pressures during the charging steps 

✓ Add a stream and label it Pressure Charging steps 

✓ Add the following components, NaCl, CO2, H2S, N2, and CH4 

✓ Change the units to Metric-Batch-Mass 

✓ Set the H2O to 450 g and the NaCl to 50 g 

Calculate the final state of the autoclave 

✓ Add a Single Point calculation and label it Final conditions 

✓ Open the Specs window and select the target gases, CH4, CO2, H2S, and N2 

 

✓ Set the following Calculation Parameters 

✓ Final Temperature = 100 C 

✓ Final Pressure = 200 atm 

✓ Vessel Volume = 1 L 

✓ PCO2 = 20 atm 

✓ PH2S = 1 atm 

✓ PN2 = 10 atm 

✓ Compute Results = Final 

 

✓ Click on the Output tab and view the inflows 



9-32 Chapter 9 Autoclave Calculations Tricks of the Trade 

 

✓ View the Calculation results and the partial pressures for each component.  The PCH4 and 
PH2O were calculated .  The PCH4 is shown here. 

 

Calculating the pressure steps for the H2S addition 

✓ Add a new Single Point calculation and label it H2S charging 

✓ Open the Specs window and select the target gases, H2S 

 

✓ Set the following Calculation Parameters 

✓ Final Temperature = 100 C 

✓ Final Pressure = 200 atm 

✓ Vessel Volume = 1 L 

✓ PCO2 = 20 atm 

✓ PH2S = 1 atm 

✓ PN2 = 10 atm 

✓ Compute Results = Final 
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9.9 Advanced Autoclave #1 - CO2 and H2S in 
headspace of a 5% NaCl-H2O solution 
The purpose of this example, is to simulate a basic autoclave preparation.  The procedure is as follows:  

1) place the deaerated water and the test apparatus in the autoclave and seal it, 2) purged the autoclave 
with N2 to remove any remain oxygen 3) Add CO2 and H2S gases to the prescribed initial pressure, and 4) 
heat the vessel to test temperature.   

The above procedure is seven steps.  By comparison, the basic Autoclave tool is a single-step 
calculation.  All materials are entered at one time.  Therefore, what is explained in this chapter is how to 
use the current autoclave and mixer objects to perform properly, each of the above steps.  This example 
will detail each step. 

This example uses the following Autoclave settings.   

The autoclave is a 1 L vessel filled with 0.5 L of 5% NaCl solution, and a 0.25 L test apparatus.   

The test temperature is 115 C and the test partial pressures for CO2 and H2S are 20 and 0.1 atm, 

respectively.   

You will compute the conditions of the autoclave at each step, compute the amounts of CO2 and H2S to 
be added, and lastly compute the autoclave pressures at ambient and at test conditions. 

Getting Started 

Creating the 0.5 L, 5% NaCl solution 

✓ Add a new stream and label it 0.5 L of 5% NaCl 

✓ Change the framework to MSE 

✓ Change the units to Metric-Batch-Mass  

 

✓ Add NaCl to the grid and enter 5 grams 

✓ Change water to 95 grams 

✓ Change the stream amount to 0.5 kg (estimate) 

 

✓ Add a single point calculation, and label it Confirm Volume 

✓ Calculate and Click on the Output tab when converged 

✓ Right-mouse-click on the grid and select Sections>Phase Flow Properties 
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✓ View the liquid volume – it needs to be 0.5 L 

 

✓ Adjust the Stream amount in the Stream object to make this volume is 0.5 L.  The value is 
0.5165 kg. 

 

It’s important that this amount change be done in the Stream object, because this object will be used in 
the next calculation. 

Creating a 0.25 L sample and holder 

✓ Add a new calculation to the stream and label it 0.25 L Sample/Holder 

✓ Set the framework to MSE -  

✓ Set the units to Metric-Batch-Mass 

✓ Add C (carbon) to the grid and give it a mass of 750 g  

✓ Set the water flow to zero 

 

Aluminum is inert in these calculations because REDOX is not on.  Thus, it is a convenient material to 
occupy the 250 ml volume.  The exact amount of Al needed to produce 250 ml still needs to be 
compute, and this will be done next. 

✓ Add a single-point calculation and label it Confirm Sample volume 

✓ Calculate and click on the Output tab 

✓ Open the Volume section of the grid (Right-mouse-click, Sections>Phase Flow Properties) 

The 750 grams C occupies 330.8 ml volume.  Therefore, you will adjust this to 676.1 g to produce the 
250 ml volume (250/330.819*750).   

 

✓ Change the C value to 566.78 grams in the Sample and Holder stream 
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✓ Return to the calculation object, calculate, and confirm that the volume is 250 ml 

 

Create the N2 purge gas 

During the procedure, N2 is added to purge any excess O2.  If the autoclave is at 1 atm back pressure, 
then the pressure in the vessel will be 1 atm, and N2 (plus some H2O) occupies the headspace.   The 
software does not have the practical problem of excluding oxygen, but there is still a need to include the 
N2 that fill the headspace.  Therefore, this N2 stream is needed for this step. 

✓ Create a new stream and label it N2 purge gas 

✓ Set the framework to MSE 

✓ Add N2 to the grid, and give it a value of 1 mole 

✓ Set H2O to zero 

 

It’s not necessary to test volume here, because that will be done once the three streams are mixed.  
That will be next. 

Step #1 - Add the Brine and sample holder to the open autoclave 

This next step is performed in a mixer object.  The mixers were presented in Chapter 5, and so if there 
are questions about how this block works, refer to that chapter. 

✓ Add a Mixer object  and label it Open Autoclave 

✓ Add the following streams to the mixer, 0.5 L of 5% NaCl and Sample and Holder 

Notice the Total inflow row. They should show the mass of each stream adjusted in the previous steps. 
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✓ Click on the Report tab and scroll down to the Total and Phase flow table 

Both the liquid and solid volumes should be the expected values, 500 ml liquid and 250 ml solid.  

 

 

Step #2 - Add N2 purge gas to the closed autoclave 

✓ Add a new mixer and label it Closed Autoclave 

✓ Add the Open Autoclave and N2 Purge gas streams to the Selected section 

The Total inflows row now shows mole units, because the units in the Open Autoclave object was nit 
modified.  This will not affect the next steps. 

 

The next step is to add sufficient N2 so that it fills the autoclave headspace.  The total autoclave volume 
is 1 L, and 750 ml is occupied by the water and apparatus.  Thus, you will manually change the multiplier 
of the N2 purge gas, until the total volume is 1 L.  This is a manual process, and so this step may take 
several iterations. 

The amount of N2 needed to fill 250 ml headspace at ambient conditions, can be calculated from the 
ideal gas equation:  
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𝑛 =
𝑃𝑉

𝑅𝑇
=

1 𝑎𝑡𝑚 ∗ 0.25 𝑙

0.082057 
𝑙 − 𝑎𝑡𝑚
𝑚𝑜𝑙 − 𝐾

∗ 298.15 𝐾
= 0.01022 𝑚𝑜𝑙𝑒𝑠 

✓ Set the N2 purge gas multiplier to 0.01022 

 

✓ Calculate 

✓ Click on the Report tab and view the Total and Phase Flow table 

 

 

The autoclave is 1.62 ml too high.  Once again, using ideal gas to remove this much from the sample 

0.01022 −
1 𝑎𝑡𝑚 ∗ 0.00162 𝑙

0.082057 
𝑙 − 𝑎𝑡𝑚
𝑚𝑜𝑙 − 𝐾

∗ 298.15 𝐾
= 0.01016 𝑚𝑜𝑙𝑒𝑠 

✓ Change the multiplier to 0.01016  

 

✓ Calculate and view the phase flow table in the Report 

 

Step #3 and #4 – Add the CO2/H2S and set the final Autoclave condition 

The last two steps are combined into one.  First, the mixer output is converted to a stream and then an 
autoclave calculation computes the amount of CO2 and H2S needed.   

✓ Right-mouse-click on the Closed Autoclave mixer object and select Add as Stream 

 

 

✓ Name the stream Heated Autoclave 

✓ Add CO2 and H2S to the grid 
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✓ Add a Single Point calculation and label it Test Temperature 

✓ Change the calculation type to Autoclave 

✓ Open the Specs window and select CO2 and H2S from the Target Gas list 

 

✓ Set the final temperature to 115 C 

✓ Set the Vessel volume to 1 L 

✓ Set the CO2 Partial Pressure to 20 atm 

✓ Set the H2S Partial Pressure to 0.1 atm 

✓ Set the Compute results to Final 

 

✓ Calculate 

✓ Click on the Report tab and view the Stream Parameters table  

The software computes that the final pressure is 23.3 atm and the pH is 3.5.   

✓ Scroll up to the Stream Inflows table 

The software computes that to achieve the target partial pressures, 0.220 moles CO2 and 0.00202 
moles H2S are needed.   

The software does not show the Ambient pressure in this view, and the calculation needs to be 
repeated to see it.  For this, the Compute Results needs to be changed Ambient 

✓ Change the Compute Results to Ambient and calculate 

✓ View the Summary section to find the ambient pressure 
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According to the software, the pressure needs to be increase with CO2 and H2S to 0.4 atm.  The 
assumption is that a gas bottle will be created with the molar ratio of 0.2197 CO2 to 0.002023 moles H2S.  
This converts to a 99.087% CO2 and 0.912% H2S gas composition in the bottle.  

Summary 

The purpose of this example is to show how several calculation objects are used to model the autoclave 
charging and test procedure.   
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9.9 Advanced Autoclave #2 - Manual Autoclave setup 
using stepwise gas addition 
This next example provided by a client, was to simulate the NACE TM-0185-06 standard (internal 

coatings testing).  The procedure called for a stepwise charging of the autoclave with H2S and CO2.  After 
each charging step, the autoclave pressure is measured.  The targets were the concentrations of 
dissolved H2S and CO2 (molecular only) in the water at test temperatures.   

This experimental approach is not covered by the Autoclave calculation because two ambient pressures 
are needed rather than one.   As a result, the mixers are used to mimic the experimental procedure.  

The image below is a cartoon of the autoclave apparatus.  Water and the coupon apparatus are added 
to the autoclave and autoclave sealed.   N2 (hydrated) purges the water to remove O2.  The gas release 
valve is closed and H2S is added to a specified total pressure.  The H2S valve is closed and CO2 gas is 
added to a specified total pressure.   The CO2 valve is closed and the reactor is heated to test 
temperature.  The test pressure is recorded.  

 
Figure 1  autoclave adapted from : https://www.researchgate.net/figure/285578029_fig1_Fig-1-Schematic-for-immersion-
corrosion-testing-in-a-stainless-steel-autoclave-type 

You will create five inlet streams, the salt water, headspace gas, apparatus, CO2 gas, and H2S gas.  These 
streams will be added to a four mixers lined up in series, with each mixer representing a different 
procedure step.  The table below contains the target specification for the autoclave.   

2.3 CO2 Sequestration Autoclave Setup 

Stream and Autoclave (mixer) Setup Autoclave Target Specification 

Streams Salt Water 
Sparging N2 
Apparatus 
H2S gas 
CO2 gas 

Vessel Vol 3.6  L 

Final T 260 F 

  

Autoclave 
(mixer unit) 

Autoclave Step 1 (fill and seal) 
Autoclave Step 2 (Charge with H2S) 
Autoclave Step 3 (Charge with CO2) 
Autoclave Step 4 (Heat to test T) 

Dissolved CO2 3500 mg/l 

Dissolved: H2S 500 mg/l 
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Explanation  

The images below are an indication how this procedure will be performed.    

Step 1 - Setting up the autoclave with water, apparatus volume and sparging N2 in headspace 

The first image shows the initial charging step.  The water, apparatus and headspace make up the total 
volume in the sealed autoclave at ambient conditions.  Controllers, are used to adjust the volume each 
inflow to match the specified filling volumes and the total autoclave volume.   In this example, you will 
act as the controller by adjusting manually, the amount of each stream.  

 

To accomplish this step, you will create three streams, brine, sparging N2, and apparatus and add it to a 
mixer.  You will then adjust manually the Multiplier cell in the mixer so that the specified volumes are 
met. 

Step 2 through 4 – Adding H2S, CO2, and Raising temperature 

The next image contains Steps 2 through 4 in which H2S and CO2 are added individually and the amount 
required is based on the concentrations measured at test temperature.  Three controllers adjust; the 
amount of H2S, the amount of CO2, and the final pressure at test temperature.    
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You will create two streams, H2S and CO2, and three mixers, H2S Charging, CO2 Charging, and Heating 
Step.  You will then manually adjust the H2S and CO2 inflows (using the Multiplier cell in the mixers) until 
their target concentrations in the Heating Step mixer are met.  You will simultaneously adjust Pressure 
in the Heating Step mixer until the total volume matches the total autoclave volume.  All three 
adjustments are interdependent, and thus are made simultaneously. 

These three manual adjustments will take multiple iterations (several minutes).  Through these 
adjustments, you will observe the impact of total pressure on CO2 and H2S solubility, CO2 and H2S mass 
inflow on total pressure, and CO2 and H2S inflow on the solubility on the other gas. 

Steps 5 and 6 – calculate the ambient pressure for the H2S and CO2 charging steps 

The final steps are to calculate the pressures in the H2S and CO2 charging steps.  you will adjust 
manually the pressure in the H2S mixer and the CO2 mixer until the total volume is 3.6 L.  the pressure 
obtained represents the regulator pressure of the gas tanks that feed H2S and CO2 into the autoclave. 

 

You will adjust the pressure in each mixer until the total calculated volume in each match the 3.6L 
autoclave volume. 

Getting started 

The table below contains the streams you will create. Note the units.  

Brine 
N2 

(100% humidity@21C) 
Apparatus H2S CO2 

(grams) (mole %) (moles) (moles) (moles) 

Stream 
Amt 

1000 Stream 
Amt 

1 
(moles) 

Stream Amt 1 Stream 
Amt 

1 Stream 
Amt 

1 

T, C 21 T, C 21 T, C 21 T, C 21 T, C 21 

P, atm 1 P, atm 1 P, atm 1 P, atm 1 P, atm 1 

H2O 994.75 H2O 2.46 H2O 0 H2O 0 H2O 0 

NaCl 5 N2 97.54 Carbon 1 H2S 1 CO2 1 

NaHCO3 0.25   Solids Only 
box  

Check 
box 

    

✓ Create the streams using the information provided in the above table.   Note the units 
change. 

✓ Select the MSE framework for ALL the streams 
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Carbon is used for the Apparatus mass because it will be inert to all chemical reactions in this 
calculation.  Using carbon is not intuitive, rather it is discoverable, and this, plus shortcuts will become 
routine as you spend time using the software. 

✓ Create four mixers, label them Autoclave Step 1 Autoclave Step 2, Autoclave Step 3 and 
Autoclave Step 4 

Use the information in the table below for the input settings 

Inlet Streams Autoclave Step 1 Autoclave Step 2 Autoclave Step 3 Autoclave Step 4 

Units Metric-batch-moles Metric-batch-moles Metric-batch-moles Metric-batch-moles 
Aqueous = Concentration 
Vapor = mole fraction 

T, F 21 21 21 130 

P, atm 1    

Streams Brine 
N2 
Apparatus 

Autoclave Step 1 
H2S 

Autoclave Step 2 
CO2 

Autoclave Step 3 

Target Spec Brine = 1 L 
Apparatus = 500 ml 
Total Vol = 3.6 L 

Total Vol = 3.6L Total Vol = 3.6 L CO2 (aq) = 3500 mg/l 
H2S (aq) = 500 mg/l 
Total Vol = 3.6 L 

Add first Autoclave (Autoclave Step 1) 

✓ Create the first mixer – label it Autoclave Step 1 

✓ Add the stream, Brine 

✓ Calculate  

✓ Check the total volume in the Report.   

✓ Modify the Report so that the total volume appears at the top of the report.  Select the 
Customize button in the Report and deselect all tables except for Total/Phase Flows 

 

✓ Adjust the Multiplier until the volume is exactly 1. 

  

✓ Add the Apparatus stream to the mixer and calculate 
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✓ Review the solid volume in the report.  Adjust the multiplier until the solids volume is 500 ml 

   

✓ Add the N2 stream to the mixer and calculate 

✓ Review the Total volume in the report.  Adjust the multiplier until the total volume is 3.6 L. 

 

 

Create the remaining autoclaves 

✓ Add a new mixer – label it Autoclave Step 2 

✓ Change the T to 21 C and add the streams Autoclave Step 1 and H2S 

 

✓ Add a new mixer – label it Autoclave Step 3 

✓ Change the T to 21 C and add the streams Autoclave Step 2 and CO2 
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✓ Add a new mixer – label it Autoclave Step 3 

✓ Change the T to 130 C and add the streams Autoclave Step 3 

 

Modify the H2S and CO2 multipliers and the Test Pressures to match Test Concentrations 

✓ Press the Calculate button in Autoclave Step 4 – this will create a cascading calculation for 
all mixers and streams. 

✓ Click on the Report for Autoclave Step 4.  Modify the report so that the Total Volume and 
Species Output (True Species) tables are at the top 

✓ Click on the Customize button.  Clear All tables except for Total/Phase Flow and Species 
Output.  Close the window. 
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✓ Click on the Species Output True Species title to open the Table editor.  Deselect all Report 
items except for CO2 and H2S 

 

The Report should now look like this.  This will speed up the manual adjustments required in this case 

 

✓ Adjust the total pressure until the total Volume reads 3.6 liters. 
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✓ Review the CO2 and H2S concentrations.   

The target CO2 is 3500 mg/l and the target H2S is 500 mg/l.  you will change the multiplier in the 
Apparatus Step 2, Apparatus Step 3, and total pressure in Apparatus Step 4 to meet these targets. 

✓ Reduce the H2S multiplier in Autoclave Step 2 from 1 to 0.5 

 

✓ Increase the CO2 multiplier in Autoclave Step 3 from 1 to 6 

 

✓ Calculate Autoclave Step 4 

 

✓ Change the Total Pressure in Autoclave Step 4 until the Volume is 3.6 L 
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✓ Repeat these steps until the target specifications are met. 
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Final Step – calculate the pressures in the Step 2 and Step 3 autoclaves 

✓ Adjust the pressure in Autoclave Step 2 until the total volume is 3.6 L 

 

 

✓ Adjust the pressure in Autoclave Step 3 until the total volume is 3.6 L 
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Summary 

The manual procedure presented is an example of how an autoclave can be modeled when there is no 
automatic procedure, or if a flowsheet modeling tool is not available. 



 Advanced 
Calculations: REDOX, 
Adsorption & Kinetics 

Introduction 

In this section we will work on advanced reduction/oxidation, adsorption, and kinetics calculation.  

Section List 

 10.1 REDOX Advanced Calculation: calculating equilibrium of H2S subsystems (page 10-2) 

 10.2 Adsorption – Basic Surface Complexation: modeling the adhesion of ions to a 
surface (page 10-4) 

 10.3 Adsorption – Basic Ion Exchange: adsorption with Exchange database (page 10-8) 

 10.4 Kinetics – Basic Gas-Phase Reaction: using kinetics in the OLI Studio (page 10-12) 
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10.1 REDOX Advanced Calculation 

Overview 

Oxidation reduction reactions can be kinetically limited, and as a result, having REDOX enabled can 
result in incorrect output. The sulfur system below is an example: 

𝐻2𝑆 + 𝐻2𝑂 = 𝑆0 + 𝑂𝐻− +
1

2
𝐻2 [𝑆(−𝐼𝐼) 𝑡𝑜 𝑆(0)] 

𝑆0 +
3

2
𝐻2𝑂 =

1

2
𝑆2𝑂3

−2 +
3

2
𝐻2 [𝑆(0) 𝑡𝑜 𝑆(𝐼𝐼)] 

𝑆2𝑂3
−2 + 2𝐻2𝑂 = 𝑆2𝑂4

−2 + 𝐻2 [𝑆(𝐼𝐼) 𝑡𝑜 𝑆(𝐼𝐼𝐼)] 

𝑆2𝑂4
−2 + 2𝐻2𝑂 = 𝑆2𝑂5

−2 + 𝐻2 [𝑆(𝐼𝐼𝐼) 𝑡𝑜 𝑆(𝐼𝑉)] 

𝑆2𝑂5
−2 + 2𝐻2𝑂 = 𝑆2𝑂6

−2 + 𝐻2 [𝑆(𝐼𝑉) 𝑡𝑜 𝑆(𝑉)] 

𝑆2𝑂6
−2 + 2𝐻2𝑂 = 2𝑆𝑂4

−2 + 𝐻2 [𝑆(𝑉) 𝑡𝑜 𝑆(𝑉𝐼)] 

2𝑆𝑂4
−2 + 2𝐻2𝑂 = 𝑆2𝑂8

−2 + 𝐻2 [𝑆(𝑉𝐼) 𝑡𝑜 𝑆(𝑉𝐼𝐼)] 

𝑆2𝑂8
−2 + 2𝐻2𝑂 = 2𝑆𝑂5

−2 + 𝐻2 [𝑆(𝑉𝐼) 𝑡𝑜 𝑆(𝑉𝐼𝐼)] 

The thermodynamic result of oxidizing H2S with O2 is the formation of sulfate, S(VI). However, the 
reaction generally ends at elemental sulfur, S(0) because oxidizing elemental sulfur to sulfate is a slow 
process. For example, sulfuric acid production involves burning sulfur to form SO2, followed by an 
oxidation step to sulfate. Since most calculations in OLI Studio are flash calculations of electrolyte 
solutions, oxidizing H2S will generally stop at sulfur. However, without fine-tuning the calculation 
options, sulfate will form instead. 

In this example, we will prepare a solution of H2S and oxygen in water. We will calculate to equilibrium 
in two ways. In the first calculation, we will include all sulfur subsystems. In the second calculation, we 
will include only the S(-II) and S(0) subsystems.  

Modifying the REDOX subsystems 

 Create a new stream and rename it ‘Advanced REDOX’  

 Enter the inflows from the table above 

10.1 - Advanced REDOX Calculation 

Stream Name Advanced Redox  Stream Amount (calculated) Inflows (mol) 

Name Style Formula Temperature 25 °C H2O 55.508 

Framework Aqueous Pressure 1 atm H2S 0.001 

Units Set Default (moles)   O2 0.01 

Settings REDOX ON     

 Ensure that REDOX calculations are turned on  

 Ensure that Sulfur REDOX reactions is turned on  

 Add a Single Point calculation > Isothermal calculation  

 Calculate and review the Element Balance table at the bottom of the report 
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All the H2S was oxidized to S(VI), which is known to be the most thermodynamically stable oxidation 
state of sulfur in the presence of excess oxygen. However, this result is impractical because process 
applications would not produce sulfate. Rather, the product would be elemental sulfur. To 
accommodate for such limitations, the OLI Studio allows us to select or allow specific oxidation states  

 Click on Chemistry>Model Options from the Menu bar 

 Click on the Redox tab 

 Expand the Sulfur Subsystem section and deselect all the oxidation states higher than S(0)  

 

 Close the window, Calculate, and review the Element balance table 

 

The results now show that two oxidation states are possible. Furthermore, the total sulfur is 100% 
elemental sulfur. 
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10.2 Adsorption – Basic Surface Complexation 

Overview 

Adsorption onto reactive surfaces is a common natural and industrial phenomenon. The OLI Studio has 
a special database and mechanisms that allow us to model these reactions. The database is called the 
Surface Complexation Double Layer Model. Surface Complexation refers to the chemical reaction, and 
Double Layer Model refers to the electrostatic double layer theory used to compute the attraction of 
ions to and from the surface.  

Adsorption reactions are available in the Aqueous Framework. They have not been transferred to the 

MSE framework (as of V9.1.5). This database contains a single-surface active functional group, Fe-OH, 
which is based on the hydrous ferric oxide surface data developed by Dzombak and Morel (1990)1.  

Setting up the Case 

 Create a new stream and rename it ‘Surface Complex  

 Select the Surface Complexation Double Layer Model from the AQ database dropdown list 

 

 Enter the inflows from the table below 

10.2 - Surface Complexation Calculation 

Stream Name Surface Complexation  Stream Amt (calculated) Inflows (mol) 

Name Style Formula Temperature 25 °C H2O 55.508 

Framework Aqueous Pressure 1 atm HOHFO1CPM 0.1 

Units Set Default (moles)   Na2HPO4 0.1 

Database 
Surface Complexation 

Double layer model 

  Na2HAsO4  
  PbCl2  

 Add a Single Point calculation and confirm the type of Calculation is Isothermal  

 Confirm the initial concentrations of 0.1 mole for Na2HPO4 and HOHFO1CPM 

 Calculate then click on the Report and review the Species Output table 

                                                             
1 Dzombak, D.A and Morel, F.M.M. (1990), Surface Complexation Modeling: Hydrous Ferric Oxide, Wiley-Interscience, New York, 393 pp. 
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In some versions of the software, the bottom of the table will show six surface complexes. Three of the 
surfaces are the protonation-deprotonation reactions of the ferric oxide surface. 

≡ 𝐹𝑒 − 𝑂𝐻0 = ≡ 𝐹𝑒 − 𝑂− + 𝐻+ 

≡ 𝐹𝑒 − 𝑂𝐻0 + 𝐻+ = ≡ 𝐹𝑒 − 𝑂𝐻+ 

The remaining species are the adsorbed phosphate, and represent the following reactions  

≡ 𝐹𝑒 − 𝑂𝐻0 + 𝐻2𝑃𝑂4
−1 = ≡ 𝐹𝑒 − 𝑂 − 𝑃𝑂3𝐻2

0 + 𝑂𝐻− 

≡ 𝐹𝑒 − 𝑂𝐻0 + 𝐻𝑃𝑂4
−2 = ≡ 𝐹𝑒 − 𝑂 − 𝑃𝑂3𝐻−1 + 𝑂𝐻− 

≡ 𝐹𝑒 − 𝑂𝐻0 + 𝑃𝑂4
−3 = ≡ 𝐹𝑒 − 𝑂 − 𝑃𝑂3

−2 + 𝑂𝐻− 

Furthermore, in some versions of the software certain species in the table will have two suffixes, -CPM, 
-OH and -H. The –CPM suffix indicates that the surface has a zero charge. The –OH and –H suffixes 
indicates that the surface is charged and that the counter-ions (to balance the charge) is either the OH- 
or H+ ion. 

Based on the calculation, the surface distribution is as follows 

OLI Variable Name Surface Species Calculated amount (moles) 

H2OHFO1OH ≡ 𝐹𝑒 − 𝑂𝐻+ 1.924e-5 

HPO4HFO1H ≡ 𝐹𝑒 − 𝑂 − 𝑃𝑂3𝐻−1 2.811e-3 

OHFO1H ≡ 𝐹𝑒 − 𝑂− 2.769e-3 

PO4HFO1H ≡ 𝐹𝑒 − 𝑂 − 𝑃𝑂3
−2 0.0929 

HOHFO1CPM ≡ 𝐹𝑒 − 𝑂𝐻0 1.525e-3 

H2PO4HFO1CPM ≡ 𝐹𝑒 − 𝑂 − 𝑃𝑂3𝐻2
0 1.445e-6 
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 Recalculate the stream using 0.1 mole of Na2HAsO4 instead of Na2HPO4 (set Na2HPO4 to 
0.0) 

 Click on the Report and view the Species Output table 

 

The new species represent the following reactions  

≡ 𝐹𝑒 − 𝑂𝐻0 + 𝐻2𝐴𝑠𝑂4
−1 = ≡ 𝐹𝑒 − 𝑂 − 𝐴𝑠𝑂3𝐻2

0 + 𝑂𝐻− 

≡ 𝐹𝑒 − 𝑂𝐻0 + 𝐻𝐴𝑠𝑂4
−2 = ≡ 𝐹𝑒 − 𝑂 − 𝐴𝑠𝑂3𝐻−1 + 𝑂𝐻− 

≡ 𝐹𝑒 − 𝑂𝐻0 + 𝐴𝑠𝑂4
−3 = ≡ 𝐹𝑒 − 𝑂 − 𝐴𝑠𝑂4𝐻−3 

OLI Variable Name Surface Species Calculated amount (moles) 

H2OHFO1OH ≡ 𝐹𝑒 − 𝑂𝐻+ 0.0340 

HASO4HFO1H ≡ 𝐹𝑒 − 𝑂 − 𝐴𝑠𝑂3𝐻−1 9.954e-4 

HOASO4HFO1H ≡ 𝐹𝑒 − 𝑂 − 𝐴𝑠𝑂4𝐻−3 0.0344 

OHFO1H ≡ 𝐹𝑒 − 𝑂− 6.048e-4 

HOHFO1CPM ≡ 𝐹𝑒 − 𝑂𝐻0 0.02995 

H2ASO4HFO1CPM ≡ 𝐹𝑒 − 𝑂 − 𝐴𝑠𝑂3𝐻2
0 3.654e-5 

 

 Recalculate the stream by using 0.1 mole of PbCl2 instead of Na2HAsO4 

 Click on the Report and view the Species Output table 
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The new species represent the following reactions  

≡ 𝐹𝑒 − 𝑂𝐻0 + 𝑃𝑏+2 = ≡ 𝐹𝑒 − 𝑂 − 𝑃𝑏+ + 𝐻+ 

OLI Variable Name Surface Species Calculated amount (moles) 

H2OHFO1OH ≡ 𝐹𝑒 − 𝑂𝐻+ 0.0487 

OHFO1H ≡ 𝐹𝑒 − 𝑂− 1.86e-12 

PbOHFO1OH ≡ 𝐹𝑒 − 𝑂 − 𝑃𝑏+ 0.0513 

HOHFO1CPM ≡ 𝐹𝑒 − 𝑂𝐻0 1.987e-6 

 

This is a simple example of surface complexation.  
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10.3 Adsorption – Basic Ion Exchange 

Overview 

Adsorption onto reactive surfaces through an ion exchange reaction is also a common natural and 
industrial phenomenon. Ion exchange occurs on clays to balance permanent charges located on the 
basal plane of these clay minerals. Ion exchange occurs on industrial resins because these resins are 
designed to have a fixed charge (e.g., a sulfonate group) and a mobile counter ion (e.g., Na+). The OLI 
Studio has a special database – the Exchange database - and mechanism to model these reactions.  

The Exchange database and reactions are available in the Aqueous Framework only. This database 
contains the following exchange surfaces and exchange reactions. All are cation exchange surfaces (the 
database does not have entries for Anion Exchange). 

Exchange Surface Acid ion Exchange ions 

-PS4SOL H Cs, Na 

-PS6SOL H Cs, Na 

-PS8SOL H Cs, Na 

-PS10SOL H Cs, Na 

-PS12SOL H Cs, Na 

-PS16SOL H Cs, Na 

-PS20SOL H Cs, Na 

-BIBDJSOL H Cs, Na 

-CS100SOL H Cs, Na 

-IE96SOL H Cs, Na 

-50DOWEXSOL H Cu, Na 

-KAOSOL H Pb, Cu, Ni 

-AMBIRSOL H Na, K, Ca 

The exchange functional group, -PS4SOL for example, represents the surface containing the permanent 
charge. The -SOL suffix shown for each exchange surface is a variable text that instructs the software 
that the species being added (and calculated) is part of an ion exchange reaction. The software will 
handle these species differently than the other phases (solid, vapor, 2nd liquid, and aqueous). 

There is presently a limited number of species. OLI developed this database (and the mechanism) to 
model radioactive cesium removal from water. Now both the database and mechanism are used to for 
teaching purposes. Clients have developed private databases to utilize this calculation function.  

Setting up the Case 

 Create a new stream and rename it ‘Ion Exchange”  

 Select the Exchange database from the Aqueous database dropdown list 
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 Enter the inflows from the table below 

10.3 - Ion Exchange Calculation 

Stream Name Ion Exchange   Stream Amt (calculated) Inflows (mol) 

Name Style Formula Temperature 25 °C H2O 55.508 

Framework Aqueous Pressure 1 atm HKAOSOL 0.1 

Units Set Default (moles)   NiCl2 0.05 

Database Exchange   CuCl2  

    PbCl2  

 Add a Single Point calculation and confirm the type of Calculation is Isothermal  

 Confirm the initial values of 0.05 mole for NiCl2 and 0.1 mole for HKAOSOL 

 Calculate 

 Click on the Report and review the Species Output table 

There are two exchange surfaces at the bottom of the table, HKAOSOL and NiKAO2SOL. The NiKAO2SOL 
exchange species is comprised of one nickel and two KAOSOL functional groups. It is a bidentate 
structure. This is why the total solids is 0.076 moles instead of the 0.1 moles that we originally added. 
According to the calculation, 52% of the -KAOSOL surface is still protonated, which is an indication of the 
selectivity of this surface for Ni or H. 

 

Note the H+ concentration, it is 0.048 moles, and represents the H+ exchanged off the 0.1 moles of 
HKAOSOL (0.1-0.052005=0.047995 moles). This system should therefore have a low pH. 

 Scroll up to the Stream Parameters and record the pH 

 



10-10 Chapter 10: Advanced REDOX, Adsorption & Kinetics Tricks of the Trade 

The pH is computed to be low, 1.43. Thus, this exchange reaction results in a lower pH. Had Ni(OH)2 
been added instead of NiCl2, then the H+ would have been neutralized. 

 Recalculate the case using 0.05 mole of CuCl2 instead of NiCl2 

 Review the results 

The fraction of exchange sites populated by Cu+2 is only slightly different from Ni+2, indicating that the 
selectivity coefficient for Ni+2 and Cu+2 are similar (assuming ideal surface activity). 

 

 Recalculate the case using 0.05 mole of PbCl2 instead of CuCl2 

 Review the results 

 

According to these results, there is less selectivity for Pb+2 than for either Ni+2 or Cu+2. The selectivity is 
about 50% less. The cause of this difference appears to be in part due to the precipitation of PbCl2 solid. 
As a result, only half the Pb+2 exists as a soluble species, compared to the Ni+2 and Cu+2. 

 

 Change the inflows to the following 

 

 Calculate and review the Species Output  

This calculation represents competition among the three cations for the surface. Most of the surface is 
still protonated, and only a fraction of the Pb+2 has adsorbed, again because of the PbCl2 solid phase. 
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We can better see the amount of Ni+2, Cu+2, and Pb+2 removed from the water with another section of 
the table.  

 Scroll down to the Element balance table 

According to the table, of the 0.025 moles Ni+2, Cu+2, and Pb+2 added to the water, about 50-60% of the 
metal still remains dissolved. Thus, adding more exchange material, or modeling this as a plug-flow 
column reactor, rather than a batch reactor, would improve the removal efficiency.  
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10.4 Kinetics – Basic Gas-Phase Reaction 

Overview 

In this section, we will look at the OLI Studio’s approach to kinetics. The kinetics function is available 
within single point calculations. This function works by overriding the equilibrium equation for the 
reaction we select. It can also create a reaction mechanism that is not part of the standard OLI database.  

In the case below, we will model the following gas-phase chemical reaction: 

2𝐻2 + 𝑂2 = 2𝐻2𝑂 

NOTIFICATION – The kinetics model is functional as of V9.1.5 (November 2014). However, calculations 
with the standard Arrhenius equation are not working properly for gas-phase reactions. Therefore, to 
develop your own kinetics reaction, we recommend contacting OLI Technical Support. 

10.4a Adding the File Viewer plug-in 

Before we get started, we will enable the File Viewer tab. This tab lets us view internal calculation 
results, which contain reaction rate details. In the future software versions, the reaction rate details will 
be available within the Report tab.  

 Save all the files that need to be saved from the previous section because we will need to 
restart the software  

 From the menu bar, select Tools> Options> Plug-ins 

 Add a check to the OLI File Viewer box 

 Press the OK button at the bottom of the screen (NOT THE ADD button) 

 

 Restart the software 

 Reopen the previous cases  

10.4b Setting up the Kinetics Case 

 Create a new stream and rename it “H2-O2 Kinetics”  
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 Select the Names Manager, then select the Formula view and press OK 

 Enter H2 and O2 into the input grid  

 Enter 1 mole each of H2O, O2 and H2 

 

 Select Chemistry>Model Options>Phases from the menu 

 Click on the Kinetics box in the lower left and press OK to close the window 

 

 Add a Single Point Calculation and name it “Isothermal Flash”  

 Calculate and record the Species Output concentrations  

Notice that there is no reaction between H2 and O2. 

 

 Return to the ‘H2-O2 Kinetics’ stream and add a new Single-Point calculation 

 Rename it “Isothermal REDOX”  
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 Click the Re (REDOX) button on the Ribbon bar -  

 Calculate and view the results 

In this case, 100% of the H2 has reacted, which is expected, because the reaction is highly exothermic. 

 

 Return to the ‘H2-O2 Kinetics’ stream and add a new Single-Point calculation 

 Rename it “Isothermal Kinetics”  

 Click the Specs button 

 Select Kinetics from the Category section 

The kinetics category is empty, but we will add a kinetic reaction here.  

 Click the Add button at the top to create a new reaction and press OK 

 

 Double-click on <Create New Reaction> 

 
 

 Enter the following reaction exactly as shown (this part of the software requires specific 
typing) then press <ENTER>:  

2H2VAP+O2VAP=2H2OVAP 

The reaction will appear in the field.  
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 Next select STD from the Rate Specification drop-down 

 

 Click on the Add button in the center right to add the rate constants 

 

 Select KF and KR from the add list 

This is the Forward and Reverse rate constant- it is temperature independent 

 

 Enter the following values for the constants 

Constant Value 

KF 1e7 

KR 1e3 

These constants represent the forward and reverse rate of the reaction.  

 

 Close the Calculation Options window  

 Calculate 

 Select the Report tab and view the Species Output table 
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The reactants and products have the following values: 

Constant Value 

H2VAP 2.69e-3 

O2VAP 0.5014 

H2OVAP 0.0164 

Adding this to the overall rate equation 

𝐾𝑟𝑥𝑛 =
𝑘𝑓

𝑘𝑟
=

𝐻2𝑂𝑉𝐴𝑃2

𝑂2𝑉𝐴𝑃 ∗ 𝐻2𝑉𝐴𝑃2 =
0.01642

0.5014 ∗  0.002692 = 74.13 

 View the new results 

Viewing the Kinetics calculation details 

Kinetics calculation results became part of the report in V9.3.  For earlier versions, the information is in 
one of the Output files.  You can view these results in the File Viewer tab. This output is not on by 
default, so we our first step will be to turn it on.   If you are using V9.3 or newer, then skip this next set 
of instructions 

 Return to the Definition tab (if not already there) 

 Click on the Specs… button 

 Click the Enable trace button 

 

 Close the window then recalculate 

 Click on the File Viewer tab 

 Select Trace File from the File Type dropdown menu on the left side of the screen 

 

 Click anywhere within the trace screen (to make this the focus of the mouse) 
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 Scroll down to about row 54 and see the values and units associated with the components 

 V9.2.1 or Newer - click on the Report Tab and the Customize Button.   

 Select the Reaction kinetics box at the bottom of the Report Contents List 

 

 View the results using this output 

Hour 1 

 
Hour 2 

 

Note the EXTENT value; this represents the progress of the reaction at each time step  

𝐸𝑥𝑡𝑒𝑛𝑡 = 𝑟𝑎𝑡𝑒 =
𝑚𝑜𝑙𝑒𝑠

𝑡𝑖𝑚𝑒 𝑠𝑡𝑒𝑝
= −2 ∗

𝑑𝐻2

𝑑𝑡
= −

𝑑𝑂2

𝑑𝑡
= 2 ∗

𝑑𝐻2𝑂

𝑑𝑡
 

The overall rate is the sum of the extent after each time step 

𝑂𝑣𝑒𝑟𝑎𝑙𝑙 𝑟𝑎𝑡𝑒 = 𝐸𝑥𝑡𝑒𝑛𝑡𝑡=1 + 𝐸𝑥𝑡𝑒𝑛𝑡𝑡=2 + ⋯ + 𝐸𝑥𝑡𝑒𝑛𝑡𝑡=𝑛 

The Extent of reaction after hour 1 and 2 (Stage 1 and Stage 2) is: 

0.4894 + 0.0092 = 0.4897 𝑔𝑚𝑜𝑙 

For O2, starting with 1 mole, the remaining O2 amount is:  

1 𝑔𝑚𝑜𝑙 − 0.4897 𝑔𝑚𝑜𝑙 = 0.5013 𝑔𝑚𝑜𝑙 

For H2, starting with 2 moles, the remaining H2 amount is: 

2 𝑔𝑚𝑜𝑙 − 2 ∗ 0.4897 𝑔𝑚𝑜𝑙 = 0.002691 𝑔𝑚𝑜𝑙 

Both values can be observed for O2 (vapor) and H2 (vapor).   
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It is noted above that 99.94% of the reaction is completed after the first hour.   

Using the Hold-up time and reaction steps 

There is an option on the grid that allows the user to fix the overall reaction time and the individual 
time steps. In the previous case, the calculation time (Holdup time) was set to two hours, and this was 
divided into two steps. These values are needed to compute the RATE FORWARD, RATE REVERSE, and 
EXTENT variables.  

 

 Recalculate using the following holdup time and steps (1 hr and 1 step) 

 

 Select the File Viewer tab and view the Trace File 

 Scroll down to about line 190 to find the rate values 

 

According to these results, the overall extent is 0.489 gmol/hr, the same as in the 2-hr case, but this is 
largely because the reaction has already come to equilibrium. Note the rate derivative values Rate 
Forward and Rate Reverse values. These values are computed based on the initial concentrations and 
the rate coefficients. The overall rate derivative is Rate Forward-Rate Reverse = 0.489 gmol/hr2. The 
time is one hour, and there is only one time step. Therefore the overall rate extent is 0.489 gmol/hr2*1 
hr*1 step=0.489 gmol/hr. 

 Return to the Report tab and view the Species Output table 
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The O2 value is 0.5109 moles 0.489 moles less than the starting value. The H2O is 0.0219 moles, or 
2*0.489 moles less than the starting value.  

Using the Arrhenius Equation 

There is a second way to create the rate constant for this reaction. The KF above is a temperature-
independent rate constant. Many reactions are temperature dependent, based on kinetic theory (the 
higher temperature the faster they move). The Standard Arrhenius equation is part of the software 
construct and has the following form:  

𝑟𝑎𝑡𝑒 = 𝐴𝑒−𝐸𝑎
𝑅𝑇 

The OLI Version is: 

𝑟𝑎𝑡𝑒 = 𝐴𝑒− 𝐵
𝑅𝑇 

Since the reaction has a forward and reverse form, the OLI version becomes 

𝐹𝑜𝑟𝑤𝑎𝑟𝑑 𝑟𝑎𝑡𝑒 = 𝐴𝐹𝑒−
𝐵𝐹
𝑅𝑇 

𝑅𝑒𝑣𝑒𝑟𝑠𝑒 𝑟𝑎𝑡𝑒 = 𝐴𝑅𝑒−
𝐵𝑅
𝑅𝑇 

 Add a new single point calculation; rename it “Isothermal Arrhenius”  

 Open the Specs window and select Enable Trace 

 

 Click on the Kinetics category 

 Select the Add button then enter the H2 combustion reaction: 2H2VAP+O2VAP=2H2OVAP 

 Select STD in the Rate Specification dropdown menu 

 Click on the Add button and select the following variables, AF, BF, AR, BR 

These are the forward and reverse constants of the Arrhenius equation.  

 Enter the following values for the constants 

Constant Value 

AF 1e5 

BF 300 

AR 10 

BR 600 

The screen should look like the following 
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 Set the Hold-up time and steps to 1 

 

 Calculate, and view the Species Output in the Report 

The extent of reaction is 1 - 0.92112 = 0.0788 moles, and since the holdup time is 1 hr, r=0.0788 mol/hr.  

 

 Click on the File Viewer, select Trace and view the Kinetics values 

The values for EXTENT confirm these results.  

 



Appendix 

Introduction 

This section describes features of the OLI Studio. The chapter starts with an overview of the OLI Studio 
Interface, including some calculation objects discussed previously.  
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A.1 Creating Custom Units 

Overview 

The OLI Studio has many actions that take time to setup but may be useful later. These include developing 
custom units or names, using private databases, selecting a thermodynamic framework, and modifying 
calculation options. The purpose of this section is to explain some of these features so that the reader can 
best use their capabilities 

Creating Custom Units 

Custom units are created through the Tools-Options menu. It is at this location where the user manages 
the internal files that save these units. You will create a sample custom unit set. 

 Add a new Stream. Label it Training Units - .  

 Select Tools>Options>Units from the menu 

The Units tab contains two sections, Default units and User Defined units. You will work in the User 
Defined units.  

 

 Click on the Manage button at the bottom of the window. This will open a User Defined Units 
dialog window 

 

 Select the New button. This opens another dialog window: Enter a custom unit set name: 

 Enter the name Training and press OK 
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This opens a new window, called Edit Units. This window should look familiar, as it is the main edit window 
for all unit modifications. The basis units set is moles-grams-m3-hr. Each of these are editable. 

 

 Change the Composition tab to the following. Note, that the gray areas are not editable (they 
are set by other cells, or there is no information to enter) 

 Change the system to Batch from Flowing 

Variable Basis Units 

Stream Amount Mass  

Inflows Mass Fraction  

   

Aqueous 
Composition 

Concentration  

Vapor Composition Mole Fraction  

Solid Composition Concentration  

2nd Liquid 
Composition 

Mole Fraction  

Total Composition Moles  

   

Moles  mol 

Mass  g 

Volume  L 

Concentration  mg/l 

Molar Concentration  mol/l 

Mass Fraction  ppm (mass) 

Mole Fraction  ppm (mole) 

The window should look like the screenshot below. 



A-4  Appendix Tricks of the Trade 

 

 Press Save to close the window 

The User Defined Units window now contains the Training units.  

 

 Close the Options  

 Click on the Units Manager radio button in the Ribbon 

 Click on the first-down-arrow button in the Units Manager  

The new units we created will be available when we start the software. It is important that we exit the 
software normally for this to be saved. So, if we are at a point where we can stop, close the software and 
restart it. 

 

It is also possible to set these units to be the default units set. This can be done in a few ways, instructions 
for which will provided by the instructor.  



Tricks of the Trade  Appendix A-5 

A.2 Single Point Calculations 
The OLI Studio has 11 types of single point calculations. This includes 10 standard calculations and 1 

customizable option. These calculations are only available when a Stream is active or highlighted in the 
Navigator. Calculations are “added” to the Navigator as branches to the active stream.  

When added, the screen will show the Description grid of the default single point calculation type, 
Isothermal. To the right of the Description grid, After selecting the single point option from the Actions 
Pane, the client will see the Type of Calculation dropdown menu to the right of the Description grid. When 
selected, the calculation  

 

A stream’s single point calculation selection menu 

Isothermal: This is a constant temperature and pressure calculation. 

Isenthalpic: In this calculation, a client enters a constant heat loss or heat gain to determine how the 

pressure or temperature changes meet the new heat content. 

Bubble Point is when the temperature or pressure is adjusted to reach a condition where a small amount of 

vapor begins to appear. 

Dew Point is when the temperature or pressure is adjusted to reach a condition where a small amount of 

aqueous liquid appears. 

Vapor Amount is when the temperature or pressure is adjusted to produce a specified amount of vapor. 

Vapor Fraction is when the temperature or pressure is adjusted to produce a specified amount of vapor as 

a fraction of the total quantity. 

Set pH is when the pH of the solution can be specified by adjusting the flow rate of a species. 

Precipitation Point is the amount of a solid (solubility point) may be specified by adjusting the flow rate of a 

species. 

Composition Point is the aqueous concentration of a species may specified by adjusting the flow rate of a 

species 

Reconcile Alkalinity is Compute the total alkalinity of a fluid at the standard 4.5 pH end point or at a value 

specific to your system.   

Custom Combinations of the above calculations can be created. 
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A.3 Species Names Icons and Selecting Display Names 
What are the small symbols adjacent to the species in the input grid? 

The species in the OLI databases are sorted by several different names. The sort order can be modified by 
the user and this will be discussed later in this document.  The symbols appear next to the species names: 

 

Each symbol has a different meaning. 

 

 SYN is a component synonym.  

 

STAR is the species Display Name – it is one of 
the display options in the Names Manager 
toolbar. 

 

Test Tube is the component’s chemical formula. 
A green drop is the common formula name is 
displayed. A yellow drop is the alphabetical 
formula name. 

 LOL is the EPA list of list name.  

 
CAS is the Chemical Abstracts Service registry 
number for the species.  

 
OLI is the OLI program variable name, which is 
used internally by the OLI Engine. 
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How to speed up the search for components? 

Select Tools > Names Manager 

 

You can speed up the selection of names by limiting the search order for the various symbols. This is not 
recommended for stand-alone systems but network systems may experience increased search speed by 
limiting the species types. 

Select Search Criteria from the tabs. 

 

Uncheck any item you do not wish to have searched. 
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A.4 Viewing Critical Pseudocomponent & Assay Data  
These steps will walk you through viewing the critical properties of pseudocomponents that you 

generated. The procedure for determining the critical parameters for assay pseudocomponents is almost 
the same as for a single pseudocomponent. The only difference is that the resultant file has more 
components. 

 

Click on Specs and Enable 
Trace on the Calculation 
Option tab 

Calculate  

 

 

 

 

 

 

Select the File Viewer tab 

 

 

 

 

 

 

 

 

 

Select the list of file types 
and select Trace File 

 

 

 

 

 

 

Copy the first line of the 
Trace File which is the 
location of the temporary file 

 

After you have completed entering the data for pseudocomponents or 
assays, you will normally go to the Enable trace option in the Specs menu 
to turn on the debugging information. Then you will calculate as normal.  

 

If the File Viewer tab is not visible, then you may need to enable the File 
Viewer Plug-in (previous section of Appendix).   

 

The Trace File is stored in a temporary file area within Windows. As the 
program runs, these files are created then automatically deleted. In order 
to view the file, you will have to do so while the software is running.  

 

The first line in the Trace File view shows the temporary file location. In 
this case, the file location is 
C:\Users\AQSIM\AppData\Local\Temp\OLI5f072.  

 

Notice that the trace file name here is OLIe4132_SinglePoint1.oue. 
You can also search for this file name using Windows explore
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Paste file address in an 
explorer window 

 

 

Find the file with the *.A01 
extension  

 

 

 

 

 

 

 

Open the file with Notepad 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This is a partial list of the generated thermodynamic values in Notepad. 

 

This table explains some of the units used in this report.  

KEYWORD  Definition Units 

MOLW  Molecular Weight g/mole 

ACEN  Acentric Factor  

TCRI  Critical Temperature K 

PCRI  Critical Pressure Pa 

VCRIT  Critical Volume m3/mol 

BOIL  Normal Boiling Point K 

CP  Heat Capacity J/mol/K 

HREF  Reference State Enthalpy J/mol 
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A.5 Stability Diagram Plot Options  
Within the Stability Diagrams tab, several options are available to customize your view. We will focus on 

the Display Choices tab within the Plot Options window, which we open by selecting the Customize button.  

 

Display Choices is one of three tabs in the Plot Options window. The other two tabs are self-explanatory: 
Color Options and Diagram Fonts.  

 

Display Choices contains the following options:  

 Aqueous and Solid Lines – Choose one of the three display options. 

 Natural pH – Toggle the pH line 

 Show ORP – Toggle the Oxidation Reduction Potential circle 

 Shading – Add or remove plot coloring or change the metal/subsystem that is colored. Only one 

metal/subsystem can be selected for coloring. 

 Display Subsystems – Choose which subsystem will be displayed on the plot. Only subsystems 

where REDOX is on will be active. The others will be grayed out. You can turn on the REDOX 

subsystem by selecting Chemistry>Model Options> Redox from the menu bar 
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A.6 Corrosion Rate Survey by Options 
There are 12 calculations available. They fall into three general categories, the first six (Single Point 

through pH) are thermochemical variations. Four of the remaining six (Pipe Flow to Rotating Cylinder, and 
Shear Stress) are hydrodynamic variations, and two deal with the thermal aging of a weld. The last, Liquid 
Flow in pipe, is an estimate of multi-phase flow (oil-water) mixing on corrosion.  

 

Grid Section 

 

The Grid section looks similar to the other objects. The Calculation Parameters section is used in Single 
Point and Survey calculations, and the Contact Surface is used in the Pourbaix Diagrams. 

Calculation Parameters 

Depending on the survey selected, the Calculation Parameters grid changes its appearance. When the 
calculation type is Single Point, Temperature, Pressure, or Composition, the following grid is used. The only 
option is to set the flow type and effect of corrosion related scales.  

 

Survey by Single Point Rate, Temperature, Pressure, or Composition 

When the survey type is pH, the grid includes the description of the pH variables. 
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Survey by pH 

The calculation grids for other survey options are shown below.  

 

Survey by Pipe Flow  

 

Survey by Sheer Stress  

 

Survey by Rotating Disk 

 

Thermal Aging Temperature and Thermal Agin Ttime 

 

Survey by Rotating Cylinder 

 

Survey by Liquid Flow in Pipe 
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A.7 Adding a Names Dictionary and Private Database 
Creating the Names Dictionary 

The Names Dictionary creates a list of client-generated “user names” for species within the OLI database. 
The feature may help a client who wants to call up a species with something other than its formula, display 
name, or OLI Tag. For instance, we can give the hydrocarbon C21H44 a simpler name like C21 and enter this 
as an inflow instead of the formula or display name (n-Heneicosane). The Names Dictionary may be 
especially helpful for anyone who works extensively with hydrocarbons.  

 Select Tools> Names Manager 

 

 Select the Names Dictionary tab  

 

 Enter a component (e.g. C21H44) and give it unique name (e.g. C21) 

 Press <Enter> to advance to the next cell 

We can also use the right-mouse button menu to copy/paste a two-column component/username list into 
the Names Dictionary.  

 

 Select the Names Style tab  

 Select the Display Name button and check the Use Names Dictionary box 

 

 Press OK to exit the Names Manager when finished 
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Inserting a private database 

This section describes how to import a database.   

 Select Chemistry > Model Options from the Menu bar  

 

 Click on the Import Databank button 

  

 Click on the Browse button 

 Find the database, for example, AminesHCL.DIC 

As of OLI Studio Version 9.1, all databases end with the *.dic extension.  

 Click Next 

 

 When you see the green check mark next to Completed, select the Finish button 

 Click on the down arrow in the Thermodynamic Framework field and change the selection to 
MSE (H3O+ ion) 

 

 Highlight the database and send to right hand side then press the OK button  
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 Press OK 

 

 Save the file 
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